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INTRODUCTION 
 

In Ukraine, there has recently been a rapid growth of ecological and economic 
organizations and social movements for the protection of the environment. In their 
work, they use experimental data, which must be skillfully and scientifically 
competently processed, systematized and visually displayed for society. It is for this 
reason that the discipline "Informatics" was introduced for students of higher 
educational institutions under the educational program of training of specialists of 
Bachelor's degree in specialties 101 - "Ecology", 051 - "Economics". Nowadays, life 
without computers is almost impossible. Computers are necessary at home, at work, 
in banking, in the film industry and many, many other places. Currently, it is 
impossible to even imagine life without computers. They opened a qualitatively new 
stage in the life and development of human civilization. However, the information 
contained on one computer is rather difficult, especially with large volumes of 
information, to be transferred to another computer for further work. 

Until now, a standard program has been developed, several methodological 
instructions for performing laboratory work in the discipline have been issued, an 
educational and methodological complex has been prepared and electronic training 
courses have been introduced in the Elearn and Moodle system, and an educational 
practicum in informatics has been issued. The textbook is based on theoretical and 
practical material from the disciplines "Computer networks" for students of the 
Bachelor's degree. 

The textbook consists of six sections containing: 1) use of the MS Office 
package (Osypova T.Yu.); 2) modern network and information and communication 
technologies ( Mamchenko S.M. ); 3) use of distance learning environment and 
Internet resources (Glazunova O.G.); 4) use of the Mathcad application 
( Osypova T.Yu.); 5) MS Access database management system (Mamchenko S.M.); 
6) designing presentations in the MS Powerpoint processor ( Kasatkin D.Yu. ). 

The textbook is addressed to students of the Bachelor's degree in the 
specialties 101 - "Ecology", 051 - "Economics" and may be useful for students of 
other non-technical specialties. 
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CHAPTER 1. USING THE MS OFFICE PACKAGE  
 

1.1. Creation of tables in the word processor MS Word and carrying out 
calculations in them 

Tables are used to present information containing numerical data in a form 
more convenient for analysis. The word processor Word has quite developed tools 
for quickly and conveniently creating tables of any configuration with wide 
possibilities of editing and formatting their content, as well as changing the structure 
of the table itself, performing simple calculations with numerical data. 

 
Creating a table 

▪ perform actions: Insert  Table⇒ Insert a table ; 
▪ in the dialog box that opens, in the Number of columns field set the required 

number of columns, and in the Number of terms field - the number of lines; 
▪ press the OK button . 

A table can also be created using the Add table button ( ) on the standard 
toolbar, or by following the steps : Insert ⇒Table  To draw the table . 

When a table is created by one of the above methods and the cursor is placed 
in one of the cells, two new tabs Design and Layout for working with tables 
automatically appear in the menu bar on the right. 
Table formatting 

▪ Changing column width and row height: 
− place the cursor on the vertical or horizontal dividing 

line of a column or row so that it takes the form  

←║→ ; 
− when the left mouse button is pressed, the dividing line is moved. 

▪ Merging cells: 
− select a range of cells for merging; 
− perform actions: Layout (work with tables)⇒ Mergee cells . 

▪ Column insertion (row, cells) : 
− place the cursor in the cell near which the object should be inserted (column, 

row, cell); 
− perform actions: Table ⇒Add ; 
− in the cascading submenu that opens, select the desired object and its insertion 

option relative to the location of the cursor. 
▪ Horizontal and vertical alignment of information in a table cell: 

− place the cursor in the desired cell; 
− press the right mouse button;  
− in the dialog box that opens, select the Alignment in cell item , 

go to the cascading submenu and choose one of the 9 options for aligning the 
contents of the cell; 

or : 
− perform actions View⇒ Panels tools⇒ Tables and borders ; 
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− buttons for 9 alignment options will appear on the toolbar; 
− select a range of cells the contents of which must be aligned; 
− choose one of the alignment options. 

▪ Changing the direction of writing text in a cell (horizontally, vertically): 
− set the cursor in the cell; 
− perform actions: Format⇒ Text direction ; 
− in the dialog box that opens, in the Orientation field choose the text 

orientation option in the cell; 
− press the OK button . 

▪ Changing the thickness and type of the table line: 
− set the cursor in the cell of the table; 
− perform actions: Table ⇒ Table properties ; 
− or call the context menu; 
− in the dialog box that opens, select the Table tab and press the Borders and 

filling button ; 
− in the next dialog box, on the Border tab in the Type zone , mark: Grid - to 

change the type and thickness of the grid, All - to change the type and thickness 
of all table lines, Frame - to change the formatting parameters of the table 
frame; 

− in the fields Type , Color , Width, select the desired one from the lists; 
− in the Apply to field, select: table – to format the lines of the entire table, cell 

– the lines of the cell in which the cursor is located, or the selected range of 
cells; 

− click the OK buttons in both dialog boxes. 
▪ Changing the background and color of the working field of the table: 

− place the cursor in a cell of the table, or select a range of cells, the color of 
which must be changed; 

− perform actions: Table⇒ Table properties ; 
− in the dialog box that opens, select the Table tab and click the Borders and 

fill button ; 
− in the next dialog box, on the Fill tab , select a color from the palette; 
− In the Apply to field , select the desired one; 
− click the OK buttons in both dialog boxes. 

 
Splitting and joining tables 

 The table can be divided horizontally into several. To do this, set the cursor in 
the selected place, perform the following actions: Table ⇒ Split the table . The 
table will be divided into two. The dividing line will pass above the cursor location. 
To combine the tables, they are placed one under the other and all punctuation marks 
between them are removed, including the paragraph end mark.  

 
Conversion of text to table and table to text 
When entering text that is planned to be converted into a table, the following 

rules apply: 
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▪ fragments of the text, which will be placed in separate columns of the table, are 
separated by certain punctuation marks: tabulation ( Tab key ), semicolon, 
paragraph or others; 

▪ text fragments, which will be located in separate lines, are separated by the end 
of the paragraph mark ( Enter ). 
Select the text intended for conversion into a table and perform the following 

actions: 
▪  Insert ⇒Table ⇒ Convert into a table ⇒Text into a table ; 
▪ in the Convert to Table dialog box  enter the number of columns of the future 

table in the appropriate field, the number of rows may not be entered; 
▪ in the Auto Selection of width of columns group of switches choose one of the 

proposed options; 
▪ in the group of switches Separator note a tick mark used to separate text 

fragments intended for placement in separate columns; 
▪ if there is no such sign among the proposed ones, choose the Another item and 

enter the desired character in the corresponding field; 
▪ press the OK button . 

To convert the table into text, perform the following actions: 
▪ separate the table; 
▪ Work with tables ⇒Layout ⇒ Convert to text ; 
▪ in the fields of the dialog box, similarly enter the parameters upon request. 

Using formulas in a table 
With the numerical information placed in the MS Word table, you can perform 

simple calculations, for example, adding, multiplying, dividing the numbers located 
in different cells of the table, by using VBA functions ( Visual programming 
language Basic for applications). To perform calculations in a table cell, perform the 
following actions: 
▪ set the cursor in the selected cell; 
▪ Work with tables ⇒Layout ⇒Formula; 
▪ in the dialog box that opens, one of the calculation formulas will be offered in 

the Formula field , depending on which cell was previously selected: 
− =SUM(ABOVE) – adding the numbers located above the selected cell (the 

cell with the formula is below the column with numbers); 
− =SUM(LEFT) – adding the numbers placed to the left of the selected cell (the 

cell with the formula is to the right of the row of numbers); 
− if there are empty cells in a row or column, they must be filled with zeros for 

calculations; 
▪ if the proposed formula suits you, press the OK button ; 
▪ if not, then it is removed from the Formula field , leaving only the = (equals) 

sign; 
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(Формула=formula, формат числа=number format, Вставить функцию=enter 
function, Вставить закладку=enter bookmark) 

▪ enter the formula yourself, or select the menu (see fig.). 
Addresses of cells with data are used when entering formulas. The cell address 

consists of the column designation and the row number. Columns are denoted by 
Latin letters (for example, A, B, C, D, etc.), rows by numbers (for example, 1, 2, 3, 
etc.). The address of the cell located at the intersection of column D and the second 
row will look like D2. 

The following can be used in the formula: 
▪ mathematical operators (for example, + (addition), – (subtraction), * 

(multiplication), / (division)); 
▪ VBA functions (for example, SUM - sum, PRODUCT - product, MIN - 

minimum value, MAX - maximum value, etc.); 
▪ the required function is selected from the Insert function list of the Formula 

dialog box ; 
▪ after entering the formula, press the OK button . 

Examples of using functions : 
=SUM(LEFT)/2 – the sum of the numbers located to the left of the selected cell, 

divided by two; 
=MIN(LEFT) – the minimum number from those located to the left of the 

selected cell; 
When the data presented in the table is changed, calculations according to the 

formulas are repeated. For this purpose: 
▪ select the table, or the part of the table in which changes have taken place, using 

the mouse, or by performing the following actions: Table⇒ Highlight⇒ Table 
; 

▪ press the F9 key ; 
▪ cell values calculated by formulas will be updated. 

The main categories of functions, arguments, operators are given in table 1.1.



10 
 

Table 1.1. 
Categories of functions 

Statistical 
AVERAGE() Average 
COUNT() Number of values 
MAX() Maximum 
MIN() Minimal 
SUM() Sum 

Mathematical 
ABS() Module 
ROUND(x, y) rounding 
MOD(x, y)  
INT(x) Integral 
SIGN(x) Whole part 
PRODUCT() Product 

Logical 
IF( x,y,z ) If 
AND( x,y ) AND 
OR( x,y ) Or 
NOT(x) Denial 
FALSE is a logical constant of 0 False statement 
TRUE is a logical constant of 1 True 
DEFINED(x) Determines the value in a cell 

Arguments (indicated in round brackets) 
RIGT To the right of the cell 
LEFT Left 
ABOVE Above 
BELOW Lower 
CELL ADDRESSES A1, etc 
constants Numbers, text in double quotes 
WORD functions  
signs of operations   
+ Addition 
- Subtraction 
* Multiplication 
/ Division 
% Percentage 
^ Exponentiation 
= Is equal to 
< Less 
<= Less or equal 
>= More or equal 
< > Not equal to 
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Practical work #1 
The purpose of the work : to learn how to create, edit and format tables in the Word 

processor 
 

 
Execution program 

1. Download text editor Word. 
2. Set page parameters: (left margin – 3 cm; right – 2.5 cm; top – 2.0 cm; bottom – 

2.0 cm; page orientation – portrait). 
3. Create a table. 1.2 given in the task, using the appropriate Word tools for this . 
4. Copy table 1.2 and supplement it so that it looks like table 1.3, adding the missing 

elements and carrying out the appropriate formatting: 
− table header: Times New Roman , 14 pt, bold, alignment of text in the middle 

of the page; 
− table header: Times New Roman , 13 pt, bold, cell center alignment; 
− the content of the first column of the table: Arial , 13 pt, bold italics, center 

alignment. 
− information in cells: Times New Roman , 14 pt, ordinary, in the center; 
− type of lines for framing - according to table 1.3.: (double line 1.5 pt thick; 

single lines 0.75 pt thick; filling with the color of the table cap - 25% gray). 
5. Align the width of the columns with numerical information and the height of the 

rows. 
6. Calculate the average values and the sum using the formulas ! 
7. Split the table. 1.3. into two 
8. Go to the next page. 
9. Enter the text given in the task to be converted into a table, using the appropriate 

punctuation marks. 
10. Convert the entered text into a table. 
11. Enter the name of the performer, the name of the group and the date of the work 

in the header of the document. 
12. Save the created document in your own folder. 
13. Exit Word. 
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Tasks for practical work 
Table 1.2 

 
(1. Content of trace elements in sludge deposits of cleaning spores mg/kg of dry 

matter 
 
Microelement name 
 
Content of trace elements, mg/kg of dry matter) 
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Table 1.3. 

 
(2. Results of research on the content of microelements in sludge deposits of 

sewage treatment plants, mg/kg of dry matter 
 
Content of trace elements, mg/kg of dry matter 
 
The name of the trace element 
 
1 repetition 
 
2 repetition 
 
3 repetition 
 
Average) 
 
Text to be converted into a table. 
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(3. Levels of radiation pollution in Ukraine 
 
Object Strontium - 90, nKi/kg, l 
 
Cesium 137, Ki/kg, l 
 
Hay of natural lands 247±53.7 
 
543±121.5 
 
Hay of sown herbs 
 
209±41.8 
 
269±109.3 
 
Straw 127±37.7 
 
118±85.2 
 
Grass of natural lands 
 
164±67.8 
 
253±91.5 

 
Silage 91±47.6 87±44.4 
 
Potatoes 13.5±2.08 17.1±2.13 
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Fodder beetroot 
 
31.6±11.8 
 
46.4±20.17 
 
Combined feed 38.2±6.32 51.6±7.73 
 
Milk 5.7±1.07 26.2±13.21 
 
Cattle meat 
 
15.3±1.52 136.3±47.32 
 
Bovine bones 1084±231.36 
 
363±127.73) 

Self-test questions 
1. How to insert a table into a text document? 
2. What are the ways to create a table of the desired configuration? 
3. How to change row height and column width? 
4. How to give the same width or height to a group of cells? 
5. How to move the cursor through the cells of the table? 
6. How to change the direction of writing text in a cell? 
7. How to change the type and thickness of the table line? 
8. How to change the color of the working area of a cell, table? 
9. What are the options for aligning information in cells and how to implement 

them? 
10. How to combine and split cells in a table? 
11. How to insert and remove additional rows, columns and cells? 
12. How to convert text to table and table to text? 
13. How to split a table into two and how to merge two tables into one? 
14. How to enter a formula into the table? 
15. What VBA functions are offered for performing calculations? 
16. How to renew calculations by formulas? 
How to format data in a table? 
 
 

1.2. Calculation by means of MS WORD 
Using fields for calculations in MS Word 

When working in the word processor MS Word, there is often a need to type 
and calculate simple formulas. At the same time, you can abandon the use of MS 
Equation and use the insertion of fields of the Eq type . In this case, the user writes 
the code corresponding to the required formula in the text. 



16 
 

Suppose we need to display the formula I = U / R not in a row, but as a fraction. 
To do this, press Ctrl + F9 - two curly brackets will appear on a gray background, 
inside which you need to enter the code: eq I = \ f (U; R). If you press F9 at the 
moment when the cursor is inside the field, the field will be updated and its value 
will be displayed - we will see the expression as a fraction. 

  
Fig. 1. The code and the result of its execution 
If desired, you can turn this field into an MS Equation object by double-

clicking on it with the left mouse button. To switch the field back to code display, 
press Shift + F9 when the cursor is on the field or it is highlighted, or right-click on 
the field and select "Codes / field values". The code can be edited and the fonts of 
symbols in it can be changed both in the usual way and through styles. The key 
combination Alt + F9 switches the display mode of field codes / values in the entire 
document. 

Types of formulas that can be specified using the Eq fields can be viewed by 
selecting the " Field " item in the " Insert " menu. In the left half of the window, 
select the " Formulas " category, and in the right - the " Eq " field, then click on the 
" Parameters " button, and we will see a list of possible keys for this field. 
Highlighting each of them, you can read a brief description of the keys at the bottom 
of this window. 

We will list only the most used keys: 
• \ f (x; y) - fraction , this key was used in our example; 
• \ r (n; x) - the sign of the root , the degree of the root is written before the 

semicolon, after - the expression itself; 
• \ i (a; b; f) - integral , the first parameter - the lower limit, the second - the 

upper limit, the third - the integral expression; 
• \ b () - brackets , the size of which corresponds to the size of the expression 

enclosed within them; 
• \ s (a; b) - places each subsequent parameter below the previous one, for 

example, if you want to write the variable U squared, and also with the subscript i, 
then write the code in the field: eq U \ s (2; i). 

With the help of the "=" field, Word can perform simple mathematical 
calculations. Press Ctrl + F9 and enter the expression code in the field, for example: 
= (10 + 16 ^ 0.5) * 2. When pressed, the field will be updated and we will see the 28 
in the result. 

In technical reports (for example, in course projects), calculations must be 
made in the form of: 

U = 50 V 
R = 10 Ohms  

)(5
10
50 A

R
UI ===

 
For this, Word provides for the creation of so-called bookmarks (variables). 
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These bookmarks can be assigned to any fragments of text or numbers and then used 
in fields (almost like in a programming language). To do this, type the first two lines 
of the example. Now select the number 50 and press Ctrl + Shift + F5 - the 
bookmark editing window will appear (it can also be called via the " Insert " -> " 
Bookmark " menu). In the upper field " Bookmark Name ", give the number the 
name U_1 (you cannot give names of the U1 type to numbers, because in the 
calculated fields Word perceives these names as references to table cells) and click 
the " Add " button. Next, select the number 10 and give it the same name R_1. Then 
go to a new line in the text and type: 

{ eq I = \ f (U; R) = \ f ({U_1}; {R_1}) = {= U_1 / R_1}} (A) 
Curly brackets are not entered manually, but mean the insertion of fields when 

pressing Ctrl + F9. If everything is entered correctly, after updating the fields (select 
the entire line and press F9), the third step of our example will be in two layers. 

 { eq I=\f(U;R)=\f({U_1};{R_1})} 

   
Figure 2. The code and the result of its execution 
If the result of the calculation needs to be presented with several significant 

figures after the decimal point, then you can use the numeric format key. For 
example, by adding \ # 0.0 after = U_1 / R_1, we get 5.0. 

For ease of use, you can set the switch in the "Bookmarks" option in the " 
Service " -> " Options " menu on the "View" tab , then the numbers 50 and 10 to 
which the bookmarks are assigned are displayed in square brackets (the brackets are 
not displayed when printing). If you change these numbers now, the new calculation 
result will be displayed after updating the fields. For convenience, variable values 
can be highlighted in dark blue. Then you can immediately see where you need to 
enter data, and when printing on a black and white printer, the dark blue color is 
almost indistinguishable from black. 

 
{ eq I=\f(U;R)=\f({U_1};{R_1})={=U_1/R_1}} 
50105(A) 
Figure. 3. The code and the result of its execution. 
Setting up the toolbar for calculations using MS Word 
In Word, you can calculate the value of an expression without using fields. 

But first you need to add a special command to the toolbar. In Word 2016, we do the 
following: 

Select in the File menu 
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(Панель швидкого доступу=Quick Access panel, команди не на стрічці= 

commands not on tape, обчислити=calculate, додати=add) 
Word Settings→Options→Select commands from→All commands Select 

commands in the corresponding window . 
Before clicking the Add button , it is possible (not necessary) to create a group 

on one of the tabs, for which the corresponding button serves. The group can be 
renamed (for example, Calculations). 

Now that the group is created, you can add your favorite teams. At the end, 
press OK , and the corresponding commands will appear on the quick access panel. 

In Word 2003, you need to open Service > Settings > the Commands tab, 
find the All commands item in the Categories list (on the left) . A full list of Word 
commands will appear on the right. Any of them can be dragged to the menu or to 
the toolbar. You need to select ToolsCalculate and drag it to any toolbar. 

 
(Команди=commands) 
The button is not active yet. 
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In order to apply it. We write an algebraic expression: 
3.02 * (6.32 + 5.21) / 2.85 = 
We highlight it (the = sign does not need to be highlighted!), and click on the 

added button - the result is placed in the clipboard. To see the result, place the cursor 
after the = sign and press the Insert button or CTRL + V. 

3.02 * (6.32 + 5.21) / 2.85 = 12.2178 
To raise a number to a power , you need to use the symbol ^ ( Shift + 6 in the 

English keyboard layout). For example, 5 to the third power: 
5 ^ 3 = 125 
Four arithmetic operations (+, -, /, *), parentheses, exponentiation, and 

percentage calculations can be used in formulas. All letters are ignored, so you can 
use notation like "5000 hryvnias", "$125" in the formula. For example, 600 hryvnias 
* 5% = 30. 

As you know, calculations in MS Word can also be done in tables using 
Formulas . If there is a need to use formulas in tables quite often, then for 
convenience it is suggested to add the Formula button to the toolbar and the most 
used Summation operation ( Σ ( AutoSum )). 

(Команды=commands, Таблицы=tables, Автосумма=AutoSum, Все 
команды=All commands) 

Practical work #2 
The purpose of the work: to master skills of performing calculations in an 

MS Word document 
 

Execution program 
1. Download MS Office Word word processor. 
2. Customize the calculation toolbar. For this purpose, add commands 

Σ ( Autosum or Sum ), fx (Formula), Calculation ( Calculate or 
ToolsCalculate ) 

3. Calculate the values of the given expressions using the Calculate or 
ToolsCalculate tool . Moreover, ordinary fractions should be entered 
in parentheses, and the numerator should be separated from the 
denominator by parentheses. 

1.

( )
.

25,08,12
125
48625,075,3

15
144,0

3
1

125,0
6
1

4
15,0



−
+

++

+++

 

2.

.25,0

25
3:0345,0

4
16128,0

20
11

40
76,0725,0



−

+++

 
4. Find 78% of 6,000 hryvnias, 37% of $5,000. Raise the following 

expressions to the power of .17;8,13;7,56;185 3325
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5. Make calculations in table 1.4. using the appropriate commands on the toolbar 
Table 1.4 

6. Follow the example given in the task with the calculation of I through 
U and R. Change the parameters of current strength I and voltage U 
to 13A and 5V. Enter all the necessary parameters in the 

corresponding fields and calculate the resistance R, if I
UR =

. 
7. Save the document in its own folder. 
8. Shut down the computer. 

 
Self-test questions. 

1. How do I set up my own dashboard for calculations? 
2. What field codes are used for calculations in Word. 

 
1.3. Entering formulas into a text document 

To write mathematical expressions in text documents that cannot be written 
using superscripts, subscripts and other text tools, use the formula editor Microsoft 
Equation 3.0 . 

 
Loading the formula editor   

▪ perform actions: Insert⇒ Object ⇒Microsoft Equation 3.0 ; 
▪ press the OK button ; 

▪ or click on the   button on the toolbar. 
 
 

No. 
z/p Product name Number of 

sown areas, ha 

Productivity 
without the 
contribution of 
fertilizers, cwt/ha 

The pFig of one 
centner, hryvnias 

1 Winter wheat 200 22 126 
2 Spring wheat 150 19 110 
3 Barley 80 18 80 
4 Oat 70 19 79 
5 Rye 55 29 90 
6 Buckwheat 40 34 145 
7 Millet 35 70 85 
8 Pea 30 95 95 
9 Corn 70 190 85 
10 Potato 144 370 60 
11 Beet 155 390 55 

Everything    
On average    
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Record formulas 
▪ the formula is recorded in a special area that appears on the workspace after 

loading the formula processor together with the special Formula panel ; 

 
▪ before writing symbols with indices, under the sign of the root, sum, integral, in 

the form of a fraction, etc., first enter the appropriate template from the Formula 
panel , and then fill it in; 

▪ Cyrillic and Latin characters are entered from the keyboard; Greek alphabet, 
mathematical and special symbols - from the Formula panel by selecting them 
with the mouse pointer; 

▪ the position of the blinking cursor in the template zones indicates the current 
location of the symbol; 

▪ movement through the zones of the template or according to the formula is carried 
out with the cursor control keys or with the help of the mouse; 

▪ writing a symbol of a mathematical operation will refer to the symbol framed by 
the cursor at the time of writing; 

▪ the transition to a new line in the formula is carried out using the Enter key ; 
▪ indentation between symbols within the formula zone is carried out with the space 

key while holding down the Ctrl key , or using the Spaces and ellipsis panel from 
the Formula toolbar ; 

▪ to write a new formula, leave the area of the previous formula and load the formula 
editor again. 

 
Editing formulas 

▪ Contents of the formula: 
− highlight the formula by clicking on it once; 
− enter the formula area by double-clicking on it so that a blinking cursor appears 

in the middle of the formula; 
− place the cursor in the place of the formula where you need to edit; 
− to remove symbols or signs, use the Delete or Backspace keys ; 
or: 
− right-click on the highlighted area of the formula; 
− in the context menu that opens, select the items Object ⇒Formula ⇒Open ; 
− the content of the previously highlighted area of the formula will open in a 

special window with improved conditions for editing; 
− after editing the formula, close the window. 

▪ Size formula: 
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− leave the formula zone by clicking with the mouse outside its borders on a free 
place; 

− select the formula by clicking once with the mouse so that a frame with eight 
markers in the shape of black squares appears around it; 

− place the cursor on one of the markers so that it takes the shape of a double-
sided arrow ( ↔) and, with the left mouse button pressed, change the size of 
the formula to the desired one. 

▪ The size of the symbol in the formula: 
− enter the formula area; 
− highlight the character whose size needs to be changed; 
− in the Size menu select the type of character size you want. 

 
Use of "fields" for date entry and autonumbering of formulas 

 To enter the date , which will be automatically updated each time the 
document is opened, perform the following actions: 

− Insert⇒ Date and time ; 
− in the Date formats field choose the desired format; 
− press the OK button ; 
− when clicking with the mouse on the date entered in this way, it will be 

highlighted with a gray rectangle . 
 To autonumber formulas, perform the following actions: 
▪ place the cursor to the right of the formula, which must be numbered; 
▪  Links ⇒Insert name ; 
▪ in the Name dialog box , in the Parameters group , in the signature field , select 

Formula from the list ; 
▪ while in the Name field the inscription Formula 1 will appear ; 
▪ if necessary check the Exclude signature from names box , after which the word 

Formula will disappear in the inscription Formula 1 and only the number will 
remain; 

▪ press the OK button ; 
▪ as a result, the inscription Formula 1 will appear to the right of the formula (if 

the signature was not excluded from the name), and the number will be in a gray 
frame; 

▪ in the inscription, you can change everything except what is highlighted in gray 
(located in the field); 

▪ if necessary, remove the inscription Formula , and put the remaining number in 
round brackets, set the appropriate formatting parameters, mostly formatting 
parameters of the main text or formula. 

To update formula numbers, highlight the text fragment where the changes 
occurred and press the F9 button . 

To work in the formula editor, it is possible to use both the Formula panel and 
the keyboard. The table shows the main key combinations for effective work in the 
formula editor. 

Table 1.5 
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Superscript characters 
Dash from above CTRL+SHIFT+HYPHEN 
Tilda CTRL+SHIFT+~ 
Arrow (vector) CTRL+ALT+HYPHEN 
One stroke CTRL+ALT+' 
Two strokes CTRL+SHIFT+" 
Single point CTRL+ALT+. 

Blank spaces 
Tabulation CTRL+TAB. 
Zero space SHIFT+SPACE 
Space 1 pt CTRL+ALT+SPACE 
Short space (one sixth of a long space) CTRL+SPACE 
Middle space (one third of a long space) CTRL+SHIFT+SPACE 

Fractions and indices 
Fraction CTRL+F 
Slashed fraction CTRL+/ 
Superscript CTRL+H 
Subscript CTRL+L 
Superscripts and subscripts CTRL+J 
Integral CTRL+I 
The square root of a number CTRL+R 
() Round brackets CTRL+9 or CTRL+0 
{} Curly brackets CTRL+SHIFT+{, CTRL+SHIFT+} 
[] Square brackets CTRL+[, CTRL+] 

Greek letters 
Entering Greek letters Ctrl+G followed by a Latin letter 

 
 

Practical work No. 3 
The purpose of the work: to master skills of performing calculations in an 

MS Word document 
Execution program 

1. Download word processor. 
2. Set the margins of the document: (left – 2.5; right – 1.5; top – 2.0; bottom – 2.0). 
3. Set the work execution date, which will change automatically at each session of 

working with the document. 
4. Enter the text document with formulas specified in the task, adhering to the 

established formatting options. 
5. Insert autonumbering of formulas. 
6. Give formula numbers formatting options for the main text. 
7. Move the text fragment with formula (3) to the beginning of the text. 
8. Update the numbering of formulas. 
9. Save the created document in your own folder. 



24 
 

10. Exit Word. 
Tasks for practical work 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(In the following text, which will be a translation of the figure above, all 

formulas will be replaced with ‘*formula*’ 
[Date] 
 
1. The average concentration of a substance in a flowing reservoir: 

*formula* 
 
where *formula* total flow of wastewater entering the reservoir, m³/year; and the 
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volume of the reservoir, m³; T- duration of the forecast, year; k value of the 
coefficient of conservatism of the substance, 1/year; C - initial concentration of 
the substance, g/m³; O - amount of water flowing out of the reservoir, 
 
m³/year; T - conditional time of water exchange, year.  
 
2. The equation for the number of young (No. 1) and old (No. 2) cells in the 
microbial population: 
 
*formula* 
 
where T1 is the average maturation time of a young cell; T2 - the average time an 
old cell stays in the reproductive period; D - flow rate. 
 
3. Matrix model of the age structure of the population:  
 
*formula* 
 
where X(to) is a vector that characterizes the population at the initial moment of 
time; 
 
X(4) is a vector characterizing the population at the next moment in time; and 
 
birth rate; in the survival rate.) 
 

Self-test questions 
1. How to download formula editor? 
2. What is the order of writing the formula? 
3. How to change the size of the formula area? 
4. How to format the content of the formula? 
5. How to change the size of symbols in a formula? 
6. How to insert autonumbering of formulas? 
7. How to set a date that will change every time the document is opened? 
8. How to update formula numbering? 

 
1.4. Creation of graphic objects in the Word processor 

The word processor Word allows you to design a text document with graphic 
objects (flow charts, graphs, diagrams, photos, etc.) by directly creating them or 
importing them from other applications, files or the library of the processor itself. 

 
Creation of graphic objects 

▪ perform actions: Insert⇒ figures ; 
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▪ in the menu that opens, select the type of graphic object that is planned to be 

created; 
▪ move the cursor to the working field (the cursor will take the shape of + ) and 

while holding the left mouse button, move it, creating a graphic object of the 
required size; 

▪ to create absolutely correct shapes, such as vertical or horizontal lines, a circle, a 
square, etc., perform the specified actions with the Shift key pressed . 

 
Entering text 

To enter text inside a graphic object : 
▪ separate the object - autofigure ; 
▪ click on it with the right mouse button; 
▪ in the context menu that opens, select the Add text item, after which a cursor will 

appear in the middle of the autoshape ; 
▪ enter text. 

To create text labels anywhere in the working area of a complex graphic object 
:  
▪ choose a rectangle; 
▪ draw a rectangle at the place where the text inscription is created and write the 

text inside it; 
▪ select the received shape with text, call up the context menu, open the list of 

possible options and choose None ( the outer borders of the text area will not be 
visible); 

▪ the text area can be freely moved around the working field. 
To create artistic or vertically placed text inscriptions : 
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▪ in the Insert menu , select WordArt ( ); 
▪ in the dialog box that opens, select the recording style and click on the OK button 

; 
▪ in the next dialog box, enter the text and set its formatting parameters; 
▪ click on the OK button . 

 
Formatting of created graphic objects 

Moving the object on the working field 
▪ select a graphic object (click on it once so that rectangular markers appear around 

it); 
▪ bring the cursor to the object so that it takes the shape of a cross; 
▪ move while holding the left mouse button; 
▪ for smooth movement use the key combination ( Ctrl + ←↑→↓) . 

Changing the orientation of the object in space 
▪ select a graphic object, the Format tab for working with drawing tools 

automatically appears; 
▪ on the Format tab , select the Return/ Reflect sub-item , go to the submenu and 

select the appropriate action. 
Changing the type and line thickness of a graphic object 

▪ single out the graphic object; 
▪ on the Format tab , click the Shape Contour button ( ) and in the expanded 

menu, select the option to change the type and thickness of the lines; or the 
Stroke Type button ( )– to change the solid line to another of the proposed 
options. 

Changing the color background of a graphic object 
▪ select the graphic object; 
▪ on the Format tab, next to the Shape fill button ( ), open the list of possible 

color gamut options and select the desired one; 
▪ to create a background in the form of a combination of two colors with a smooth 

transition from one to the other, choose the Filling options option ; 
▪ in the dialog box that opens, on the Gradient tab in the Color and Hatch Type 

zones select options. 
Setting the overlapping order of graphic objects 
When creating a complex graphic image that consists of many shapes and text 

zones, the order in which they overlap each other is important, because the shape or 
text zone that is in the upper layer can cover part of the object that is below it. The 
last created shape is automatically placed higher relative to the already created ones. 
To change the overlapping order of objects, perform the following actions: 
▪ separate a graphic object that is planned to be placed above or below another; 
▪ on the Format tab in the Sorting item select the Move forward ( Move back) 

sub-item ; 
▪ go to the cascading submenu and select the item To background , To foreground 

or another . 
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Combining several graphic objects into one 
Combining provides the possibility of working with an object that is created 

from many separate elements, as with a single whole. In particular, copy, change the 
overall size, prevent the object from breaking between pages, etc. For this: 
▪ on the Format tab , click the Selection area button on the Ordering panel ;  
▪ Selection panel appears to the right of the created picture , which lists all the 

graphic objects in the picture; 
▪ while holding the CTRL key, select all objects one by one; 
▪ on the Format tab in the Sorting zone select the Group item ; 
▪ grouped objects will form a single object. 

Disconnecting grouped objects 
▪ select a grouped object by clicking on it;  
▪ on the Format tab in the Sorting zone select the sub-item Ungroup; 
▪ the ungrouped object will consist of separate objects, which makes it possible to 

format them separately. 
 

Practical work #4 
The purpose of the work : to learn how to create and format graphic objects in the 

Word processor 
Execution program 

1. Download word processor. 
2. Set page orientation to landscape. 
3. Create the structural diagram given in the task according to the following 

requirements: 
− the name of the structure scheme: Arial , 16 pt, semi-bold, all caps, sparse 2 pt, 

center alignment; 
− text inside auto figures: Arial , 12 pt, bold ; 
− fill the objects and set the formatting parameters of individual elements 

according to fig. 3; 
− group all elements into one object. 

4. Save the created document in your own folder. 
5. Exit Word. 

 
Tasks for practical work 

 
It is shown in fig. 
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(Втрати біогенних елементів ґрунтом і шляхи їх компенсації -  



30 
 

Self-test questions 
1. How to create a graphic object? 
2. How to move the created graphic object? 
3. How to write text inside a graphic object? 
4. How to change text direction? 
5. How to format the text inside the object? 
6. How to make the outer borders of the text area invisible? 
7. How to change the overlapping order of objects? 
8. How to change the formatting parameters of the external lines of the 

object? 
9. How to insert a WordArt object ? 
10. How to change the size and orientation in space of a graphic object? 

How to group graphic objects? 
 

1.5. Creating, editing and formatting spreadsheets 
The Excel spreadsheet is a powerful software tool for effective 

processing of data presented in tabular form: performing various 
calculations, constructing graphic dependencies , creating databases, 
modeling, forecasting and optimizing processes, finding the roots of 
equations, etc. 

The structure of the table processor window is in many respects 
similar to the structure of the windows of other Windows applications. The 
Excel window displays a title bar, a menu bar, by default two toolbars, 
Standard and Formatting , a formula bar, an address bar, a workspace, a 
status bar, and scroll bars. 

When you load Excel, a new document called Workbook 1 is 
automatically created, which can have up to 255 sheets. Each sheet of the 
workbook is presented in the form of a table consisting of 256 (2 8 ) columns 
and 65536 (2 16 ) rows. Column headings are usually marked with letters of 
the Latin alphabet, and row headings with numbers. 

A rectangle is located at the intersection of each column and row, 
which is called a cell . A cell clicked with the left mouse button is considered 
active, it is highlighted by a bold black frame. Each cell has its own address 
(name), which is determined by the title of the corresponding column and 
the row number (for example, the cell formed by the intersection of column 
F and row 2 has the address F2). In Excel, in addition to the addresses of 
individual cells, the addresses of cell ranges that include part of a column 
(D2:D8), part of a row (C3:C12), or a block of cells (B3:E6) can be specified. 
At the same time, the symbol “ : ” separates the address of the first cell (upper 
left) from the range and the last cell (lower right). 
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Start Microsoft Excel  

▪ load the Windows operating system; 
▪ perform actions: Start⇒ Programs ⇒Microsoft Excel ; 
▪ or : click with the mouse on the image of the icon or the shortcut of the 

application, if they are located on the desktop; 
▪ or : Start⇒ Create an Office document⇒ New book . 

 
Creating a table 

The working field of an Excel sheet has the form of a table consisting 
of columns of the same width and rows of the same height, at the intersection 
of which there is a cell. The user, as a rule, creates a table structure depending 
on personal needs: gives a certain look to the table header by combining 
cells, changes the width of the columns and the height of the rows. 

Merging cells 
The merging of cells is used to form the structure of the table, not to 

increase the width or height of the cells.  
The procedure of combining cells involves creating one cell from a 

certain number of cells. For this purpose: 
▪ select the cells that are planned to be merged (drag the cursor along the 

cells with the left mouse button pressed); 

▪ click on the button Combine and place in the center ( ) on the 
formatting panel; 

▪ or perform a sequence of actions: Format⇒ cells ⇒ Alignment ⇒ 
Association cells ; 

▪ in case of erroneous merging of cells, perform a similar sequence of 
actions and remove (disable) the Merge option cells 
Changing the height of rows and width of columns  

The height of the rows and the width of the columns depends on the 
content of the cells formed by their intersection, the requirements for the 
appearance of the table and the personal preferences of the user. Most often, 
the size of the cell is changed using the mouse. For this purpose: 
▪ set the cursor between the column names - to change the column width, or 

between the row numbers - to change the row height, so that it takes the 
form ◄┼► ; 

▪ when the left mouse button is pressed, the borders of rows and columns 
are moved, setting the required height and width. 

Changing the width and height of a group of cells 
To give a group of cells the same size, other than the default, the 

previous method is not very efficient and not accurate enough. For this 
purpose: 
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▪ single out a group of columns , the width of which is planned to be 
changed to the same value; 

▪ perform actions: Format⇒ Column ⇒Width ; 
▪ in the dialog box that opens, enter the width value from the keyboard (one 

unit corresponds to the width of one character of size 10); 
▪ press the OK button ;   
▪ single out a group of lines , the height of which is planned to be changed 

to the same value; 
▪ perform actions: Format⇒ The line⇒ Height ; 
▪ in the dialog box, enter the line height value in the appropriate field from 

the keyboard (the number 12.75 corresponds to the height of a character 
of size 10, 25 - corresponding to the height of a character of size 20); 

▪ press the OK button . 
Inserting a cell (row, column) 

▪ select a cell next to which you need to insert an empty cell (row, column); 
▪ perform actions: Insert ⇒Cells (Rows, Columns ); 
▪ when inserting an empty cell, mark the direction of movement of filled 

cells in the dialog box that will open when performing the specified 
actions; 

▪ the column is automatically inserted to the left of the active cell, the row 
is inserted from above. 

 
Create notes 

Notes are used to provide additional information about the contents of 
cells. For this purpose: 
▪ select the desired cell; 
▪ call up the context menu and select the Add note item ; 
▪ in the rectangular area that appears, enter the text of the note and click 

with the mouse outside it (the entered text will disappear, and a red 
triangle will appear in the upper right corner of the selected cell); 

▪ when the mouse cursor is placed on a cell with a note, a rectangular area 
with the text of the note appears; 

▪ changing the text of a note or removing it is carried out using the 
corresponding items in the context menu. 

 
Data types in cells and their input  

Information entered into the cells can be of different types (formats): 
text, number, date and time, formula. 

To enter any type of data into a table cell, perform the following 
sequence of actions: 
▪ activate the cell for entering data; 
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▪ enter data (number, text, formula) using the keyboard; 
▪ confirm input: 

− press a key enter 
− or click the mouse on another empty cell. 

Text 
Most often, filling in tables begins with text entry. Text when entered 

is displayed in a pre-activated cell and is automatically aligned to the left 
edge. If the length of the text label exceeds the size of the cell, the rest of it 
is written to the right of the active cell. However, in fact, all information is 
only in the cell activated at the beginning of text input. If you click with the 
mouse outside the cell with the entered text, only its part, limited by the size 
of the cell, will be displayed on the screen, and the rest of the text will be 
invisible. To place the text within one cell both physically and visually, 
perform the following sequence of actions: Format ⇒Cells⇒ Alignment ⇒ 
Moves by words . As a result, fragments of text, limited by the width of the 
column, will be located under each other. 

Numbers 
Any number is entered into the activated cell and is automatically 

aligned to the lower right edge. If necessary, the location of the numbers in 
the cell is changed. Numerical data can be entered in various forms and 
formats: as an integer (124); decimal fraction (14.426) with accuracy up to 
30 decimal places; ordinary fraction (1 1 / 5 ); monetary format (1.20 hryvnias, 
$5). If the number has more than 12 digits, Excel automatically converts it 
into a floating point format, i.e. the number 0.000000000137 entered in the 
cell after changing the active cell will become 1.37E - 10. When writing a 
decimal fraction, the whole part of the decimal is separated by a comma! To 
write a number in a certain format, perform the following sequence of 
actions: Cell ⇒Format ⇒Number and select the desired format. 

Date, time 
One form of numerical information in an Excel cell can be a date or 

time. Dates are most often entered in the form 14.3, 14.03.05,  
14 Mar 05, etc. When entering a date, days, months and years are separated 
by a dot , which automatically converts the number into a date format (this 
is often the cause of an error when writing a decimal fraction). The time is 
recorded similarly. The appearance of the date and time record can be 
changed in a wide range by performing the following actions: Format 
⇒Cells ⇒Number ⇒Date . 

Autofill cells 
auto-completion tool in its asset , which significantly speeds up the 

input of numerical and textual data that changes within a certain interval or 
according to a certain law. An example of such data can be serial numbers 
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(1,2,3 ...), dates (1.02.05, 2.02.05 ...), days of the week (Monday, Tuesday, 
...), months of the year (January, February ...) and other lists. 

Filling adjacent cells with numerical data using the autofill function 
can be done in different ways. 

Dragging the autofill marker 
▪ the initial value is written in the selected cell; 
▪ activate the adjacent cell and record the next value; 
▪ the difference between the second and first entered values will determine 

the step size (when entering dates with a change step of 1 day, this action 
is skipped); 

▪ select the cells that contain the initial and next value of the list; 
▪ place the mouse pointer in the lower right corner of the selected cells on 

the autofill marker ( ) so that it takes the form of a black cross ( 🞤); 
▪ when the left mouse button is pressed, the cursor is dragged through a 

range of cells; 
▪ as a result, the selected range will be filled with data that differ from each 

other by a given step; 
▪ when dragging the marker down or to the right, the data will increase, up 

or to the left, −it will decrease. 
Progression 
If the list to be created consists of numbers, each of which differs from 

the previous one by some constant value, or a certain number of times, then 
you can fill a range of cells using the arithmetic or geometric progression 
tool. For this purpose: 
▪ enter the first value of the list in the selected cell, confirm the entry by 

pressing the Enter key ; 
▪ activate the cell with the entered value; 
▪ perform actions: Main⇒ fill in ⇒Progression ; 
▪ in the dialog box of the same name that opens, in the Location group 

mark by columns or by terms ; 
▪ enter the step size (difference between two adjacent values) in the Step 

field; 
▪ in the Type zone, mark arithmetic or geometric ; 
▪ in the Limit field value indicate the maximum value of the list; 
▪ press the OK button . 

To autofill cells, standard Excel autofill lists are also used, or personal 
ones can be created. 

Formatting cell contents 
Regardless of the type of information entered into the cells of the table, 

a wide range of formatting tools can be applied to it. In order to reduce the 
time required to carry out the same type of formatting operations (setting the 
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type and size of the font, number format, alignment in a cell, etc.), it is 
advisable to carry out similar operations with a group of cells. For this 
purpose: 
▪ select a cell or a range of cells to which formatting should be applied; 
▪ perform a sequence of actions: Format⇒ cells ; 
▪ in the dialog box that opens, for: 
⮚ data format changes: 
− perform actions: Number⇒ Numerical formats and select the 

desired number format; 
⮚ changes to the alignment of information in the cell: 
− select the Alignment tab ; 
− in the Alignment zone, in the horizontal and vertical fields, select 

the alignment option from the lists; 
− in the Orientation zone, move the word inscription to an angle of 

90 o for the vertical location of the information in the cell, or at any 
other angle of inclination, indicating the required value on the 
numerical pointer; 

− in the Display area note the item transferred by words for the 
location of information in the cell not in one line, but with the 
possibility of its transfer to subsequent lines; 

− mark the point of unification cells to merge previously selected cells 
into one; 

⮚ font changes and index entries: 
− select the Font tab ; 
− in the Font , Pattern , Size fields , select the type, pattern, and size 

of the letters from the lists; 
− in the Modification zone mark the appropriate point for writing the 

superscript or subscript next to the symbol; 
⮚ changes to the format of table lines: 
− select the Border tab ; 
− in the All zone , mark the table boundaries to which formatting will 

be applied; 
− line type in the fields and color choose the type and color of the table 

lines from the lists; 
⮚ changing the background color of the cells: 
− select the View tab ; 
− in the Color zone note the color of the background of the cell, which 

will be displayed in the Sample area ; 
▪ after setting the formatting parameters, press the OK button . 
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Practical work #5 
The purpose of the work : master the skills of working in the Excel spreadsheet 

environment, learn how to create, format and edit tables 
Execution program 

Download the Excel spreadsheet. 
Create and fill in the table given in the task. 1.6 according to the following 

requirements: 
− the name of the table ( Arial , 14 pt, bold); 
− cap ( Times New Roman , 12 pt, bold, center alignment) ; 
− digital information of cells ( Arial , 12 pt, center alignment); 
− fill in the numbers in order using the autofill marker ; 
− dates to be filled using a progression; 
− the concentration of ketamine before cleaning with the help of 

progression; 
− the names of the columns "before cleaning", "after cleaning" for 

chemical oxygen consumption should be filled using the auto-fill 
marker ; 

− fill in the value of the installation performance using the autofill 
marker ; 

− set the same column width and row height; 
− the general frame of the table is double. 

In the cell containing the name of the table, make a note in which to place 
information about the performer of the laboratory work. 

Give the cells with the dates of the measurements the date format of the type 
"March 14". 

On the cell with the name "HCK" set the note "Chemical oxygen 
consumption". 

1. Save the created document in your own folder. 
2. Exit Excel. 

Tasks for practical work 
 

Performance indicators of the bioreactor when purifying water 
from ketamine by an association of gram-negative bacteria 

Table 1.6 

Item 
no . 

Date 
of 

measu
remen

ts 

The concentration of 
ketamine , 

mg/dm 3 
CCC, mg/dm 3 

Productivity of 
the installation, 

dm 3 /day before 
cleanin

g 

after 
cleanin

g 

befor
e 

cleani
ng 

after 
clea
ning 
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1. 01.05.06 100 5 120 80 6 
2. 19.05.06 200 7 280 115 6 
3. 06.06.06 300 12 610 150 6 
4. 24.06.06 400 15 860 240 6 
5. 12.07.06 500 18.5 1056 320 6 

 
Self-test questions 

1. How to download MS Excel? 
2. What is common and different in the structure of the window of the word 

processor Word and the processor of electronic spreadsheets Excel? 
3. What is an Excel document? 
4. What does a workbook sheet consist of? 
5. How to create a table of the desired configuration? 
6. How to merge cells and what is the use of merging cells? 
7. How to change column width and row height? 
8. How to set the width or height of the same size for a group of cells? 
9. How to set table boundaries? 
10. How to insert an empty cell, column and row? 
11. What types of data can be entered in the cell and what are the features of 

their recording? 
12. How to change data format? 
13. What is the cell format and how to set it? 
14. How to align the location of the information in the cell? 
15. How to change the orientation of placing information in a cell? 
16. How to place a fragment of text in a cell, the size of which exceeds the 

width of the cell? 
17. What means of automating the entry of table information does Excel 

provide? 
18. How to set a note on a cell? 
19. How to edit, format and remove the content of a note? 

 
1.6. Calculations in spreadsheets 

Calculations in Excel are carried out thanks to the presence of a 
powerful formula machine, which provides the ability to process data with 
entering the results of calculations directly into a table. Formulas are usually 
used to perform operations on data located in different cells of a worksheet, 
on different sheets, or in different books. A formula in Excel is a sequence 
of characters beginning with the sign “=” (equal), which can include constant 
values (constants or references to cells with constants); references to cells 
containing variables; names; functions; operators the formulas use the 
following operators: addition "+", subtraction " −", multiplication 

"*", division "/", raising to the power "^", as well as 
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relative, absolute and mixed references to cell 

addresses. Examples of formulas can be the following 

entries: 
=A8 −B8; =C3+D3*$E$1; =F6/G6; = SUM(A5:A12). 
The result of these actions is recorded in the cell containing the 

formula after it is entered and the Enter key is pressed . 
If the cell with the formula is made active again, the formula can be 

seen and edited in the formula bar. 
 
Record formulas 

▪ activate the cell in which the formula must be written; 
▪ enter the “=” sign (without quotation marks) from the keyboard; 
▪ switch the keyboard to the Latin (English) layout; 
▪ write down the required formula in the form of a sequence: addresses of 

cells with data on which calculations must be made; mathematical 
symbols; numbers; built-in functions, etc., depending on the calculation 
algorithm ( numerical data in the form of decimal fractions must be 
written after a comma ! ); 

▪ press the Enter key ; 
▪ the result of calculations will be displayed in the selected cell. 

If the cell is activated again, the formula used for the calculation will 
be displayed in the formula bar. 

To ensure the execution of mathematical operations in the formula in 
a certain order, appropriate pairs of parentheses are used. For example, if you 
need to find the average between the values of four cells with the addresses 
F4, C5, F6, D9, then the formula will look like this: 

= (F4+C5+F6+D9)/4. 
Using references to cell addresses in formulas 

Formulas in Excel can contain a reference to a cell address (for 
example, A5), the addresses of a range of cells (for example, A5;B5;G5), or 
the address of a range of cells (for example, D5:D10). In order to save time 
and eliminate errors when entering links to cell addresses or their ranges, use 
the mouse. To do this, in the process of writing the formula, it is enough to 
click on a cell, or select a range of cells whose coordinates are present in the 
formula, and the desired address will appear at the location of the cursor in 
the formula. If the values of the cells referenced in the formula change, the 
calculation result of the formula will also change automatically. 

Formulas use relative (type A1), absolute (type $A$1) and mixed (type 
$A1, A$1) references to cell addresses. 

In relative links (type A1), the address of the cell to which the link was 
made is automatically updated when the formula is spread from one cell to 
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another. That is, if the distribution of the formula is carried out from cell A1 
in the vertical direction, then the address of the cell in the formula to which 
the reference is made will change as follows: A2, A3, A4, ... . If - in the 
horizontal, then: B1, C1, D1, ... . In addition to relative references, Excel 
uses absolute references (such as $A$1). The $ symbol fixes the reference, 
leaving it unchanged when spreading the formula to other cells. If you need 
to fix only a row or only a column in the formula, then use mixed links, for 
example, A$1 or $A1. In this case, the $ symbol fixes part of the link and 
leaves it unchanged when spreading the formula only vertically or 
horizontally. 

Thus, by entering one formula, you can expand it to fill a rectangular 
range of cells with data. 
  

Move, copy and distribute formulas 
The procedure for entering formulas is a relatively time-consuming 

process. To speed up the process of filling the table with the results of 
calculations, the once entered formula is distributed, moved or copied to the 
cells in which similar calculations are performed. 

 Distribution of the formula to a range of cells (part of a column or 
row) is carried out if you need to perform similar actions with the data 
contained in a certain range of cells. When spreading in the formula, the 
relative references to the cell addresses change. 

To distribute the formula, perform the following actions: 
▪ select the cell with the formula; 
▪ bring the mouse pointer to the lower right corner of the cell ( autofill 

marker ) so that it takes the form of a black cross; 
▪ while the left mouse button is held, the cursor is moved to the last cell of 

the range in which the result of the calculation according to a similar 
formula should be obtained, after which the key is released. 

When moving a formula to a new table location, the references in this 
formula do not change. The cell in which the formula was previously 
becomes free. To move the formula, perform the following actions: 
▪ select the cell with the formula; 
▪ bring the mouse pointer to the border of the cell so that the pointer image 

changes from a white cross to a black one; 
▪ while the left mouse button is held, the contents of the cell are moved to 

the desired place in the table, after which the key is released. 
When moving several formulas that are located in adjacent cells and 

can be separated into a block, the mouse pointer is raised to the border of the 
block and the specified actions are performed. 

To copy the formula : 
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▪ select the cell with the formula; 
▪ perform the sequence of actions specified in the previous section to move 

the formula, while holding down the CTRL key . 
To highlight the formulas directly in the cells of the table, and not the 

results of calculations based on the formulas, perform the following actions: 
Service⇒ Parameters ⇒View ⇒Formula . To hide the formula display 
mode, perform the specified sequence of actions again. 

 
Conditional formatting of table cells 

When analyzing large arrays of numerical data presented in tabular 
form, as well as to track their changes depending on changes in input data, 
conditional formatting of certain table cells (usually cells with final or 
intermediate results) is used. Conditional formatting consists in setting 
conditions for changing the appearance of a cell (color, background, font 
type, etc.) depending on the value located in it (entered or obtained as a result 
of calculations using a formula). 

For example, you can set parameters for conditional formatting of 
cells according to which: the numbers in the cells, where the average value 
of the levels of bird disease by district is determined, will change color to 
red if the average value exceeds the permissible level, if not , then the font 
color will remain black. Basically, conditional formatting is used to focus 
the user's attention on numbers that deviate from the norm or need attention. 

To set conditional formatting: 
▪ select a range of cells, the values of which are planned to be set to 

conditional formatting; 
▪ perform actions: Home ⇒Conditional formatting ; 
▪ in the dialog box that opens, in the Cells Selection Rules area  , select a 

condition from the list ( between, more or equal to, etc. ), according to 
which formatting will be performed, and indicate the limits of numerical 
values to which conditional formatting will be applied according to the 
first condition; 

▪ press the Format button ; 
▪ in the dialog box that opens, on the Font tab , set the font parameters, or 

on the View tab , select the fill color of the cell, which it will acquire when 
the formatting condition is met; 

▪ if it is necessary to format cells according to several conditions, again refer 
to the menu of conditional formatting of cells and configure the 
parameters of formatting according to additional conditions similarly as 
many times as the conditions need to be displayed. 
 
Practical work #6 
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The purpose of the work: to master the skills of writing formulas, copying 
and distributing them, and performing calculations based 
on them 

 
Execution program 

1. Load the Excel spreadsheet editor. 
2. Create and fill in the table given in the task. 1.7 according to the following 

requirements: 
− table name: Arial , 12 pt, bold; 
− table header: Times New Roman , 12 pt, bold, center alignment; 
− in the first column: Times New Roman , 12 pt, bold, alignment on left 

margin; 
− numerical information in cells  - Times New Roman , 12 pt, center 

alignment. 
3. The values in the cells of the table, surrounded by a dash-dotted line, are 

obtained by calculations: 
− 1000/)3000*)(( ФГДКД заг −= ,  

where загД is the permissible entry of harmful impurities into the soil, 
g/ha;  
ГДК – the maximum allowable concentration of this impurity in the 
soil, g/t of dry matter of the soil; 
Ф – background (analytically found) content of this impurity in the 
fertilized soil, g/t of dry soil matter; 
3000 is the approximate average mass of the arable soil layer, t/ha. 

− х

заг
сер СТ

ДД
*

=
, 

where серД is the average dose of possible fertilization in the soil, t/ha 
per year based on the dry matter of the sediment; 

хС – the content of a controlled admixture in this fertilizer, g/t of dry 
matter of OMD; 
Т - the maximum period of application of PES or composites based on 
it on one and the same site, years. 

− сермакс ДД 5= , 
where максД is the one-time maximum dose of the specified fertilizer 
when it is applied to the soil once every 3-5 years. 

4. Formulas for calculations are entered in the upper cells of the 
corresponding columns, using relative and absolute references to the 
addresses of cells with values, and spread them to ranges of cells that 
require similar calculations. 
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5. Conditionally format the column containing , максД according to the 
following conditions: 
− cells with values less than or equal to 50 are painted green; 
− cells whose values are between 50 and 300 are yellow; 
− cells whose values are greater than or equal to 300 are red. 

6. Compare the obtained results with those given in the table. 
7. Save the created document in your own folder. 
8. Exit Excel. 

 
Tasks for practical work 

Table 1.7 
Experimental and calculated normative indicators limiting the use of OMD 

for fertilizing agricultural lands 

substance 
(admixture) 

Average 
content in 
the studied 

soils, g/t 
(F) 

Soil 
GDK, g/t 
(GDC) 

The 
average 

content in 
the 

obtained 
OMD, C x , 

g/t 

D 
general , 
kg/ha 

D sir , 
t/ha 

D max . , 
t/ha 

Nitrates (KO 3 ) 21.2 130 1220 326.4 5.35 26.75 
Chlorides (Si) 34.2 100 116.5 197.4 33.89 169.44 
The sum of 
water-soluble 
salts ( åи ) 

840 3000 13183 6480 9.83 49.15 

Cr general 63.9 100 327.8 108.3 6.61 33.04 
No 52.4 100 255.1 142.8 11,20 55.98 
Cu 42.9 100 634.5 171.3 5.40 27.00 
Zn 161.4 300 1133 415.8 7.34 36.70 
CD 0.25 3 36 8.25 4.58 22.92 
Pb 31.9 100 97.8 204.3 41.78 208.90 
As 1.8 20 12.7 54.6 85.98 429.92 
Sn 10 50 39.6 120 60,61 303.03 
Hg 1,2 2.1 0.8 2.7 67.50 337.50 
Sr. staff 95.2 600 1835.4 1514.4 16.50 82.51 
Mn 588.3 1500 577.3 2735.1 94.75 473.77 
The maximum period of application of PES or composites based on it on one 
and the same land plot, years (T) 50.00 

 
Self-test questions 

1. What is called an Excel formula and how do you start entering it? 
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2. How can you see and edit a formula entered in a cell? 
3. How to enable the formula display mode in cells and what is it used for? 
4. How do formulas use references to addresses of cells with data and what 

are they? 
5. How to spread the formula to a range of cells? 
6. How do you copy and move formulas? How do references to cell 

addresses in formulas change? 
7. How to give conditional formatting to cells? What is it used for? 
8. How many conditions can be specified for conditional formatting? 

 
1.7. Calculation of functional dependencies and construction of their 

graphs 
The calculation of functional dependencies in MS Excel includes the 

following stages: entering the values of the argument (arguments); entering 
a formula that reflects a given functional dependency, using absolute and/or 
relative references to cell addresses with argument/argument values; 
spreading the formula to the range of cells corresponding to the range of cells 
with the argument/argument values. The calculation of function values for 
various given combinations of the values of its arguments is called 
tabulation of functions . According to the results of tabulation of the 
function, its graph is built. 

Entering argument values 
If the argument is represented by a range of its values, then its values 

are entered in the selected range of cells with a certain step, starting from the 
minimum and ending with the maximum. To speed up the input of argument 
values, use the Progression tool or other MS Excel tools for autofilling . 

1st method. Dragging the autofill marker 
▪ activate the selected cell and enter the initial value of the range 

to be created; 
▪ activate the adjacent cell and enter the next value of the range, 

which will determine the size of the step between the two values; 
▪ select the cells that contain the initial and subsequent values; 
▪ place the mouse pointer in the lower right corner of the selected 

cells on the autofill marker ( <) so that it takes the form of a black cross ( 
🞤); 

▪ when the left mouse button is pressed, the cursor is dragged 
through a range of cells to fill with data; 
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▪ as a result, the selected range will be filled with data differing 
from each other by a step determined by the difference between the second 
and first entered numbers; 

▪ when dragging the marker down or to the right, the data will 
increase, up or to the left, −it will decrease. 

2nd method. Progression 
If the list to be created consists of numbers, each of which differs from 

the previous one by some constant value, or a certain number of times, then 
you can fill a range of cells using the arithmetic or geometric progression 
tool. For this purpose: 

▪ activate the cell and enter the initial value of the list to be 
created; 

▪ place the mouse cursor on the autofill marker of the cell with 
the first value in the list and, while holding the right mouse button, drag the 
cursor through the cells that need to be filled; 

▪ in the context menu that will appear after releasing the right key, 
select the Progression item ; 

▪ in the dialogue box of the same name, indicate the type of 
progression and the step of changing the values; 

or: 
▪ enter the first value of the list in the selected cell, confirm the 

entry by pressing the Enter key ; 
▪ activate the cell with the entered value; 
▪ perform actions: Main ⇒ fill in ⇒Progression ; 
▪ in the dialog box of the same name that opens, in the Location 

group mark by columns or by terms ; 
▪ enter the step value in the Step field; 
▪ in the Type zone, mark arithmetic or geometric ; 
▪ in the Limit value field indicate the maximum value of the list; 
▪ press the OK button . 
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(Прогрессия - Progression) 
Entering the values of two arguments 
Calculations in Excel are carried out thanks to the presence of a 

powerful formula machine, which provides the ability to process data with 
entering the results of calculations directly into a table. Formulas are 
usually used to perform operations on data located in different cells of a 
worksheet, on different sheets, or in different books. A formula in Excel is a 
sequence of characters beginning with the sign “=” (equal), which can 
include constant values (constants or references to cells with constants); 
references to cells containing variables; names; functions; operators The 
formulas use the following operators: addition "+", subtraction " −", 
multiplication "*", division "/", raising to the power "^", as well as relative, 
absolute and mixed references to cell addresses. The result of these actions 
is recorded in the cell containing the formula after entering it and pressing 
the Enter key. 

If it is necessary to determine the value of the function from two 
arguments, represented by the ranges of their values, then, alternately, the 
values of one argument are entered into the selected ranges of cells, and then 
the second one. When entering the values of two arguments, auto-completion 
tools are also used. Usually, the value of the first argument is entered in a 
column , for example, starting from cell A2, and the value of the second 
argument is entered in a row , for example, starting from cell B1. Then, in 
cell B2, you can enter a formula for calculating the functional dependency, 
using in it relative (type A1), absolute (type $A$1), or mixed (type $A1 or 
A$1) references to cell addresses with argument values. For example, when 
entering the formula for calculating the functional dependence, the value of 
the argument x is entered in the column starting from cell A2, the value of 
the argument y is entered in the row starting from cell B1. Then the formula 
=$A2^2+ B$1^2 is entered into cell B2 , which is spread over a rectangular 
range (using the autofill marker ) of cells, the boundaries of which are the 
cells with the maximum values of the arguments. 

In relative links (type A1), the address of the cell to which the link was 
made is automatically updated when the formula is spread from one cell to 
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another. That is, if the distribution of the formula is carried out from cell A1 
in the vertical direction, then the address of the cell in the formula to which 
the reference is made will change as follows: A2, A3, A4, ... . If - in the 
horizontal, then: B1, C1, D1, ... . In addition to relative references, Excel 
uses absolute references (such as $A$1). The $ symbol fixes the reference, 
leaving it unchanged when the formula is distributed to other cells. If you 
need to fix only a row or only a column in the formula, then use mixed links, 
for example, A$1 or $A1. In this case, the $ symbol fixes part of the link and 
leaves it unchanged when spreading the formula only vertically or 
horizontally. 

Construction of graphical dependence between table data  
For the convenience of analyzing numerical data, designed as a table, 

various types of graphical dependencies are used. In Excel, depending on the 
content of the data and the way it is presented, you can build graphs of 
various types (histograms, pie charts, three-dimensional surfaces, etc.). The 
graph can be placed on the same sheet as the data or on another sheet. If the 
data on which it is based changes after creating the graph, the appearance of 
the graph will also change automatically. 

To build a graphical dependency based on tabular data, perform the 
following sequence of actions: 

▪ Insert ⇒Diagram ⇒ All diagrams 
▪ in the dialog box that opens, in the Type zones, select Point , 

in the View field - Dot chart with values connected by smoothing lines; 
▪ choose the required type of diagram and start formatting it; 
▪ to change the type of diagram, call the context menu in the 

construction field and choose Change type of diagram ;  
▪ if the OX and OY axes are incorrectly located (which means, 

they must be swapped), call up the context menu and choose Select data , 
where with the help of the appropriate commands, the row with the column 
is changed; 

▪ menu Select data is used to add series names, graph legends; 
▪ to edit the names of the axes, the name of the diagram, the chart 

layouts menu items are used  on the Designer tab . 
When constructing a graph of a function that depends on two 

arguments, perform the following actions: 
▪ Select a rectangular range of cells filled with argument and 

function values; 
▪ Insert ⇒Diagram ⇒ All diagrams 
▪ in the dialog box that opens, select Surface in the Type areas 

in the View field - Surface. Displays changing the values of two 
arguments in the form of a surface ; 
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▪ select the necessary one and format it again similarly to the 
previous schedule. 
An example of constructing a surface using mixed references to tabulate a 
function 

 
An example of constructing a surface using array formulas for tabulating 

a function. 
 

Tabulation using array formulas 
• Arguments are entered similarly to the method using mixed links, 

namely: 
– We enter X coordinates in the column; 
– Enter the Y coordinates in a row; 
– In the form of a table with an offset; 

• We highlight the range that needs to be filled with data (completely); 
• Enter the formula for calculating the function values; 
• Press Ctrl+Shift+Enter ; 
• We will get a table of values filled with data; 

– If everything is done correctly, the formula will be in curly 
brackets 
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Practical work #7 

Purpose of work: master the skills of calculating functional 
dependencies and constructing their graphs 

Execution program 
 

1. Download the Excel spreadsheet. 
2. Plot the graph of the function 

  75,2,2,10;10,
5,1100
123

==−+
+
++

= chxc
x
xxy

. 
3. Plot graphs of functions in one coordinate system (on one picture) 

  3,15;15,sin77,0 23 =−+= hxxxf and xxxz 2sin33,0100 ++= on the same 
argument change interval. 

4. Plot the function given by the logical condition

  0,1. кроком з 8,1;8,1 якшо,
0,cos2

0,
1

sin3

22

2 −











+
+

= x
xxx

x
x

x
g

 
(якщо- if, з кроком - with step of) 
5. Plot the graph of the function of two variables, pre- tabulate the function 

in one of the described ways   .2,02;2,53 22 =−−= hxyxz  
6. Construct a graph of the function of two variables, pre- tabulate the 

function in one of the described ways   .2,02;2,2 22 =−+= hxyxz  
7. Format the graphs according to the given samples. 
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(Graph to the p.2 task) 

 
(Function graph with two logical conditions) 
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(Function graph in one coordinate system) 

 
 
1.8. Finding the roots of polynomial equations when solving 

biotechnological problems 
Parameter Selection tool allows you to predict results based on known input 
values, or vice versa, to determine what the input data should be in order to 
obtain a certain result. One of the aspects of its application is finding the 
roots of polynomial equations. 
 

Finding the roots of the equation 
The rules for using the tool Selection of a parameter for finding the roots 
of a polynomial equation will be shown in the example. 
Let the dependence of the concentration of phosphorus Y in oil-contaminated 
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soil on the time of bioremediation X be described by the equation: 
Y = 0.0035 X 2 - 1.0766 X + 93.44. 
It is required to determine the period of time after which the concentration 
of phosphorus in the soil will be equal to the value that was before the 
ecological disaster, namely: 135 mg/kg. That is, it is required to solve the 
following equation: 
0.0035 X 2 -1.0766 X + 93.44 = 135,  or: 
0.0035 X 2 -1.0766 X + 93.44 - 135 = 0. 
After reduction, we have: 
0.0035 X 2 -1.0766 X -41.56 = 0 
The solution of the equation is all values of X that satisfy the given equation. 
To find the roots of the equation, perform the following actions: 
■ localize the roots, that is, find the spaces on which these roots exist; 
■ for this purpose, tabulation of the function is carried out, or its graph is 
built (the graph of the function at the interval of the change of the argument 
from 1 to 400 days is presented in Fig. 1); 
■ analyze the resulting graph: the function will take the value 0, if the value 
of the argument is close to 330; 
■ enter the value 330 in the selected cell, for example A1; 
■ a formula is entered in another cell, for example, B1, using a reference to 
cell A1: 
= 0.0035A1 ^ 2 - 1.0766A1 - 41.56; 
■ perform the following actions: Data=>Analysis “what if”=>Parameter 
selection; 

 
■ in the corresponding dialog box that opens, in the Set to cell field indicate 

B1, in the Value field , indicate "0", in the Change cell value field enter 
A1; 

■ press the OK button ; 
■ the calculation result will be displayed in cell A1: "342". 
Thus, the desired period of carrying out cleaning measures will be 
to be 342 days. 
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(Dependence of the concentration of phosphorus in the soil on the time 

of cleaning measures - Залежність концентрації фосфору у ґрунті від 
часу проведення очисних заходів, Phosphorus concentration mg/kg - 

концентрація фосфору, Time, days - час, днів) 
Figure - An example of constructing a graphical dependence for locating 

the roots of the equation 
 

Specifying the accuracy of calculations 
The root equations are found using the method of successive approximations 
using parameter selection. In order to set the precision of the root value, 
perform the following actions: 
■ Data=>Analysis “what if”=>Parameter selection ; 
■ go to the Parameters tab and set relative fallibility and limit number 
of iterations , for example, 0.00001 and 10000, respectively. 

Finding the three roots of the equation 
As a rule, a polynomial equation can have several roots . As an example, 
consider the following equation: 

x 3 +0.03 x 2 -0.7 x + 0.1=0. 
To find the roots of the equation, perform the following actions: 
■ localize the roots, i.e. find the spaces on which these roots exist; 

■ for this purpose, build a graph of the function on the interval [-1;1] with 
a step of 0.2 (the graph of the function is shown in Fig. 2); 

■ analyze the resulting graph: the graph crosses the X axis at three points, 
approximately: -0.9; 0.18; 0.7 and therefore three roots are localized; 
■ since the polynomial of the third degree has no more than three roots, 
they all turned out to be localized; 
■ set the accuracy of finding the roots, for example 0.00001 ( relative 
fallibility) and the limit number of iterations ( limit number of iterations ), 
for example 1000; 
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Figure - Graphical dependence for the localization of the three roots of the 

equation 
■ enter into the selected cell, for example A1, the first approximation of the 

root, i.e. –0.9; 
■ enter the formula in cell B1, using a reference to the address of cell A1:  

=A1^3+0.03*A1^2-0.7*A1+0.1; 
■ enter the second approximation in cell A2, i.e. 0.18; 
■ enter the formula in cell B2, or spread the previous one: 

=A2^3+0.03*A2^2-0.7*A2+0.1; 
■ enter the third approximation in cell AZ: 0.7; 
■ enter the formula in cell VZ: 

=AZ ^ 3+0.03*AZ ^ 2-0.7*AZ+0.1; 
■ perform the following actions: Data=>Analysis “what if”=>Parameter 

selection and alternately find the roots of the equation, which in this case 
with the given accuracy of calculations are equal to: -0.9149; 0.1482; 
0.7565. 

Practical work #8 
The purpose of the work: to master the methods of using the "Parameter 
Selection" tool to find the roots of polynomial equations 

 
Execution program 

1. Load up MS Excel spreadsheet. 
2. Perform tabulation of functions on intervals of changing arguments [–
2;2] and plot graphic dependencies. 

2.1 . x 3 –5.5 x 2 +0.3 x +5 = 0;  . 
2.2. (х- 0.1) 2 log( x +10)–3 = 0; 
2.3. 5 sinx–x = 0; 
2.4. x 2 cos2 x = –l; 

3. Find all the roots of the equations. 
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Figure - Graphs of functions for localization of roots of equations 

 
Self-test questions 

1. How is the Parameter Selection tool called ? 
2. What is the basis of its use? 
3. What are the rules of use and the sequence of filling in the fields of the 
parameter  selection dialog box? 
4. What is the procedure for finding the roots of polynomial equations 
using parameter selection ? 
5. How to set the accuracy of calculations and the maximum number of 
iterations? For what purpose are they used? 

 
1.9. Using array formulas in MS Excel 

One of the most interesting and powerful features in Excel is the use 
of arrays in formulas. 

An array is a set of elements that can be processed as a single group 
or individually. In Excel, arrays can be one- or two-dimensional . The 
dimensions of the arrays correspond directly to the rows and columns of the 
Excel table. For example, a one-dimensional array can be a group of cells 
arranged in a single row (horizontal array) or in a single column (vertical 
array). A two-dimensional array is placed in several rows and columns. 
Excel does not support three-dimensional arrays. 

 
Working with array formulas 
Entering an array formula 

To enter an array formula into a cell or into a range of cells, a certain 
procedure is performed that allows the Excel software to identify the entered 
expression as an array formula, as opposed to a regular formula. Namely, the 
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end of the set of the formula must be accompanied by a simultaneous 
pressing of the key combination Ctrl+Shift+Enter , after which the system 
automatically places the formula in curly brackets. 

Selection of array 
Selection of the range of cells in which the array is placed is performed 

in one of the following ways: 
▪ place the cursor in one of the cells of the array; 
▪ perform actions: Edit ⇒Go , or press the F5 key ; 
▪ in the Transition dialog box that opens, press the Select button ; 
▪ in the next dialog box Selection of groups of cells select the Current 

array switch ; 
▪ click the OK button to close the dialog box; 

or: 
▪ place the cursor in one of the cells of the array; 
▪ press the key combination Ctrl + / . 

 
Editing an array formula 

If the array formula is in several cells, editing is performed in all cells 
of the range as one. 

The following rules are followed when editing array formulas: 
▪ it is not possible to change the contents of any of the cells, the values of 

which were obtained by calculations using the array formula - when you 
try to do this, Excel will issue the message " Cannot change part of the 
array " ; 

▪ you cannot move the values of individual cells to which the array formula 
is applied (all cells with the array formula are moved together); 

▪ you cannot remove individual cells to which the array formula is applied 
(only the entire array is removed); 

▪ you cannot insert new cells into the array (this rule also applies to 
inserting new rows and columns). 
To edit an array formula: 

▪ select all cells of the array; 
▪ move the cursor to the formula line, or press the F2 button ; 
▪ curly brackets are removed; 
▪ make the necessary changes to the array formula; 
▪ after finishing editing the formula, press Ctrl+Shift+Enter to confirm 

the changes. 
After performing the specified actions, the content of all cells of the 

array will change in accordance with the changes made. 
Using an array formula for a range of cells 

In fig. an Excel document worksheet with calculations of fertilizer 
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sales volumes is presented. To calculate the selling pFig of each type of 
fertilizer (value in column D ), the formula for multiplying the quantity of 
the product (column B ) by the pFig of the product (column C ) is usually 
used. For example, the value of cell D2 can be calculated using the formula: 
= B2 * C2 , which is then spread over the range of cells corresponding to the 
cells with the argument values. In this case, we will get five separate 
formulas in column D. 

The second way to calculate the five values in column D is to use a 
single array formula. This formula will be placed in the range of cells D2:D6 
, the result of the calculation of which will be five searched values. 

To create an array formula for a range of cells: 
▪ select the range of cells in which the result of calculations according to 

the array formula should be located (in this case, it is D2:D6 ); 
▪ enter the formula =B2:B6*C2:C6 ; 
▪ press the key combination Ctrl+Shift+Enter .  

 
Fig. An example of using an array formula for a range of cells 

Using an array formula in a single cell 
Array formulas can also return a result in a single cell. In fig. the array 

formula {=SUM(B2:B6*C2:C6)} is entered in cell D8 . This formula 
calculates the total amount of sales and allows you to determine the sum of 
the products of the numbers located in cells B2 and C2 , B3 and C3 , ... B6 
and C6 . That is, first the products of the corresponding pairs of array 
numbers are found, and then these results are added. 

To enter an array formula in one cell, perform the following actions: 
▪ select the cell into which the formula will be entered (click on it with the 

mouse); 
▪ Insert ⇒Function ; 
▪ in the dialog box that opens, in the Category list, select Mathematical ; 
▪ in the Select the function  field select from the SUM list; 
▪ enter the formula =B2:B6*C2:C6 in the corresponding dialog box that 

will open in the array 1 line; 
▪ press the key combination Ctrl+Shift+Enter . 
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Fig. An example of entering an array formula into one cell 

Application of array formulas to perform operations on matFigs 
Finding the sum of matFigs 
To add matFigs of the same dimension, perform the following actions: 

▪ enter matFigs of the same dimension in the form of arrays or in the form 
of ranges of cells; 

▪ select a range of cells of the same dimension as the matFigs-additions; 
▪ enter the formula for the sum of the corresponding arrays; 
▪ press the key combination Ctrl+Shift+Enter . 

In fig. an example of adding 2×2 matFigs given by the range of cells using 
array formulas is given. 

 

 
FIg. An example of adding matFigs (two-dimensional arrays) 

Finding the product of matFigs 
To find the product of matFigs in Excel, use the built-in MMULT 

function of the Mathematical category . The result of using the function is 
an array (matrix) with the same number of rows as array (matrix) 1 and with 
the same number of columns as array (matrix) 2. 

When finding the product of matFigs, the following restrictions are 
observed: 
▪ the number of columns of array (matrix) 1 must be the same as the number 

of rows of array (matrix) 2; 
▪ matFigs are entered as array formulas or in a range of cells. 



58 
 

the algorithm for finding the product of matFigs using the built-in 
MMULT function as an example: 

?.
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1
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To find the product of matFigs, perform the following actions: 

▪ enter the matrix (array) 1, for this: 
− select a range of cells that corresponds to the dimensions of the matrix 

A , for example B2:D4 (see the introduction of a two-dimensional 
array); 

− ={1;2;4:3;2;0:−1;4;2} in the formula line ; 
− press the key combination Ctrl+Shift+Enter ; 

▪ Enter matrix (array) 2: 
− select a range of cells corresponding to the dimensions of the matrix 

D , for example F2:F4 (see the introduction of a one-dimensional 
vertical array); 

− ={1:2:3} in the formula line ; 
− press the key combination Ctrl+Shift+Enter . 
To find the result of the product of two matFigs, the corresponding 

formula is entered as an array formula. For this purpose: 
▪ separate the range of cells corresponding to the number of rows of array 

1 and the number of columns of array 2; 
▪ go to the formula line; 
▪ perform actions: Insert ⇒Function ; 
▪ in the dialog box that opens, select the category of Mathematical 

functions ; 
▪ in this category, select the MMULT function from the list ; 
▪ in the corresponding dialog box that opens, enter a range of cells with the 

elements of the first matrix (for example, B2:D4) in the array x field ; 
▪ enter a range of cells with the elements of the second matrix (for example, 

F2:F4 ) in the array field ; 
▪ press the key combination Ctrl+Shift+Enter . 

or: 
▪ enter =MMULT( B2:D4 ; F2:F4) ; 
▪ press the key combination Ctrl+Shift+Enter . 

The result of the matrix product will be displayed in the form of an array 
(Fig.). 
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Fig. An example of finding the product of matFigs using array formulas 
 
The result of multiplying the matFigs given in the example corresponds 

to the mathematical expression: 
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Finding the determinant of a matrix 
To find the determinants of matFigs in Excel, there is a MDETERM 

function of the Mathematical category . The matrix determinant is usually 
used to solve systems of equations with several unknowns. To calculate the 
determinant, the matrix must contain the same number of rows and columns. 

The matrix (array) can be specified as a range of cells, for example A1:C3, 
or as an array of constants, for example {1;2;3:4;5;6:7;8;9}. 

MDETERM function also returns an error value of #SO! , if the array 
has an unequal number of rows and columns. 

To find the determinant of the matrix given by the range of values, 
perform the following actions: 
▪ activate the cell to output the calculation result; 
▪ perform actions: Insert ⇒Function ; 
▪ in the dialog box that opens, select the category of Mathematical 

functions ; 
▪ in this category, select the MDETERM function from the list; 
▪ in the corresponding dialog box that opens, in the line array, enter the 

corresponding matrix in the form of a range of values ; 
▪ press a key enter 

or: 
▪ activate the cell to output the calculation result; 
▪ =MDETERM (A1:D4) is entered in the formula line ; 
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▪ press a key Enter . 
To find the determinant of a matrix given as an array, for example 3 × 3 

in the form ={2;-1;3:1;-2;4:3;-3;0}, perform the following actions: 
▪ activate the cell to output the calculation result; 
▪ perform actions: Insert ⇒Function ; 
▪ in the dialog box that opens, select the category of Mathematical 

functions ; 
▪ in this category, select the MDETERM function from the list; 
▪ in the corresponding dialog box that opens, in the line array, enter the 

appropriate matrix in the form of a range of cells B2:D4 ; 
▪ press a key Enter . 

An example of calculating the matrix determinant using the built-in 
MDETERM function is shown in Fig. 

 

 
Fig. An example of using the MDETERM function 

 
Finding the inverse matrix 
To find the inverse matrix in Excel, there is a MINVERSE function of 

the Mathematical category . Inverse matFigs, like determinants, are usually 
used to solve systems of equations with several unknowns. 

The matrix (array) must be specified as a numeric array with the same 
number of rows and columns. In addition, the array can be specified as a 
range of cells (for example A2:C4) or as an array of constants, for example 
{1;2;3:4;5;6:7;8;9}. 

To find the matrix inverse of the given: 
▪ activate the range of cells corresponding to the dimensions of the original 

matrix; 
▪ perform actions: Insert ⇒Function ; 
▪ in the dialog box that opens, select the category of Mathematical 

functions ; 
▪ in this category, select the MINVERSE function from the list; 
▪ in the corresponding dialog box that opens, in the array line, enter the 

appropriate matrix in the form of a range of cells B2:D4; 
▪ press the key combination Ctrl+Shift+Enter ; 
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or: 
▪ activate the range of cells corresponding to the dimensions of the original 

matrix; 
▪ =MINVERSE (А2:С4) is entered in the formula line ; 
▪ press the key combination Ctrl+Shift+Enter . 

An example of finding the inverse matrix using the MINVERSE function 
is shown in Fig. . 

 

 
Fig. An example of using the MINVERSE function 

 
Practical work #9 

The purpose of the work: 
 To get acquainted with the features of working with 
array formulas in Excel, their purpose and use 

Execution program 
1. Launch MS Office Excel. 
2. Using the formulas of the arrays MMULT, MDETERM, find the 

product of the matFigs AB and the determinant of the matrix A, 
choosing the option by number in the group list. 

3. Complete each task on a separate sheet in an Excel book. Give the file 
the following name " version number_performer 's last name". 
 

Control questions 
1. What is an array in Excel? 
2. What types of arrays does Excel support? 
3. What are the features of creating array formulas? 
4. How to edit an array formula? 
5. What actions are not allowed when working with array formulas? 
6. How to enter an array formula to display the result in one cell? 
7. How to enter an array formula into a range of cells? 

 
Tasks for practical work 
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1.10. Solving systems of linear algebraic equations  
Cramer's rule 

For simplification, we will consider a system of three linear equations 
with three unknowns x 1 , x 2 , x 3 , which can be written as follows: 









=++
=++
=++

,
,
,

3333232131

2323222121

1313212111

hxaxaxa
hxaxaxa
hxaxaxa

(1) 
the numbers a ij (and, j =1,2,3) are the coefficients of the system; the first 

index i is the number of the equation, the second - j is the number of the 
unknown x i , at which this coefficient stands. Numbers h 1 h 2 , h 3 — free 
members of the system. 

If all free members of system (1) are equal to zero 0321 === hhh , 
then the system is called homogeneous. If there is at least one non-zero free 
term, then the system is called inhomogeneous. 

The main determinant of the system is the determinant consisting of 
coefficients with unknowns 

333231

232221

131211

ааа
ааа
ааа

=

(2) 
To find the solution of system (1), we perform the following actions. We 

multiply each of the equations by the corresponding algebraic additions to 
the first coefficient of this equation. Namely, multiply the first equation on 
A 11 , the second equation — on A 21 and the third - on A 31 . We will get 
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Let's add these equations, collecting the corresponding coefficients for the 

unknowns x 1 , x 2 , x 3 . We have 
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In the first brackets, we have the distribution of the main determinant ( by 
the elements of the first column (property 9). In the second and third 
brackets, we have the sum of the products, respectively, of the second and 
third hundredths by the algebraic additions to the first column. Therefore, 
according to property 10, these expressions are equal to zero. Thus , we get 

.00 313212111321 AhAhAhxxx ++=++  
In this equality, on the right is a distribution over the elements of the first 

column of the determinant, in which the first column is composed of free 
terms and the other two coincide with the corresponding columns of the main 
determinant . Let's mark 

33323

23222

13121

1

ааh
ааh
ааh
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Then the last equation takes the form: 

.11 = x  
Similarly, multiplying each of the equations of system (1) by the algebraic 

complements of the elements of the second (third) columns and performing 
the same transformations, we obtain 

.22 = x , .33 = x , 
where 
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. 
Thus, system (1) reduced to an equivalent system: 

.11 = x , .22 = x , .33 = x , (3) 
Let 0  Then x 1 , x 2 , x 3 can be expressed from system (3) . 
 




= 1

1x
, 


= 2

2x
, 


= 3

3x
. (4) 

 
Formulas (4) make up the content of Cramer's rule: if the main 

determinant of system (1) is not equal to zero 0 , then the system has a 
unique solution, which is determined by formulas (4). 
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Formulas (4) are also called Cramer's formulas. 

Determinants 1 , 2 , 3 are obtained from the main determinant 
(see (2)) by replacing the corresponding column of coefficients with 
unknowns by a column of free terms. 

Cramer's rule also applies when solving a system of n linear equations 
with n unknowns, that is, a system of the form 
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(5) 
This system can be abbreviated as: 
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The main determinant of system (5) will be the determinant composed 

of coefficients for unknowns x 1 , x 2 , ... x n i.e 
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Cramer's rule. If the main determinant of the system of n linear 

equations with n unknowns is different from zero ( 0 ), then the system 
has a unique solution expressed by the formulas: 




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1x
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
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, , 


= n

nx
. 

where j ( j =1,2,... ,n) is the determinant obtained by  replacing the 
elements of the jth column with a column of free members, 
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Note that this method requires cumbersome calculations and is rarely 

used when n > 3 . Therefore, it is convenient to use Excel array formulas to 
solve SLAE. 

 
Examples. Solve a system of linear equations using Cramer's rule. 
a) Let the system of two equations with two unknowns be given: 
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The solution. We compile the main determinant from coefficients with 

unknowns and using the MDETERM function. 
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, so the system has a unique solution 

We calculate 1 and 2 , replacing  the first and second columns, 
respectively, with a column of free members. We have 
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We find x 1 and x 2 using formulas (4): 
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b) Let the given system of three equations with three unknowns: 
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The solution. We compile the main determinant and calculate it using the 
MDETERM function 

.04
015
112

521
−=−

−
=

 
Therefore, the system has a unique solution. We calculate 1 ; 2 , 3 : 
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According to formulas (4), we have 
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. 
Remark. If the main determinant of the system = 0, then it is obvious 

that Cramer's formulas can’t be used. Therefore, system (1) or (5) cannot 
have a unique solution. At the same time, from equations (3): 

)...,,2,1( njx jj ==  

we have that 0 j for at least one number j the solution system is not 

has( jjx =0 , a 0 j which is impossible). If 0= j for 
everyone 

j =1, 2,... n, then the system has either many solutions or no solution at 
all. A system of equations that has a solution (one or many) is called 
compatible, and a system that does not have a solution is called 
incompatible. 

Solving and studying systems of linear equations using matFigs 
Consider the system (1) of three linear equations with three unknowns 

(but all conclusions are valid for any n 2  ). Let's make the matrix A from 
the coefficients with unknowns — the system matrix, the column matrix X 
from the unknowns, and the column matrix H from the free terms, i.e. 
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(6) 
Taking into account the definition of the product of matFigs and the 

condition of equality of matFigs, we obtain the equivalent expression of 
system (1) in matrix form 

АХ=Н    (7) 

Equation (1) is called a matrix equation. Let 0А Then, as is known, 
on the one hand, system (1) has a unique solution, on the other hand, the 
matrix A has an inverse A -1 . 

Multiply both parts of equality (7) on the left by A -1 and get: 
HААХА 11 −− = ; HAЕX 1−= . 

 Given that EХ=Х, we have the solution of Х in matrix form: 
X=A -1 N.   (8) 

To obtain the values of the unknowns x 1 , x 2 , x 3 , we will use the fact that 
the matFigs on the left and right in (8) are equal. 

This method of solving system (1) (or (5)) is called the matrix method. 
If A is a singular matrix: A = 0, then A -1 does not exist, and if there is a 

solution of system (1) (or (5)), then it is not unique. 
An example. Solve the system by the matrix method 
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The solution. Let's write down the matrix of system A and look for A -1 

using the MDETERM and MINVERSE Excel functions . 
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The matrix A has an inverse, and the system has a unique solution. 
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Let's write out the matrix-column H of the free members of the system 

and find X according to formula (8) using the MMULT function : 
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Therefore, x 1 = - 3, x 2 = 1, x 3 = 1. 
Practical work #10 

The purpose of the work: 
 To get acquainted with the features of working with 
array formulas in Excel for solving systems of linear 
algebraic equations 

Execution program 
1. Launch MS Office Excel. 
2. Using the formulas of the MMULT, MDETERM, and 
MINVERSE arrays , find the solutions of the SLAE according to 
Cramer's rule and the matrix method, choosing the option by the 
number in the group list. 
3. Compare the obtained results. 
4. Complete each task on a separate sheet in an Excel book. Give the 
file the following name " version number_performer 's last name". 
5. Save in your own folder. 

Tasks for practical work 
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Control questions 

1. What is an array in Excel? 
2. What types of arrays does Excel support? 
3. What are the features of creating array formulas? 
4. How to edit an array formula? 
5. What actions are not allowed when working with array formulas? 
6. How to enter an array formula to display the result in one cell? 
7. How to enter an array formula into a range of cells? 
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1.11. Solving problems of linear programming with minimization of 

the objective function 
Solving any technical and economic problem consists in achieving a 

certain defined goal with a limited number of means and resources. The 
optimal solution to the problem is considered to be the one that ensures the 
achievement of the goal with minimal costs. At the first stage, a 
mathematical model for solving the problem is formulated. Combinations of 
various types of model elements form different classes of optimization 
problems that require their own solution methods. Integral solutions of the 
problem that satisfy all restrictions and boundary conditions are called 
admissible. An admissible solution that maximizes (minimizes) the objective 
function is called an optimal solution. There can be many, one, or none 
possible solutions . It depends on the number of variables n in the 
optimization problem, the type and number of constraints t. A necessary 
requirement for the existence of admissible solutions of the optimization 
problem is the fulfillment of the condition n>t. 

The mathematical model of the task of finding the optimal solution 
consists of the following components: 

■ initial data; 
■ variables 
■ dependencies 

Each of these components has its own types. 
The initial data can be deterministic (when the exact values are 

known) and stochastic (if the values are random values subject to statistical 
distributions). 

Variables can be continuous or discrete. 
Dependencies between variables (objective function, constraints) can 

be linear and non-linear . Linear are such dependencies that contain 
variables in the first degree. All other dependencies are called non-linear. 

One of the most common problems of this class is the linear 
programming problem , which has deterministic inputs, continuous 
variables, and linear dependencies. 

The linear programming problem is a partial case of the generalized 
optimization problem and is written by a mathematical model: 
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The given form of recording the task of finding the optimal solution, 

as a rule, consists of four parts: 

● An objective function 

=

=
n

j
jj xcZ

1 that specifies an optimization 
criterion and can lead to a maximum, minimum, or some constant 
value (constant). 

● Constraints establishing dependence between variables ( )jjij bxa  . 
● Boundary conditions that set the limits in which the desired values of 

the variables in the optimal solution can change . .jjj Dxd   
● njmi ,1,1 == , where m is the number of constraints, n is the number 

of variables. 
To solve problems of linear programming, use the tool Search for a 

solution. 
Example. According to the results of a qualitative assessment of the 

farm's natural pasture lands, in order to preserve and use grass stands, it is 
recommended to feed the pasture by applying fertilizers in the amount of: 
nitrogen - 65 kg/ha, phosphorus - 15 kg/ha, potassium - 20 kg/ha. Labor 
productivity when applying organic fertilizers is 5 t/hour, when applying 
complex mineral fertilizers is 0.7 t/hour. The time resource for applying 
fertilizers is 20 hours. The cost and chemical composition of fertilizers are 
given in Table 1.8. The area of the pasture is 25 hectares. 

Table 1.8 
Cost and chemical composition of fertilizers 

Type of fertilizer Cost, 
hryvnias/ton 

Chemical composition, kg/t 

nitrogen phosphorus potassium 

Organic 70 8 2 5 

Complex mineral 1400 250 120 120 
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It is required to distribute the use of fertilizers in such a way that the 
cost of applied fertilizers is minimal while meeting all requirements. Solving 
the problem can be divided into the following stages: 

■ Designation of unknown variables . Let's enter the following 
designations of unknown variables: X 1 – amount of organic fertilizers, t; X 
2 – amount of complex mineral fertilizers, i.e. 

■ Definition of the objective function . Taking into account the 
cost of organic fertilizers, which is UAH 250/t, and complex mineral 
fertilizers – UAH 1,400/t, the target function is formulated: 

Z=250X 1 + 1400X 2 → min, 
which means, the total cost of fertilizers intended for use should be 

minimal. 
■ Introduction of restrictions . Limitations on the values of the 

variables are determined based on the results of the environmental 
examination regarding the required amount of fertilizer application: nitrogen 
– 65 kg/ha, phosphorus – 15 kg/ha, potassium – 20 kg/ha and time resource 
– 20 hours. 

Restrictions on the rate of nitrogen application. 1 ton of organic 
fertilizers contains 8 kg of nitrogen, and 1 ton of complex mineral fertilizers 
contains 250 kg. Therefore, the total amount of nitrogen that can be applied 
to the pasture will be determined by the expression: 8X 1 +250X 2 , which 

should not be less than 65 kg/ha∙25ha= 1625 kg. 
Therefore, the restriction on the use of nitrogen will be as follows: 8X 

1 +250X 2 ≥1625 
Restrictions on the rate of phosphorus application. 
2X 1 + 120X 2 ≥3 75 
Restrictions on the rate of potassium intake. 
5X 1 +120X 2 ≥500 

Time limit . 
20

7,0
1

5
1

21 + XX
, or 

0.7X 1 + 5X 2 ≤70 
Special restrictions. The unknown variables and the objective function 

cannot be equal to zero or acquire negative values. 

X 1 ≥ 0, X 2 ≥ 0, Z ≥ 0. 
Solving the problem of linear programming. 
Enter the initial data and formulas for calculation, as shown in fig. (a 

fragment of the MS Excel document is presented in formula checking mode). 
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The results of the calculation according to the formulas are given in 
the table. 

To find the optimal solution, perform the following actions: 
■ Data=>Analysis=>Search for a solution; 

 
■ in the corresponding dialog box that opens, in the Set target cell 

field , specify the address of the cell with the formula for determining the 
target function, in this case B6; 

■ in the field Equal , set the check box to the Minimum value; 
■ in the Changing cells field , indicate the range of cells 

containing the values X 1 , X 2 , namely: ВЗ:В4 (place the cursor in the input 
field, use the mouse to select the desired range of cells); 

■ to the right of the Restrictions field , press the Add button; 
■ in the dialog box Adding restrictions, enter the link to the cell 

containing the restriction formula in the left field, select the appropriate sign 
in the middle field, and enter the address of the cell containing the restriction 
value in the right field; 

■ press the Add button and enter the following restriction; 
■ after entering the last limit, press the OK button; 
▪ as a result of the performed actions, the following restrictions will 

be entered in the Restrictions field : $В$8>=$С$8, $В$9>=$С$9, 
$В$10>=$С$10, $В$11<=$С$11, $В $12>=$C$12, 
$B$13>=$C$13, $B$14>=$C$14; 

■ press the Execute button. 
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Figure. Preparation of input data for finding a solution 

Table 1.9 
Results of input data preparation 

Type of 
fertilizer 

Amount 
of 

fertilizers, 
i.e 

Cost, 
hryvnias/ton 

Chemical composition of 
fertilizers, kg/t 

nitrogen phosphorus potassium 

Organic 
fertilizers X 1 

1 70 8 2 5 

Comp. 
mineral, 
fertilizers X 2 

1 1400 250 120 120 

Objective 
function Z 1470     

Limitation The left 
part 

The right 
part    

according to 
the rate of 
nitrogen 
application 

258 1625    

according to 
the rate of 
phosphorus 
application 

122 375    
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according to 
the rate of 
potassium 
application 

125 500    

by time 5.7 70    
X 1 1 0    
X 2 1 0    
Z 1470 0    

After the calculations and an affirmative answer, Excel will make 
changes to the initial table that relate to the maximum value of the objective 
function and cells with the values X 1 - the amount of organic fertilizers, t; X 
2 - the amount of complex mineral fertilizers, t. The results of the found 
solution are shown in the table. 

Thus, the minimum costs for applying fertilizers are UAH 9,100, 
while only mineral fertilizers are applied in the amount of 6.5 tons. 

Table. 1.10 
Solution search results 

Type of 
fertilizer 

Number 
fertilizers 

Cost, 
hryvnias/ton 

Chemical composition of fertilizers, 
kg/t 

nitrogen phosphorus potassium 

Organic 
fertilizers 

X 1 

0 70 8 2 5 

Complex 
mineral 
fertilizers 
X 2 

6.5 1400 250 120 120 

Objective 
function Z 

9100     

Limitation
: 

Left 
part 

rights 
part 

   

according 
to the 

contributio
n rate 

nitrogen 

1625 1625    
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according 
to the 

contributio
n rate 

phosphorus 

780 375    

according 
to the rate 

of 
potassium 
application 

780 500    

By time 32.5 70    
X 1 0 0    

X 2 6.5 0    
Z 9100 0    

Practical work #11 
The purpose of the work: to master the methods of using the Solution 

search tool for solving linear programming problems with minimization of 
the objective function 

Execution program 
1. Download the Excel spreadsheet. 
2. Determine the amount of fertilizers that should be applied under 

the condition of minimizing costs, if it is recommended to fertilize the 
pasture by applying fertilizers in the amount (not less than): nitrogen - 75 
kg/ha, phosphorus - 25 kg/ha, potassium - 35 kg/ha. Labor productivity when 
applying organic fertilizers is 4 t/hour, when applying complex mineral 
fertilizers is 1.5 t/hour. The time resource for applying fertilizers is 25 hours. 
The cost and chemical composition of fertilizers are given in the table. The 
area of the pasture is 35 hectares. 

Table 1.11 
Cost and chemical composition of fertilizers 
Type of fertilizer Cost, 

hryvnias/ton 
Chemical composition, kg/t 

nitrogen phosphorus potassium 
Organic fertilizers 350 15 4 9 

Complex mineral 
fertilizers 

1300 210 150 130 

3. Find optimal solutions to problems after selecting one problem by 
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number in the group list 
1. max Z = 2x 1 + x 2 2 . max Z = x 1 – 2 x 2 
–x 1 + 2x 2 ≤ 4 x 1 + 3x 2 ≤ 6 
3x 1 + 6x 2 ≤ 12  –2x 1 + x 2 ≤ 4 
x 1 ≥ 0, x 2 ≤ 2 x 1 ≤  0, x 2 ≤ 2 

                                          
3 . max Z = 2x1 –3x2  4 . min Z = x 1 +2 x 2 
x 1 + 2x 2 ≤ 6 –x 1 + x 2 ≤ 4 
–2x 1 + 6x 2 ≤ 6 2x 1 + x 2 ≥ 6 
x 1 ≥ 0, x 2 ≥ 1.8  x 1 ≥ 0, x 2 ≥ 2.8 

 
 

5 . max Z = 2x 1 + x 2 6 . min Z = 3x1 + 4x2 
–x 1 + 3x 2 ≤ 6  –x 1 +3 x 2 ≤ 6 
2x 1 + 6x 2 ≤ 12 2x 1 + x 2 ≥ 8 
x 1 ≥ 0, x 2 ≥ 1 x 1 ≥ 0, x 2 ≤2.6 

  
                                                        

7. min Z = –x 1 + x 2 8 . min Z = 2x 1 – x 2 
2x 1 – 3x 2 ≤ 6 x 1 – 4x 2 ≤ 8 
–3x 1 + x 2 ≤ 3 3x 1 – x 2 ≥ 3 
x 1 +4 x 2 ≤ 8                                                  2 x 1 +3 x 2 ≤ 12 
x 1 ≥ 1, x 2 ≥ 0 x 1 ≥ 0, x 2 ≥ 0   

                                               
9. min Z = 2x1 + 3x2 10 . min Z = –2x 1 + x 

2 
2x 1 + 6x 2 ≥12 –x 1 + 3 x 2 ≤ 3 
–x 1 + 2x 2 ≤ 4  3x 1 – x 2 ≥ 6 
x 1 ≤ 6, x 2 ≥ 0  2 x 1 + 4 x 2 ≥ 8 
 x 1 ≤ 3, x 2 ≥ 0   

                                                 
11 . max Z = x 1 + 2x 2 12 . max Z = 3x 1 + x 2 
3x 1 – x 2 ≥ 3 –x 1 +2x 2 ≤ 4 
3x 1 + 6x 2 ≤ 12  2x 1 – 3x 2 ≤ 6 
–x 1 + 2 x 2 ≤ 4 6 x 1 +2 x 2 ≤ 12 
x 1 ≥ 0, x 2 ≥ 0 x 1 ≥ 1, x 2 ≥ 0   

 
13 . max Z = – x 1 + 3x 2 14.  max Z = 2x1 + 3x2 
x 1 – 2 x 2 ≤ 4 4x 1 – 6x 2 ≤ 12 
–2x 1 + 6x 2 ≤ 12 2x 1 + 3x 2 ≥ 6 
2x 1 + x 2 ≤ 6 x 1 ≥ 1, x 2 ≤ 2   
x 1 ≥ 0, x 2 ≥ 0  

                 
15 . max Z = 3/2 x 1 + x 2 16 . max Z = 3x 1 + x 2 
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6 x 1 + 2 x 2 ≥ 6  x 1 – 2x 2 ≤ 4 
2x 1 – 5x 2 ≤ 10 –x 1 + 3x 2 ≤ 6 
x 1 + 2x 2 ≤ 8 x 1 ≥ 3, x 2 ≥ 0   
x 1 ≥ 1, x 2 ≤  0  

                                  
17 . max Z = x 1 + 2x 2 18 . max Z = 2x1 + 3x2 
x 1 + 2 x 2 ≥ 6  x 1 – 2x 2 ≤ 4 
–3x 1 + x 2 ≤ 3 –x 1 + 2x 2 ≤ 4 
2x 1 – 2x 2 ≤ 6  x 1 + 2 x 2 ≥ 4 
x 1 ≥ 1, x 2 ≥  0 x 1 ≥ 0, x 2 ≥ 0   

 
19 . max Z = x 1 + 3x 2 20 . max Z = x 1 + x 2 
x 1 + x 2 ≥ 2 2x 1 – 4x 2 ≤ 8 
–2х 1 + 3х 2 ≤ 6 –2x 1 + 3x 2 ≤ 6 
3x 1 – 2x 2 ≤ 6 2 x 1 + 4 x 2 ≥ 8 
x 1 ≥ 0, x 2 ≥  0 x 1 ≥ 0, x 2 ≥ 0   

                    
21 . max Z = –x 1 + 2x 2 22.  max Z = 2x 1 – x 2 
–x 1 + 2 x 2 ≥ 4 3x 1 + 2x 2 ≤ 6 
2 x 1 + 3 x 2 ≤ 6  4x 1 + x 2 ≤ 4 
2x 1 – 3x 2 ≥ 6 3 x 1 – 2 x 2 ≥ 6 
x 1 + x 2 ≥ 6 x 1 ≥ 0, x 2 ≥ 4 
x 1 ≥ 0, x 2 ≥  0  

       
 23 . max Z = –x 1 + 3x 2 24 . max Z = 2x 1 – x 2 
–3х 1 + 3х 2 ≤ 9 3x 1 + 3x 2 ≤ 9 
x 1 + x 2 ≤ 4 x 1 – x 2 ≥ 3 
2х 1 – х 2 ≥ 4 –x 1 + x 2 ≥ 3 
x 1 + x 2 ≥ 6 x 1 ≥ 4, x 2 ≥ 0   
x 1 ≥ 0, x 2 ≥  0  

                                              

                  
 

 
Self-test questions 

1. What are the components of the task of finding the optimal solution? 
2. What can be the input data of the task of finding a solution? 
3. What can the variables be? 

25. max Z = –x 1 + 3x 2 26 . max Z = x 1 + x 2 
–2 x 1 + 3 x 2 ≤ 6 3x 1 – 6x 2 ≤ 12 
x 1 – x 2 ≥ 3 – x 1 + x 2 ≤ 4 
x 1 ≥ 0 x 1 + x 2 ≥ 4 
x 2 ≥  2 x 1 ≥ 0, x 2 ≥ 0  
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4. What can be the dependencies between variables? 
5. What tasks are solved using the Solution search tool? 
6. How to call the Solution search tooland what data is entered in the fields 
of the dialog box of the same name? 
7. How is the optimal solution of the problem called? 
8. How is an admissible solution to the problem called? 
9. What are the conditions for the existence of an admissible solution to the 
problem? 
10. What is related to linear programming problems? 
11. How to formulate the objective function and the system of constraints? 
12. What is the sequence of solving linear programming problems using 
the Solution search tool? 
13. How can you accept the proposed solution and how can you refuse it? 
14. Why is it recommended before using Solution search tool to make a 
copy of the working document? 

 
1.12. Solving systems of non-linear equations using the tool " Search 

solutions " 
MS Excel Solution Search is a powerful auxiliary tool for performing 

complex calculations. It allows you to find a set of variable values that meet 
certain criteria based on a given value of the result. 

Search solutions allows finding solutions of systems of nonlinear 
equations. For example, it is necessary to solve the following system of 
nonlinear equations: 





=+
=+

132
322

yx
yx

 
It is known that a pair of values ( x , y) is a solution of a system of 

equations if and only if it is a solution of the following equation with two 
unknowns: 

( ) ( ) 01323 2222 =−++−+ yxyx  
With the help of the Solution search tool , instead of a system of 

equations, an equivalent equation is solved. Geometrically, the solution of 
this system of equations is the point of intersection of a straight line with a 
circle whose radius is .73205,13= . Therefore, this equation has no more than 
two solutions. Determined by the  Solution search tool, solution to a 
nonlinear problem depends on the initial approximation, therefore, its 
successful selection is essential For this purpose: 

■ localize the roots of the equation by calculating the right-hand side of 
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the equation by the variables x and y on the interval [-1.7;+1.7] with a step 
of 0.3 (this interval was taken because the roots of the equation will be inside 
a circle whose radius is approximately 1.73205); 

■ to calculate the values of the equation in the range of cells A2:A13 
enter the value of the variable x in the range from -1.7 to +1.7 with a step of 
0.3; 

■ in the range of cells B 1 : M 1, enter the corresponding values of the 
variable y at the same interval and with the same step; 

■ enter the formula in cell B2: 
=($A2 ^2+B$1^2-3) ^2+(2*$A2+3*B$1-1)^2; 
■ spread the formula over the range of cells B2:M 13; 
■ analyze the obtained tabular values and set the x and y values at which 

the function will approach 0 as closely as possible, in this case it will take 
the values 0.08 and 0.4325; 

■ x and y (1.6; -0.8) and (-1.4; 1.3) are taken as the initial approximation, 
respectively , which correspond to the obtained minimum values of the 
function. 

To use the solution search tool , the following preparation is carried 
out: 

■ in the selected cell, for example A16, enter the first value of x, which 
is equal to 1.6; 

■ in cell B16, enter the first value of y, which corresponds to the first 
value of x and is equal to -0.8; 

■ enter the formula in cell SI6: 
=(A16^2+B16^2-3)^2+(2*A16+3*B16-1 )^2; 
■ x = -1.4 in cell A17 ; 
■ y =1.3 in cell B17 ; 
■ enter the formula in cell C17: 
=(A17^2+B17^2-3)^2+(2*A17+3*B17-1)^2; 
■ perform the following actions: Data=>Analysis => Search for a 

solution and fill in the fields of the dialog box that will open; 
■ enter the address of cell SI6 in the Set target cell field; 
■ select the Equal to Value item in the group and set 0 in the 

corresponding field; 
■ enter the range of cells $А$16:$В$16 in the Changing cells field; 
■ press the Execute button ; 
■ in the request window that opens, you need to make sure that the Save 

found solution item is selected and click the OK button . 
■ x = 1.57634, y = -0.7173 will be found ; 
■ perform similar actions to find another solution to the equation, for 
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which: x=- 1.269 and y=1.179. 
 

Practical work #1 2 
The purpose of the work: to master the methods of solving systems of 

nonlinear equations using the " Search for a solution " tool 
 

Execution program 
1. Download Excel spreadsheet. 
2. Solve systems of nonlinear equations: 
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Self-test questions 
1. What is the procedure for solving a system of nonlinear equations using 
Solution Search ? 
2. Why is it necessary to localize the roots of the equation? 
3. How are the roots of the equation localized? 
4. What is the order of entering the two arguments to the tab function? 
5. Which use references to cell addresses when tabulating a function from 
two arguments? 
6. How to tabulate a function from two arguments? 
7. What type of graph is used to display the graphical dependence of a 
function on two arguments? 
8. What values of the arguments are chosen as approximate values? 

 
1.13. Solving linear programming problems with objective 

function maximization 
The MS Excel solution search tool also allows solving linear 

programming problems in which it is required to find a parameter of the 
problem that provides the maximum value of the objective function subject 
to certain restrictions. 

Example. Determine the structure of crops of winter wheat, millet and 
buckwheat, so that the profit from the sale of products is maximum under the 
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following conditions: 
- the total area of crops does not exceed 1150 hectares; 
- reserves of mineral fertilizers amount to 1,250 tons; 
- labor resources - 65,000 man-hours; 
- the area of millet crops should not be less than 270 hectares. 
Norms of labor costs and the amount of profit based on 1 ha of crops 

are given in Table 1.12. 
Table 1.12 

Norms of labor costs and the amount of profit 
 A B C D E 
1 

Indicators Unit 
measurement 

Accounts for 1 hectare 

2 winter wheat millet buckwhea
t 

3 Labor costs man-hours 72 65 53 

4 Consumption of 
fertilizers c 1.7 1.6 1.1 

5 Profit Faculty of 
Arts 165 85 285 

To solve the problem, make its mathematical model. For this purpose: 
■ enter the following designations: 
- X 1 - area of winter wheat crops, ha; 
- X 2 - the area of millet crops, ha; 
- X 3 - area of buckwheat crops, ha; 
■ make up the target function: Z =165X 1 +85X 2 +285X 3 →max; 
■ constitute a system of restrictions: 
■ the sum of the sown areas of individual crops should not exceed the 

total sown area: X 1 + X 2 + X 3 ≤ 1150;' 
■ restrictions on labor resources: 72X 1 +65X 2 +53X 3 ≤565000; 
■ restrictions on mineral fertilizers: 1.7X 1 +1.6X 2 +1.1X 3 ≤1250; 
■ restrictions on the area of millet sowing: X 2 ≥270; 
■ crop areas cannot be less than zero: X 1 >0, X 2 >0, X 3 >0; 
■ the objective function cannot be less than zero: Z > 0 . 
Fill in the table with additional data: 
■ enter into the cells, for example, in C 6 , D6, E 6 , designations of 

variables (areas of individual crops): X 1 , X 2 , X 3 ; 
■ in cells C7, D7, E7 enter arbitrary values of variables, for example 1 , 

which will change as a result of finding the optimal solution; 
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■ in cell B9, enter the formula for determining the objective function, 
using references to the corresponding cells with variables; 

■ in cells B11, B12...B19 enter formulas for calculating the left parts of 
the restrictions, using references to the corresponding cells; 

■ enter the right part of the restrictions in cells C11, C12...C19; 
■ this completes the data preparation for finding the optimal solution. 
The results of entering data into the table for finding the optimal 

solution in the formula display mode are shown in the table. 
To find the optimal solution, perform the following actions: 
■ Data=>Analysis => Solution search ; 
■ in the corresponding dialog box that opens, in the Set target cell field 

, specify the address of the cell with the formula for determining the target 
function, in this case B9; 

■ in the field Equal, set the flag to the Maximum value ; 
■ in the Changing cells field , indicate the range of cells containing the 

values X 1 , X 2 , Xz, namely: C7:E7 (place the cursor in the input field, use 
the mouse to select the desired range of cells); 

■ to the right of the Restrictions field , press the Add button; 
■ in the dialog box Adding restrictions, enter the link to the cell 

containing the restriction formula in the left field, select the appropriate sign 
in the middle field, and enter the address of the cell containing the restriction 
value in the right field; 

Table 1.13 
Data preparation for finding the optimal solution 

 A B C D E 
1 

Indicators Unit of measurement 
Accounts for 1 hectare 

2 winter 
wheat millet buckwheat 

3 Labor costs man-hours 72 65 53 

4 Consumption of 
fertilizers c 1.7 1.6 1.1 

5 Profit conditional units 165 85 285 
6   XI X2 Khz 
7   1 1 1 

9 Objective function =C5*C7+D5*D7+E5*E
7    

10 Restriction system:     

11 
by the total area 

sown of individual 
cultures 

=C7+D7+E7 1150   
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12 on labor resources =СЗ*С7+D3*D7+ЕЗ*Е
7 65000   

13 on mineral fertilizers =C4*C7+D4*D7+E4*E
7 1250   

14 by the area of millet 
sowing =D7 270   

15 crop area values are 
positive     

16 XI =C7 0   
17 X2 =D7 0   
18 X3 =E7 0   

19 
the objective 
function has a 
positive value 

=B9 0   

■ press the Add button and enter the following restriction; 
■ after entering the last limit, press the OK button ; 
■ as a result of the performed actions, the following restrictions will be 

entered in the Restrictions field : $В$11<=$С$11,  $B$12<=$С$12, 
$В$13<=$С$13, $В$14<=$С$14, $В $16>=$C$16, $B$17>=$C$17, 
$B$18>=$C$18, $B$19>$C$19; 

■ press the Execute button . 
After the calculations and an affirmative answer, Excel will make 

changes to the initial table that relate to the maximum value of the objective 
function and cells with the values X 1 - the area of winter wheat sowing; X 2 
- millet sowing area; X 3 - buckwheat sowing area. 
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Table 1.14 
The results of the search for the optimal solution 

Indicators Unit 
measurement 

Accounts for 1 ha of crops 

winter 
wheat 

millet buckwheat 

Labor costs man-hours 72 65 53 

Consumption of 
fertilizers 

c 1.7 1.6 1.1 

Profit conditional 
units 

165 85 285 

  XI X2 X3 

  0 270 743.63 
Objective function 234886.36    

Restriction system:     

by the total area of crops 
of individual cultures 

1013.64 1150   

on labor resources 56962.73 65000   

on mineral fertilizers 1250.00 1250   

by the area of millet 
sowing 

270.00 270   

crop area 
values are positive 

    

XI 0.00 0   

X2 270.00 0   

X3 743.64 0   

objective function 
value is positive 

234886.36 0   

The found solution is shown in the previous table. 
According to the obtained data, in order to achieve the maximum profit, 

which will amount to 234886.36 units, under these restrictions, the farm 
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should sow buckwheat in the amount of 743.63 hectares and millet in the 
amount of 270 hectares. 

Practical work #13 
The purpose of the work: to master the methods of using the tool 

Search for a solution for solving problems of linear programming with the 
maximization of the objective function 

 
Execution program 

1. Download Excel spreadsheet. 
2. Determine the structure of crops of spring wheat, corn and sugar 

beets, so that the profit from the sale of products is maximum under the 
following conditions: 

● the total area of crops does not exceed 1000 hectares; 
● stocks of mineral fertilizers - 1200 tons; 
● labor resources - 70,000 people. hours; 
● the sugar beet area is no more than 200 hectares. 
● The norms of labor costs and the amount of profit per 1 ha of 

crops are given in the table: 
Table 1.15 

Norms of labor costs and the amount of profit 

Indicators Unit 
measurement 

Accounts for 1 ha of crops 
Spring wheat corn Sugar beets 

Labor costs man-hours 70 60 56 
Consumption of 

fertilizers C 1.6 1.5 1.0 

Profit Conditional 
units 161 75 275 

Self-test questions 
1. What are the problems of linear programming with the 

maximization of the objective function? 
2. What are the differences in filling in the fields of the Find a 

solution dialog box for finding the maximum value of the objective function 
compared to finding the minimum? 

3. How to formulate the objective function and the limit system in 
this case? 

4. In which cases is it usually required to find the maximum of the 
objective function, and in which cases - the minimum? 

5. What are the consequences of the incorrect formulation of the 
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system of restrictions? 
6. In what cases do they refuse to accept the found decision? 
7. How to make changes or additional restrictions in the system of 

restrictions already formulated and entered in the corresponding field of the 
Search for a solution dialog box ? 

 
1.14. Forecasting methods in the Excel spreadsheet 

 
Sometimes we need to know in advance "what will happen". It helps 

to make the right decision. This is the case in science prediction is called 
forecasting. The basis of forecasting is observational data, experimental data. 

 
Frequency analysis 
When processing statistical data in horticulture, demography, 

marketing, when analyzing the chemical-technological evaluation of fruits 
of economic indicators, the question arises: "How often among the results 
that are observed or investigated, there are values that belong to a certain 
range?". The answer to this question determines the correct behavior in the 
future. For example, when determining the concentration of nitrogen dioxide 
in the atmospheric air of different parts of the city, several data were 
obtained. If there are different permissible concentration limits (0.04 mg/dm 
3 , 0.05 mg/dm 3 , 0.06 mg/dm 3 , 0.085 mg/dm 3 ), it is necessary to determine 
the number of districts whose indicators fall within the specific limit. 

Fill out the spreadsheet as indicated below. 

Concentration of nitrogen 
dioxide (mg/dm 3 ) 

Concentration 
limits (mg/dm 3 

Number 
of 

districts 
0.065 0.088 0.065 0.055 8.00   
0.05 0.09 0.04 0.02 10.60   

0.065 0.065 0.092 0.07 11.50   
0.055 0.015 0.075 0.035 15.40   
0.03 0.025 0.075 0.085     

Then you need to do the following actions: 
● highlight the cells in the Number of districts column (there are one 

more of them than cells with concentration boundaries); 
● we use the FREQUENCY statistical function , where the first 

argument are cells with a defined concentration by district, the 
second argument is cells with specified concentration limits; 

● finish work with the function by pressing Ctrl + Shift + Enter . 
The result of the analysis will be displayed in the column Number 

of districts : 
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Concentration of nitrogen 
dioxide (mg/dm 3 ) 

Concentration 
limits (mg/dm 3 

) 

Number 
of 

districts 
0.065 0.088 0.065 0.055 0.04 6 
0.05 0.09 0.04 0.02 0.05 1 

0.065 0.065 0.092 0.07 0.06 2 
0.055 0.015 0.075 0.035 0.085 8 
0.03 0.025 0.075 0.085   3 

It shows that in three districts the concentration of the harmful 
substance reaches above the maximum permissible (0.085 mg/dm 3 ), in eight 
districts the concentration is 0.06-0.085 mg/dm 3 . That is, after performing 
such an analysis, it is possible to predict the deterioration of the atmospheric 
air indicators of the entire city. 

Approximation  
Approximation is one of the forecasting methods that allows you to 

describe the observed results with an analytical function, that is, it uses an 
equation that describes the experimental points. First, it is necessary to build 
a graphical dependence between the experimental data (the type of graphical 
dependence is " Point " ), and then find an equation (mathematical model). 

An example of assumptions about the relationship between features 
can be equations: 

xbay += – linear dependence; 
6

6
3

3
2

21 ... xbxbxbxbay +++++= – polynomial dependence; 
xbay ln+= – logarithmic dependence; 

bxay = – power dependence; 
xbeay = – exponential dependence. 

The form of the corresponding equation is chosen by conducting an 
analysis of the placement of experimental data. 

 Finding the parameters of the equation 
To find the parameters of the equation (mathematical model) that 

would describe this dependence, it is necessary: 
▪ select the constructed graph (click once with the left mouse button on 

one of the points of the graph); 
▪ call the context menu of the object; 
▪ in the menu that appears, select the item "Add a trend line " ; 
▪ in the dialog box, on the "Type" tab , select one of the proposed lines 

of functional dependencies , by which the approximation of the 
experimental points is planned; 



92 
 

▪ in the "Parameters" tab , check the item " show equation on the 
diagram ” ; 

▪ press the " Ok " button ; 
▪ an approximating line with the equation by which it is constructed will 

appear on the graph. 
▪ select the item "Trend line format  " ; 
▪ in the dialog box that appears, in the "Type" tab , select another 

functional dependency; 
▪ in the "Parameters" tab , check the item " put the approximations 

reliability value on the diagram  " ; 
▪ press the " Ok " button . 

 
Substitution table 
A substitution table is an Excel tool that shows how changing specified 

values in formulas affects the results of those formulas. These tables allow 
you to quickly calculate several versions within the framework of one 
operation, as well as to view and compare the results of different options on 
one sheet. That is, substitution tables are one of the methods of forecasting, 
as calculations of the "what-if" type are carried out. Substitution tables work 
only with one or two values (variables) at the same time. 

 

Create a lookup table with one variable 
A lookup table with one change is formed so that the values that are 

entered are located either in a column (oriented on different columns) or in 
a row (oriented on different rows). Formulas used in a lookup table must 
refer to a cell for input. An input cell is a cell where values from the 
substitution table are substituted. Any cell on the worksheet can be an input 
cell. To create a table, perform the following actions: 

1. In a separate column or in a separate line, enter the list of values that 
need to be inserted into the input cell. 

2. If the values are located in a column, then enter the formula in the cell 
that is one line above and one cell to the right of the first value. To the 
right of the first formula, we enter any other formulas. 

3. If the values are located in a row, then enter the formula in the cell that 
is located one column to the left and one row below the first value. In 
the same column, but below, enter any other formulas. 

4. Select a range of cells with formulas and substitution values. 
5. In the main menu, select the command Data => Analysis " what if 

”=> Table data  . 
6. If the substitution table is column-oriented, then enter a link to the 

input cell in the “ Substitute values by columns in" . If the 
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substitution table is oriented by rows, then enter a link to the input cell 
in the " Substitute values by rows in" . 

 

Create a substitution table with two variables  
A two-variable lookup table uses one formula with two sets of values. 

The formula must reference two different input cells. To create a table, 
perform the following actions: 

1. In a sheet cell, enter a formula that has a link to two data entry cells. 
2. In the same column below the formula, enter the substitution value for 

the first variable. Substitution values for the second variable are 
entered in the row to the right of the formula. 

3. Select the range of cells with the formula and both sets of substitution 
data. 

4. Execute the main menu command Data => Analysis “ what if ”=> 
Table data  . 

5. In the " Substitute values by columns in" field enter a link to the 
input cell for the substitution values that are in the row to the right of 
the formula. 

6. In the " Substitute values by lines in”  field enter a reference to the 
input cell for the substitution values that are in the column below the 
formula. 

Practical work #14 
The purpose of the work: to develop forecasting methods using substitution 

tables, trend lines, and frequency analysis. 

Work execution program 
1. Launch the Excel spreadsheet. 
2. Apply frequency analysis when the effectiveness of the insecticide is 

determined on the example given in the task (Fig. 1). 
3. On sheet Sheet2, create the table given in the task about the effect of 

temperature on damage to strawberry leaves by Phytophthora cactorum 
(Fig. 2). 

4. Build a graphic relationship between temperature and the degree of 
damage to the leaves (Fig. 2, " dot schedule ").   

5. Approximate the experimental data with a function (see task, Fig. 2). 
6. Determine the equation of the indicated dependence and the accuracy of 

the approximation. 
7. Create table 1 from the assignment for laboratory work on the 

Substitution Table sheet, where the concentration of the substance is 
calculated according to the specified formula. 
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8. With the help of a substitution table, analyze (forecast) the influence of 
waste water consumption on the concentration of the substance in the 
control body of the river (table 2 from the assignment for laboratory 
work). 

9. Analyze (forecast) the impact of changes in two values (wastewater 
consumption, concentration of a substance in wastewater) on the 
concentration of a substance in the control body of the river (table 3 from 
the laboratory task). 

10. Save the created document in your own folder. 
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Tasks for practical work 
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Effectiveness of the action of the 
insecticide ( zolon , k.e. ) against the 
first generation of the eyed weevil, % 

Efficiency 
limits, % 

Number of 
experiments 

71.6 71.9 89.5 89.4 76.8 79.8 75 2 
99.9 97.6 95.9 99.1 97.8 98.1 85 4 
99.8 98.4 99.6 94.8 99.8 98.5 90 8 
99.1 99.2 95.9 97.4 98.6 98.0 96 13 
93.4 89.3 92.8 91.2 92.9 91.9   15 
86.2 91.3 92.7 86 93.4 89.9     
93.9 94.7 79.5 88.1 75.8 86.4     

 
Fig. 1. Frequency analysis 

 
Fig. 2. Effect of temperature on damage to strawberry leaves by 

Phytophthora cactorum 
 

Self-test questions 
1. What is the sequence of finding the equation of the approximating 

line? 
2. How to bring the equation of the approximating line to the working 

field? 
3. How to change the type of approximating line? 
4. What is the purpose of the FREQUENCY function ? 
5. What is the purpose of substitution tables? 
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6. What can substitution tables consist of? 
7. How to create a table with one variable? 
8. How to conduct a bivariate analysis? 
 

1.15. Use of built-in functions when conducting calculations 
Application of built-in functions  

Functions are predefined formulas that perform calculations on given 
values (arguments) in the specified order. Each function consists of an equal 
sign (=), a name, and an argument(s) whose value(s) is used in the 
calculation. The argument list can consist of numbers, text, logical values, a 
range of cells, and formulas, which in turn can contain built-in functions. 

When using the built-in functions, the Functions Wizard is used, 
which are called using the f x icon or a sequence of actions: 
▪ Insert ⇒Function ; 
▪ in the Functions Wizard window in the Category field , select the 

function category, in the Select function field - the function itself; 
▪ in the dialog box that opens, set the arguments of the function (arguments 

are entered from the keyboard or using the mouse, selecting the desired 
range of cells with the given stroke). 

MS Excel contains the following categories of functions: Financial , 
Date and time , Mathematical , Statistical , References and arrays , 
Working with the database Data , Text , Logical and others. 

Functions of the " Statistical " category 
The Statistical category includes functions for determining the main 

statistical indicators of a sample population of data and others. The following 
functions are the most used among them: 
AVERAGE(number1; number2;...) – determination of average values of 
sample totalities (function arguments are ranges of cells with elements of 
sample totalities); 
STDEVP(number1, number2...) – determination of mean squared 
deviations of sample totalities; 
CONFIDENCE(alpha; standard deviation; size ) – determination of the 
absolute confidence error of the mean value. The arguments of the function 
are the reliability level  , the mean square deviation, and the number of 
sample values. For applied studies  = 0.05, which corresponds to the 
confidence probability Р D =95%. 

An example of using statistical functions (in formula display mode). 
Each type of function is entered once and is spread over a range of cells in 
which similar calculations are performed. 
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(Sample average value - вибіркове середнє значення, sample average 

square deviation - вибіркове середнє квадратичне відхилення, absolute 
confidence error - абсолютна довірча похибка, AVERAGE - СРЗНАЧ, 

STDEVP - СТАНДОТКЛОНП, CONFIDENCE - ДОВЕРИТ) 
 
Functions of the “ Text ” category 
To the Text category includes about 24 text functions. Among them 

are the following text functions: 
LEFT(text; number_of_characters ) – outputs the specified number 

of characters from the beginning of the line; 
CONCATENATE (text1; text2; ...) - combines several text lines into 

one. The "&" symbol, which is equivalent to the CONCATENATE 
function, is also used to combine text data . In order to make a gap between 
the last name and the first name, use the following sequence of characters: 
"gap" (quotes, gap, quotes). In order to put a period between the elements 
that are being combined, it is also entered between two quotation marks: “.” 
. 

Application examples 
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Functions of the “ Logical ” category 
Logical functions are used to carry out calculations, the course of 

which depends on the fulfillment (or non-fulfillment) of a certain condition. 
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Basic logical functions: 
IF( log_output ; value_if_true ; value_if_false ) – gives one value if 

the logical condition is asserted, and another if it is not asserted. The 
arguments of the IF function can be numbers, text fragments, and zeros. The 
IF function supports up to 64 levels of nesting. 

AND (logical_value1; logical_value_2;…) – outputs the value 
TRUE if all arguments have the value TRUE . 

Logical functions also include the following functions: 
− COUNTIF( range ; criterion ) – counts the number of non-empty cells 

from the specified range, the value of which corresponds to the criterion; 
− SUMIF ( range ; criterion ; range summation ) – calculates thSe sum 

of the values in the cells of the range that meet the conditions. 
 

 

 
 
Practical work #15 

The purpose of the work : to get acquainted with various types of built-in 
functions of the spreadsheet processor and the features of 
their application. 

Execution program 
1. Launch the Excel spreadsheet. 
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2. Create a table. 1.15 from the task, calculate the mean, variance, standard 
deviation, absolute error of the mean using the appropriate built-in 
functions, 

3. Derive thSe bounds of the confidence interval for the mean using the 
built-in CONCATENATE function (see application examples). 

4. Create a table. 1.16 from the task. 
5. Create a table. 1.17 from the task in which the "Type of environmental 

situation" is determined using the IF() logical function , using references 
to cell addresses with data in table 2 (see application example) 
 
Tasks for practical work 
 
Table 1.16 
The type of ecological situation depending on the potassium content 

 

 
Table 1.17 

Assessment of the ecological situation of field lands 
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field 
no 

The content of 
mobile 

potassium, 
mg/100 g of 

soil 

Type of 
ecological 
situation 

according to 
potassium 

content 
1. 3.8 Crisis 
2. 4.6 Pre-crisis 
3. 9.5 Satisfactory 
4. 2.5 Crisis 
5. 13 Auspicious 
6. 8,9 Satisfactory 
7. 5,6 Pre-crisis 
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Table 1.15 
Data for determining statistical indicators 

SOIL INDICATORS 

Ite
m 

no . 
The name of the indicator 

Repeat measurements Sam
pling 
avera

ge 
value 

Sample 
mean 

square
d 

deviatio
n 

Absol
ute 

mistr
ust 

Limits of the 
confidence 

interval for the 
mean value of 

the general 
totality 

1 2 3 4 5 

1 Soil density , g/ cm3 1,2 1.13 1.23 1.23 1.19     

2 MPRPM in 0-100 cm, mm 108 110 108 108 126     

3 Hydrolytic acidity, mg- eq /100 g 2.34 2.11 2.21 2.86 1.88     

4 Acid exchange , pH saline 5.68 6.01 5.98 5.56 6.25     
5 Acidity relevant, pH is water 6.21 6.53 6.52 60.7 6.95     

6 The sum of absorbed bases, mg- eq 
/100 g of soil 26.6 27.8 29.1 25.9 30.84     

7 Humus content, % 3.36 3.38 3.14 2.93 3.49     

8 Content of easily hydrolyzed 
nitrogen, mg/kg 83.3 87.6 81.3 54 106.7     

9 The content of mobile phosphorus, 
mg/kg 100 62.5 67.5 47.5 47.5     

10 Content of exchangeable potassium, 
mg/kg 150 112.5 125 75 75     

11 Boron content, mg/kg 0.67 0.81 0.63 0.51 0.61     
12 Manganese content, mg/kg 17.8 17.1 17.8 16.8 15.1     
13 Cobalt content, mg/kg 1.29 1.21 1.21 1.19 0.87     
14 Copper content, mg/kg 5.2 5.4 4.5 4.9 4.6     
15 Zinc content, mg/kg 3 3.8 4.6 4.6 3.9     
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Self-test questions 
1. What is the purpose of built-in functions? 
2. How are built-in functions called? 
3. What are the categories of built-in functions? 
4. How are functions used in formulas? 
5. What can be function arguments? 
6. What are the main functions included in the Statistical category ? 
7. Give examples of the use of statistical functions. 
8. What functions are included in the Text category ? 
9. Give examples of the use of built-in text functions. 
10. What functions are included in the Logical category ? 
11. Explain the mechanism of application of logical functions. 
12. What is the built-in Date and Time category used for ? 
13. What functions belong to the Date and time category ? 

 
 

1.16. Detection of the presence and assessment of the closeness of statistical 
dependence between variables 

 
The dependence of random variables, in which each value of one of them 

corresponds to the distribution law of the second, that is, a change in one of the 
variables causes a change in the distribution of the value of the second, is called 
statistical. The statistical dependence of random variables, in which the influence of 
a change in one of the values on the average value of the second is studied, is called 
correlation. For example, correlation is the dependence of the average values of 
hematological and biochemical indicators of peripheral blood of pigs on the time 
that has passed since the introduction of the drug that affects these indicators. 

One of the indicators that allows you to establish the presence of a linear 
relationship between two variables and evaluate its closeness is the pair correlation 
coefficient .  

 The pairwise correlation coefficient yxr , of two values X and Y is determined 
by the formula: 
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where X i , Y i – variables, the relationship between which is studied; 

YX , – average values of the studied variables; 
n is the number of observations. 

 The modulus of the pair correlation coefficient does not exceed unity, that is 
1, ухr , which is equivalent to the double inequality: 11 , − ухr . If the correlation 
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coefficient is statistically significant, then there is a linear relationship between the 

variables. If yxr , >0, then the relationship between the variables is direct, if yxr , <0, 
then the relationship is inverse. If the correlation coefficient is statistically 
insignificant or equal to zero, then the two random variables X and Y do not have a 
linear dependence, but may have a nonlinear one. 

The statistical significance of the pairwise correlation coefficient is 
determined using the Student's test. 

The calculated value of the criterion розрt is calculated according to the 

formula:     
2
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where r x, y are the values of the pair correlation coefficient; 
n is the number of observations. 

The calculated absolute value of the Student's criterion is compared with the 
table (critical) value. If the calculated value of the criterion is greater than the table 
value, then the accepted null hypothesis that the correlation coefficient is equal to 
zero is rejected, that is, the value of the correlation coefficient is statistically 
significant. 

The tabular (critical) value of the criterion is calculated using the built-in MS 
Excel function TINV of the Statistical category , the arguments of which are the 
level of significance ( 05,0= ) and the number of degrees of freedom ( f =( n -2)). 

Built-in MS Excel array formulas for working with data 
To simplify complex calculations, use the built-in formulas of MS Excel 

arrays, performing the following actions: Insert ⇒Function⇒ Mathematical . 
According to the array formula, several types of calculations can be performed at 
the same time, the result of which can be a single value or an array of values. An 
array formula handles multiple sets of values called array arguments. Each array 
argument must include the same number of columns and rows. Arguments are 
separated by “;”. 

Array formulas include: 
SUMXMY2( array_x;array_y ) – the sum of the squares of the difference of the 
corresponding values of two arrays. 
SUMPRODUCT( array_x; array_y ) – the sum of the products of the 
corresponding elements of two arrays. 

Built-in MS Excel functions for determining correlation characteristics 
Built-in MS Excel functions for determining correlation characteristics are 

grouped in the Statistical category . 
The correlation coefficient is calculated by one of two built-in functions: 

CORREL or PEARSON, whose arguments are ranges of cells with input data. 
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Practical work #16 
 

Execution program 
1. LaunchMS Excel spreadsheet. 
2. Enter the data from the table task. "Dependence of blood indicators of pigs on 

time" : the value of one of the indicators (Y) and the column "Day of 
observation" (Х). 

3. Calculate the mean value of a series of observations using the corresponding 
built-in function. 

4. Complete the table with the following columns: 
Indicator  

( Y i ) 
Observation 
day ( X i ) 

Y p Y i - Y p  X p  
X and - X 

p 
where Y s , X s are the average values of indicators. 
5. Fill the table with values, using relative and absolute references to the 

addresses of cells with data. 
6. Calculate the components of formula (1) with the help of the formulas of the 

SUMPRODUCT and SUMXMY2 arrays. 
7. Calculate the coefficient of pair correlation according to formula (1), using 

the calculated values of the components. 
8. Check the correctness of calculations using the built-in function CORREL or 

PEARSON . 
9. Calculate the calculated value of the Student's criterion according to formula 

(2). 
10. Calculate the critical (table) value of the Student criterion using the built-in 

TINV function . 
11. In the free cell, enter the formula for comparing the calculated and critical 

values of the criterion using the built-in logical function IF so that in the case 
of confirming the significance of the correlation coefficient, the inscription 
"Significant!" is displayed, and in the opposite case - "Not significant". 

12. Draw conclusions about the presence and closeness of the linear relationship 
between the variables. 
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Tasks for practical work 
Dependence of pig blood parameters on time 

Dynamics of biochemical indicators of blood serum of pigs after 
the use of a modified isotonic solution 

Item 
no . 

Observa
tion day 
( X and ) 

The name of the indicators ( Y and ) 

total 
prote

in, 
g/l 

album
in, % 

globu
lin, % 

α-
globul
in, % 

β-
globu
lin, % 

γ- 
globuli
n, % 

1 5 52.9 48.4 51,58 24,21 15,12 12.25 
2 14 53.7 47.6 52.4 24.86 15.2 12.34 
3 30 56.9 47.4 52.6 21.56 16.4 14.64 
4 60 63.4 48.5 51.48 19.88 16.8 14.8 
5 90 69.1 41.55 58.45 21,16 16.1 21,19 
6 150 72.1 41,51 58,49 20.9 16.2 21.3 
7 270 76 41,18 58.82 19.85 16.82 22.16 

  
 

Self-test questions 
1. What relationship between variables is called correlation? 
2. What characteristics are used to establish the presence of a correlation 

between two random variables? 
3. What does the magnitude and sign of the pair correlation coefficient indicate? 
4. How is the statistical significance of the pairwise correlation coefficient 

tested? 
5. What built-in functions are used to determine the correlation coefficient? 
6. What are array formulas used for? 
7. What are used as arguments of array formulas? 
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CHAPTER 2. MODERN NETWORK AND INFORMATION AND 
COMMUNICATION TECHNOLOGIES  

 
2.1. Network devices and means of communication 

Twisted pair, coaxial cable and fiber optic lines are most often used as means 
of communication. When choosing the type of cable, the following indicators are 
taken into account: 
• The cost of installation and maintenance; 
• Information transfer speed; 
• Limitation on the size of the information transmission distance (without 

additional repeater amplifiers ); 
• Security of data transfer. 

The main problem is to provide these indicators at the same time, for 
example, the highest data transfer rate is limited to the maximum possible data 
transfer distance, which still provides the necessary level of data protection. Easy 
expandability , ease of expansion of the cable system affect its cost and security of 
data transmission.  

Network cards are responsible for transferring information between network 
units. Any network card consists of a connector for a network conductor and a 
microprocessor that encodes/decodes network packets, as well as auxiliary software 
and hardware complexes and services. Each card has its own MAC address - a 
unique identifier of the device. 

  

 
Figure 2.1 - Network map  
Coaxial cable has an average pFig, is well protected against interference and is 

used for communication over long distances (several kilometers). 
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The speed of information transfer is from 1 to 10 Mbit/s, and in some cases it 

can reach 50 MbІit/s. Coaxial cable is used for basic and broadband information 
transmission. 

 
Figure 2.3 – Connecting the adapter Figure 1.4 – Connecting computers to a 

thin coaxial network cable with a thin cable 
The minimum set of equipment for a single-segment network on a thin cable 

should include the following elements: 
• network adapters (by the number of computers connected to the network) - ( 

network interface card ) - a peripheral device that allows computer to interact with 
other devices networks ;  lengths of cable with BNC connectors at both ends, the 
total length of which is sufficient to connect all computers; 

• BNC T- connectors (by the number of network adapters) (Fig. 1.5, a) 
(intended to connect three cables); 
• one BNC terminator without grounding (the terminator is an energy absorber 

at the end of a long line , resistance of which is equal to wave resistance of this line) 
(Fig. 1.5, b); 

• one BNC terminator with grounding (Fig. 1.5, c). 
 
 

http://uk.wikipedia.org/wiki/%D0%90%D0%BD%D0%B3%D0%BB%D1%96%D0%B9%D1%81%D1%8C%D0%BA%D0%B0_%D0%BC%D0%BE%D0%B2%D0%B0
http://uk.wikipedia.org/wiki/%D0%90%D0%BD%D0%B3%D0%BB%D1%96%D0%B9%D1%81%D1%8C%D0%BA%D0%B0_%D0%BC%D0%BE%D0%B2%D0%B0
http://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
http://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
http://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
http://uk.wikipedia.org/wiki/%D0%9B%D0%BE%D0%BA%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BE%D0%B1%D1%87%D0%B8%D1%81%D0%BB%D1%8E%D0%B2%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BC%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%9B%D0%BE%D0%BA%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BE%D0%B1%D1%87%D0%B8%D1%81%D0%BB%D1%8E%D0%B2%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BC%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%9B%D0%BE%D0%BA%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BE%D0%B1%D1%87%D0%B8%D1%81%D0%BB%D1%8E%D0%B2%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0_%D0%BC%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%94%D0%BE%D0%B2%D0%B3%D1%96_%D0%BB%D1%96%D0%BD%D1%96%D1%97
http://uk.wikipedia.org/wiki/%D0%94%D0%BE%D0%B2%D0%B3%D1%96_%D0%BB%D1%96%D0%BD%D1%96%D1%97
http://uk.wikipedia.org/wiki/%D0%95%D0%BB%D0%B5%D0%BA%D1%82%D1%80%D0%B8%D1%87%D0%BD%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
http://uk.wikipedia.org/wiki/%D0%95%D0%BB%D0%B5%D0%BA%D1%82%D1%80%D0%B8%D1%87%D0%BD%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
http://uk.wikipedia.org/wiki/%D0%95%D0%BB%D0%B5%D0%BA%D1%82%D1%80%D0%B8%D1%87%D0%BD%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
http://uk.wikipedia.org/wiki/%D0%A5%D0%B2%D0%B8%D0%BB%D1%8C%D0%BE%D0%B2%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
http://uk.wikipedia.org/wiki/%D0%A5%D0%B2%D0%B8%D0%BB%D1%8C%D0%BE%D0%B2%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
http://uk.wikipedia.org/wiki/%D0%A5%D0%B2%D0%B8%D0%BB%D1%8C%D0%BE%D0%B2%D0%B8%D0%B9_%D0%BE%D0%BF%D1%96%D1%80
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 (a)  (b) (c) 
Figure 2.5 – General view of BNS: (a) - BNC T- connectors , BNC terminator 

without grounding (b) and with grounding (c) 
If the network is created from several segments using repeaters and hubs, it 

should be taken into account that some hubs have built-in 50-ohm terminators 
(sometimes they are disconnected), which simplifies coordination problems. 

A hub is a connecting component to which all computers connect in network 
by “star” topology (Fig. 1, 5, b). 

  

 
Figure 2.5, b - Example of work with a hub 
Ethernet cable is also a coaxial cable with a wave resistance of 50 Ohms (Fig. 

1.6). 

 

http://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
http://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
http://uk.wikipedia.org/wiki/%D0%9C%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%9C%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%9C%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%9C%D0%B5%D1%80%D0%B5%D0%B6%D0%B0
http://uk.wikipedia.org/wiki/%D0%97%D1%96%D1%80%D0%BA%D0%B0_(%D1%82%D0%BE%D0%BF%D0%BE%D0%BB%D0%BE%D0%B3%D1%96%D1%8F)
http://uk.wikipedia.org/wiki/%D0%97%D1%96%D1%80%D0%BA%D0%B0_(%D1%82%D0%BE%D0%BF%D0%BE%D0%BB%D0%BE%D0%B3%D1%96%D1%8F)
http://uk.wikipedia.org/wiki/%D0%97%D1%96%D1%80%D0%BA%D0%B0_(%D1%82%D0%BE%D0%BF%D0%BE%D0%BB%D0%BE%D0%B3%D1%96%D1%8F)
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Figure 2.6 – General view of Ethernet cables (RG-8, 10Base5) 
  
It is also called thick Ethernet or yellow cable. It uses a 15-pin standard plug. 

Due to interference protection , it is an expensive alternative to conventional coaxial 
cables. The average data transfer speed is 10 Mbit/s. The maximum available 
distance without a repeater does not exceed 500 m, and the total distance of the 
Ethernet network is about 3000 m. The Ethernet cable, thanks to its trunk topology, 
uses only one load resistor at the end. 

Cheaper than Ethernet cable is the Cheapernet cable (RG58) connection ( 
Figure 1.7) or, as it is often called , thin Ethernet . It is also a 50-ohm coaxial cable 
with a data transfer rate of 10 Mbit/s. When connecting Cheapernet cable segments, 
repeaters are also needed. Computer networks with a Cheapernet cable have a low 
cost and minimal costs during expansion. Network cards are connected using widely 
used small-sized bayonet connectors (SR-50) (Figure 1.8) ( bayonet is a type of 
connection). 

  

  
Figure 2.7 - General view of the Cheapernet cable (RG-58, 10Base2) 

Additional shielding is not required. The cable is connected to the PC using T- 
connectors . The distance between two workstations without repeaters can be a 
maximum of 300 m and a minimum of 0.5 m, the total distance for a network on a 
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Cheapernet cable is about 1000 m. The Cheapernet receiver is located on the network 
board both for galvanic isolation between the adapters and and to amplify the 
external signal 

 

        

        

        

  
Figure 2.8 – General view of SR-50 type connectors 

  
1.1.4 Broadband coaxial cable 

Broadband coaxial cable (Figure 2.9) is immune to interference, easily 
expandable, but its pFig is high 
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Figure 2.9 – General view of broadband coaxial cable 

RG-59 (75 Ohm ): wire - 24 AWG (0.6 mm, copper, stranded), external . diam 
. - 6.1 mm, screen (95% mesh), light, flexible 

The speed of information transfer is equal to 500 Mbit/s. When transmitting 
information in the base band of frequencies for a distance of more than 1.5 km, an 
amplifier or a so - called repeater is required . Therefore, the total distance when 
transmitting information increases to 10 km. For computer networks with a "tire" or 
"tree" topology, the coaxial cable must have a matching resistor (terminator) at the 
end. 

The cheapest cable connection is a twisted two-wire connection , often called a 
"twisted pair " ) (Fig. 2.10). 

  

  
Figure 2.10 – Twisted pair 

Such a connection allows you to transfer information at a speed of up to 10 
Mbit/s, it is easily expanded, but it is fail-safe . The length of the cable cannot exceed 
1000 m at a transmission speed of 1 Mbit/s. The advantages are a low pFig and 
trouble-free installation. 

An unshielded twisted pair consists of eight wires. Each wire is insulated 
separately; all eight wires are assembled into four twisted pairs. Curling the wires 
prevents cross interference caused by adjacent pairs and external sources. All four 
pairs are placed in a common envelope. 

With cables of the "twisted pair" type, RJ45 connectors are used (Fig. 2.11), 
the same as for standard telephone cables, only with eight contacts instead of four 
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or six. 

  
Figure 2.11 – General view of the RJ45 connector 

  
to increase the immunity of information, that is, a twisted pair enclosed in a 

shield, similar to the shield of a coaxial cable. This increases the cost of twisted pair 
and brings its pFig closer to the pFig of coaxial cable. 

Twisted pair has been used in telephone networks for more than a decade, but 
it was adapted to computer networks relatively recently. Twisted pair has supplanted 
coaxial cable from the LOM world thanks to several distinct advantages. First, the 
"twisted pair" cable consists of eight separate wires, which makes it more flexible 
than coaxial and, accordingly, makes it easier to lay. Secondly, thousands of ready-
made qualified installers of telephone cables can be safely involved in the laying of 
cables for LOM. In new buildings, telephone and network cables are often laid by 
the same contractor at the same time. 

The minimum set of equipment for a twisted pair network includes the 
following elements: 

• network adapters (according to the number of computers connected to the 
network) with RJ-45 UTP connectors;  

• cable segments with RJ-45 connectors at both ends (by the number of 
computers to be joined); 

• one hub that has as many UTP ports with RJ-45 connectors as it is necessary 
to connect computers. 

 
Fiber optic lines (10 BaseFL ) 

The most expensive are optical conductors (Fig. 2.12), also called cable. 
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Figure 2.12 - Optical fiber 

The speed of information spread from them reaches 100 Mbit/s, and on 
experimental equipment samples - 200 Mbit/s. Allowable removal of more than 50 
km. The external influence of obstacles is practically absent. At the moment, this is 
the most expensive connection for LOM. They are used where electromagnetic 
interference fields occur or information transmission over very long distances 
without the use of repeaters is required. They have properties because the technique 
of branching in fiber optic cables is very complicated. Optical conductors are 
combined in JIBM using a star-shaped connection. 

In this case, information is transmitted over two fiber optic cables that transmit 
signals in different directions (as in 10BASE-T). Two-wire fiber optic cables are 
sometimes used , containing two cables in a common outer sheath, but more often - 
two single cables. Contrary to popular belief, the cost of fiber optic cable is not too 
high (it is close to the cost of thin coaxial cable). Although, in general, the equipment 
in this case turns out to be significantly more expensive, because it requires the use 
of expensive fiber optic transceivers. 

IEEE 802.3d specification Fiber Optical Inter Repeater Link (FOIRL) was 
proposed in 1987. It was intended to ensure information interaction of repeaters ( 
network equipment for amplification of signal ) , which are at a considerable (up to 
1000 m) distance from each other. SMA and ST type connectors were used for 
connection to the fiber optic line (FOL). 

In the future, however, this technology was not developed, as new network 
technologies of the 10 Base -F family appeared, which also used fiber -optic cable 
for data transmission and provided the best information and operational 
characteristics. 

Using a fiber optic cable for data transmission  
The main advantages of data transmission over fiber -optic communication 

lines are: 
• The high speed of data transmission is the limit of 3GHz for industrial WANs, 

while for a copper cable this value is no more than 500 MHz. 

http://uk.wikipedia.org/wiki/%D0%A1%D0%B8%D0%B3%D0%BD%D0%B0%D0%BB
http://uk.wikipedia.org/wiki/%D0%A1%D0%B8%D0%B3%D0%BD%D0%B0%D0%BB
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• Insensitivity to electromagnetic interference 
• Absence of electromagnetic radiation during data transmission 
• Provision of galvanic isolation between the transmitter and data receiver 
Fiber optic cable consists of the following components: optical fiber, optical 

screen, protective screen. 
Its own transmission medium - an optical fiber is a glass or plastic core, the 

thickness of which, depending on the purpose of the cable, can vary from units to 
hundreds of microns. The diameter of the central fiber clearly determines the 
performance characteristics of the used fiber optic cable. Cables with a fiber 
diameter of 10 microns are called single-mode by the name of the radiation mode of 
the transmitting element - the laser. Cables with a fiber diameter of 60 microns or 
more are called multimode . Single mode fiber optic cables ( Single Mode Fiber - 
SMF) are more difficult to manufacture and operate, however, they are able to 
provide a greater range of information signal spread. Cheaper to manufacture and 
convenient to use are multi-mode ( Multi Mode Fiber - MMF) cables provide a 
shorter range of information signal spread. 

To indicate the type of fiber optic cable, use the expression types: <Fiber 
diameter> / <Screen diameter>, in micro meters, for example: 62.5/125 

Currently, multimode is the most widely used for data transmission in local 
networks fiber optic cable, however, only single-mode can be used to provide data 
transmission at speeds above 1 GHz over long distances fiber optic cable. 

The 10 Base F (IEEE 802.3j) set of standards defines physical layer protocols 
for data transmission over fiber optic cable in IEEE 802.3 networks. 

Specification 10 Base FB ( Fiber Back Bone ) defines a special protocol of the 
physical level, which is designed to ensure the improvement of the efficiency of 
information interaction of repeaters in IEEE 802.3 networks. 

To ensure the synchronization of the clock generators in the absence of sent 
and frames, the transmitter and receiver exchange 2.5 MHz synchronizing 
sequences. 

The 10 Base FB protocol is not universal and does not provide, in particular, 
information interaction between the repeater and the workstation. 

Specification 10 Base FP ( Fiber Passive ) defines a physical layer interface to 
ensure the interaction of local network components using the principle of a passive 
optical splitter. When using the 10 Base FP technology, it is possible to build a 
passive unifying structure that can ensure the interaction of 33 workstations located 
at a distance of up to 500 m. 

Specification 10 Base FL ( Fiber Link ) defines the data transfer protocol over 
two fiber -optic cables at a speed of 10 Mbit/ s over a distance of up to 2000 m. The 
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10 Base FL physical layer protocol provides information interaction in various 
options: 

• Workstation - workstation 
• The workstation - repeater   Repeater - repeater  
  
Base FL protocol parameters 

No Parameter Parameter value 
1 Data transfer speed 10 Mbit 
2 Cable type 62.5/125 
3 Max. segment length 2000 m 
4 Type of connectors ST 

  
10BASE-FL uses a multimode cable and light with a wavelength of 850 

nanometers, but there is also equipment for using a single-mode cable (with a 
maximum length of up to 5 km). Fiber optic transceiver is called FOMAU ( Fiber 
Optic MAU). It performs all the functions of a conventional transceiver (MAU), but, 
in addition, converts an electrical signal to an optical signal during transmission and 
back when receiving. FOMAU also generates and monitors the link integrity signal 
transmitted in the pauses between packets. The integrity of the communication line, 
as in the case of 10BASE-T , is displayed by the " Link " LEDs and is determined by 
the presence of an " Idle " signal with a frequency of 1 MHz between transmitted 
packets. To connect the transceiver to the adapter, a standard AUI cable (Fig. 1.13) 
is used, the same as in the case of 10BASE5 , but its length should not exceed 25 
meters. There are also network adapters with built-in FOMAU transceivers , which 
have only external fiber optic connectors and do not require transceiver cables. 

  
Figure 2.13 – General view of the AUI cable 
The length of optical fiber cables connecting the transceiver and the hub can 
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reach 2 kilometers without the use of any repeaters. Thus, it is possible to join a local 
network of computers located in different buildings, spread over the territory. 

 
Figure 2.14 – Connection of adapter and hub in 10BASE-FL  
 As in the case of 10BASE-T, several hubs can be connected together to obtain 

a tree topology. In general, the 10BASE-FL segment is most often used to connect 
two hubs. And computers are connected to hubs according to the 10BASE-T 
standard. Thus, it is possible to combine the advantages of both segments - the low 
cost of 10BASE-T and the long distances of 10BASE-FL. 

 
Figure 2.15 – Connecting computers to a network according to the 10BASE-FL standard 
  
The minimum set of equipment for connecting two computers with a fiber optic 

cable includes the following elements: 
• two network adapters with transceiver connectors; 
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• two optical fiber transceivers (FOMAU); 
• two transceiver cables; 
• two fiber optic cables with ST connectors (or SC or MIC connectors) on the 

ends. 
There are many optical connectors . Their main types are presented in table 2.2. 
Version of SC connector in Double format for multimode fiber (Fig. 2.16). 
  

  
Figure 2.16 – SC connector in Double format  
  
Table 2. 2 - Types of optical connectors  

Marking Appearance Description 
 

Losses ( Db ) at 
1300 nm for 
multimode / 
singlemode 

1 2 3 4 
ST - Straight 

Tip connector  
  Initial type, now 

deprecated. Fixation by 
turning around the axis 
by 1/4 turn. The rotation 
of the base is excluded 
due to the longitudinal 
groove in the socket 
connector. Requires a lot 
of free space during 
assembly / disassembly. 
The optical tip is 
ceramic, 2.5 mm in 
diameter with a rounded 
end.  

0.25/0.3  
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FC - Fiber -
Optic Connector   

  ST-type 
development. The 
threaded fixation of the 
frame provides excellent 
performance. 

0.2/0.6 

SC - 
Square/Subsc

riber  
Connector   

  Installation / 
removal is carried out 
only by reciprocating 
movement, no rotating 
parts 

(mainly). Optical 
tip - 2.5 mm in diameter, 
almost completely 
hidden by the case. The 
case has latches for 
fixing in the socket. Can 
have a device for 
attaching a paired tip or 
be produced in duplex 
option. The color of the 
case for single-mode is 
blue, for multi-mode - 
gray. 

0.2/0.25 

LC - Little  
or  

Local 
Connector   

  

A small version of the 
SC connector . The case 
is equipped with a latch 
similar to a latch on an 
RJ-45 connector. 
Ceramic tip, diameter 
1.25 mm. 

0.1/0.1  

  
Indicators of the three most typical means of communication for data 

transmission are given in tables 1.3-1.4. 
  
 
 
Table 2.3 – Main indicators of means of communication 

Indicators 
Means of communication for data transmission  

Two-wire twisted 
pair  

Coaxial cable  Fiber optic cable  

PFig  Low Relatively high High 

Build-up  Very simple It is problematic Simple 

http://translate.google.com/translate?hl=uk&prev=_t&sl=ru&tl=uk&u=http://pavel.su/prof/tables/fo-connectors.htm%23double#double
http://translate.google.com/translate?hl=uk&prev=_t&sl=ru&tl=uk&u=http://pavel.su/prof/tables/fo-connectors.htm%23double#double
http://translate.google.com/translate?hl=uk&prev=_t&sl=ru&tl=uk&u=http://pavel.su/prof/tables/fo-connectors.htm%23double#double
http://translate.google.com/translate?hl=uk&prev=_t&sl=ru&tl=uk&u=http://pavel.su/prof/tables/fo-connectors.htm%23double#double
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Eavesdropping 
protection  Insignificant good High 

Problems with 
grounding  No Possible No 

Susceptibility to 
obstacles  There is There is Absent 

  
Table 2.4 – Comparative characteristics of network conductors 

Cable 
type 

(10 Mbps 
= approx 

1 MB per 
second ) 

Data transfer 
speed 

( megabits per 
second) 

Max official 
segment 
length, m 

Max 
unofficial 
segment 
length, m 

The 
possibility of 
recovery at 
damage 
/ 
Lengthening 

Tendency to 
interference 

  

Cost 

Twisted pair  

Unshield
ed twisted 
pair 

100/10/1000 
Mbit / s 

100/100/100 
m 

150/300/100 
m 

  
good 

average low 

Shielded 
twisted pair 

100/10/1000 
Mbit / s 

100/100/100 
m 

150/300/100 
m 

  
good 

low average 

P-296 
field cable 

100/10 
Mbit / s 

------ 300 (500) / 
800 m 

good low High 

Four-
wire 
telephone 
cable 

  
30/10 Mbit 
/ p 

------ No more than 
30 m 

good High Very low 

Coaxial cable  

Thin 
coaxial cable 

10 Mbps 185 m 250 (300) m bad 
Soldering 

is required 

High low 

Thick 
Coaxial 

cable 

10 Mbps 500 m 600 (700) bad 
Soldering 

is required 

High average 

Optical fiber  

Single 
mode  fiber 
optic  

100-1000 
Mbit 

Up to 100 
km 

---- Special 
equipment is 
required 

Absent $1-3 
per meter 
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Multimo
de  fiber 
optic  

1-2 Gbit  Up to 550 
m 

---- Special 
equipment is 
required 

Absent $1-3 
per meter 

There are a number of principles for building LOM based on the components 
discussed above. Such principles are also called topologies , which we will consider 
in the next section. 
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2.2 Computer network topologies 

   
The concept of a star network topology comes from the field of mainframe 

computers, in which the main machine receives and processes all data from 
peripheral devices as an active data processing node. This principle is used in data 
transmission systems, for example, in RelCom network e-mail . All information 
between two peripheral workplaces passes through the central node of the computer 
network. 

The bandwidth of the network is determined by the computing power of the 
node and is guaranteed for each workstation. Data collisions do not occur. 

Cabling is quite simple because each workstation is connected to a node. 
Cabling costs are high, especially when the central node is not geographically 
located in the center of the topology. 

When expanding computer networks, previously completed cable connections 
cannot be used: a separate cable must be laid from the center of the network to the 
new workplace. 

  

 
Figure 2.17 – Structure of the LOM topology in the form of a "star" 
  
The star topology is the fastest of all computer network topologies , since data 

transmission between workstations passes through the central node (with good 
performance) on separate lines used only by these workstations. The frequency of 
information transfer requests from one station to another is low compared to that 
achieved in other topologies . 

The performance of the computer network primarily depends on the power of 
the central file server. It can be a bottleneck of a computer network. In the event of 
failure of the central node, the operation of the entire network is disrupted. 
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The central control node - the file server implements the optimal protection 
mechanism against unauthorized access to information. The entire computing 
network can be controlled from its center. 

In a ring network topology, workstations are connected to each other in a circle, 
that is, workstation 1 to workstation 2, workstation 3 to workstation 4, etc. The last 
workstation is connected to the first. The communication link is closed in a ring 
(Figure 1.18). 

  

 
Figure 2.18 – The structure of the ring topology of LOM  
  
Cabling from one workstation to another can be quite difficult and expensive, 

especially if the geographic location of the workstations is far from the ring shape 
(for example, in a line). 

Messages circulate regularly in a circle. The workstation sends information to 
the specified final address after receiving a request from the ring. Message 
forwarding is very efficient because most messages can be sent "on the road" over 
the cable system one at a time. It is very easy to make a circular request to all stations. 
The duration of information transfer increases in proportion to the number of 
workstations included in the computer network. 

The main problem with the ring topology is that each workstation must actively 
participate in forwarding information, and in case of failure of at least one of them, 
the entire network is paralyzed. Malfunctions in cable connections are easily 
localized. 

Connecting a new workstation requires a short-term shutdown of the network, 
because the ring must be open during installation. There is no limit to the length of 
the computer network, as it is ultimately determined solely by the distance between 
two workstations. 
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A special form of ring topology is a logical ring network. Physically, it is 
mounted as a connection of star topologies . Individual stars are turned on with the 
help of special switches , which are sometimes called "hub". Depending on the 
number of workstations and the length of the cable between the workstations, active 
or passive hubs are used. Active hubs additionally contain an amplifier for 
connecting 4 to 16 workstations. A passive hub is an exclusively branching device 
(for a maximum of three workstations). Management of an individual workstation 
in a logical ring network is the same as in a conventional ring network. Each 
workstation is assigned an address corresponding to it, by which control is 
transferred (from the oldest to the youngest and from the youngest to the oldest). 
The disconnection occurs only for the lower (nearest) node of the computer network, 
so that only in rare cases can the operation of the entire network be disrupted. 

 
Figure 2.19 – The structure of the logical ring node LOM 

  
With the bus topology, the information transmission environment is presented 

in the form of a communication path available to all workstations, to which they 
must all be connected. All workstations can directly communicate with any 
workstation on the network. 
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Figure 2.20 – The structure of the bus topology of the LOM 

  
Workstations can be connected to or disconnected from the entire computer 

network at any time without interrupting the operation of the entire computer 
network. The functioning of a computer network does not depend on the state of an 
individual workstation. 

In a standard situation, a thin cable or Cheapernet cable with a triple connector 
is often used for an Ethernet bus network. Disconnecting and especially connecting 
to such a network requires a bus break, which causes a violation of the circulating 
flow of information and a system freeze. 

New technologies offer passive plug boxes through which stations can be 
disconnected and/or connected while the computer network is operating. 

Due to the fact that workstations can be connected without interrupting network 
processes and the communication environment, it is very easy to listen to 
information, that is, to branch information from the communication environment. 

In LOM with direct (non- modulating ) transmission of information, there can 
always be only one station that transmits information. To prevent collisions, in most 
cases, a time division method is used, according to which each connected 
workstation is given the exclusive right to use the data channel at certain times. 
Therefore, the requirements for the bandwidth of the computer network at increased 
load are increased, for example, when new workstations are introduced. 
Workstations are connected to the bus using TAP devices ( Terminal Access Point 
). TAP is a special type of connection to a coaxial cable. A needle-shaped probe is 
introduced through the outer sheath of the outer conductor and the dielectric layer to 
the inner conductor and is connected to it. 

In modulated broadband LOM, different workstations receive, as needed, a 
frequency on which these workstations can send and receive information. The 
transmitted data is modulated on the corresponding carrier frequencies, that is, 
modems for modulation and demodulation are located between the information 
transmission medium and workstations, respectively. The technique of broadband 
messages allows simultaneously transporting a fairly large amount of information in 
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the communication environment. For the further development of discrete data 
transport, it does not matter what the original information is fed into the modem 
(analog or digital), as it will still be transformed in the future. 

The main characteristics of the three most typical computer network topologies 
are given in Table 2.5. 

Table 2.5 – Main characteristics of computer network topologies 

Characteristics 
Computer network topologies 

Star  Ring  Bus 

Cost of expansion  Insignificant average average 

Joining subscribers  passive active passive 

Protection against failures  Insignificant Insignificant High 

System dimensions  Any Any Limited 

Protection against 
eavesdropping  good good Insignificant 

Connection cost  Insignificant Insignificant High 

System behavior at high 
loads  good Satisfactory bad 

Ability to work in real time  
Very good good bad 

Cabling  good Satisfactory good 

Service  Very nice Average Average 
  
Along with the well-known "ring", "star" and "bus" computer network 

topologies , a combined one, for example a tree structure, is also used in practice. It 
is formed mainly in the form of combinations of the aforementioned computer 
network topologies . The base of the computer network tree (root) is located at the 
point where information communication lines (branches of the tree) gather. 
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Figure 2.21 – Tree structure of LOM 

  
Computer networks with a tree-like structure are used where it is impossible to 

directly apply basic network structures in their pure form. Network amplifiers and/or 
switches are used to connect a large number of workstations in accordance with 
adapter boards. A switch that simultaneously has the functions of an amplifier is 
called an active hub. 

In practice, two of their varieties  are used, which provide the connection of 
eight or sixteen lines, respectively. 

A device to which a maximum of three stations can be connected is called a 
passive hub. A passive hub is usually used as a splitter. It does not need an amplifier. 
The prerequisite for connecting a passive hub is that the maximum possible distance 
to the workstation should not exceed several tens of meters. 

Many people think that this is the most difficult stage of laying a network, 
because there are so many conductors, it is so easy to get tangled in them, you need 
to buy a special crimping tool , etc. In fact, everything is quite simple. To crimp the 
twisted pair, you will need special pliers and a pair of RJ-45 connectors , as shown 
in Figures 2.22 and 2.23. 
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Figure 2.22 - RJ-45 connectors 
  
Sequence of actions during crimping: 
1. Carefully cut the end of the cable, it is best to use the cutter that is built into 

the crimping tool. 

    
Crimping tool RJ-45 Twisted pair insulation stripping knife 

Figure 2.23 – Crimping tool RJ-45 
2. Remove the insulation from the cable. You can use a special knife for 

stripping the insulation of twisted pair, its blade protrudes exactly to the thickness 
of the insulation, so you don't damage the conductors. 
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Figure 2.24 – Twisted pair insulation stripping 

  
However, if there is no special knife, you can use an ordinary one or take 

scissors, or use the knives of a crimping tool. 
  

 
Figure 2.25 – Twisted pair without insulation 

  
3. Separate and unravel the wires, align them in one row, while observing the 

color sequence 



132 
 

 
Figure 2.26 - Layout of the color sequence 

  
4. After cutting off the wires so that they remain a little more than a 

centimeter 

  
(Cut off the redundant) 

Figure 2.27 – Cutting length of twisted pair wires 
 
 
 
  
5. Insert the conductors into the RJ-45 connector 
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Figure 2.28 – Inserted conductors into the RJ-45 connector 

  
6. Check that the wiring is correctly arranged 
7. Make sure that all the wires are fully inserted into the connector and rest 

against its front wall 
8. Place the connector with the installed pair in the pliers, then gently but 

firmly crimp 
  
 

  
Figure 2.29 – Crimping a connector with an installed pair 

There are two common standards for diluting color pairs: Siemon 's T568A and 
AT & T's T568B. Both of these standards are completely equivalent. 

With such a layout, the information is carried by the conductors: White-green, 
Green, White-orange, Orange. 
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Fig. 2.30 View of the network card connection – Switch according to the T568A standard 
 

  
Fig. 2.31 Network card - switch connection according to the T568B standard 
With such a layout, the information is carried by the conductors: White-orange, 

Orange, White-green, Green. 
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Fig. 2.32 Network card - network card connection ( crossover cable) 
  Crimping in this way, you may need a twisted pair in 2 cases: 
1. To connect 2 computers without a switch. 
2. To connect 2 or more Hub / Switch  
  

 
Fig. 2.33 View of contacts 
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 2.2 Addressing in IP networks  
  
The WINDOWS network operating system contains a set of utilities useful in 

diagnosing a network using TCP / IP protocols. 
The main tasks of these utilities are: 

- Determination of network parameters and characteristics; 
- Determination of network performance; 
- In the event of a network malfunction - localization of the segment or service causing 

the malfunction. 
The main parameters of network connections are their channel and network 

addresses and other parameters affecting the operation of the network layer. 
Each computer in the Internet network (they are usually called hosts ) has 

addresses of two levels: channel and network. 
The channel address of the host is determined by the technology used to connect 

it to the Internet . For machines connected to Ethernet local networks , this is the so-
called MAC address ( Media Access Control ) of the network adapter, which is 
assigned by the equipment manufacturer and is unique. For existing LAN 
technologies, the MAC address has a 48-bit format (6 bytes): 

- The first bit indicates: a frame is assigned to a single (0) or group (1) addressee; 
- The next bit indicates whether the MAC address is globally (0) or locally (1) 

administrative ; 
- The next 22 bits are the manufacturer's company identifier; 
- The lower 3 bytes are uniquely assigned by the manufacturer. MAC addresses are 

usually represented in the 16-bit system, for example, 00-E0-4C-78-23-FD. The FF-
FF-FF-FF-FF-FF address is broadcast. 

As the network address of the host Internet uses IP addresses ( Internet Protocol 
Address ), which characterizes not a separate computer or router, but one network 
connection. When communicating via the Internet, the global uniqueness of the 
address is required, which is provided by the recommendations of the special 
Internet division InterNIC ( Network Information Center ). Internet service providers 
obtain address ranges from InterNIC units and then distribute them to their 
subscribers. In the case of a local network isolated from the Internet, the uniqueness 
of the network address is necessary only within its boundaries, while IP addresses 
must be selected by the administrator from blocks of "closed" addresses specially 
reserved for such networks. 

In the most common fourth version of the Internet Protocol (IP.v4), an IP 
address is a 32-bit binary number written as four decimal numbers (values from 0 to 
255) separated by dots (for example, 192.168.0.1). The address consists of two 
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logical parts - the network number and the host number in the network. 
With the class model of address formatting, the values of the first bits of the 

address determine which part of it refers to the network number, and which part 
refers to the host number , as shown in the table. 2.6. 

 
Table 2.6 – Class model of address formatting 

 
  
A number of network and subnet addresses are special: 

- If the entire IP address consists only of binary zeros, then it indicates the address of 
the host that generated this packet; 

- If all binary bits of the host's IP address are equal to 1, then the packet with this 
destination address is broadcast, that is, it must be sent to all hosts on the same 
network as the source of this packet; 

- If all the binary digits of the host IP address are 0, then this address does not represent 
an individual address, but the entire network; 

- The address 127.0.0.1 means forwarding within the same host (used for offline 
debugging of network software); 

- Addresses of closed networks (private network, Internet network) are in the ranges 
10.0.0.0-10.255.255.255, 172.16.0.0-172.31.255.255, 192.168.0.0192.168.255.255. 

In order to more economically distribute IP addresses between users, the class 
model is replaced by a classless one, in which the allocation of bits in the address 
allocated for network numbering is specified by a special four-byte code - the subnet 
mask. The bits of the mask used for numbering networks have single values. For 
example, the mask 255.255.255.240 (code 
11111111.11111111.11111111.11110000 in the binary system) indicates that 28 
high digits are used for network numbering, and only 4 low digits of the 
corresponding IP address are used for host numbering. IP address entry of the type 
192.96.10.0/28 is often used. The number after the slash means the number of single 
digits in the subnet mask. 

IP addresses for specific computers can be set manually by the network 
administrator, which is very difficult. To automate the process of assigning IP 
addresses to local network hosts, a special DHCP protocol (Dynamic Host 
Configuration Protocol) is used, which provides static or dynamic assignment of IP 
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addresses. Address assignments are formed by the DHCP server based on requests 
from DHCP client programs installed on individual hosts. 

In the automatic static method, the DHCP server assigns an IP address and other 
configuration parameters to the client from a pool (set) of available IP addresses 
without operator intervention. The limits of the pool of assigned addresses are set by 
the administrator when configuring the DHCP server. Between the client's ID and 
its IP address, there is a constant correspondence between the client's ID and its IP 
address, as before, as with manual assignment. It is set at the moment of initial 
assignment of the client's IP address by the DHCP server. With all subsequent 
requests, the server returns the same IP address. 

With dynamic allocation of addresses, the DHCP server assigns an address to 
the client for a limited time, which makes it possible to later reuse IP addresses by 
other computers. 

Computers use numerical IP addresses to communicate, while humans are more 
comfortable working with verbal names. In order for verbal names to be used in 
network applications, a name-to-IP address conversion mechanism is required, 
which is implemented by the DNS (Domain Name System) domain name service, a 
distributed database that supports a hierarchical name system for identifying hosts 
on the Internet. 

The DNS service is designed to automatically look up an IP address using a 
known symbolic host name. DNS servers store a part of the database on the 
correspondence between symbolic names and IP addresses. This database is 
distributed across the administrative domains of the Internet. Clients of the DNS 
server know the IP address of the DNS server of their administrative domain and, 
using the IP protocol, send a request in which they report a known symbolic name 
and ask to return the IP address corresponding to it. 

If data about the requested match is stored in the database of this DNS server, 
then it immediately sends a response to the client, if not, then it sends a request to a 
DNS server of another domain, which either processes the request itself or forwards 
it to another DNS server. All DNS servers are connected hierarchically, according 
to the hierarchy of Internet domains. 

The DNS database has a tree structure called a domain namespace , in which 
each domain (tree node) has a name and can contain subdomains. The domain name 
identifies its position in this database in relation to the parent domain, with periods 
in the name separating the parts that correspond to the domain hosts. 

Top-level domains are assigned on a country-by-country basis as well as on an 
organizational basis. The domain name is made up of words separated by dots and 
containing Latin letters, numbers and a minus sign (-). Domain names can contain 
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up to 63 characters and are case-insensitive, meaning uppercase and lowercase 
letters are considered the same. 

The InterNIC organization, which manages the entire Internet address space, as 
well as the entire name space, delegates to some organizations the right to maintain 
first-level domains, which include the following "organizational" zones ( com - 
commercial, edu - educational, gov - government, int - international, mil - military, 
net - organizations that ensure the operation of the network, org - non-profit 
organizations, biz - the same as com , info - information resources), as well as more 
than two hundred "geographic" domains ( ru and su - Russia, uk - Great Britain, de 
- Germany, fr - France, ua - Ukraine, etc.). 

The owner of the domain zone can organize any subdomains in it and delegate 
the functions of administration of these subdomains to other organizations. A 
subdomain is created by appending another dot-separated word to the domain name 
on the left. Each domain has a unique name, and each subdomain has a unique name 
within its own domain. Each host on the Internet is uniquely identified by its full 
domain name, which includes the names of all domains from the host to the root. An 
example of a full DNS name: alice.pnzgu.ru. 

  
2.3 Network diagnostics system utilities  

  
Ipconfig utility is designed to verify the correctness of the TCP/IP 

configuration for the Windows operating system. Returns values for the current 
configuration of the TCP/IP stack: MAC and IP addresses, subnet mask, default 
gateway address, WINS (Windows Internet Naming Service) and DNS server 
addresses, DHCP usage. 

When troubleshooting a TCP/IP network, you should first check the correctness 
of the configuration using the ipconfig utility . 

Syntax utilities : ipconfig [/ all] [/ renew [adapter]] [/ release [adapter]] . 
Parameters (optional parameters are indicated in square brackets hereafter): 

- all displays the entire list of parameters, without this key only the IP address, mask 
and default gateway are displayed; 

- renew [adapter] renews the DHCP configuration parameters for the specified 
network adapter named adapter ; 

- release [adapter] releases the allocated DHCP IP address. 
Thus, the ipconfig utility (Fig. 2.34) allows you to find out whether the 

configuration is initialized and whether the IP addresses are not duplicated: 
- if the configuration is initialized, the IP address, mask, and gateway appear; 
- if the IP addresses are duplicated, the network mask will be 0.0.0.0; 
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- if the computer could not get an IP address when using DHCP, then it will be equal 
to 0.0.0.0. 

  

  

 
Figure 2.34 – Display of network configurations installed on the computer by the i pconfig 

utility 
  
The ping ( Packet Internet Grouper ) utility is used to check the TCP/IP 

configuration and diagnose connection errors. It determines the availability and 
functioning of a specific host - any network device that exchanges information with 
other network devices via TCP/IP. Using ping is the best way to verify the existence 
of a route between a local computer and a network host. 

ping command checks the connection with a remote host by sending Internet 
Control Message Protocol (ICMP) echo packets to it and listening for echo 
responses. Ping displays the number of transmitted and received packets. Each 
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received packet is checked against the transmitted message. If communication 
between hosts is poor, ping messages will show how many packets are lost. 

By default, four 32-byte echo packets are transmitted, representing a sequence 
of uppercase alphabetic characters. Ping allows you to change the size and number 
of packets, specify whether the route it uses should be recorded, what the lifetime 
value can be set, whether the packet can be fragmented, etc. When receiving a 
response, the field determines how long (in milliseconds) the sent packet reaches the 
remote host and turns back Since the default value for waiting for a response is 1 s, 
all values of this field will be less than 1000 ms. If the "Timeout Interval Exceeded" 
message is issued, it is possible that increasing the response timeout will allow the 
packet to reach the remote host. 

When using the ping utility , you should remember: 
- the delay, which is determined by the utility, is caused not only by the bandwidth of 

the data transmission channel to the checking machine, but also by the load of this 
machine; 

- some servers may not send echo responses for security purposes, as a hacker attack 
may start from the ping utility. 

Ping can be used to test both a host's domain name and its IP address. If the IP 
address is pinged successfully and the name fails, it means that the problem is in the 
resolution of the address and name, not in the network connection. 

Syntax : ping [-t] [-a] [-n count] [-l length] [-f] [-i ttl] [-v tos] [-r count] [-s 
count] [[-j host -list | [-k host-list]] [-w timeout] destinationlist . Parameters: 

- -t executes the ping command until it is interrupted ( Ctrl-Break - see statistics and 
continue, Ctrl-C - interrupt command execution); 

- -a allows you to determine the domain name of the remote computer by its IP 
address; 

- - n count sends the number of Echo packets specified by the count parameter (by 
default, four requests are sent); 

- -l length sends packets of length bytes (maximum length 8192 bytes); 
- -f sends a packet with the "Do not fragment" flag set, prohibiting fragmentation of 

the packet on transit routers; 
- -i ttl sets the lifetime of the packet to the value of ttl (each router reduces ttl by one, 

that is, the lifetime is a counter of passed routers (hops)); 
- -v tos sets the value of the "service" field, which sets the priority of packet 

processing; 
- -r count records the path of the outgoing packet and the returning packet in the path 

entry field, count - from 1 to 9 hosts; 
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- -s count sets the maximum possible number of transitions from one subnet to another 
(hops); 

- -j host-list routes packets using the list of hosts specified by the host-list parameter 
.), the maximum number of hosts is 9; 

- -k host-list routes packets through the list of hosts specified in host-list , and the 
specified hosts cannot be separated by intermediate routers (hard static routing); 

- -w timeout indicates the waiting time for a response timeout from the remote host 
in milliseconds (default - 1s); 

- -destination-list specifies the remote node to which ping packets should be directed 
, can be a hostname or machine IP address. 

In practice, options are most often used in the command format 
-t and -n . 
  An example of the operation of the ping utility is shown in Figure 2.35. 

  

 
Figure 2.35 is an example of using the ping utility 

  
Ping utility can be used in the following ways: 

1. To verify that TCP/IP is installed and configured correctly on the local 
computer, the loopback address is specified in the ping command: ping 127.0.0.1 . 

If the test is passed successfully, you will receive the following response: 
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Reply from 127.0.0.1: number of bytes = 32 time <1ms TTL = 128 
Reply from 127.0.0.1: number of bytes = 32 time <1ms TTL = 128 
Reply from 127.0.0.1: number of bytes = 32 time <1ms TTL = 128 
Reply from 127.0.0.1: number of bytes = 32 time <1ms TTL = 128 

2. To make sure that the computer is correctly added to the network and 
the IP address is not duplicated, the IP address of the local computer is used: ping 
IP-address_local_host . 

3. To check that the default gateway is functioning and you can establish 
a connection with any host on the local network, the IP address of the default 
gateway is set: ping gateway_IP_address . 

4. To check the possibility of establishing a connection through the router, 
the IP address of the remote host is specified in the ping command: ping IP_address 
of the remote host . 

The tracert ( trace route ) utility allows you to discover the sequence of routers 
through which an IP packet passes on its way to its destination by examining ICMP 
messages sent back by intermediate routers. 

The tracert utility works as follows: I send three test ICMP protocol echo 
packets with TTL = 1 to the destination node, the first router will send an ICMP 
"Timeout" message to the source computer. The TTL is then incremented by 1 in 
each subsequent packet until the packet reaches the destination host or the maximum 
possible TTL value is reached (default is 30). 

The machine name can be the hostname or IP address of the machine. The 
output is a list of hosts starting with the first gateway and ending with the destination. 
At the same time, the waiting time for a response to each packet is displayed on the 
screen. 

In those cases where the remote node cannot be reached, using the tracert 
utility is more convenient than ping because it can be used to locate the area of the 
network in which there are communication problems. 

If there are problems, the utility displays asterisks (*) or messages such as "The 
specified network is not available", "Time out". 

It should be remembered that some routers simply destroy packets with an 
exhausted TTL and will not be visible to the tracert utility . 

Syntax utilities : tracert [-d] [-h maximum_hops] [-j host-list] [-w timeout] 
destination-list . Parameters: 

- -d indicates that addresses for hostnames are not to be resolved; 
- -h maximum _ hops indicates the maximum number of hops (by default - 30); 
- -j host-list specifies non-rigid static routing according to hostlist ; 
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- -w timeout indicates that you need to wait a specified number of ms for a response 
to each echo packet; 

- -destination-list specifies the remote node to which ping packets should be directed 
. 

tracert utility is shown in Fig. 2.36. 
  

  

 
Figure 2.36 – An example of using the tracert utility 
  
rp ( Address Resolution Protocol ) utility allows you to manage the so-called 

ARP cache - a table used to translate IP addresses into corresponding local addresses. 
Entries in the ARP cache form the ARP protocol. If the necessary entry in the table 
is not found, then the ARP protocol sends a broadcast request to all computers on 
the local subnet, trying to find the owner of the given IP address. 

The cache can contain two types of entries: static and dynamic. Static records 
are entered manually and stored in the cache permanently. Dynamic entries are 
cached as a result of broadcast requests. For them, there is a concept of life time. If 
the entry was not needed for a certain time (by default, 2 minutes), it is deleted from 
the ARP cache. 

Syntax utilities : arp [-s inet_addr eth_addr] [-d inet_addr] [-a] . 
Parameters: 
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- -s inet_addr eth_addr enters a static record with the specified IP address and MAC 
address into the cache; 

- -d inet_addr deletes an entry for a specific IP address from the cache; 
- -a scans the cache contents for all network adapters on the local computer, as shown 

in Fig. 2.4. 

  

 
Figure 2.37 – An example of using the arp utility 
  
The netstat utility displays protocol statistics and current TCP/IP connections 

and has the following syntax: netstat [-a] [-e] [-n] [-S] [-p name] [-r] [interval] . 
Parameters: 

- -a displays complete information on all connections and ports on which the computer 
is waiting for a connection; 

- -e displays Ethernet statistics (this key can be used in conjunction with the -s key ); 
- -n displays addresses and port numbers in numeric format, without converting them 

into symbolic DNS names and into the name of network services, which is done by 
default t ; 

- -p name specifies the display of information for the name protocol (valid values of 
name : tcp , udp or ip ) and is used together with the s key ; 

- -r displays the contents of the route table (routing table); 
- -s displays detailed protocol statistics. By default, data is output for TCP, UDP, and 

IP. The p key allows you to set the data output according to a certain protocol, the 
interval key initiates the repeated output of statistical data after the interval specified 
in seconds (in this case, to stop the data output, press the Ctrl + C keys ). 

The result of executing the command is a list of active connections, which 
includes established connections and open ports (Fig. 2.38). 
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Figure 2.38 – An example of displaying the TCP connections established on the computer 

by the netstat utility 
Open TCP ports are marked in the "Status" column with the line LISTENING 

- passively open connections ("listening" sockets) or ESTABLISHED - established 
connections, that is, already used by network services. Some of the ports are related 
to Windows system services and are displayed not by number, but by name - epmap 
, microsoft-ds , netbios-ss , etc. Ports that do not belong to standard services are 
displayed by numbers. UDP ports cannot be in different states, so the special 
LISTENING flag is not used for them. Like TCP ports, they can be displayed by 
name or by number. 

  
nslookup utility is designed to query DNS servers to resolve names to IP 

addresses and, in a simple case, has the following syntax: nslookup [host [server]] . 
parameters: 

- host - the domain name of the host, which should be converted into an IP address; 
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- server - the address of the DNS server that will be used to resolve the name. If this 
parameter is omitted, then DNS server addresses from the TCP/IP protocol 
configuration parameters (displayed by the ipconfig utility ) will be used. 

The results of the nslookup command are shown in Fig. 2.39. 
  

  
Figure 2.39 – An example of display by the nslookup utility 

The first two lines of the response contain the name and IP address of the DNS 
server that was used to resolve the name. The following lines contain the real domain 
name of the host and its IP address and the indication Nonauthoritative answer , 
which means that the answer was not received from the DNS server responsible for 
the penza.ru zone . An Aliase string may also be present , which contains alternative 
names for the server being searched for. 

  
When tracing routes or checking the availability of a host on the Internet, it is 

often necessary to determine the IP address of the host of its legal owner and the 
contact details of its administrator. 

Regarding second-level domains, this information becomes freely available to 
any Internet user through the Whois service . On-line service Whois can be obtained 
through the form on the website page http://www.nic.ru/whois .  

  
2.4 Studying the configuration of ETHERNET networks 

The Ethernet network (IEEE 802.3 standard) became the most widespread 
among local computer networks. The standard defines multiple access to a "bus" 
type monochannel with conflict detection and transmission control (in English 
CSMA / CD - Carrier - Sense Multiple Access / CollisionDetection - an access 
method with carrier control and collision detection).  

The main characteristics of the IEEE 802.3 standard are as follows: topology - 
"bus", transmission speed - 10 Mbit/s, access method - CSMA / CD, narrowband 
transmission (monochannel). Transmission is in packets of variable length. 
Individual, group and broadcast addressing is provided. 

In addition to the standard topology of the "bus" type, topologies of the "passive 
star" and "tree" types are also used. At the same time, the use of repeaters and passive 

http://www.nic.ru/whois
http://www.nic.ru/whois
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concentrators connecting different parts (segments) of the network is assumed (Fig. 
2.40). 

  

 
Figure 2.40 – An example of using repeaters and hubs 
  
A single subscriber can act as a segment. The main thing is that there are no 

closed paths (loops) in the resulting topology. In fact, it turns out that the subscribers 
are all connected to the same "bus", since the signal from each of them spreads 
immediately in all directions and does not return back. 

For the Ethernet network, the standard defines four main types of transmission 
media: 

- 10 BASE 5 ("thick" coaxial cable); 
- 10 BASE 2 ("thin" coaxial cable); 
- 10 BASE - T (twisted pair); 
- 10 BASE - F (optical fiber cable). 

The designation of the transmission medium includes three elements: the 
number "10" means a transmission speed of 10 Mbit/s, the word BASE means 
transmission in the main frequency band (that is, without modulation of the high-
frequency signal), and the last element means the permissible segment length: "5 "- 
500 meters," 2 "- 200 meters (more precisely, 185 meters) or the type of 
communication line: "T" - twisted pair (from the English "twisted - pair", "F" - 
optical fiber . 

10 BASE 5 equipment ("thick" cable) 
10 BASE 5 hardware is shown in fig. 2.41, and the connection diagram of the 

adapter to the "thick" cable - in fig. 2.42. 
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Figure 2.41 - 10 BASE 5 hardware 

 

 
Figure 2.42 – Connection diagram of the adapter to the "thick" cable 
"Thick" coaxial cable has a diameter of 0.5 inches (about 1 cm) and is 

characterized by high rigidity, which leads to great difficulties in installing 
equipment. The wave resistance of a "thick" coaxial cable is 50 ohms. The maximum 
length of the segment is 500 meters (without repeaters). "Thick" cables of the RG-8 
and RG-11 type are widely used. 
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N-type connectors are used to connect pieces of "thick" coaxial cable and 
connect terminators to it. Two N-type connectors are connected using Barrel 
connectors. 

At the ends of the segment cable, 50-ohm N-type terminators must be installed, 
one of which must be grounded. 

An AMP connector is most often used to connect transceivers to a "thick" cable. 
A special transceiver (or MAU - Medium Attachment Unit) is placed directly 

on the cable, which is connected to the network adapter by means of a flexible multi-
conductor transceiver cable AUI (about 1 cm in diameter), consisting of 4 twisted 
pairs, which has 15-pin connectors at the ends (DIX connectors of the "plug" type). 
The length of an ordinary transceiver cable can reach 50 m, and a thinner and more 
flexible office variant of the transceiver cable - up to 12.5 m. The transceiver is 
powered by a computer power source. 

A transceiver (transmitter + receiver = transceiver) is a part of a network 
adapter that performs the following functions: 
- reception and transmission of data from cable to cable; 
- determination of collisions on the cable; 
- electrical separation between the cable and another part of the adapter; - cable 
protection against incorrect operation of the adapter. 

It is allowed to connect no more than 100 transceivers to one segment, and the 
distance between the transceiver connections should not be less than 2.5 m. The 
connection diagram of the computers of the network segment on the "thick" cable is 
shown in Fig. 2.43. 

  

 
Figure 2.43 – Diagram of connecting computers of a network segment on a 

"thick" cable 
A network adapter working with a "thick" cable must have an external 15-pin 

AUI connector (DIX type "socket" connector). 
The standard allows the use of no more than 4 repeaters (repeater hubs) and, 
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accordingly, no more than 5 cable segments in the network. This gives a maximum 
length of 10 BASE 5 network equal to 2500 meters. Only 3 segments out of 5 can 
be loaded, that is, those to which computers are connected. There must be unloaded 
segments between the loaded segments, so that the maximum network configuration 
is two loaded end segments that are connected by unloaded segments to one more 
central loaded segment. 

The rule for using repeaters (repeater concentrators) in the network 
Ethernet 10 BASE 5 is called the "5-4-3 rule": 5 segments, 4 repeaters (repeater 

hubs), 3 loaded segments. 
Each repeater (repeater hub) is connected to a segment with its own transceiver, 

so no more than 99 computers can be connected to loaded segments. The maximum 
number of computers in a 10 BASE 5 network is 99.3 = 297 computers. 

The minimum set of equipment for a single-segment network on a "thick" cable 
includes the following elements: 

- network adapters (by the number of connected computers); 
- "Thick" cable with N-type connectors at the ends, the total length of which is 

sufficient to connect all computers in the network; 
- transceiver cables with 15-pin connectors at the ends of the length from the computer 

to the "thick" cable (according to the number of network adapters); 
- transceivers (by the number of network adapters); 
- two N-type barrel connectors for connecting terminators at the ends of the cable; 
- one N-terminator without grounding; 
- one N-terminator with ground. 

  
10BASE2 hardware ("thin" cable) 
A "thin" coaxial cable differs from a "thick" one by a smaller thickness - a 

diameter of about 0.5 inches (5 mm), greater flexibility, great ease of installation, 
and lower cost. "Thin" cable has an impedance of 50 ohms and requires 50 ohm 
termination. The maximum length of the segment is 185 meters (without repeaters). 

The biggest disadvantage of the "thin" cable is the shorter permissible length 
of the segment (up to 185 m). The most common types of "thin" coaxial cable are 
RG -58 / U, RG -58 A / U, RG -58 C / U. 10 BASE 2 hardware is shown in fig. 2.44, 
and the connection diagram of the adapter via a "thin" cable - in fig. 2.45. 
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Figure 2.44 - 10 BASE 2 hardware 

 
Figure 2.45 – Connection diagram of the adapter via a "thin" cable 
  
If the entire network is performed on a "thin" cable, then, according to the 

standard, the number of segments should not exceed five (the total length of the 
network will be 925 m, four repeaters will be required). At the same time, there 
should not be more than 30 subscribers on one segment, including repeaters, that is, 
the total number of computers in the network based on a "thin" cable cannot be more 
than (30-1)*3 = 87. The minimum distance between computers - 1 m. 

The 10 BASE 2 standard provides for the use of repeaters (repeater 
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concentrators), the use of which must also comply with the "rule 5-4 - 3". 
The minimum set of equipment for a single-segment network on a "thin" cable 

should include the following elements: 
- Network adapters (by the number of computers connected to the network); 
- lengths of cable with BNC connectors on two ends, the total length of which is 

sufficient to connect all computers; 
- BNC T-connectors (by the number of network adapters); - one BNC terminator 

without grounding; - one BNC terminator with grounding. 
  
10BASE-T hardware (twisted pair) 
In an Ethernet network based on a twisted pair (UTP cable, Unshielded Twisted 

- Pair Cable), signal transmission is carried out over two twisted pairs of wires, each 
of which is transmitted only in one direction (one pair is transmitting, the other is 
receiving). Each of the subscribers of the network is connected by a cable to the hub, 
the use of which is mandatory. 

The length of the connecting cable between the adapter and the hub should not 
exceed 100 m. The cable used is flexible, with a diameter of about 6 mm. The most 
common type of cable is EIA / TIA category 3 telephone cable. 

Cables are connected by 8-pin RJ-45 type connectors, in which only four 
contacts are used. Hubs sometimes also use 50-pin Telco connectors. 

The standard defines the maximum number of hubs between two network 
stations, namely 4. This rule is called the "4-hub rule". When creating a 10 BASE-T 
network with a large number of stations, hubs can be connected to each other in a 
hierarchical way, forming a tree-like structure. 

Loop connections of hubs in the 10 BASE-T standard are prohibited. 
Reservation of connections (creation of parallel communication channels between 
important hubs to reserve connections in case of failure of a port, hub or cable) is 
possible only by transferring one of the parallel connections to an inactive (blocked) 
state. 

The total number of computers in the network is 10 BASE-T-1024, the 
maximum length of the network (the maximum distance between two computers in 
the network) is 500 m. 

The minimum set of equipment for a twisted pair network includes the 
following elements: 
- Network adapters (by the number of computers connected to the network) 
with RJ-45 connectors; 
- cable segments with RJ-45 connectors at the ends (by the number of 
computers to be joined); 
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- One hub that has as many UTP ports as it is necessary to connect computers. 
  
 
 
 
10BASE-FL equipment (optical fiber cable) 
The use of an optical fiber cable in Ethernet, in addition to providing full 

galvanic isolation of network computers, allowed to increase the length of the 
segment and significantly increase the stability of the transmission. 

Information is transmitted over two fiber optic cables that transmit signals in 
different directions. 

The 10 BASE FL standard provides communication between two computers, 
between two repeaters or between a computer and a repeater. The standard 
guarantees the length of the fiber optic connection between repeaters up to 1 km with 
a total network length of no more than 2500 m. The maximum distance between a 
computer and a hub is 2000 m. The maximum number of repeaters (repeater hubs) 
between any computer by network computers - 4. The maximum length of the 10 
BASE - FL fiber optic cable connecting repeater hubs (repeaters) with computers 
should not exceed 400 meters. Computers can be connected to all segments. 

10 BASE - FL equipment is similar to both 10 BASE 5 equipment (external 
transceivers connected to the transceiver adapter cable are used) and 10 BASE - T 
equipment (passive star topologies and two unidirectional cables are used). The 
network adapter and hub connection diagram is shown in Fig. 2.46. 

  

 
Figure 2.46 – Network adapter and hub connection diagram 

  
The minimum set of equipment for connecting two computers with a fiber optic 

cable includes the following elements: 
- two network adapters with transceiver connectors; 
- two optical fiber transceivers (FOMAU); 
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- two transceiver cables; 
- two fiber optic cables with ST-connectors at the ends. 

  
Independent work. Selecting an Ethernet configuration  

  
Adherence to the numerous restrictions established for various standards of the 

physical layer of Ethernet networks guarantees the correct operation of the network. 
The rules of "5-4-3" for coaxial networks and "4-hubs" for networks based on 

twisted pair and optical fiber not only guarantee network performance, but also leave 
a large "safety margin" of the network. 

For networks consisting of mixed cable systems, for which the rules on the 
number of repeaters are not calculated, additional calculations must be made. 

In order for an Ethernet network consisting of segments of different physical 
nature to work correctly, four basic conditions must be met: 

- the number of computers in the network is no more than 1024; 
- the maximum length of each physical segment is not more than the value defined in 

the corresponding physical level standard; 
- the time of double signal turnover between the two most distant computers of the 

network is no more than 575 bit intervals; 
- reduction of the inter-frame interval when passing a sequence of frames through all 

repeaters should be no more than 49 bit intervals. 
Compliance with these requirements ensures correct operation of the network 

even in cases where simple configuration rules, which determine the maximum 
number of repeaters and the total length of the network of 2500 m, are violated. 

 Calculation of the time of double turnover of the signal (PDV-Path Delay 
Value or RDT - Round Trip Delay) 

The model used to estimate the Ethernet change is based on calculating the time 
characteristics of a given configuration. It uses two calculation systems: one 
involves the calculation of the double (circular) time of the signal passing through 
the network, and the other - checking the admissibility of the received (interframe) 
time interval. At the same time, calculations in both calculation systems are 
conducted for the worst case. 

The first system of calculations uses concepts such as "initial segment", 
"intermediate segment" and "final segment". Note that there may be several 
intermediate segments, and the initial and final segments may change places in 
different calculations. The delay values presented in Table 2.9 are used for 
calculations. 

Table 2.9 – Values of delays 
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Segment 
type 

Ethernet 

Max. 
length, m 

Initial 
segment 

Initial 
segment 

Initial 
segment 

Initial 
segment 

t0 tm t0 tm t0 tm t1 
10BASE5 500 11.8 55.0 46.5 89.8 169.5 212.8 0.0866 
10BASE2 185 11.8 30.8 46.5 65.5 169.5 188.5 0.1026 
10BASE-

T 
100 15.3 26.6 42.0 53.3 165.0 176.3 0.1130 

10BASE-
FL 

2000 12.3 212.3 33.5 233.5 156.5 356.5 0.1000 

FOIRL 1000 7,8 107.8 29.0 129.0 152.0 252.0 0.1000 
AUI (> 2 

m) 
2+48=50 0 5.1 0 5.1 0 5.1 0.1026 

Note. Delays are given in bit intervals. 
  
procedure is reduced to the following: 

1. The path of the longest length is distinguished in the network; 
2. If the length of the segment is not maximum, then the double (circular) 

travel time in each segment of the selected path is calculated according to the 
formula: ts= L*t1+t0, where L is the length of the segment in meters (in this case, 
the type of segment: initial, intermediate or final must be taken into account ); 

3. If the length of the segment is maximum, then the delay value tm is 
taken from the table for it; 

4. The total amount of delays of all segments of the allocated path should 
not exceed 575 bit intervals; 

5. Then it is necessary to perform the same actions for the reverse 
direction of the selected path (that is, considering the final segment as the initial one, 
and vice versa); 

6. If the delays in both cases do not exceed 575 bit intervals, then the 
network is operational. 

If in your chosen network configuration the path of the longest length is not so 
obvious, then similar calculations must be made for all paths claiming the greatest 
signal delay. In any case, the double transit time according to the standard is not 
enough to make a final conclusion about the performance of the network. 

   
Calculation of the reduction of the interframe interval (PVV - Path variability 

Value) 
In order to recognize the network configuration as correct, it is also necessary 

to calculate the reduction of the inter-frame interval by repeaters (repeater hubs). 
This value must not be less than 49 bit intervals. The concepts of initial segment 
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and intermediate segment are also used for calculations here (the final segment does 
not contribute to shortening the interframe interval, since the packet reaches the 
receiving computer through it without passing through repeaters and repeater 
concentrators). 

To calculate the reduction of the interframe interval, you can use the values of 
the maximum values of the reduction of the interframe interval when passing 
repeaters (repeater concentrators) of different physical environments given in table 
2.10. 

  
Table 2.10 - Physical environments 

Segment type Initial segment Intermediate segment 
10BASE5 16 11 
10BASE2 16 11 
10BASE-T 10.5 8 
10BASE-FL 10.5 8 

  
By summing up the reductions of the interframe interval for the largest path in 

the selected configuration and comparing the sum with the limit value of 49 bit 
intervals, we can draw a conclusion about the performance of the network. 

The same calculations are carried out for the return direction along the same 
path. 

 
Procedure for performing independent work 

1. Familiarize yourself with the theoretical part before the laboratory 
work. 

2. According to the given option, design the local computer network of 
the organization. 

3. Prepare a specification for the equipment and materials of the designed 
local computer network of the organization (APPENDIX 3.2). An example of work 
performance is given in APPENDIX 3.3. 

          
Address types of the TCP/IP stack 

There are three types of addresses used in the TCP/IP stack: 
 local (also called hardware) 
 IP addresses 
 symbolic domain names 

Local addresses 
A local address in TCP/IP terminology is a type of address that is used by the 
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underlying technology to deliver data within a subnet, which itself is an element of 
a composite internetwork. 

In different subnets, different network technologies and different protocol stacks 
are permissible, therefore, when creating a TCP/IP stack, the presence of different 
types of local addresses was already assumed in advance. 

If the subnet of the internet is a local network, then the local address is the MAC 
address assigned to the network adapters and network interfaces of the routers. 

MAC addresses are assigned by equipment manufacturers and are unique because 
they are managed centrally. For all existing LAN technologies, the MAC address 
has a 6-byte format, for example 11-AO-17-3D-BC-01. 

It should be noted that since the IP protocol can also work on higher-level 
protocols. In this case, the local addresses for the IP protocol will accordingly be the 
addresses of the corresponding higher-level protocols. 

It should be taken into account that a computer in a local network can have several 
local addresses even with one network adapter. Conversely, some network devices 
do not have local addresses at all. For example, such devices include global router 
ports designed for point-to-point connections. 

IP addresses are the main type of network layer addresses 
Based on IP addresses, the network layer transmits packets between networks: 
IP addresses consist of 4 bytes (32 bits). 
IP addresses are assigned by the administrator during the configuration of 

computers and routers. 
An IP address consists of two parts: a network number and a node number. 
  
The network 

number can be 
chosen by the administrator arbitrarily, or assigned based on the recommendation of 
a special Internet unit (Internet Network Information Center, InterNIC), if the 
network must work as a component of the Internet. Typically, ISPs obtain address 
ranges from InterNIC units and then distribute them to their subscribers. 

The node number in the IP protocol is assigned regardless of the node's local 
address. 

By definition, the router enters several networks at once. Therefore, each port of 
the router has its own IP address (Fig. 4.1). 

 
 190.15.67.1  190.15.40.1190.15.40.2185.30.155.1 (Мережа - Network ) 

Figure 2.47 – An example of irrational use of the IP address space 

Network number Node (host) 
number 

   
 Мере

жа 190.15.67
.0 

 Мере
жа 190.15.40

.0   
 Мере

жа 185.30.155
.0 
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Before sending the packet to the next network, the router must determine its local 
address based on the found IP address of the next router. For this, the IP protocol, as 
shown in Fig. 4.2, refers to the address resolution protocol (ARP). 

An endpoint can also belong to multiple IP networks. In this case, the computer 
must have several IP addresses, according to the number of network connections. 

Thus, an IP address does not characterize a single computer or router, but a single 
network connection. 

Symbolic names 
domain names in IP networks . 
Domain names are built on a hierarchical basis. A full symbolic name in IP 

networks consists of several components, which are separated by a dot. They are 
listed in the following order (from left to right): name of the node group, name of 
the end name of the larger node group. (for example, the name of the . (subdomain) 
of the organization) 

The domain is indicated according to the geographical principle: UA - Ukraine, 
RU - Russia, UK - Great Britain, SU - USA) 

An example of a domain name can be the name base2.sales.zil.ru. There is no 
correspondence between the domain name and the IP address of the node, so it is 
necessary to use some additional tables or services so that the Internet node can be 
uniquely identified in the network, both by the domain name and by the IP address. 

IP addresses. Classes of IP addresses 
IP address structure 

IP addresses are not assigned to the nodes of the component network, but to the 
network interfaces of the nodes of the component network. 

Most computers on an IP network have a single network interface (and as a 
result, a single IP address). But computers and other devices can have several (if not 
more) network interfaces - and each interface will have its own IP address. 

Thus, a device with 6 active interfaces (for example, a router) will have + 6 IP 
addresses - one for each interface in each network to which it is connected. 

Therefore, the IP address uniquely determines the network and the node that is 
connected to this network. The length of the IP address is 4 bytes (4 by 8 bits), this 
gives a total of 32 bits of available information. 

To improve readability, the IP address is written as four numbers separated by 
periods: 

  
Binary form: 
ХХХХХХХ. ХХХХХХХ. ХХХХХХХ. ХХХХХХХ 
X= bit state, 0 or 1 
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XXXXXXXXX - byte 

Decimal form: 
YYY. YYY. YYY. YYY 
YYY= a number between 0 and 255 

  
For example, 128.10.2.30 is the decimal form of the address representation - 4 

(decimal) numbers separated by dots (.), and 10000000 00001010 00000010 
00011110 - binary representation of the same address. 
  

Binary 
system 

7-bit 6-bit 5-bit 4-bit 3-bit 2-
bit 

1-bit 0-bit 

Decimal 
system 

2 7 = 
128 

2 6 = 
64 

2 5 

=32 
2 4 = 
16 

2 3 =8 2 2 

=4 
2 1 =2 2 0 = 1 

The sum of all numbers in the decimal number system within one byte 
2 7 +2 6 +2 5 +2 4 +2 3 +2 2 +2 1 +2 0 =255 
  
Since each of the four numbers is a decimal representation of an 8-bit byte, 

each number can take values from 0 to 
255 (gives 256 unique values - remember, zero is also a value).  
The decimal form of recording the IP address is used mainly in operating 

systems, as it is the most convenient for configuration. 
In addition to the binary form, there is a hexadecimal form of the IP address 

record: C0.94.1.3  
Using 32-bit binary numbers allows you to create 4294967296 unique IP 

addresses - more than enough for any private intranet. 
The IP address consists of two logical parts - the network number and the 

node number in the network (Fig. 2.48) (in general, 32 bits are allocated for the IP 
address, and of these, N-bits are used to identify the node, and 32-N are used to 
identify the network number) . 

32 - N bits N - bit 
Network number Node number 

Figure 2.48 – IP address structure 
  
Classes of IP addresses 
Of course, the question immediately arises: how to determine in one address 
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where the network number is, and where the node number is? You can agree to use, 
for example, the first 8 bits of the address for the network number, and the rest for 
the node numbers in that network, or the first 16 bits, or the first 24 bits. But in this 
case, the addressing turns out to be completely flexible, we will have either many 
small networks and few large ones, or vice versa. 

In order to more rationally determine the size of the network and at the same 
time distinguish which part of the IP address belongs to the network number, and 
which part belongs to the node number, it was agreed to use a class system. The class 
system uses the value of the first bit of the address. 

But, in such a way that the values of these first bits of the address are indications 
of which class this or that IP address belongs to. Figure 2.49 shows address classes. 

 
Figure 2.49 – Classes of addresses 

  
A separate table lists the ranges of network numbers and the maximum number 

of nodes corresponding to each class of networks:  
Table 4.1 – Network number ranges and maximum number of nodes 

Class  The first bits  
The shortest 
network 
address  

The longest 
network address  

Maximum 
the number of 
nodes  

A  0  1.0.0.0 126.0.0.0 2 24 (16 777 216-2) 
B  10  128.0.0.0 191.255.0.0 2 16 (65536-2) 
C  110  192.0.1.0 223.255.255.0 2 8 (256-2) 
D  1110  224.0.0.0 239.255.255.255 Multicast 
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E  11110  240.0.0.0 247.255.255.255 reserved 
  
If the address begins with the sequence 1110, then it is a class D address and 

denotes a special, group address - multicast . 
If a class D address is specified as the destination address in the packet, then 

such a packet must be received by all nodes assigned this address. 
If the address begins with the sequence 11110, it means that this address 

belongs to class E. Addresses of this class are reserved for future applications. 
Thus, it can be clearly determined that: large networks receive class A 

addresses, medium ones - class B, and small ones - class C (Fig. 2.51). 
  

 
Figure 2.51 - Assignment of classes of IP addresses 

  
Depending on which class (ABS) the address belongs to, the network number 

can be represented by the first 8, 16, or 24 digits, and the host (node) number by the 
last 24, 16, or 8 digits. 

There are some values of IP addresses that are reserved in advance, that is, there 
are IP addresses that are reserved for special purposes: 

1) If all IP addresses consist of only binary zeros, then it indicates the 
address of the node that generated this packet 

  
0 0 0 0 ………………   0 0 0 0 

  
this mode is used only in some ICMP ICMP messages. 

2) If the network number field contains zeros, then by default it is assumed 
that the destination node belongs to the same network as the node that sent the 
packet. 

  
0 0 0 0 ……………… 0 Node number 
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An IP address with a host number of zero is used to address the entire network. 
For example, in a class C network with the number 199.60.32, the IP address 
199.60.32.0 represents the network as a whole. 

3) If all the binary digits of the IP address are equal to 1, then the packet 
with this destination address must be sent to all nodes on the same network as the 
source of this packet. 

   
1 1 1 1 …………

…… 
1 1 1 0 

  
Such a mailing is called a limited broadcast message . 

4) If there are only ones in the destination node number field, the packet 
with this address is sent to all network nodes with the given network number. For 
example, a packet with the address 192.190.21.255 is delivered to all nodes on the 
192.190.21.0 network. 

  
Networ

k number 
1 1 1 …………

…… 
1 1 1 1 

  
Such a mailing is called a broadcast message ( broadcast ), that is, the data 

stream is intended for reception by all sections of the network (within one network 
segment (Fig. 2.52). 

 
Figure 2.52 – Wide-language transmission scheme 

  
Suppose, for example, that one of the hosts on a Class C network with a network 

address of 199.60.32.0 is going to send a message to all other hosts on the same 
network. In this case, the message should be sent to the address 199.60.32.255 (the 
last byte 255 is broadcast). 

Thus, neither the network number nor the node number can consist of only one 
binary ones or only one binary zeros. It follows that the maximum number of nodes, 
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which is given in table 4.1 for networks of each class, should be reduced by 2 
(broadcast + node numbers) in practice. 

The IP address, the first octet (byte) of which is equal to 127 and is reserved 
for testing programs and the interaction of processes within the same machine, has 
a special meaning. 

When the program sends data to the IP address 127.0.0.1 , a "loop" is formed, 
that is, the data is not transmitted over the network, but is returned to the upper-level 
modules as soon as they are received. 

Therefore, in an IP network, it is forbidden to assign IP addresses to machines 
starting with 127. This address is called loopback . 

You can assign the address 127.0.0.0 to the internal network of the routing 
module of the node, and the address 127.0.0.1 to the address of this module on the 
external network. 

In fact, any network address 127.0.0.0 serves to indicate its routing module, not 
just 127.0.0.1, such as 127.0.0.3. 

In the IP protocol, there is no concept of broadcast in the sense in which it is 
used in channel-level protocols of local networks, when data must be delivered to 
absolutely all nodes. 

Both the limited broadcast IP address and the broadcast IP address have their 
limits of distribution in the intranet - they are limited either to the network to which 
the source node of the packet belongs, or to the network whose number is specified 
in the destination address. Therefore, partitioning the network by means of routers 
localizes the broadcast storm to the boundaries of one of the components of the 
common network of parts simply because there is no way to address the packet 
simultaneously to all nodes of all the networks of the component network. 

Multicast IP addresses mean that this packet must be delivered at once to 
several nodes that form a group with the number specified in the address field. 

Nodes identify themselves, which means they determine which group they 
belong to. The same node can belong to several groups. Members of any multicast 
group do not necessarily have to belong to the same network. In the general case, 
they can be distributed over completely different networks, located from each other 
on an arbitrary number of hops (transit section of the computer network). 

The group address is not divided into the network and node number fields and 
is handled by the router in a special way. 

The main purpose of a multicast address is to distribute information according 
to the "one-to-many" scheme. 
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Figure 2.53 - Multicast technology 

  
It works as follows: a host that wants to transmit the same information to many 

subscribers, using a special protocol IGMP (Internet Group Management Protocol), 
reports the creation of a new multicast group with a certain address in the network. 

Routers that support multicasting distribute information about the creation of a 
new group in the networks connected to the ports of this router. 

Hosts that want to join a newly created multicast group report this to their local 
routers, which forward this information to the host that initiated the creation of the 
new group. 

In order for routers to be able to automatically distribute packets with a 
multicast address over a complex network, it is necessary to use special modified 
routing information exchange protocols in the end routers. 

In general, group addressing was intended for economic distribution on the 
Internet or a large corporate network of audio or video programs intended for a large 
audience of listeners or viewers at once. 

It must be said that if such tools find widespread use (now they represent mainly 
small experimental areas in the general Internet), then the Internet will be able to 
create serious competition for radio and television. 

So, an IP address can mean one of three things: 
1. Network IP address (a group of IP devices that have access to a common 

transmission medium - for example, all devices in an Ethernet segment). A network 
address always has the interface (host) bits of the address space set to 0 (if the 
network is NOT subnetted); 
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2. The IP network's broadcast address (the address to "talk" to all devices on the IP 
network). Broadband addresses for a network always have the host bit of the address 
space set to 1 (unless the network is subnetted). 

3. Interface address (for example, Ethernet - adapter or PPP interface of the host, router, 
print server, etc.). These addresses can have any value of the host bits, excluding all 
zeros or all ones - not to be confused with network addresses and broadcast 
addresses. 

For a class A network ... 
(One byte of network subaddress, three bytes for host number) 
10.0.0.0 is a class A network because all host bits are 0. 
10.0.1.0 is the host address on this network 
10.255.255.255 is the broadcast address of this network because all network 

bits are set to 1 For a Class B network... 
(Two bytes for the network address, two bytes for the host number) 
172.17.0.0 class B network 
172.17.0.1 is the host address on this network 
172.17.255.255 network broadcast address For Class C network. 
(Three bytes for the network address, one byte for the host number) 192.168.3.0 

Class C network address 
192.168.3.42 host address on this network 
192.168.3.255 network broadcast address Not all available network IP 

addresses belong to class C. 
  

Masks in IP addressing 
So, the traditional IP address distribution scheme for network number and node 

number, which is based on the concept of class, is considered. The class is 
determined by the values of the first few bits of the address. Now, for example, we 
can determine that since the first byte of the address 185.23.44.206 falls into the 
range 128-191, then this address belongs to class B, which means that the network 
number is the first two bytes, supplemented by two zero bytes 185.23.0.0, and the 
number node - 0.0.44.206. 

It is obvious that the determination of network numbers by the first bytes of the 
address is also not a completely flexible mechanism for addressing. And what if we 
use some other sign, with the help of which it would be possible to more flexibly set 
the boundary between the network number and the node number? 

As such a sign, masks have now become widespread. 
The mask is a 32-bit number that looks like an IP address. The mask is used in 

a pair with the IP address, but does not match it. 
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The principle of separating the network number and the number of the network 
node using a mask is as follows: the binary entry of the mask contains ones in those 
digits that should be represented as a network number in the IP address and zeros in 
those digits that are represented as a host number. 

Mask (overlaid on IP address) 
111…..1111  000…..000  
Defines the 
network 

Specifies the host 
(node) 

  
Each class of IP addresses (A, B and C) has its own mask, which is used by 

default. 
Since the network number is an integer part of the address, the ones in the mask 

must also represent a continuous sequence. Thus, for standard classes of networks, 
masks have the following values: 

Class A 11111111. 00000000. 00000000. 00000000 255.0.0.0 
Class B 11111111. 11111111. 00000000. 00000000 255.255.0.0 
Class C 11111111. 11111111. 11111111. 00000000 255.255.255.0 

  
For example: 

If the address 185.23.44.206 is assigned a mask of 255.255.255.0 ( 
11111111.1111111.1111111.0000000 ), then the network number will be 
185.23.44.0 , and not 

185.23.0.0 , as defined by the rules of the class system: 

AN
D 

10111001.00010111.00101100.11001110 185.23.44.206 IP 
address 

11111111.11111111.11111111.00000000 255.255.255.0 Mask 
  10111001.00010111.00101100.00000000 185.23.44.0 Chain 

Other formats are used to record masks , for example, it is convenient to interpret 
the value of a mask written in hexadecimal code: FF.FF.00.00 - mask for Class B 
addresses. 

The following designation is often found: IP address / network prefix. For 
example, 185.23.44.206/16 - this entry says that the mask for this address contains 
16 units (network prefix), or that in the specified IP address 16 binary digits are 
assigned to the network number : 

 
Figure 2.54 – Mask in the binary number system 
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Network prefix notation is also known as Classless Interdomain Routing 
(CIDR). 

Thus, it is very easy to abandon the concept of classes of addresses, by giving 
each IP address an arbitrary (not necessarily a multiple of 8), thereby making the IP 
addressing system more flexible. 

 
 
 
Example: assign a mask to the IP address 129.64.134.5 
255.255.128.0, which in binary form will look like this: 
  
IP address - 129.64. 134.5 10000001.01000000.1 0000110.00000101 
Mask - 255.255.128.0 11111111.11111111.1 0000000.00000000 
  
Here, the first 17 consecutive units in the mask are "superimposed" on the IP 

address according to the "AND" principle (that is, two units will be one, and zero 
and one will be zero), and determine the network number: 

  
The IP address of the node 

is 129.64.128.0 
10000001. 01000000. 10000000. 

00000000 
  
and 15 zeros determine the node number: 
  
0000110.00000101 or 0.0.6.5.  
  
The mechanism of masks is very widespread in IP routing, and masks can be 

used for a variety of purposes. With their help, the administrator can structure his 
network without requesting additional network numbers from the service provider. 

Based on the same mechanism, service providers can combine the address 
spaces of several networks by introducing so-called "prefixes" in order to reduce the 
volume of routing tables, and thereby increase the performance of routers. 

Masks during recording are always "inseparable" from the corresponding 
addresses, subnet mask IP addresses - this is how we will now describe the address 
of any network host. 

  
Procedure for assigning IP addresses. Autonomous IP addresses. Automation 

of IP address assignment 
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In the situation shown in the example (Figure 2.55), for a dedicated network 
formed by a channel connecting the ports of two adjacent routers, it is necessary to 
allocate a separate network number, although there are only 2 nodes in this network. 

  
(Мережа - network, Пограничні маршрутизатори - border routers, Вироджена 

мережа - dedicated network) 
Figure 2.55 – An example of a dedicated network 
  
Let's consider another situation: what IP addresses can the administrator use if 

the Internet service provider has not assigned any address to him? If, for example, 
we know for sure that the network we administer will never connect to the Internet 
in the future (works in "offline mode"), then we can use any IP addresses, observing 
the rules for their assignment, which were discussed in the speech above. For 
simplicity, you can use class C addresses: in this case, you do not have to calculate 
the value of the subnet mask and calculate the address for each host. 

In this case, we would simply have to assign each segment of our local network 
its own Class C network number. 

If all segments of our local network have their own class C network numbers, 
then 254 host numbers can be created in each segment. 

However, if there is even a small chance that our network may be connected to 
the Internet at some point in the future, we should not use such IP addresses. They 
may conflict with other addresses on the Internet. To avoid such conflicts, you 
should use IP addresses reserved for private networks. 

For this purpose, several blocks of IP addresses are specially reserved, which 
are called autonomous. 

Autonomous addresses are reserved for use by private networks. They are 
usually used by organizations that have their own large private network - intranets 
(local networks with the architecture and logic of the Internet), but small networks 
often find them useful.) 

These addresses are not processed by Internet routers under any circumstances. 
These addresses are selected from different classes: 
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Class  From the IP 
address  

To the IP address  Total address nodes in 
the range 

A 10.0.0.0 10.255.255.255 16,777,216-2 

B 172.16.0.0 172.31.255.255 65 536-2 

C 192.168.0.0 192.168.255.255 256-2 

  
These addresses are reserved for private networks. Thus, if in the future we 

decide to connect our network to the Internet, then even if the traffic from one of the 
hosts in our network gets into the Internet in any way, there should not be a conflict 
between the addresses. A router on the Internet is programmed not to broadcast 
messages sent from or to reserved addresses. 

It must be said that the use of autonomous IP addresses also has disadvantages, 
which are that if we connect our network to the Internet, we will have to re-configure 
the hosts connecting to the Internet. 

Subnetting can be said to be a method of taking a network IP address and 
breaking it up locally so that one network IP address can actually be used in multiple 
interconnected local networks. 

One network IP address can only be used for one network. The most important 
thing: division into subnets is a local setting, it is not visible "from the outside". 
Dividing one large network into subnets significantly relieves the overall traffic and 
allows you to improve the security of the entire network as a whole. 

Algorithm for dividing the network into subnets: 
1) We establish physical connections (network cables and network 

connectors - such as routers); 
2) We decide how big/small subnets you need, based on the number of 

devices that will be connected to them, that is, how many IP addresses need to be 
used in each network segment. 

3) We calculate the corresponding network masks and network addresses; 
4) We give each interface in each network its IP address and the 

corresponding network mask; 
5) We configure each router and all network devices;  
6) 6) We check the system, correct errors. 

Now our task is to figure out how to perform the 2nd and 3rd steps. 
  

Example 1 
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Suppose we want to divide our network into subnets, but we only have one 
network IP address: 

IP address 
of the network 

210.16.15.0 

Solution: 
  

Class C (defined by address range)  
Default mask 255.255.255.0 (depending on the class)  
Maximum number of hosts 254 - network address - broadcast address 

= 252 
Network address 210.16.15.0 (mask applied to the address)  
Broad address 210.16.15.255 (last host address)  
  
1) First step: determine the "size" of the subnet. 
There is a relationship between the number of created subnets and "spent" IP 

addresses. 
Each individual IP network has two addresses that are not used for interfaces 

(hosts): 
- IP address of the network itself - Broadband address. 
When dividing into subnets, each subnet requires its own unique network IP 

address and broadcast address - and they must be correctly selected from the range 
of IP addresses of the network we are dividing into subnets. 

So, when dividing the IP network into subnets, each of which has two network 
addresses and two broadcast addresses, it should be remembered that each of them 
will reduce the number of used interface (host) addresses by two. 

We must always take this into account when calculating network numbers. 
2) The next step is to calculate the subnet mask and network numbers. 
The netmask is what does all the logical manipulation of dividing an IP network 

into subnets. 
There are standard network masks for all three classes of IP networks: 

• Class A (8 network bits): 255.0.0.0  
• Class B (16 network bits): 255.255.0.0  
• Class C (24 network bits): 255.255.255.0  

To create a subnet , you need to change the subnet mask for a given address 
class. 

The subnet number can be set by borrowing the amount of digits required for 
subnet numbering in the host number: 
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ХХХХХХ.ХХХХХХХ XXX XXXXX 

For example: network area X - bit state, 0 or 1  The range of hosts to be subnetted 

In this example: 24 bits for network, 3 bits for 
subnet and 4 bits for hosts 

The subnet, hosts, and network range in an IP 
address may be different for different networks 

Borrowing 
of the region 

hosts for 
subnet 

identification 

A range of 
hosts that 

remain 
when dividing 

into subnets 

The input mask in the given example: 
1111111.1111111.1111111.00000000 
The newly created mask for identifying the subnet in the given example: 
1111111.1111111.1111111.11100000 
In the last byte, 3 high-order bits are added to identify subnets 

  
To do this, the left (higher) digits of the host number are taken, in the mask the 

self-taken digits are filled with ones to show that these digits now number NOT the 
node, but the subnet. The values in the bits of the subnet mask remain zero; this 
means that the remaining bits in the host number in the IP address must be used as 
the new (smaller) host number. 

For example, to split a network address into two subnets, we must borrow one 
host bit by setting the corresponding bit in the network mask of the first host bit to 
1. 

If we need four subnets - we use two host bits, if eight subnets - three bits, etc. 
It is clear that if we need five subnets, then we will use three host bits. The subnet 
mask changes accordingly: 

The procedure for determining the number of bits allocated to the identification 
of N subnets is shown in Fig. 2.56. 
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Figure 2.56 – Algorithm for determining the number of bits to identify N subnets 

For class C addresses , when divided into 2 subnets, this gives a mask - 
11111111.11111111.11111111.10000000 or 255.255.255.128 
when divided into 4 subnets, the mask is in binary form - 
11111111.11111111.11111111.11000000 or in decimal 255.255.255.192 etc. 
For our class C network address 210.16.15.0 , the following several methods of 

subnetting can be defined. 
Table 2.11 – Subnetting methods 

Number 
of subnets 

Numb
er of 
hosts 

Network mask 

2 126 255.255.255.128 (11111111.11111111.11111111.10000000) 
4 62 255.255.255.192 (11111111.11111111.11111111.11000000) 
8 30 255.255.255.224 (11111111.11111111.11111111.11100000) 
16 14 255.255.255.240 (11111111.11111111.11111111.11110000) 
32 6 255.255.255.248 (11111111.11111111.11111111.11111000) 
64 2 255.255.255.252 (11111111.11111111.11111111.11111100) 
  
Now you need to resolve the issue of network addresses and broadband 

addresses, and the range of IP addresses. 
Again, taking into account only class C network addresses, and specifying only 

sequential (host) addresses, Table 4.3 is obtained. 
From Table 2.12, it is immediately clear that increasing the number of subnets 

reduces the total number of available host addresses. Based on this information, you 
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can assign host and network IP addresses and network masks. 
Table 2.12 – Address structure 

Network 
mask 

Subnet Chain Broadcast minIP maxIP hosts Total 
hosts 

128 2 0 127 1 126 126 252 
128 255 129 254 126 

192 4 0 63 1 62 62 248 
64 127 65 126 62 
128 191 129 190 62 
192 255 193 254 62 

224 8 0 31 1 30 30 240 
32 63 33 62 30 
64 65 65 94 30 
96 97 97 126 30 
128 129 129 158 30 
160 161 161 190 30 
192 193 193 222 30 
224 225 225 254 30 

  

Example 2. 

Let's determine how many subnets are needed for our Class C network to break 
it up into subnets of 10 hosts each. 

Solution: 
A Class C network can support a total of 254 hosts plus a network address and 

a broadcast address. 
For addressing 10 hosts, 3 bits are not enough, so 4 bits are needed. So, of the 

eight possible for class C, we need only 4 bits to address 10 hosts, the others can be 
used as network bits to address subnets. Each subnet reduces the number of possible 
host addresses by a factor of two. 

4 bits must be used to address 16 subnets. So, let's now count the number of 
nodes in each of the 16 subnets: 2 4 -2 = 14 hosts. This quantity more than satisfies 
the condition of the problem. Let's calculate the subnet mask, in this case it looks 
like this: 

  
11111111.11111111.11111111.11110000 or 255.255.255.240 

  
We will need to specify this mask when configuring each host on our network 

(regardless of which subnet the host is on). 
Now, for example, we can say the address 192.168.200.246 with mask 
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255.255.255.240 - means network number 192.168.200.240 and node number 
0.0.0.6 . Example 3.  

Now, for all three classes, we will determine the subnet masks, respectively, 
and the maximum possible number of nodes in each of these subnets, if it is 
necessary to divide the class A network, class B network, and class C network into 
4 separate subnets, respectively. 

Solution: 
For a class A network. 
The maximum number of nodes is 16,777,216. 2 bits (00000010) are needed to 

address 4 subnets, so 22 bits remain for addressing hosts. Thus, each of the four 
subnets is capable of serving 2 22 - 

2=4194302 hosts in each of the subnets. 
Number 

of subnets 
Number of 

hosts 
Network mask 

4 4,194,302 255.192.0.0 (11111111. 11000000.00000000.00000000) 
  
For a class B network. 
The maximum number of nodes is 65536 . To address 4 subnets in a class B 

network address , you also need to use 2 bits , but now 14 bits remain free . Thus, 
each of the subnets can serve 2 14 -2 =16 382 hosts. 

  
Number of 
subnets 

Number 
of hosts 

Network mask 

4 16,382 255.255.192.0 
(11111111.11111111.1000000.00000000) 

  

Example 3. 

Divide the IP network 192.168.0.0 with mask 255.255.255.0 into 4 subnets. 
Specify the broadcast address for the subnet. 

 
Solution: 
Class C network. Total number of hosts 2 8 -2 =254 . 
Mask 255.255.255.0 allocates 24 high bits for network identification and 8 bits 

for host identification: 
192.168.0.0 11000000.10101000.00000000. 0000000 network address 
255.255.255.0 11111111.11111111.11111111. 0000000 mask 
  Network 

(24 bits) 
hosts 
(8 bits) 
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The number of 4 subnets must correspond to 2 states of bits in the order of their 

increase from 0 to the fourth state. That is, 4 states 00000000, 00000001, 00000010, 
00000011 correspond to the number of bits that will be allocated to identify subnets. 

The two most significant bits of the host name are allocated to identify the 
subnet by creating a new subnet mask: 

  
 

192.168.0.0 11000000.10101000.00000000. 00 000000 network address 
255.255.255.192 11111111.11111111.11111111. 11 000000 Subnet mask 

  Network 
(24 bits) 

 

hosts 
(6 bits) 
 

  

  
The address change step is equal to the value of the lower bit of the subnet, i.e. 

64, i.e.: 0 - the beginning of the first subnet, 0+64=64 - the beginning of the second 
subnet, 64+64=128 - the beginning of the third subnet, 128+64=192 - the beginning 
of the fourth subnet Accordingly addresses are divided into subnets: 

192.168.0.0-192.168.63.255 - 1st subnet 
192.168.64.0-192.168.127.255 - 2nd subnet 
192.168.128.0-192.168.191.255 - 3rd subnet 
192.168.192.0-192.168.255.255 - 4th subnet 
Each subnet has 256 addresses from 0 to 255, of which 254 are available to 

hosts, as 0 identifies the subnet: 
192.168.0.0 
192.168.64.0 
192.168.128.0 
192.168.192.0, and 255 is the broadcast address: 
192.168.63.255 
192.168.127.255 
192.168.127.255 
192.168.127.255 
  
Since the assignment of IP addresses to network nodes, even with a small 

network size, is a very difficult procedure for the administrator, therefore as the  
second step in IP addressing the developers decided to automate this process. 
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For this purpose, the Dynamic Host Configuration Protocol was developed 
(DHCP) , which frees the administrator from these problems by automating the 
process of assigning IP addresses . 

DHCP can support a method of automatic dynamic address allocation, as well 
as simpler methods of manual and automatic static address assignment. The DHCP 
protocol works according to the client-server model. 

During system startup, a computer that is a DHCP client sends a broadcast 
request to the network to obtain an IP address. DHCP - the server responds and sends 
a response message containing an IP address. It is assumed that the DHCP client and 
DHCP server are on the same IP network. 

With dynamic allocation of addresses, the DHCP server issues addresses to the 
client for a limited time, it is called lease duration. This makes it possible to later 
reuse this IP address to assign to another computer. 

The main advantage of DHCP is the automation of the administrator's routine 
work on the configuration of the TCP/IP stack on each computer. Sometimes the 
dynamic division of addresses allows you to build an IP network, the number of 
nodes of which exceeds the number of IP addresses available to the administrator. 

In the manual procedure for assigning static addresses, the administrator takes 
an active part, who provides the DHCP server with information about the 
correspondence of IP addresses with physical addresses or other client identifiers. 
The DHCP server, using this information, always issues the address assigned by the 
administrator to a certain client. 

In the automatic static method, the DHCP server assigns an IP address from a 
pool of available IP addresses without operator intervention. And the limits of the 
assigning address pool are set by the administrator when configuring the DHCP 
server. 

The address is given to the client from the pool for permanent use, that is, with 
an unlimited rental period. Between the client's ID and its IP address, there is a 
constant correspondence, as before, as with the manual one. It is set when the client's 
IP address is first assigned by the DHCP server. In all subsequent requests, the server 
returns the same IP address. 

DHCP provides a reliable and simple way to configure a TCP/IP network, 
ensuring no duplication of addresses by centrally managing their distribution. 

In this case, the administrator can only control the process of assigning 
addresses using the "lease duration" parameter, which determines how long the 
computer can use the assigned IP address before requesting it again from the DHCP 
server for lease. 

Cloud Internet technologies are now more and more setting the tone for using 
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the Internet and storing information on the network. Worldwide social networks 
such as Facebook, Twitter and others work with them. The "cloud" principle has 
been developed for a long time, it is a convenient environment for storing and using 
information that combines hardware, software, communication channels and 
technical support. With the help of this Internet service, the user has access to his 
own information, and at the same time he does not have to take care of the 
infrastructure with which he works. 

Often, the concept of cloud or distributed technologies refers to the entire 
Internet network. In fact, it is an updated version of IT services, or servers, available 
over the Internet. The technology allows you to expand the IT capabilities of the 
enterprise, while not requiring additional investments in the creation of new 
infrastructure, the involvement of additional employees and the retraining of already 
working personnel. 

Fiber optic Internet technology implies high-speed data transmission. Optical 
waveguides are used to connect fiber-optic Internet, the signal travels along them at 
the speed of light. At the moment, electronic equipment is used to receive and 
transmit information, so converters of electronic signals into optical signals and vice 
versa are needed. Such converters, or fiber optic modems, have long been developed 
and widely used. 

Fiber optic technologies made it possible to get high-speed Internet and use it 
in large areas. The optical signal in the fiber optic cable is practically not distorted 
and does not weaken during transmission over long distances. When using fiber 
optic Internet, you are protected from unauthorized access to transmitted information 
- induction reading, hacking and other dangers. The technology makes it possible to 
connect interactive television, IP telephony, video surveillance, security systems, 
etc. Quartz is the material for the manufacture of optical fiber cable, it is very light, 
has a long service life, is not exposed to atmospheric influences and is fire-resistant. 
Currently, the number of users who prefer fiber-optic Internet far exceeds those who 
use cable Internet. 

 
Modern network technologies provide more and more opportunities both for 

ordinary Internet users and for business development and advertising, they bring 
progress in the transmission of systematized data and processing of data arrays. They 
have their advantages and disadvantages and nevertheless bring tangible benefits to 
society. 
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SECTION 3 . USE OF DISTANCE EDUCATIONAL 
ENVIRONMENT AND INTERNET RESOURCES 

 
3.1. Modern universal and designer and online tools for creating 

educational websites and blogs 
Due to the rapid development of information technologies, when the Internet 

is added to mass media, which allows working with information at a higher level, 

the role of educational Internet resources is growing. If a website of an educational 

institution is created, it helps to improve its image, becomes its business card, 

advertising tool that works around the clock. Most educational institutions use new 

information technologies in both educational and extracurricular activities. An 

educational resource on the Internet is an opportunity to demonstrate your 

achievements, post relevant information for those who are interested (parents, 

applicants, schoolchildren, teachers, students, lecturers, colleagues, etc.), inform 

society about educational services, publish your assets, materials, research results, 

implement exchange of experience, consultations, etc. 

In his works, H. Stetsenko singles out the following types of educational sites 

[ 1 ]: 

1. Official websites. These are the sites of governing bodies that host the 

following educational web resources: government documents, regulations, laws (for 

example mon.gov.ua – official website of the Ministry of Education and Science of 

Ukraine; kmu.gov.ua – Government portal). 

2. Websites of educational institutions. Accordingly, these sites differ in size 

(sites of higher educational institutions: nubip.edu.ua - site of the National 

University of Life and Environmental Sciences of Ukraine). 

3. Cultural and educational sites. These include: virtual libraries (nbuv.gov.ua 

– National Library of Ukraine named after V.I. Vernadskyi); reference websites of 

libraries (zntu.edu.ua – website of the library of the Zaporizhia National Technical 

University); collections of abstracts and other scientific works (site of Ukrainian-

language abstracts; virtual magazines and newspapers (educational electronic 

Internet publication for teachers "Informatics and information technologies"), virtual 
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museums (/scH544/museum - virtual museum of informatics). 

4. Sites for online learning. Centers of online education: atutor.tu.edu.te.ua - 

online learning server of Ternopil State Technical University; Electronic textbooks: 

/vcg/useful_ukr.html – electronic textbooks on computer science. 

5. Reference sites: encyclopedias (open Ukrainian wiki-encyclopedia) are 

electronic pages with texts and graphic images of a classic encyclopedic nature; 

dictionaries - an electronic database of definitions from a certain field of knowledge 

or in several areas; catalogs – contain a list of web addresses of sites by subject; 

information and reference resources (olymp.vinnica.ua - All-Ukrainian Center for 

School Olympiads on the Internet) - sites containing reference information about 

conferences, competitions, seminars, grants , etc. 

6. Thematic sites. A site on a certain topic or field of knowledge. 

7. Personal sites. The site of an individual person, which contains general 

information about this person, what he does, what interests he has, etc. For example, 

pedagogika.at.ua is the website of  Nadiya Mykolaivna Stetsenko. 

8. Portals. One of the most effective ways to accumulate large amounts of 

information. (for example: .ua – educational portal) 

9. Means of communication. Teleconferences, chats, forums, methodical 

associations of teachers serve for the exchange of opinions, information, and 

cooperation with colleagues from other regions. (For example: 

ki.ifmion.npu.edu.ua/forum - forum of the Department of Informatics of 

Drahomanov NPU). 

It should be noted that over ten years of our research of the Ukrainian segment 

of the Internet, the situation with Ukrainian-language educational Internet resources 

has changed for the better. High-quality resources of various educational topics are 

appearing, using new technologies for the development and functioning of web 

resources. New Internet services that can be used by educators are being developed. 

In the Ukrainian segment of the Internet, we distinguish the following types 

of Internet resources according to the type of information resource: 

1) catalogs — sets of links to web resources with a brief description of them, 
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structured by appropriate sections, which can be ranked by various features (by 

quotation index, by date of addition, by alphabet, etc.); 

2) ratings — sites, the purpose of which is to evaluate web resources according 

to various criteria (by attendance, by the quotation index, by the results of user 

voting, etc.); 

3) search engines — online services that provide the ability to search for 

information on the Internet thanks to the implementation of the site indexing 

mechanism by the search robot; 

4) portals — a multi-level combination of various resources designed to 

provide integrated information or provide users with various interactive services 

(search, forums, blogs, news, discussions, mail, file storage, etc.); 

5) sites - web nodes, a set of web pages physically located on the same server, 

united by the same design, theme and navigation; 

6) personal pages — web pages or small sites dedicated to information about 

the professional activity of one person; 

7) blogs - websites, the main content of which are records, images or 

multimedia, which are regularly added by users of blogs through a convenient visual 

interface; 

8) forums - Internet resources, which are a means of communication on the 

Internet of many users with the help of a certain online service, which provides for 

the presence of rules for posting, editing and deleting information; 

9) social Internet networks - an Internet service that facilitates the creation and 

maintenance of social circles and networks, communication and establishing 

connections between people using a set of web tools. 

The classification of educational resources according to other characteristics 

is presented in the study of V. Osadchyi "Educational possibilities of the Internet" [ 

1 ]. 

Modern site builders are amazingly simple services that allow you to create 

your own site in the browser without having any special skills. The results of our 

analysis of popular services for creating websites are presented in the table. 3.1. 
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Table 3.1. 

Universal services for creating web pages 
Service Jimdo.com Google sites Weebly Yola 

Link http://ru.jimdo.
com 

https://sites.googl
e.com/site/sites 

http://www.
weebly.com 

http://www.yo
la.com 

Cyrillic 
interface available available available available 

Website 
address 

mysite.jimdo.c
om 

sites.google.com/s
ite/mysite 

mysite.weeb
ly.com 

mysite.yolasit
e.com 

The site is on a 
separate domain  

in the paid 
version + + in the paid 

version 
Storage space 500 MB 100 MB not limited 1 GB 
HTML editor + + + + 
creating a blog  + — + + 

restricting 
access  to the site 

in the 
commercial 

version 
+ 

in the 
commercial 

version 
+ 

Optimizing for 
mobile devices + + + in the paid 

version 

Peculiarities of 
service 

Dropbox 
integration 

Other google 
services integration, 

free project 

Multi-user 
site 

management 
interface 

Online editing 
of images 

In late June, Domo published an infographic showing the minute-by-minute 

activity of 2.1 billion Internet users. According to this data, every minute 571 new 

sites are created on the Internet. And this means that thousands of people ask the 

question "How to make your web resource?" every day. 

http://ru.jimdo.com/
http://ru.jimdo.com/
https://sites.google.com/site/sites
https://sites.google.com/site/sites
http://www.weebly.com/
http://www.weebly.com/
http://www.yola.com/
http://www.yola.com/
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Fig. 3.1. – Domo infographics showing the minute-by-minute activity of 

internet users 

The answer to this question can be very different. You can entrust the creation 

of the site to a team of web developers, or you can choose one of the free or paid 

CMS, buy hosting and create the site yourself. Another relatively inexpensive (and 

in some cases, completely free) option is to use a site builder. On the one hand, it 

saves a technically untrained user from the need to deal with FTP server settings and 

make changes to configuration files, and on the other hand, it gives an opportunity 
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to creatively work on your own site to your satisfaction. 

There are different types of site builders: both those that can be used to create 

sites of almost any orientation, and specialized ones, which means, focused only on 

certain types of web resources (business card sites, portfolios, and others). In this 

review, we will pay attention only to universal designers. 

Jimdo.com . The Jimdo.com project was originally created for small 

companies, and its goal was to create a site management system so simple that 

employees of the organization could create and update the site themselves, without 

contacting webmasters. 

 
Fig. 3.2. – Home page for creating a Jimdo web resource. 

When such a CMS was created, the project was opened to a wide audience. It 

turned out that Jimdo is suitable not only for portfolios of organizations, but also for 

blogs, educational pages, photo galleries, online stores and many other types of sites. 

After registration, each Jimdo user receives 500 MB of space for free file storage, as 

well as a mysite address .jimdo.com. The ability to link your own domain is one of 

the paid functions of the service. 

The site is completely controlled from the browser. On the title page there is a 

link to login as an administrator. After logging in, all blocks of the site become 

editable: it is possible to make changes to them, delete them, as well as add new 

ones. 
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Fig. 3.3. – Edit navigation menu in Jimdo pages 

Blocks range from plain text to tables, text, galleries, map embeds, Flickr 

photos, Twitter feed, guestbook, file download links, RSS feeds, and more . 

 
Fig. 3.4. – Toolbar in the Jimdo editor 

For a page with information about the site or about the author, it is convenient 

to use the "Image in text" block, with which you can place the text, the 

accompanying picture on the page and set the image wrapping parameters. Files can 

be uploaded to the site not only from the hard drive, but also from the Dropbox 

online storage - Jimdo integrates with this service. This is convenient, for example, 

when creating a gallery. By the way, the image gallery can be created both on the 

basis of HTML and Flash tools with flipping animation transition effects and others. 

Jimdo also has a unit for playing Flash videos (SWF files). 

You can quickly add a "Like" button to the site to promote the page on 
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Facebook, as well as a "Share" block so that visitors can post links to the page on 

their Facebook profiles , VKontakte and other social sites. 

To edit the page layout or change the site structure, you need to use the special 

navigation panel that appears on the right side of the screen (Fig. 3.5) . 

 
(Шаблон - Template, свернуть - collapse) 

Fig. 3.5. – Jimdo editor navigation panel 

Basic options for changing the design include uploading a custom image for 

the site header, choosing a template from a large library, setting the colors of 

headers, links, menus and page backgrounds. More advanced users can download 

their own template and edit it using HTML and CSS editors. 

Many site settings that can be found in the admin panel work only in the paid 

version of the service. For example, users of free accounts cannot change links in 

the footer of the site, protect pages with a password, set meta tags for pages, hide 

links for entering the administration panel, do newsletters. 

Jimdo is well suited for creating an online store. True, it is worth keeping in 

mind that in the free version the number of products is limited to five, and payment 

is accepted only through Paypal, so the store can only work fully for users of Pro 
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accounts. 

Creating a store is as automated as possible: products can be presented in the 

form of a list or gallery, for more convenient organization, not only categories, but 

also labels are used. The store owner can change the standard letters that are sent to 

those who placed an order, set the cost of delivery to different regions, choose the 

countries to which the product is delivered. 

"Google Sites" . Google has its own website creation tool . You can make your 

project with the help of this service absolutely free of charge and in a matter of 

minutes. The site is assigned a pretty tasteless name like 

https://sites.google.com/site/mysite, but you can also link the site to your own 

domain. In addition, you should not forget that you are dealing with Google, which 

means that the chance that there will be any problems with hosting is minimal. 

 
Fig. 3.6. – Start page for creating a Google web page 

The site is created in a few simple steps: you need to specify its name, 

description, choose a template and design theme. 
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Fig. 3.7. – The first step of creating a Google website  

By default, the site is available to everyone, but if you wish, you can prohibit 

its indexing by search engines or limit access to it altogether by manually specifying 

those people who will be able to access the site. The last option makes sense if you 

need to post paid lessons or other content intended for a limited number of users. 
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Fig. 3.8. – Choosing a Google website template 

 
Fig. 3.9. – Selection of site access parameters 

The site can contain any number of pages. Their structure can be managed by 

dragging the page names in a tree-like list with the mouse. The service offers several 

templates for quickly creating pages, including a standard page with information, a 

blog with announcements, files, a repository, and presenting information in the form 

of a list. You can create templates yourself, and later use them for new pages. 
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Fig. 3.10. – Google Website Control Panel 

Pages are edited using a visual editor. Pages can contain a wide variety of 

blocks, including, for example, recently added files, recent messages, content, a list 

of subpages, etc. Among the available blocks (in Google Sites they are called 

gadgets) there are many that are related to other services of the Internet giant. For 

example, you can insert a document stored in Google Drive, a slide show based on 

photos from Picasa web albums, a video from YouTube, an AdSense ad block, etc. 

Note, however, that the site creation service has apparently not been updated for a 

long time, as here you can find a block for the now defunct Google Wave and Google 

Video services. At the same time, there is no hint of integration with the currently 

actively promoting social network Google+. 
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Fig. 3.11. – Mode for inserting a picture into a Google web page 

The service also integrates with other Google projects for webmasters: Google 

Analytics statistics and Google Webmaster Tools, designed for search engine 

optimization of the site. It is also worth noting the automatic creation of a version of 

the site intended for viewing on mobile devices. 

100 Mbytes of disk space is allocated for storing files related to the site. You 

can manage downloaded data using a special section of the admin panel. Here you 

can find file location, size, download date are displayed. 

Weebly . The Weebly site builder does not have Russian localization, so if this 

is a problem for you, it is better to look for another service. However, for those with 

at least a high school curriculum level of Shakespeare, Weebly may definitely be of 

interest. The service is not completely free, but it allows you to create sites on your 



192 
 

own domains as part of a basic account. 

There are practically no ads on free Weebly sites - just a small link in the bottom 

of the page. The disk space allocated to the site is not limited, but the size of one file 

cannot exceed 5 MB. 

 
Fig. 3.12. – Weebly web editor home page 

Since it is assumed that after signing up with Weebly, the user will start creating 

the site right away, the number of mouse clicks that he needs to make to do this is 

kept to a minimum. Immediately after registration, a window appears where you 

need to enter the name of the site and specify the category, which it belongs to. Then 

the user must choose which domain he will host the site: on his own or on the third-

level domain mysite.weebly.com. 

After that, you can immediately proceed to work on the title page. A visual 

editor is used to change the content: first, on the settings panel, elements are selected 

for insertion on the site, then you can edit each block by calling the settings by 

clicking on it. Since there are quite a lot of types of blocks, they are divided into 

categories: basic, multimedia, income generation, others. 
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Fig. 3.13. – Control panel in Weebly web editor 

In particular, you can add slideshows, photo galleries, flash videos, Google 

maps, videos from YouTube, links to download files, a form for contacting the 

administration, multi-column text, polls, and RSS feeds. There is also the insertion 

of custom blocks of HTML code. But the ability to play video and audio files 

uploaded to the site in the player is the prerogative of premium users. Pro-account 

gives an opportunity to add various documents (.doc, .pdf, .xls, .ppt) to the site, 

which are opened directly in the browser window. The premium options also include 

password protection of the site and individual pages and uploading a site icon 

(favicon). 

Weebly offers its users to place AdSense advertising blocks on their sites, but 

it is worth keeping in mind that site owners receive only half of the income from 

advertising - the service takes the other half. 

It is also very easy to edit page properties and manage the site structure: you 

can create the required number of pages, including those that will lead to external 

sites, set titles, descriptions and meta tags, place the code in the title or at the very 

bottom of the page, determine which pages will be hidden in the navigation menu, 

hide the site from search engines, enable optimization for mobile devices. 

In the page settings, you can also find a button to add a blog to the site. Date 

and time settings, as well as comments, are offered for the blog. You can set pre-

moderation of comments before publication, and turn on notification of new 

comments by email. A convenient window is used to manage comments, in which 

you can view all received messages, approve them, delete them, and mark them as 

spam. 

Weebly even implements the possibility of multi-user site management. The 

owner of the resource can add editors and define their roles: for example, some users 
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are given the right to delete comments, others can edit some pages, left users can 

give full access to change the site. However, it is worth keeping in mind that only 

administrators with unlimited powers can be added to a free account (Fig. 3.14). 

 

 
Fig. 3.14 – Adding administrators with unlimited powers 

The site created in the Weebly constructor appears on the Web only after 

clicking the Publish button, so before presenting the project to the world, you can 

collectively work on it in closed mode. 

Yola . Yola is an English-language site builder that is suitable for web projects 

of the most different orientations (Fig. 3.15). One of the interesting features of the 

service is the automatic selection of a template based on the site's theme. 
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Fig. 3.15. – The start page of the English-language site builder Yola 

Immediately after registration, it is suggested to specify the name of the site 

and inform the service of the nature of the content to be placed on it. For example, 

if you inform them that the site will be dedicated to mechanisms, Yola immediately 

selects a suitable template for it. 

As in other site builders, adding elements is done by simply dragging blocks 

from the settings panel to the page area. You can add videos from YouTube, photos 

from Flickr, upload flash videos and audio files for playback on web pages, and any 

file up to 5 MB. At the same time, up to 1 GB of disk space is allocated for the site. 

It is also very easy to add social buttons to the Yola website: Google +1, "Facebook 

comments", "Like", "share on Twitter" and others. 

Working with Yola, the user has the opportunity not only to choose a template, 

but also to change the layout of the page. After the markup is defined, hints appear 

in those areas of the site that are not yet filled with content. Images uploaded to the 

service can be edited online thanks to the integration of Yola with the Aviary editor 

(Fig. 3.16). 
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Fig. 3.16. – editing of pictures and drawings by the Aviary editor 

In addition, the service offers integration with the Fotolia photo store, thanks 

to which you can choose, buy, upload a photo and place it on the site without leaving 

the designer page. You should also pay attention to the free clipart from Yola. 

Like Jimdo, the Yola service allows you to create an online store on the site, 

but this is a paid option. By the way, the store module was developed by the Russian 

company Ecwid, located in Ulyanovsk. The store supports integration with popular 

payment systems, social functions and a mobile version. 

As part of a free account, you can create a third-level domain name like 

mysite.yolasite.com. Using your own domain name is again a paid option. The 

premium features of the service also include CSS editing, the use of additional styles, 

and the removal of the Yola advertising block in the "basement" of the site. 

Thus, it should be emphasized that without deep comprehensive studies of the 

experience of developing educational web resources, without studying their 

pedagogical orientation and opportunities in education, it is impossible to talk about 

the effective use of educational Internet resources in the learning process. During 

development, pedagogical goals and tasks of its creation are outlined, methods of its 

use in the educational process are designed, stages and technologies of its 

development and implementation are chosen. 

Modern site builders have nothing in common with the tools that ten years ago 

were offered for creating home pages on free hosting. These are full-fledged CMSs, 
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with the help of which you can create quite decent educational sites for a variety of 

purposes: and web resources of educational organizations, thematic blogs, photo 

galleries. And paid editions of site designers should not be ignored either, because 

the pFig includes not only additional opportunities for creating web resources, but 

also not very expensive hosting. 

 
 

3.2 The method of using a distance learning environment as a factor in 

the training of engineering specialists 

The improvement of the professional training of future specialists in the 

economic direction occurs thanks to the use of information and communication 

technologies and a distance learning environment in the educational process, which 

contributes, in particular, to the development of personality. The essence of the 

concept of "distance learning environment" as an informational and educational 

space built on the informational integration of computer and telecommunication 

technologies (virtual libraries, distributed databases, an optimally structured 

educational and methodological complex) and aimed at self-development of the 

individual is revealed. The educational situation in such an environment is designed 

as a dynamic process of subject interaction of all participants of the educational 

process, mediated by computer technologies. 

The problems of development and use of remote and computer-oriented 

learning tools are studied in the works of V. Bykov, A. Gurzhii, M. Zhaldak, Yu. 

Zhuk , N. Morse, N. Tverezovska, and others. Psychological-pedagogical and 

methodical aspects of this issue are reflected in the works of E. Mashbits. The main 

competence of the teacher is his renewed role in the conditions of the distance 

learning environment - the role of a guide of knowledge, a kind of "navigator" who 

helps to learn and navigate in the bottomless ocean of information. The task of a 
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modern teacher is to teach the optimal choice of an individual educational route and 

methods of its passage, i.e. "navigation in education". However, it can be concluded, 

and this is confirmed by numerous studies and observations, that not all teachers are 

prepared to fulfill their updated role [ 69, p.330 ]. 

The widespread introduction of computer-oriented environments in the 

educational process is restrained by two factors: the lack of subject-oriented methods 

of using ICT tools in educational activities; insufficient number of scientifically 

based educational software tools. 

More and more scientists are coming to the conclusion of the expediency of 

presenting teaching and methodical materials in electronic form. Therefore, we 

consider the creation of a structural and logical scheme of a distance learning 

environment according to our methodology and the use by the teacher of a structural 

and logical scheme of a distance learning environment to be a priority task of modern 

education, which will allow to create in the future a single informational and 

methodological educational space of the informatized educational and educational 

process of any institution of higher education as indicated in fig. 3.17.  

E -learning courses are classified by: 

− a functional feature (they can be classified as educational publications); 

− submission form (belong to the category of electronic publications); 

− creation technology (software products). 

Therefore, monitoring of the quality of electronic training courses 

(hereinafter, ENC) should be multi-level, taking into account their classification. 

ISO 9000 standards (a series of quality management standards) are considered 

the main quality standards today. In the field of software - the ISO/IEC 9126 

standard (attributes and methods of software quality requirements) and the set of 

ISO/IEC 14598 standards (regulates methods of evaluating these characteristics). IN 

totality they form model quality SQuaRE (Software Quality Requirements and 

Evaluation). Therefore , when developing ENK quality criteria, we also manage this 

model . 

Based on the theory of the step-by-step formation of mental actions (P. 
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Halperin, N. Talizina) [2, p. 78], the sequence of work in the distance learning 

environment for students' assimilation of the necessary information of modern 

scientific knowledge in the field of marketing, economic cybernetics, electronic 

commerce is determined and built structural and logical scheme of the algorithm of 

work in the environment. 

Within the framework of the SQ ua RE model, the following main 

characteristics and qualities are distinguished: 

– Functionality (accuracy, consistency, interoperability, security, usability). 

– Reliability (stability, completeness, renewability). 

– Accessibility (learning efficiency, ergonomics, comprehensibility). 

– Efficiency (resources and time). 

– Support (ease of analysis, changeability, stability, verifiability). 

– Portability (adaptability, compliance with standards and regulations, 

installation flexibility, replaceability). 

Evaluation of the quality of electronic educational materials should be 

comprehensive. A comprehensive assessment of the quality of electronic 

educational materials means an assessment of the quality of a set of parameters: 

content, technical-technological, didactic, methodical and design- ergonomic. 

Central Components: 

● Student (СТУДЕНТ): The core of the model, representing the learner. 

● Instructor (ВИКЛАДАЧ): The teacher or facilitator responsible for 

guiding the learning process. 

● Information Resources: A wide range of materials, likely including 

textbooks, online resources, and multimedia content, used by both the 

student and instructor. 

Key Processes: 

● Development of Teaching Methodology: The instructor's role in creating 

and adapting teaching methods to suit the distance learning environment. 
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● Technology for the Phased Learning Process: The use of technology to 

support the various stages of learning, from initial information reception to 

knowledge accumulation and application. 

● Control of the Learning Process: Mechanisms to monitor and evaluate 

student progress, including assignments, quizzes, and feedback. 

Components of the Learning Environment: 

● Theoretical Block: Likely referring to foundational knowledge and 

concepts. 

● Practical Block: Application of theoretical knowledge through exercises, 

assignments, or projects. 

● Independent Work: Tasks completed by the student outside of direct 

instruction. 

● Glossary of Terms: A reference resource for definitions and explanations. 

Additional Elements: 

● Sequential Presentation of Teaching Material: The structured 

organization of content. 

● Types of Educational and Control Tasks: The different kinds of 

assignments and assessments. 

● General and Specific Didactic Principles: Guiding principles for effective 

teaching and learning. 

● Principles of Distance Learning Environment Functioning: The 

underlying rules and guidelines for the distance learning system. 
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Fig. 3.17. C structural and logical scheme of the distance learning 

environment in the preparation of future specialists in the engineering profile 

The set of didactic and methodical support, implemented with the help of 

material and technical means of education, intended for use in the educational 

process of training future engineers, will be called a distributed distance learning 

environment. Note that the experiment was conducted in the discipline "Agricultural 

machines", which used a traditional form of education using personal computers 

without a network and environment (control group), and the experimental group 

studied in a distance learning environment on the Moodle platform using an 

electronic training course . 
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Fig. 3.18. - Algorithm of the student's work with an electronic educational course in 

a distance learning environment 

The content management of the distance learning environment is performed 

using the freely distributed software product P hP and the Moodle platform. We 

developed and presented the algorithm for working in such an environment as shown 

in fig. 3.18. 

Therefore, there is a certain inconsistency between the need to use the 

advantages of computer-oriented learning environments in the training of highly 

qualified engineers and the lack of pedagogically and methodologically sound 

software, methods of using these tools in educational activities. 

Having analyzed the classical model of Internet learning, we compared it with 

electronic training courses created by teachers based on the Moodle information and 

communication learning environment. On the basis of the initial data, we created an 

alternative model taking into account the peculiarities of the compilation and use of 

electronic training courses in the above-mentioned software environment. 

The main requirement for the distance education shell is that it does not 



203 
 

become "tight" for the organization of the virtual learning environment, that is, the 

shell must contain a sufficient number of tools to fully support the process of training 

engineers, marketers and others. 

On the basis (knowledge, problems) of the presented educational materials 

and tools (presentations, chat, tasks, tests, virtual conferences, forum, etc.), training 

is conducted in a computer-oriented environment in the shell of the platform 

Moodle.  

In order to check the effectiveness of the method used by economics students 

in a distance learning environment, we have created an electronic training course on 

the discipline "Agricultural machines". Therefore, in order to start classes in the 

environment, the student must first go to the educational and informational portal of 

the National University of Bioresources and Nature Management of Ukraine. 

The next step of the student in the environment is to find an educational unit 

(department) and choose an electronic educational course specified by the teacher. 

After the student has made a choice of discipline, the process of authorization 

in the electronic course takes place. It should be noted that enrollment (registration) 

of students can take place in two ways: 

− forced (a student or a group of students is enrolled by the teacher); 

− independently (with appropriate course settings, the student has the 

opportunity to independently register for the course). 

Once on the electronic course, the student sees the shell created by means of 

a computer-oriented environment on the Moodle platform , as shown in Fig. 3.19. 

From the moment the student enrolls in the course, he has the opportunity to 

familiarize himself with general information (curriculum, evaluation criteria, 

calendar plan, news, schedule, etc.). 
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Fig. 3.19. – Title page of the electronic training course in the discipline 

"Agricultural machines" for agricultural engineers, where: 
pp. 1-3 are available to the teacher and are invisible to students 

1 – a navigation bar where the abbreviated name of the site and the open course is 

indicated; 

2 - the "activity" block is used for: filling in the dictionary of terms in the form of a 

glossary, reviewing and entering the solutions to tasks sent by students, conducting and the 

results of surveys and questionnaires, filling in and reviewing the resources located on the 

course, reviewing the results of tests and slices of knowledge, etc.; 

3 – the "control" block is intended for editing and setting course parameters by the 

teacher; 

paragraphs 4-6 – make up the substantive part of the course and are open resources: 

4 – general information includes the work program, calendar plan, student evaluation 

criteria, glossary, forums, questionnaires, news, etc.; 

5 – the first (and other, if any) meaningful module, which consists of theoretical and 

practical parts, independent work, intermediate certification for the first and second modules 

in the form of an electronic test; 

6 – final attestation, which includes an exam or assessment in a test form; 

7 - block of recent events in the electronic training course made by course users. 

While studying in a computer-oriented environment, students acquire 
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knowledge and skills. In the process of learning, students acquire theoretical 

knowledge and perform practical (laboratory exercises), which are sent to a remote 

server for checking by the teacher. The teacher can observe the student's activities 

in the distance learning environment, check the sent laboratory works and evaluate 

them. After studying a certain meaningful module, the teacher conducts an 

intermediate test control to check the consolidation of the student's theoretical 

knowledge. The grade for the meaningful module includes the accumulated grade 

for the laboratory work assigned by the teacher and the grade assigned to the student 

by the environment during the module test. Evaluating the student's practical 

activity, the teacher can comment on the student's work. If necessary, by means of a 

distance learning environment, the teacher can conduct virtual communication with 

the student to clarify his knowledge or other information. The same connection can 

be made by a student in relation to a teacher or another student. 

The use of the electronic journal of student evaluations, as shown in Fig. 3.20, 

deserves special attention. The evaluation journal is always an open resource, which 

can be used by both the student and his parents for orientation in the process of 

studying the discipline. The structure of the electronic journal was developed in 

accordance with the requirements of the Ministry of Education and Science of 

Ukraine for examination information. 
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Fig. 3.20. – A window of the student's electronic evaluation journal, which is 

available for viewing by every participant of the educational process during the 

entire academic period/semester. 

Therefore, the distance learning environment allows the most complete 

realization and control of the components and stages of learning, building models of 

both the learning process itself and its subject and object, that is, the student [7, 

p.43]. 

Distance learning environment includes the following structural components: 

1. Educational and methodological complex of the discipline. 

2. Information banks of the discipline, which must be constantly updated. 

3. Modular rating pedagogical technology (a means of optimizing the 

educational process, adapted to the individual characteristics of students). 

4. Implementation of creative projects, including collective or group projects. 

Creative projects have a detailed structure of the joint activities of the participants. 

5. Student scientific and practical conferences, public defense of creative 

projects and presentation of the results of their activities on the Internet (a means of 

forming reflective and communicative skills). 

6. Automated knowledge control system (facilitates the work of teaching staff 
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and promotes openness, objectivity and impartiality of student assessment). 

7. Selection of information resources (optimal combination of electronic and 

traditional educational resources). In this regard, information projects are aimed at 

collecting information about any object, phenomenon, at familiarizing project 

participants with this information, its analysis and generalization of facts [1, p.15]. 

The given structural components have technological features and perform 

certain didactic tasks. Let's dwell on some of them. 

The electronic training course of the discipline may contain the following 

elements: 

- electronic textbooks, including theoretical material, a glossary, as well as 

topics of seminar, laboratory and practical works; 

- plans for theoretical and laboratory-practical classes; 

- virtual laboratory complexes; 

- synopsis-presentations of theoretical classes and lectures; 

- tasks for laboratory-practical works; 

- educational tasks for independent work and requirements for them; 

- questions and tasks for the final certification; 

- a description of the information tools and technologies necessary for the 

performance of educational tasks; 

- methodical instructions for using this complex; 

- electronic banks of questions and tests; 

- links to additional information resources on the discipline on the Internet ; 

- additional educational materials (textbooks, manuals, etc.) [4, p.81]. 

The presented educational and methodological complex is provided to 

students on printed media or is freely distributed through the local network of the 

educational institution and the global Internet. 
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Fig. 3.21. The learning process in the Moodle software environment 

In the process of preparing a teacher for the use of computer - oriented 

learning environments, two stages can be distinguished: 1) the formation of the 

teacher's information competence in general, 2) his ability to implement the latest 

tools in his professional field, that is, to be not only a user of ready-made software 

products, but to a greater extent act as a creator, developer of own educational and 

methodological tools as shown in Fig. 3.21. 

At the first stage, the teacher's professional training in the use of computer-

educational environments is usually carried out in professional development 

courses. This, as a rule, ends the process of professional training of teachers, and the 

second stage appears as a problem that must be solved on one's own, at best at the 

level of self-education. 

Management of students' project activities with the use of information 

technologies is a separate type of work that does not always coincide with the 
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requirements of methodical support of the class. The main task, as is known, is to 

increase students' motivation, their interest in the subject being studied, the 

development of productive thinking and the practical application of acquired 

knowledge and skills - in other words, this is the side of the method that mainly 

"works" on students. An example of the practical application of the results of 

students' project activities can be the use of software products in the educational 

process. From this point of view, a project as a demonstration material of a lesson, 

used by a teacher or submitted by a project group of students is a positive aspect of 

project activity that can be useful for the teacher in . 

However, this type of work is not always productive and convenient for the 

teacher: not all topics and approaches needed by the teacher for classes may be 

understandable to students, especially if the topic is new or difficult enough, strict 

time frames can also reduce the effectiveness of the created software product [9 , 

p.262 ] 

In our opinion, the development of an electronic educational course for 

student preparation should contribute to the involvement of students in project 

activities for the creation of a project in distance learning environments. 

The proposed course is implemented in two stages : 

1) setting and solving the task of mastering information technologies at the 

level of an active student (working with various software environments) regardless 

of the subject of study; 

2) setting and solving the task of training a future economist as an expert and 

user of ready-made software products; training of an e-commerce specialist as a 

creator of own software products that meet specific goals and tasks. 

Creation of an electronic training course of the discipline requires the teacher 

to be both an expert and user of ready-made software products, as well as a developer 

of own software products with multimedia support. 

Training courses in remote environments must have a number of necessary 

components: 

1) work program and course schedule. The ratio of theoretical and practical 
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parts of the course, 

2) information and reference materials (repositories, encyclopedias, 

directories, etc.); 

3) electronic books, 

4) educational films in compressed format, 

5) libraries of electronic visual aids and databases, 

6) methodological materials on electronic media (development of lessons, 

methodological recommendations, modular tests and other materials); 

7) Internet resources; 

8) educational and methodical software tools for accompanying foreign 

language classes (demonstration materials, presentations, lesson plans, etc. ); 

9) combined informational means of learning (educational programs, 

electronic textbooks, collections of exercises and educational games); 

10) means of monitoring the student's mastery of the studied material 

(electronic tests or exams). 

In the process of working on the structure and content of the course, the author 

should proceed from a number of key provisions that allow the student to 

successfully master and further creatively apply the acquired knowledge and skills 

in his future professional activity. The peculiarity of the interaction between a 

teacher and a student is that they communicate during the learning process as 

colleagues - current and future. Therefore, the level of training of a student as a 

future specialist in the field of information and post-information society largely 

depends on the level of use of computer-oriented learning environments by the 

teacher [7 , p.337 ] 

When modeling the educational process, part of which will be carried out 

taking into account the use of information technologies, the teacher must take into 

account the following criteria and ways of integration between them: 

1) general educational possibilities of information technologies and 

implementation of didactic principles based on them; 

2) the correlation of key educational competencies with the possibilities of 
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integrating information technologies into the educational process, as a way of 

presenting and processing educational material using a computer in class. 

During the development of the course, the following were taken into account: 

‒ computer-oriented learning methods (used as a kind of tutor, which 

organizes mostly independent development of skills through repeated repetitions, 

self-monitoring and obtaining reference information of an educational nature); 

‒ developed functions of the distance learning environment (allowed to create 

the effect of "immersion" of students in the learning environment and interaction 

between themselves and the teacher in an interactive mode); 

‒ demonstration functions of the distance learning environment (the principle 

of visibility was raised to a new level, which allowed students to observe phenomena 

both statically and dynamically, use a large number of illustrations and moving 

images, as well as display a large amount of information on the screen); 

‒ controlling functions of the distance learning environment (allowed to 

determine the level of knowledge and the degree of formation of students' abilities 

and skills in a fast, accessible and reliable way); 

‒ diagnostic functions of the distance learning environment (allowed to 

quickly and effectively carry out diagnostics and monitoring of various components 

of the educational process - curriculum, subject program, content of educational 

material, monitoring of student activity in order to optimize the allocation of 

educational time, etc.). 

‒ reference and information functions of the distance learning environment (it 

greatly facilitated access to sources of information of various nature due to rationally 

organized information search and output systems (encyclopedias, directories, the 

Internet, etc.); 

‒ combined functions of the distance learning environment (most fully 

implemented in electronic teaching aids of various purposes, levels and approaches, 

including those created by the teacher himself) [8, p. 84]. 

Among the conditions that determine the effectiveness of the use of remote 

and computer-oriented learning environments, we included: 
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‒ basic computer literacy of teachers and students; 

‒ a sufficient number of educational software; 

‒ availability of subject-oriented methods. 

Achieving these conditions ensured a significant increase in the quality of the 

educational process in the process of training both agricultural engineers and 

specialists in any other field of knowledge. 

As mentioned above, Moodle is presented in the form of a website, the 

elements of which are hypertext links that can be opened in almost any browser. 

Therefore, as a result of studying under the credit-module system on the 

Moodle platform , it is more convenient for the student to prepare for lectures and 

tests, perform laboratory and independent work. During the entire training, he can 

follow the electronic journal of his grades, study the educational material. In turn, 

the teacher can more perfectly and clearly see which aspects of the discipline are 

being mastered by a group of students to one degree or another. By creating a survey 

resource or a forum, the teacher has the opportunity to keep in touch with students, 

not in real, but virtual contact, which sometimes gives frankly interesting results. 

The use of the Moodle platform requires the teacher to have knowledge and skills in 

the use of information and communication technologies, but it repeatedly returns the 

efforts spent in mastering and applying the credit-modular system of education [3, 

p. 175]. 

An important task of our pedagogical research in the learning process was to 

identify and establish the order of regularities in the training of students of 

agricultural engineers by methods of information and communication technologies 

in education. 

It will not be superfluous to note that in modern conditions of total 

informatization of society and society, future specialists in the agrarian industry feel 

the need to use the latest information and communication technologies of learning, 

which allow more extensive and qualitative self-improvement throughout life. 

http://moodle.udec.ntu-kpi.kiev.ua/moodle/mod/glossary/showentry.php?courseid=25&concept=%D0%9Coodle
http://moodle.udec.ntu-kpi.kiev.ua/moodle/mod/glossary/showentry.php?courseid=25&concept=%D0%9Coodle
http://moodle.udec.ntu-kpi.kiev.ua/moodle/mod/glossary/showentry.php?courseid=25&concept=%D0%9Coodle
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3.3. Properties of the computer-oriented environment as a component of 
information and communication technologies in engineering education 
A computer-oriented learning environment provides an opportunity for self-

realization of an individual who possesses the necessary professional qualities. Such 

a servant environment is the foundation for the organization of the modern 

educational process [50, p. 32]. 

Let's reveal the property and characteristics of a computer-oriented educational 

environment. 

Scalability and extensibility . The architecture of the system and technological 

solutions must take into account its functions and changes in the number and quality 

of services, and the availability of productive processing of external requests from 

users of a computer-oriented educational environment . From a technical point of 

view, the properties of a computer-oriented learning environment are ensured by 

using the larger capacity of platform architectures and their capabilities. This is the 

basis for scaling the computer-oriented learning environment [55, p. 73]. 

Portability and modularity . Software of a computer-oriented educational 

environment is usually built according to the principle of modularity, individual 

modules of which can be located on different hardware and software platforms. This 

makes it possible to provide the necessary scaling of the computer-oriented 

educational environment , to use powerful computing clusters in the event of a 

change of platforms . These signs of portability cause the redistribution of the 

functions of maintenance of individual services of specific computer -oriented 

educational environments , which are used within a single educational space . 

Reliability . Regarding the external student , all computer-oriented educational 

environments operating within a single educational space must guarantee the 

necessary technical characteristics of the reliability of their functioning [54, p. 77]. 

Multilevel client-server architecture of a computer-oriented educational 

environment . A generally recognized way of structuring the environment of open 

systems is the use of the so-called reference model, in the framework of which the 

information system contains three levels, namely: the core (computing and 
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information resources), the shell (a set of standardized interfaces) and 

telecommunications (that is, the network and the standard protocols involved in it ). 

Based on this, the TVS imposes certain restrictions on the choice of the general 

architecture of building a computer-oriented educational environment that functions 

within the framework of a single educational space - computer - oriented educational 

environments are mainly built in the environment of a multi-level client-server 

architecture . 

Parameters of the computer-oriented interaction profile educational 

environment in a single educational space . Computer-oriented interaction profile 

educational environment is an agreed set of mandatory basic standards necessary to 

solve a specific task or a series of tasks. There are three main groups of standards: 

− data transfer protocols (telecommunications level); 

− software interfaces for the interaction of elements of a computer-

oriented educational environment (shell level, i.e. document formats, metadata, 

interaction protocols and services); 

− linguistic and organizational support (level of information resources) 

[55, p. 98]. 

Further, relevant proposals and justifications for each of the groups of standards 

are presented for determining the profile of a computer-oriented educational 

environment, on the basis of which the formation of a single educational space will 

be carried out. 

The general scheme of information interaction of the portals of the unified 

educational space and data exchange between the corresponding computer-oriented 

educational environments is mainly implemented in a fully automated synchronous 

(on-line) mode. To ensure the specified synchronous exchange, it is necessary to use 

a standardized data transmission protocol, as such the basic protocol of the global 

network http :// is used . On the other hand, at the initial stage of the formation of a 

unified educational space, there is a real need for interaction with already existing 

computer-oriented educational environments that do not have http :// oriented 

interfaces. Therefore, in some cases, the optional use of the standard asynchronous 
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protocol - smtp:// is provided . It is important to note that in both synchronous and 

asynchronous modes of telecommunication, the choice of these standard protocols 

is determined by the following factors: 

- the possibility of using protected modes of data transmission, including the 

use of the electronic digital signature mechanism; 

- the practical absence of restrictions on the use of various data transfer formats; 

- a high degree of reliability of server applications using these protocols [55, p. 

105]. 

Any of the portals is a means of searching and selecting high-quality Internet 

resources of a certain topic with a certain quality guarantee. That is, the portal is not 

just a recommended list of resources that is usually placed on the servers of various 

organizations, but a bibliographic tool that meets a whole set of requirements, 

including the scientific and pedagogical value of the document. 

Let's highlight the following characteristic features of the portal: 

- formulation and observance of the thematic framework of the subject, which 

determine which resources should be included in the recommended list; 

- formulation and observance during the selection of resources and quality 

criteria for thematic sites, databases or individual documents; 

- a certain form of description or annotation of each of the included resources; 

- indexing and cataloging of the collection of resources that the portal 

recommends to its students; 

- announcing and ensuring the system of responsibility of portal compilers for 

its creation, filling and constant updating [49, p. 112]. 

In their content and principle, portals are very different from search engines 

such as Google , and from directories such as Yandex. In it, the entire work of 

selecting resources, describing them, annotating and cataloging relies on a person 

whose experience and knowledge will help compensate for some of the defects that 

arise in the case of the use of automated means. 

The portals do not limit the support of their users' professional activities to 

bibliographic services. They offer their students a whole range of web services, such 



216 
 

as online conferences or forums, hosting for teams or authors working in a related 

field, sending special newsletters, etc. Educational portals contain electronic 

versions of lectures, teaching and methodical manuals, organize testing and 

computer-oriented learning environments for students. That is, the portal covers 

network sources of a certain field of knowledge, and can perform the functions of 

an information and educational environment for specialists and students. 

The selection of sources for the portal is always based on two basic criteria: 

relevance to the topic and quality of the resource. As a result, the portal covers a 

relatively small volume of network documents, but at the same time guarantees a 

selection adequate to the student's professional needs, correct and fairly complete 

annotation, and a cataloging system that corresponds to the specifics of one or 

another field of knowledge or activity. 

One of the quality criteria is the resource's belonging to certain defined 

categories. The specific selection of criteria depends on the subject field, the circle 

of users the portal is aimed at, and the selection technology adopted by the compilers. 

For example, one of the sections of the educational portal may be limited to the 

following types of documents: 

− electronic magazines (reports and articles); 

− mailing lists and archives; 

− educational software; 

− bibliographic, factual or full-text databases; 

− graphic and multimedia documents; 

− electronic news; 

− bibliographies; 

− leading pages of general educational institutions and innovative teachers [ 103 

]. 

It is more difficult with substantive quality assessment, which is difficult to 

formalize. A resource can be considered high-quality if the information it offers is 

accurate, up-to-date and comes from reliable and authoritative sources. Developers 
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of portals and authors studying their experience identify a whole range of signs by 

which it is possible to establish whether a resource is of sufficient quality to be 

included in a collection. For example, the following criteria can be identified: 

− completing the site in accordance with the announced goals; 

− reliability and reputation of the source of information and its independence; 

− accuracy of documents; 

− completeness, level of detail of the source; 

− uniqueness of the material; 

− quality of composition and presentation of the material; 

− ease of navigation; 

− student support, availability of instructions, explanations; 

− use of recognized standards; 

− relevance of information at the moment [ 104 , p. 3 1]. 

In addition, to the selection of high-quality resources, the portal is subject to a 

number of requirements, in particular, mandatory annotation or description of 

resources, as well as support for some system of their cataloging. The description of 

the resource located on various portals has a wide range of differences in scope and 

form: from a simple abstract to a detailed informative summary of the content with 

an indication of keywords. The only common thing is that portal developers 

carefully avoid the use of automatically generated descriptions compiled by search 

engines. The keyword system is used when organizing a thematic search for 

documents on a certain site. Full-text search using index files and using algorithms 

based on methods of structural linguistics is also used. 

Standards for the development of portals neither in the classification system 

nor in the used search tools have yet been developed, and this leaves a wide field for 

the independent creativity of designers, taking into account the specifics of the 

subject field and the intended range of users. 

The most important feature of a quality portal is the presence of a permanent 

team or organizational structure that is responsible for its work. Just so can provide: 
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− high level of expertise during the selection, description and classification of 

resources; 

− constant renewal of the collection of portal sources in accordance with the 

appearance of new documents in the network, changes on the sites, elimination of 

resources, etc. [ 112 , p. 14]. 

In most cases, information content management tools provide centralized 

management of accumulated data, separate content from presentation (that is, from 

site design or its application), and automate the life cycle of information content by 

different students for different tasks. 

Based on the presented principles and means, the National University of 

Bioresources and Nature Management of Ukraine created a number of electronic 

information resources and network technologies, a number of sites and portals that 

form the electronic educational space of the university: an educational and 

informational portal and a scientific library portal (Fig. 3.22, 3.23) . 

The content management of the portal of the National University of 

Bioresources and Nature Management of Ukraine is performed using the freely 

distributed PHP software product (PHP: Hypertext). 

 
Fig. 3.22. Educational and informational portal of NUBiP of Ukraine 

Achieving the goals of unification, and as a result, achieving the maximum 

practical effectiveness of individual means of information and communication 
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technologies, which are developed for the purpose of further use in the system of 

open education, must take place in strict accordance with the specifications of the 

description of information resources produced for a specific system of open 

education. 

Preprocessor; first Personal Home Page Tools - "Tools for creating personal 

web pages"). 

Developing a unified policy on the development and application of information 

and communication technologies in open education is the most difficult problem, 

which is further complicated by the fact that the formation and functioning of the 

open education system can be distributed in space and time thanks to the advantages 

of modern means of communication. 

Appropriate ICT tools are developed at different times by different creative 

teams, after which the finished products are integrated within the framework of the 

open education system by sending data through telecommunication channels. 

Teachers and students, as the main users of information and communication 

technologies, get lost in a large amount of heterogeneous information of various 

types, the basis of which are structuring based on various criteria, and the principles 

of its transmission, processing and presentation are subject to various technological 

techniques. 

There are frequent cases when the participants of the educational process have 

to master new additional methods of operating information and telecommunication 

equipment and software for each individual ICT tool used in open education. 
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Fig. 3.23 . The portal of the scientific library of NUBiP of Ukraine 

Let's highlight the trends in the use of a computer-oriented educational 

environment: 

1. Development and distribution of computer-oriented learning tools included 

in the environment. This trend is manifested in the creation of resource centers that 

are engaged in the distribution of modern computer educational resources and tools 

via the Internet, their collection, registration, systematization, and provision of 

methodical and methodological recommendations for their use. This method of 

introducing computer-oriented learning tools provides openness to the learning 

environment, which acquires flexibility and mobility, the range of use and the 

possibilities of choosing tools depending on the learning goals are expanded. With 

the development of this trend, it can be predicted that eventually the so-called 

"closed" computer-oriented educational environment, in which the use of a computer 

is reduced to the operation of one or another individual tool, will become a thing of 

the past. 

2. Changing the role and purpose of educational computer systems , in 
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particular, with elements of artificial intelligence, as part of the environment. If 

earlier educational assignment systems were created with the aim of performing 

some functions of a teacher and managing education, then in the conditions of an 

open environment their goals change. The priority is the student's independent study, 

in which the teacher will provide him with the necessary support and direction. 

Therefore, the role of artificial intelligence systems is also changing. They are used 

to support learning in its various aspects - to search for information, master a new 

subject area, evaluate, improve qualifications, etc. To some extent, artificial 

intelligence systems are turning from learning management tools into 

communication and self-learning support tools. 

3. The growing role of specialization in the process of creating and using 

educational computer systems. Computer-oriented tools are becoming more 

specialized, their use is becoming systematic. For example, the environment may 

include: a program that monitors the progress of the student's reasoning based on his 

model, provides and corrects the performance of educational tasks; one or more 

knowledge bases; a knowledge control system that can be used both by the student 

for self-testing and by the teacher to control the student's knowledge; the system is 

a pedagogical agent that provides recommendations for solving problems, finding 

the necessary material, and answering questions; a "microcosm" type program for 

modeling; exercise program and others. All these programs can be localized in 

different ways both on the server of the educational institution, where the teacher is 

located, and on the student's computer, on remote computers that the student 

accesses during the study process , etc. 

4. The growing role of integration in the creation of computer-oriented teaching 

aids. There is a tendency to create integrated tools that combine the functions of 

several tools of different types. For this purpose, separate modules are used, which 

can be part of both one and several different teaching aids [122]. Based on the 

modules, it is possible to create various configurations of the learning environment, 

taking into account a specific educational goal. Such environments will contain, for 

example, a model of the subject area together with powerful means of presentation 



222 
 

and representation of objects of study, including visualization, virtual reality 

capabilities, means of simulating an experiment; subsystem of computer support for 

establishing new patterns; interactive mastery of concepts and symbols; formulation 

of statements, their further generalization and systematization; a subsystem for 

fixing problem situations, setting and solving problems; as well as evaluation of 

learning outcomes. 

5. Increasing effectiveness and multi-levelness of used knowledge models. 

Knowledge models underlying computer systems for educational purposes are 

becoming more powerful and detailed. This leads to the creation of more effective 

models of student and teacher activity. Thanks to the improvement of student 

models, computer programs become more individualized, adapt to the peculiarities 

of the student's thinking and personality. Modern models of the teacher provide 

opportunities for communication in ordinary language, procedural and contextual 

assistance, monitoring of plans and strategies of student reasoning, etc. [123]. 

6. Development of interactive learning environments. The concept of an 

interactive learning environment is undergoing changes. Previously, this term 

meant, as a rule, educational programs that provide tools for independent student 

work and have an appropriate system of methodological instructions and 

recommendations (for example, " microworld " programs , hypertext textbooks, etc.) 

[59, p. 44]. Now environments of this type acquire an open character, when the ideas 

about the interactivity of working with them change. It is assumed not only the work 

of one student with this environment, but the communication of a group of students 

or students and teachers in the learning process. 

7. Formation of virtual learning communities. A characteristic feature of 

learning in an open computer-oriented learning environment is the formation of 

learning communities united by interests in the process of implementing an 

educational project, solving a problem, etc. This trend indicates that the participants 

of the educational environment do not necessarily belong to a certain educational 

class or educational institution, they may not belong to educational institutions or 

their networks at all. It can be any person - students, teachers, experts, specialists 
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who are interested in solving some question, scientific problem, whose sphere of 

interest concerns the environmental field. In this way, learning truly becomes open 

in the sense that it is not limited to educational institutions, but involves free 

communication and the search for new ideas [130]. 

8. The emergence of powerful banks and libraries of expert knowledge. The 

improvement of knowledge presentation methods will lead to the creation of much 

more powerful hierarchical, multi-level knowledge bases, combining them into 

libraries or banks of expert knowledge from various scientific fields and their 

subdivisions. The use of such banks enables the student to attract information from 

several related disciplines to solve, for example, an open problem. 

Thus, the goal of education is not only mastering a certain amount of 

knowledge (a person can be replaced by an expert system in many cases), but 

directing the acquired knowledge in order to solve actual practical and theoretical 

problems. 

Educational portals play an important role in the creation and development of 

an open computer-oriented learning environment . which perform various functions 

- creation, transfer, control of knowledge, confirmation of received qualifications, 

provision of information services, etc. [124]. 

Although a large number of new tools are created, their use often does not have 

a sufficiently systematic character. This problem is especially relevant in the 

conditions of Ukraine, where there are practically no servers of educational 

computer resources. This work is just beginning. Information about available 

resources, possibilities of their use, terms of distribution can be displayed in the 

portal. 

Educational portals in this context are not only a means of providing 

information, but also a means of conducting scientific research. For example, the 

compilation of lists of teaching aids and their classification can be carried out on the 

basis of data placed on the Internet, and which are displayed in an integrated form 

in the content of the portal. Even such information as the number of calls and copies 

of a particular tool to a certain extent indicates the effectiveness of its use, and such 
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data, as a rule, are displayed on the servers of educational services. There is also the 

possibility of conducting Internet surveys on the effectiveness of using certain tools, 

which could indicate their "viability" and popularity among students and teaching 

staff. 

The development of requirements and expert evaluation of computer-oriented 

tools is quite difficult in connection with the development of evaluation criteria. It 

is not always possible to predict in sufficient detail what types of learning activities 

will occur when working with the tool, the developers themselves cannot always 

predict this [128]. The issue of creating appropriate conceptual grounds for testing 

and approving means remains important. The results of expert evaluation can also 

be displayed in the portal. 

Creation of educational and computer-oriented educational environment, 

virtual Internet-centers that would provide methodological support to teachers 

regarding the use of certain computer tools, answers to questions, recommendations 

regarding the organization and use of a computer-oriented environment, conducted 

training on searching necessary resources and navigation in the Internet space. 

Creation of appropriate resources that would provide the student with the 

results of scientific research, foreign experience in organizing a computer-oriented 

environment, definition and classification of types of environment, formulation of 

requirements for the composition of the environment, information on the latest 

computer-oriented learning tools, opportunities and results of their application. 

Collection, analysis and dissemination of advanced pedagogical experience in 

the use of computer-oriented learning tools and learning environments, which could 

take place through the holding of forums on this topic, the creation and distribution 

of relevant resources, which will ultimately be manifested in the formation of virtual 

communities interested in the development of this issue . 

In recent years, the composition of the funds has changed significantly, in 

particular, a significant part of the library funds is primary information documents 

on other than traditional media (on CDs, video and audio cassettes, etc., as well as 

in the long-term memory of a PC); in the reference and search apparatus, along with 
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traditional card catalogs and paper indexes, electronic search systems (catalogues, 

file cabinets, indexes, etc.) play an important role, which, as predicted, will 

eventually completely replace traditional search tools. 

In addition, modern search systems, in particular, tools that are presented in the 

global computer network Internet, allow students in the library to search for sources 

outside of "their" library fund, that is, in the funds of the "world virtual library", and 

in many situations, after finding the address of the document in the virtual directory, 

view (or order) the document itself. Strictly speaking, we are dealing with a so-called 

"hybrid library", in which elements of a traditional electronic library are combined 

(integrated). 

The emergence of hybrid libraries depends more on cultural shifts than on 

technological progress; they are a perfectly acceptable model of the evolution of a 

traditional library. The term "hybrid library" has entered the professional glossary 

of library and information workers over the past three years. It is used to indicate an 

intermediate link on the way to a full transition to digital libraries. 

A digital library is a system of information services within which all 

information resources exist in an electronic form suitable for processing on a 

computer, and the functions of obtaining, saving, protecting, saving, accessing and 

viewing information are carried out through the use of digital technologies. Digital 

library services are not limited to providing information in text format; say, audio 

and video resources can also be provided digitally. Digital library resources are 

divided into originally created in digital format, for example, electronic journals and 

data sets, and non-digital resources, for example, manuscripts and printed 

publications, translated into digital format [47, p. 23]. 

A digital library can distribute information within a network, and in the same 

way users can select it. Among the advantages of a digital library, it is worth 

mentioning a reduction in the amount of information stored, a lower level of wear 

and tear of materials, the ability to provide the same information to several students 

at the same time, the possibility of accessing materials from home, office or other 

places outside the library, finally, the presence of a real potential for increasing 
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economic efficiency [34, p. 19]. 

A hybrid library can be given a simple definition: a means of integrating a 

traditional library with a digital one. The concept of "hybridity" is often used in 

descriptions of activities or services that combine two basic components [125]. 

Today's modern user is forced to work in a hybrid environment, addressing 

materials that exist simultaneously in electronic and paper form. 

In the information society, all members, regardless of social status, use 

information and knowledge in their activities, solving the tasks that arise before 

them. At the same time, the reserves of knowledge, experience, and the entire 

intellectual potential of society, which is concentrated in books, magazines, reports, 

and ideas, are constantly increasing. At the modern technical level, the majority of 

society members take part in everyday industrial, scientific, educational, and other 

activities. 

Summarizing the approaches to pedagogical software tools, their classification 

and didactic properties, the following conclusions can be drawn: optimization of the 

educational process during the formation of communicative knowledge, skills and 

lessons can be achieved through the use of multimedia technologies - electronic 

textbooks, dictionaries, reference books, encyclopedias, computer programs, etc. 

According to the form of presentation of educational information, all pedagogical 

software tools for learning a foreign language can be conditionally divided into 

several types: informative, situational, game, controlling, multi-aspect (complex), 

intensive, instrumental. 

Electronic courses contain a significant amount of video and audio materials, 

which provides auditory and visual clarity, making learning a foreign language more 

interesting, exciting, and effective. 

At the current stage of society's development, information is becoming the most 

important global resource of humanity, the basis of modern high technologies, the 

basis of a new information civilization; the process of society's transition to a 

qualitatively new era - the informatization of society - is being observed. 

These fundamental transformations lead to the creation of a new information 
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civilization - an information society, which also determines the socio-cultural life of 

a person, forms and develops the information culture of an individual. 

The active implementation of society's informatization technologies could not 

fail to affect the education system as well. 

The basis of the modern stage of education modernization is the wide use of 

information and communication technologies and methods of preparation, transfer 

and presentation of information to students, using the computer as a new means of 

supporting the educational process, which radically changes the dynamically 

developing system of forms and methods of education. Multimedia and hypermedia 

technologies are widely implemented in the educational process . 

Multimedia technologies are related to the process of creating multimedia 

pedagogical software, i.e. e-books, "live" and voiced pages of which are displayed 

on the display screen, multimedia encyclopedias, computer movies, databases, etc. 

A characteristic feature of multimedia pedagogical software is the combination of 

text, graphics, audio and video information, and animations. In contrast to ordinary 

pedagogical software tools, in multimedia pedagogical software tools the 

information itself comes to the fore. 

Hypermedia technologies are the development of hypertext technologies, 

which represent enormous opportunities for working with texts and organizing 

cross-references between them. Virtually all modern information and reference 

systems are implemented in hypertext technology. Global network technologies are 

a significant direction of informatization of rapidly developing society, in general 

and education in particular. 

The largest global network, which unites thousands of regional and corporate 

networks of the world into a single entity, is the Internet - a collection of various 

components: e-mail, electronic textbooks (manuals), encyclopedias, dictionaries, 

teleconferences, and even chats. 

Multimedia and hypermedia technologies make it possible to increase the 

effectiveness of education due to the stimulation of the greatest number of sensations 

in the student. Educational multimedia and hypermedia systems allow users to 
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manipulate information, deform it from various parameters, choose the necessary 

trajectory of actions, analyze user actions. 

A computer-oriented educational environment includes many information 

objects and connections between them, means and technologies for collecting, 

accumulating, transmitting, processing, producing and distributing information 

[120, p. 86]. 

The study of domestic and foreign experience in the use of information and 

communication technologies, with the aim of training future specialists, as well as 

theoretical research in the field of informatization of education allows a computer-

oriented educational environment to show that the inclusion of a computer in the 

educational process has a certain influence on the role of educational tools , which 

are used in the process of teaching this or that subject (discipline), namely the use of 

information and communication technologies reformats the traditionally formed 

structure of the educational process. 
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Chapter 4. Using the MATHCAD application in computational 
mathematics 

4.1. Introduction to Mathcad. The simplest calculations, construction of 
graphs of functions 

The "MathCAD" program package makes it possible to calculate numerical 
expressions and function values, which include addition, subtraction, multiplication, 
division, exponentiation, making logarithms, differentiation, integration, finding 
solutions of algebraic and differential equations and their systems in analytical or 
numerical in the form Problems of this type arise during mathematical modeling of 
any processes, including agricultural ones. 

"MathCAD" is based on the traditional sequence of writing and performing 
calculations using numerical expressions or formulas. 

The MathCAD environment has a number of features that must be taken into 
account when performing calculations: 
⮚ the working document is read from top to bottom, from left to right. 
⮚ symbols used in calculations, except for text zones, must be written with an 

English keyboard layout. 
⮚ decimal values of numbers are separated by a dot. 
⮚ strict sequence of placement of symbols and operations on the working field: 

- symbols and their corresponding numerical values included in the 
expression; 

- area or specific values of variables; 
- expression in general form; 
- calculation result; 
- graphical dependency based on the written expression. 
If the specified order of data placement or operations is violated, those 

symbols in the expressions whose value is not defined are highlighted in red and an 
error message is displayed in the place where it was made. 

User interface 
❖ Menu bar - menu bar; 
❖ Toolbars - toolbars: Standard, Formatting, Math, Resources, Controls; 
❖ Working area – worksheet; 
❖ Status line – status line or status bar; 
❖ Pop-up menus or context menus; 
❖ Dialog windows - dialogs; 
❖ Status bar – Status bar; 

Menu items 
▪ File; 
▪ Edit; 
▪ View – managing the appearance of the document, setting toolbars; 
▪ Insert; 
▪ Format; 



230 
 

▪ Tools – commands for managing the computing process and 
additional capabilities; 

▪ Symbolic – commands for symbolic calculations; 
▪ Windows; 
▪ Help; 

The Math panel includes palettes 
o Inserting mathematical operations - Calculator; 
o Graph insertion - Graph; 
o MatFigs and matrix operators - Matrix 
o Calculation management operators - Evaluation; 
o Operators of integration, differentiation, summation - Calculus; 
o Logical operators - Boolean; 
o Programming - Programming; 
o Greek symbols - Greek; 
o Symbolic operators – Symbolic; 

Cursor view (crosshair) 
● The mouse pointer is an arrow; 
● The input cursor is a red cross + ; 
● Input lines (editing lines) – right angle of 

different orientation (right, left)┘, ∟, | ; 
● Placeholders - □, ■; 

Moving input lines 
❖ Click the mouse in the desired city; 
❖ From the keyboard; 
❖ arrows - →↑←↓; 
❖ the Space key (highlighting different parts of the formula); 
❖ key - Ins (transfers the vertical input line from one end of the 

horizontal input line to the opposite); 
Moving formulas 
✔ Edit menu; 
✔ From the keyboard; 
✔ Context menu; 

● The symbol Hand ( Palm ), which appears after selecting the object 
when the cursor is placed on the border of the formula. 

Entering signs, symbols, operators, functions 
From the keyboard - numbers, Latin letters; 
Greek letters from the palette; 
Arithmetic operation signs, operators - from the keyboard or palettes; 
Names of functions - from the keyboard, using the Insert→Function 

command, the symbol on the f(x) panel ; 
Starting the MathCAD program   
▪ download the Windows operating system ; 
▪ click on the " Start" button; 
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▪ in the “ Programs” menu item , select the “ MathSoft Apps” sub-item , 
go to the cascade submenu and select the “ Mathcad Professional ” item; 

▪ MathCAD splash screen will appear on the screen , then the MathCAD 
window . 

Before starting any calculations, it is necessary to set up the "Mathematics" 
panel in the working window , which gives the opportunity to display the signs of 
mathematical operations, symbols, operators, graph templates, etc. on the working 
field. The order of coding of basic mathematical operations using the keyboard is 
shown in Table 1. 

 
Table 1.18 

Operator Keyboard shortcuts Description 

+ <+> Addition 
- <-> Subtraction 
x <*> Multiplication 
/ < / > Division 
÷ <Ctrl>+< / > Division into one line 

■ ■ <Shift> + < 6> Exponentiation 

 <\> Square root 
n  <Ctrl>+<\> The root of the nth power 

🞤■🞤 <Shift> + < \> Module 
x i x <[> i The variable x with a subscript and 

(x) <Shift> + < 9> x <Shift> 
+ < 0> The value of x is in parentheses 

:= <Shift> + <F> Appropriation 

■ .. ■ <F> Range of values 

yi

a
b
c

=

 

y <[ > I <Shift +Ж> a <,> 
b <,> c 

Give the variable y i a series of values 
a,b,c 

x
y x( )d

d  
<Shift> + < /> in <x> The differential of the function f(x) 

with respect to x 


i

ix
 

<Shift> + < 4> x The sum of the variables x amount 
and 


b

a

dxxf )(

 
<Shift> + < 7> The definite integral 



232 
 

 <Ctrl>+ <M> Matrix 

 

<Shift> + < 2 > Display the graph template 

 
Table 1.19 

Coding menu and toolbar commands using the keyboard 
Menu Team Translation Keyboard 

shortcuts 
Description 

File 
(File) 

New Create <Ctrl>+<N> Create a new document 

 Open Open <Ctrl>+<O> Open an existing document 
 Close close <Ctrl>+<W> Close the active document 
 Save save <Ctrl>+<S> Save the active document 
 Print Print <Ctrl>+<P> Print the active document 
Edit Undo Cancel <Ctrl>+<Z> Undo the last action 
 Redo Repeat <Ctrl>+Y> Redo the last canceled 

action 
 Cut Cut out <Ctrl>+<X> Cut the selected fragment 
 Copy Copy <Ctrl>+<C> Copy the selected fragment 
 Paste Insert <Ctrl>+<V> Insert an expression from 

the buffer 
 Delete Remove <Ctrl>+<D> Delete the selected 

fragment 
 Select All To single out <Ctrl>+<A> Select the entire worksheet 
 Find Find <Ctrl>+<F> Text search 
 Replace Replace <Ctrl>+<H> Replacing some text with 

another 
View Refresh Renew <Ctrl>+<R> Update the document 
Insert Matrix Matrix <Ctrl>+<M> Insert matrix or vector 
 Function Function <Ctrl>+<E> Insert built-in function 
 Unit Units <Ctrl>+<U> Insert the units of 

measurement of the value 
of some dimension 

 Picture Picture <Ctrl>+<T> Create a picture to display 
the matrix 

 Hyperlin
k 

Hyperlink <Ctrl>+<K> Insert hyperlink 
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Customize the Math panel 
▪ in the "View" menu item , select the "Toolbars" sub-item ; 
▪ go to the cascade submenu and check the "Mathematics" item ; 
▪ open the necessary palettes of the "Mathematics" panel by pressing the left 

mouse button once on the button of the corresponding palette. 
The MathCAD mathematical environment is used for complex mathematical 

calculations, but also as a simple calculator, when calculating numerical expressions. 
Calculation of an expression in numerical form 

▪ set the cursor anywhere in the working document; 
▪ output from the keyboard or palette: the number on which the mathematical 

operation will be performed, the sign of the operation, the number, the sign of 
the operation, etc.; 

▪ to get the result, display the equals sign. 
 Example: 

( )
4333,2

440174

367
69
24573,26,24648

=
−








−+

 
As a rule, in this mathematical environment, calculations are carried out using 

the recording of mathematical operations not in numerical, but in analytical 
expressions, which significantly expands the possibilities of calculations and 
reduces the time when calculating the values of functions for given values of the 
argument. To calculate in this form, the following sequence must be followed. 

EXAMPLE No. 1 
it is necessary to obtain the values of the linear (y=a+b x ) and quadratic 

(z=a+b x +c x 2 ) functions for the values of the variable x from 1 to 5 , and plot the 
graphs of these functions in one coordinate system. 

In this case, functions are denoted by different symbols. The recording of data 
and the procedure for performing such construction in MCAD will look like this: 

  
x 1 5= a 3= b 5= c 1−=

y x( ) a b x+=

z x( ) a b x+ c x2
+=

1 2 3 4 5
0

10

20

30

y x( )

z x( )

x

y x( )
8

13
18
23
28

= z x( )
7
9
9
7
3

=
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Writing symbols and numerical values 

▪ from the keyboard or palette, output the symbol that is part of the expression and 
has a numerical value; 

▪ use the key combination “ Shift + : ” or from the Arithmetic palette to display 
the “give value” symbol, which has the form ( := ); 

▪ type the corresponding numerical value from the keyboard. 
A variable value that is included in a formula can take on values in a specified 

range with a specified step, or these values can be a set of specific numbers. 
Setting the scope of variables 

▪ output the variable symbol from the keyboard or palette; 
▪ output the "given value" symbol ( := ); 
▪ use the “ : ” key or from the Arithmetic palette to display the template “ discrete 

value range ” (m ..n) and write the initial and final value of the interval in the 
free zones; 

▪ to specify a step of a variable other than one, write the next value of the variable 
after the initial value of the interval with a comma (for example, x := 0, 0.5 ..5). 
In this case, the step of the variable will be 0.5. 

EXAMPLE No. 2 
Calculate the functional dependence y= a x 2 + b x + c and plot the graph of the 

function when the constants take the values a=3, b= -2 , c=1.5. The x variable takes 
values from 0 to 3 in steps of 0.5. The recording of data and the procedure for 
performing such construction in MCAD will look like this: 

▪  
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Specifying specific variable values 
In the case when the value of the variable cannot be presented in the form of a 
range (1...8), and it is necessary to specify their specific values, the form of their 
recording takes on a different form. For this you need: 

▪ from the keyboard or from the palette, output the letter " and ", output the symbol 
"give a value" , output the template " discrete value range " (m ..n) ; 

▪ write instead of the initial value of the interval 1, instead of the final value - a 
number that corresponds to the number of variables; 

▪ write down the symbol of the variable, use the “[” key or from the Arithmetic 
palette to create a lower index next to the variable, write the letter “ and ” in the 
free space of the index; 

▪ output the symbol “ give a value ” (:=); 
▪ from the keyboard through which to enter specific numeric values of the variable 

(they will be formatted as a table). 
Writing the expression in its general form 

▪ write the function symbol from the keyboard; 
▪ write the symbol of the variable in parentheses next to the function symbol, if it 

is specified through a range of values; 
▪ next to the function symbol, display the subscript icon and write the letter " and 

" in the index, if the variable is specified with specific values; 
▪ display the "give value" symbol; 
▪ write the expression with the symbols of constants and variables in the form in 

which they were written before, and set the signs of the corresponding 
mathematical operations between them . 
Obtaining the result of calculations 

▪ write down the symbol of the function as it was given; 
▪ output the sign (=) from the keyboard or from the palette; 
▪ the calculation result will be presented as a table. 

Construction of graphs of two-dimensional dependencies 
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▪ "Shift + 2" key combination or the mouse from the " Graphics" palette to 
display the template of the two-dimensional coordinate system; 

▪ write the symbol of the argument in the free zone under the abscissa axis; 
▪ write the symbol of the function in the free space to the left of the ordinate axis; 
▪ to construct graphs of two or more functions in one coordinate system, it is 

necessary to write down the symbols of all functions through a comma along the 
ordinate axis; 

▪ to build a graph, press the "Enter" key or click the mouse on a free space outside 
the graph field. 
Formatting graphs of two-dimensional dependencies 

▪ double-click the mouse in the graph field; 
▪ in the dialog box that appears, in the XY Axes (X–Y Axes) tab , specify the type 

of coordinate axes, the presence and density of the coordinate grid, etc.; 
▪ in the Traces tab , the drawing type, color, thickness of any of the function graph 

lines is specified using the system lists. 
Copying objects (formulas, graphs) 

To reduce the time of writing a calculation block that contains the same formulas, 
graphics or texts, it is advisable to copy them with subsequent minor formatting. 

▪ place the cursor next to the object to be copied; 
▪ select an object by dragging the cursor along its diagonal while holding down 

the left mouse button. The selected object is framed by a dashed line; 
▪ copy the selected object to the clipboard by clicking the "Copy" button on the 

toolbar ( ); 
▪ move the cursor to the place of copying the object; 
▪ insert an object from the clipboard by clicking the "Insert" button on the toolbar 

( ). 
Moving objects 

Sometimes, to ensure a defined sequence of placing operations and symbols on 
the workspace, or to organize the structure of records, it is necessary to move an 
already created object. For this: 

▪ select an object by clicking on it. It will be framed in a black frame; 
▪ set the cursor on the frame line so that it takes on the appearance of a hand; 
▪ with the left mouse button pressed, move the object to the desired place. 

Save the file 
▪ in the "File" menu item (File) select the "Save as" sub-item (Save as) - when 

initially saving the document or "Save" (Save) - when re-saving; 
▪ in the dialog box that appears, in the "Save in" ribbon , specify the name of the 

folder or disk where the file will be saved, in the "File name" ribbon , write 
down the name of the file. 
Loading a saved file 

▪ in the "File" menu item (File) select the "Open" sub-item (Open) ; 
▪ in the dialog box that appears, find and open the desired folder and select the 

desired file; 
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▪ click the "Open" button within the dialog box. 
Finishing work with "MathCAD" 

▪ close "MathCAD" by clicking on the corresponding button in the right corner 

of the menu bar ; 
 
Practical work #1 
Execution program 

1. Download the mathematical application Mathcad . 
2. Complete the following tasks. 
3. Save the created document in your own folder. 
4. Finish work in Mathcad . 
Tasks for practical work 
I. Calculate the value of the expression. Expression numbers are determined 

by the last digit of one's own option. For example, if the last number of your option 
is 15, then you choose task #5 and the next one with an odd number, namely #7. If 
your number is 8, then you choose the next one with an even number - #8 and #0, 
etc. 

Remember!  
A. When performing calculations in the MATHCAD environment with mixed 

fractions (fractions that have a whole and a fractional part), it is necessary to convert 
the mixed fraction into an improper fraction. 

For this you need: 
1) multiply the denominator of a mixed fraction by its whole part and add 

to the numerator; 
2) write the obtained result in the numerator of an improper fraction; 
3) leave the denominator unchanged. 

For example, a fraction
.

6
13

6
162

6
12 =

+
=

 
B. The action of division (:) is entered in the form of (÷) using the < Ctrl > + 

< / > key combination, which means division into one line. 

1. 

.

9
4

3
1

27
21

24
5

28
132

42
135:

84
19

13
71

6
5

2
13

52
3

31
51

24
12

18
112

12
73

−+






 +−
















 +−






 +−

 

2. 

.

2
1175,2

375,05,4
6
12

7
5:

3
134,05,2

3
131,1:

4
32

−








 +
−

−

+
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3. 

.90

5
234

3
2:6,29,88

8
71

2
12:5

8
58,0584,0


















 −−

−







−+

 

4. 

.
7
2

70
01,0:3,0

7
234

13
9375,0

3
24

15
85:

6
14

45
45

++








 +








 −

 

5. 

.
5,4

15
2

4
324:7,7

5,0:56,0
15,0
216,0

9
26:

18
13625,0

16
3

25
3288,1








 +








 +
+

−








 +

 

6. 
.

3
1

65
18

36
17

18
52

3
2:13:

4
13

5
13:2 












 −+










+
 

7. 

( )
.

25,08,12
125
48625,075,3

15
144,0

3
1

125,0
6
1

4
15,0



−
+

++

+++

 

8. 

.25,0

25
3:0345,0

4
16128,0

20
11

40
76,0725,0



−

+++

 

9. 

.
59,0

12
5

4
31125,1

6
51

45
21

6
5

−+


−

 

10. 

.5,0

401
110

11
4

30
233,1

5,2:
24
172

8
5










 ++








 +

 
II. Plot graphs of linear baxy += , quadratic , and hyperbolic 

functions xb
xay

+
+

=
: 

1) for odd numbers of options in the interval [-1;1] with a step of 0.1; 
2) for even numbers - on the interval [-2;2] with a step of 0.2. 
Coefficients a, b, c can be obtained from the following table: 

Table 1.20 
 Odd options Pair options 
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a Option number The opposite number of the option 
number 

b The opposite number of the option 
number 

A number that is the inverse of the 
option number 

c A number that is the inverse of the 
option number 

Option number 

Format the obtained graphs according to the following requirements. 
For linear dependence: 
º The symbol is a rhombus; 
º The line is dotted; 
º Color – blue; 
º Type - line: 
º Size - 2. (see Fig. 1 at the end of the task) 

For quadratic dependence: 
● The symbol is circles; 
● The line is dashed; 
● Color – green; 
● Type – line; 
● Size - 3. (see Fig. 2 at the end of the task) 

For a hyperbolic dependence: 
▪ The symbol is squares; 
▪ The line is dash-dotted; 
▪ Color – brown; 
▪ Type – trunk; 
▪ Size - 4. 

Drawings should have the form shown in fig. 1, 2 at the end of the document. 
III. Plot the graph of the function cbxay += cos  for given variable values see 

table 1.21 
Table 1.21 

H -1 -0.7 -0.6 -0.2 0 2,3 3,4 4.8 5 
Format the graph according to the following requirements: 

− Symbol - pluses; 
− The line is dotted; 
− Color – black; 
− Type - drawing 
− Size - 3. 
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Figure 1. 
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0
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y1 x( )

x   
Figure 2. 

−  
4.2. Solving systems of linear algebraic equations in Mathcad 

Record of determinants 
When developing mathematical models, there is often a need to find solutions to 

a system of equations with several unknowns, for example, two x and y: 

111 cybxa =+  
222 cybxa =+  

The solution of the system can be found by Kramer's method through the 
determinants: 




=

x
x

,  


=

y
y

, 
where: 


a1

a2

b1

b2









= x
c1

c2

b1

b2









= y
a1

a2

c1

c2









=

 
 

To record matFigs in Mathcad, you need: 
▪ write down the symbol that will denote the matrix; 
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▪ output the "give value" sign or assign, which has the form (:=); 
▪ in the "Matrix" palette , click on the corresponding icon 









; 

▪ or press <Ctrl> + <M> to call up the matrix template; 
▪ in the dialog box that appears, specify the number of rows and columns of the 

matrix; 
▪ fill the resulting matrix template with the appropriate symbols or values. 
▪ to find the inverse matrix in Mathcad, there is an Inversion operation , indicated 

on the Matrix panel by the symbol X -1 . 
Calculation of determinants 

▪ from the "Matrix" palette , display the determinant symbol by clicking on the 
icon ( ); 

▪ write in the free zone of the determinant the symbol that denotes its matrix; 
▪ output the equals sign (=). For example: 

M
7

3

8

5








= M 11=
 

Solution of the system of equations 
The solution of the system of equations with the corresponding number of unknowns 

can be carried out using the Given/Find computing unit according to the 
following algorithm: 

▪ record the data that are known and included in the expressions forming the system 
of equations; 

▪ unknown variables are given (:=) an arbitrary value, usually 0 or 1; 
▪ write down the keyword of the beginning of the computing block Given (Given); 
▪ write down the system of equations, but without the curly bracket sign; 
▪ instead of the equal sign (=), use the " Boolean equality " sign, which is located 

on the " Boolean panel " in the " Mathematics " palette; 

▪  
▪ output the matrix template in n rows and one column, where n is the number of 

unknowns; 
▪ fill the matrix with symbols of unknowns; 
▪ give the matrix a value in the form of the word Find (Find) and in parentheses 

after the word list, separated by a comma, unknown; 
▪ to find the values of unknowns, write down their symbols and write the equals 

sign (=). 
Example: find solutions of the system of equations with respect to unknowns x , 

y , z : 
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,
.872
1353
,422









=−+
=+−
=++

zyx
zyx

zyx

 
 
In MathCAD, the solution record will look like this: 

x 1= y 1= z 1=

Given

2x 2y+ z+ 4

3x 5y− 3z+ 1

2x 7y+ z− 8

x

y

z











Find x y z( )=

x 1.941=

y 0.471=

z 0.824−=  
We will find the solutions of this system by the method of determinants. 
We add the determinants: 
Δ is the main determinant consisting of coefficients near the unknown system of 

equations; 
Δx is the determinant obtained from the main determinant Δ by replacing the 1st 

column with a column of free members; 
Δу - the determinant obtained from the main determinant Δ by replacing the II 

column with a column of free members; 
Δz is the determinant obtained from the main determinant Δ by replacing the third 

column with a column of free terms. 
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Solving the system of equations by the matrix method 

 
In Mathcad the lsolve ( A , B ) function can be used to solve SLAR . It returns a 

vector of unknowns X. 
Solving a system of equations using the lsolve ( A , B ) function 

 
 

Practical work #2 
 

Execution program 
1. Download the MathCAD mathematical application . 
2. Solve SLAR by the proposed methods. Compare the obtained results. 
3. Save the created document in your own folder. 
4. Finish work in Mathcad . 
Tasks for practical work 
Solve one system of linear algebraic equations in two ways: by the 

determinant method, using the Given / Find computing block , by the matrix method, 
using the lsolve ( A , B ) function. The task number is determined by the last digit 
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of the student in the group list. 

1. 

,
.233
524
,732









=+−
−=−+

=+−

zyx
zyx
zyx

 

2. 

,
.872
1353
,42









=−+
=+−

=++

zyx
zyx

zyx

 

3. 

,
.105

163
,52









=−
=+
=+

zy
zx
yx

 

4. 








=+−
=+−
=++

.3651110
,15235
,15327

zyx
zyx
zyx

 

5. 

,
.1465

3254
,2233









−=+−
−=+−
−=+−

zyx
zyx
zyx

 

6. 








=++
=++
=−+

.9522
,42
,823

zyx
zyx
zyx

 

7. 








−=++
=+

−=++

.123
,32

,12

zyx
zx

zyx

 

8. 

,
.922
622
,322









=+−
−=−+

=++

zyx
zyx
zyx

 

9. 
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Self-test questions 
1. What are the ways to solve SLAR in Mathcad ? 
2. What dimension should the coefficient matrix of the left part of the system have? 
3. What dimension should the column vector of free members have? 
4. What dimension should the vector of unknowns have? 
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5. What are the arguments of the function lsolve(A,B)? 
6. In what form is the result of calculations displayed using the function 
lsolve(A,B)? 
7. What is the procedure for solving systems by the matrix method? 
8. What is called matrix inversion? 
9. How to inverse in Mathcad ? 
 

4. 3. Finding roots of polynomials in Mathcad 
To find all the roots of a polynomial, the built-in function polyroots ( v ) is used 

, where v is a vector consisting of the coefficients of the polynomial. Since the 
polynomial N - ro power has N roots, then the vector v must contain N +1 elements. 
The result of the action of the function p on roots is a vector consisting of N roots of 
the polynomial 

For example, for a blank look: 
f ( x )= x 4 -6 x 3 +12 x 2 - 10x + 3 
Vector v will look like: 
 
v :=(3  -1012-61) T 

 
The first term in the vector v must be the free term of the polynomial, the second 

- the coefficient at x 1 , the third - the coefficient at x 2 , etc. 
The result of root calculations: 

 
For the function polyroots one of two numerical methods can be specified: the 

Lagger polynomial method (which is set by default) and the pair matrix method. 
To choose a numerical method, perform the following actions: 

● click the right mouse button on the word polyroots ; 
● in the context menu choose: LaGuerre or Companion Matrix ( Pair 

matrix ); 
● click with the mouse outside the scope of the function polyroots ; 
● provided that the automatic calculation mode is enabled, the polynomial 

roots will be recalculated automatically in accordance with the selected 
method; 

● when setting the AutoSelect flag ( Автоматический выбор ) MathCAD 
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will choose the calculation method independently. 
 

Practical work No. 3 
Execution program 

1. Download MathCAD mathematical processor . 
2. Find the roots of the polynomials given in the task. 
3. Save the created document in a personal folder. 
4. Exit MathCAD. 

Tasks for practical work 

f ( x ) = 25 x 4 - 14 x 3 + 7 x 2 + 32 x – 87 ; 

f (x) = 16 x 3 - 11 x 2 +7 x -8 ; 
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;231632)( 234 ++−+= xxxxxf  

;15125)( 234 ++−+= xxxxxg  
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Self-test questions 

1. MathCAD's built-in feature used to find the roots of a polynomial? 
2. What elements does the vector v consist of? 
3. How to set the type of numerical method by which the polyroots function will 
operate ? 
4. What method is used to calculate roots by default? 
5. How to set the mode of automatic selection of the calculation method? 
6. What calculation method does MathCAD use? in auto select mode? 

4.4. Solving systems of nonlinear equations 

For solving systems of nonlinear equations in MathCAD, there is a special 
calculation block, which consists of three parts, which are used sequentially one after 
the other: 
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■ Given - keyword; 
■ a system of equations written using logical operators; 
■ Find ( x 1 ,... x M ) - a built-in function for solving a system of equations with 

respect to variables x 1 ,...x M ; 

Boolean toolbar to insert logical operators (Boolean operators). The logical equals 
sign can also be displayed using the < Ctrl > and <=> key combination. Block Given 
/ Find uses iterative methods to find a solution, so in this case, as for the function 
root , it is required to set initial approximations for all roots x 1 ,... x M Even before 
using the Given keyword . The value of the Find function is a vector consisting of 
solutions for each variable. The number of vector elements is equal to the number 
of arguments of the Find function . 

 

Practical work no 4 
The goal of the work: to master the tools of MathCAD for solving systems of 

nonlinear equations 
Execution program 

1. Download MathCAD mathematical processor . 
2. Solve the systems of equations given in the task. 
3. Check the correctness of the found variable values. 
4. Save the created document to a personal folder. 

Tasks for practical work 

3. Solve systems of nonlinear equations: 

вибираються функції для представлення 
рівнянь системи 
задаються початкові наближення змінним 
вводиться ключове слово обчислювального блоку 
вводяться рівності з використанням логічного знаку 
рівності 
використовується вбудована функцій Find для 
розв'язування системи рівнянь 
виводиться вектор шуканих значень 
обчислюються значення функцій із шуканими 
значеннями змінних перевірка правильності 
розрахунків 
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Self-test questions 

1. What MathCAD tool is used to solve systems of nonlinear equations? 
2. What is the sequence of writing a computing unit? 
3. What equals sign is used when introducing the system of nannies ? 
4. What numerical method is used to solve the system of equations? 

4.5 . Solving problems of linear programming in the environment 
MathCAD 

In order to carry out effective research and production operations, it is 
necessary to be able to determine the optimal ratio between the costs of resources 
and the obtained economic effect. Linear programming is effectively used for this 
purpose. The main goal of linear programming is to determine the optimal allocation 
of resources from the position of the selected criterion under the given restrictions. 
Typical examples of the use of this method in agriculture are: allocating land for 
crops, making decisions about the types and rates of applying mineral fertilizers, 
planning labor costs and equipment needs, etc. Using the MathCAD package allows 
you to efficiently carry out similar calculations. 

The process of mathematical formulation of the problem and its solution is 
illustrated by the following example. 

Example. The farmer needs to determine the amount of manure and complex 
mineral fertilizers to feed a pasture of 20 hectares so that the total cost of applied 
fertilizers is minimal. But at the same time, 75 kg/ha of nitrogen, 25 kg/ha of 
phosphorus and 35 kg/ha of potassium should be applied. Productivity of labor when 
applying manure can be 8 t/hour, and complex fertilizer - 0.4 t/hour with time 
resources for performing this work 25 hours. 

The cost and chemical composition of fertilizers are given in the table. 
 
Fertilizers PFig 

UAH/t 
Chemical composition, kg/t 
nitrogen phosphor

us 
potassiu

m 
Manure 25 6 1.5 4 
Complicate

d 
fertilizers 

1300 250 100 100 

 
To form a problem according to the scheme of linear modeling, it is necessary 

to define three main elements of the model, namely: unknown variables, objective 
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function and restrictions on the values of unknown variables. 
 

1. Unknown variables 
The task of the farmer is to determine the amount of manure and complex 

fertilizer. Therefore, we denote by: 
X 1 - amount of manure,  
X 2 - the amount of complex fertilizers. 

2. Objective function 
The goal of the farmer is to minimize the total cost of applied fertilizers. 

Manure costs him 25 hryvnias. per ton, and complex fertilizers - UAH 1,300 each. 
per ton The full cost can be given as:  

2 5 ∙ X 1 + 1300 ∙ X 2 
If we denote the full cost by Z, then the objective function that must be 

minimized can be written in the form: 
Z = 25 ∙ X 1 + 1300 ∙ X 2 

3. Calculation 
Limitations on the values of variables are determined, firstly: by agrotechnical 

requirements regarding the minimum doses of fertilizers and by the farmer’s 
decision on nitrogen (75 kg/ha), phosphorus (25 kg/ha) and potassium (35 kg/ha) 
standards and, secondly : time resource (25 hours). 

Let's first consider the restrictions on nitrogen 

application rates. 1 ton of manure contains 6 kg, and 1 ton of 

combined fertilizers contains 250 kg of nitrogen, that is, 

manure contains 6 ∙ X 1 kg in total, and combined fertilizers 

contain 250 ∙ X 2 
kg of nitrogen. 

Thus, the total amount of nitrogen that is applied per pasture is 6 ∙ X 1 

+ 250 ∙ X 2 and this total amount should not be less than 1500 kg, since the minimum 
application rate is 75 kg/ha, and the land area is 20 ha. Taking into account the above, 
nitrogen restrictions are recorded as: 

6 ∙ X 1 + 250 ∙ X 2 ≥ 1500 
Phosphorus restrictions are recorded similarly: 

5 ∙ X 1 + 100 ∙ X 2 ≥ 500 
and potassium restrictions: 

4 ∙ X 1 + 100 ∙ X 2 ≥ 700 
Time limits will be written in the form: 
1/8 ∙ X 1 + 1/0.4 ∙ X 2 ≤ 25 
or 
X 1 + 20 ∙ X 2 ≤ 200 

Special requirements 
The objective function and constraints that are defined for this example are 

given by linear equations, that is, they do not contain variables to a power higher 
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than 1, or a product of variables. They are deterministic, since the coefficients for 
variables and constraints are constant values. The unknown variables X 1 and X 2 
cannot acquire negative values, since the introduction of a negative amount of 
fertilizers does not make physical sense. This means that the non-contradiction 
condition is removed, i.e 

X 1 ≥ 0, X 2 ≥ 0 
In addition, X 1 and X 2 under the specified restrictions can take on any values, 

which means that the continuity condition is fulfilled. 
 
Solving linear programming problems 

▪ write down the approximate values of the unknowns (as a rule, the symbol of 
the unknown quantity is given the value 1); 

▪ record the objective function; 
▪ write down the keyword of the beginning of the computing block Given 

(Given); 
▪ write equations (inequalities) of restrictions, on the 

values of variables, using signs (≥, ≤) instead of the 

equal sign (=); 
▪ display the matrix template in one column and n rows, where n is the number 

of unknowns; 
▪ fill the matrix with symbols of unknowns; 
▪ give the matrix a value in the form of a word: Minimize - to find the unknowns 

that would minimize the function, or Maximize - to find the values of the 
unknowns that would maximize the function; 

▪ in parentheses after the word enter the symbol of functions and unknowns 
through a comma; 

▪ to find the values of unknowns, write down their symbols and output the 
equals sign (=). 
An example of solving the given problem in MathCAD will look like: 
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The result of the calculation shows that in order to minimize the costs of 

feeding the lye, it is necessary to apply 111.1 tons of manure and 3.3 tons of 
combined fertilizers, spending 7111 hryvnias. 

 
Practical work No. 5 

The goal of the work: to learn how to find solutions to linear programming 
problems in order to determine optimal solutions 

Execution program 
1. Download MathCAD mathematical environment . 
2. Build a mathematical model based on the problem given in the task: write down 

the objective function and the system of unknown constraints. 
3.  Find unknowns using minimize or maximize functions . 
4. Solve linear programming problems by choosing the option by number in the 

group list. 
5.  Save the created document in your own folder. 
6.  Finish work with MathCAD . 

 
Task to practical work 

Determine the optimal areas for sowing winter wheat and barley to ensure the 
maximum gross collection of grain in the farm. 630 hectares of arable land are 
allocated to crops, and no more than 400 hectares to barley. It is planned to spend 
no more than 6,700 man-days on carrying out all agrotechnical measures for growing 
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crops. Labor costs and average yield of crops are shown in the table. 
 

 Cultures 
 
Winter wheat 
Barley 

 
Labor costs, (person-days)/ha 
15 
7 

 
Average yield, tons/ha 
35 
23 
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Self-test questions 
1. What is the order of problem formation according to the linear programming 

scheme? 
2. What is the order of recording the computing block for solving linear 

programming problems in MathCAD ? 
3. What keywords are used when solving the objective function? 
4. In what cases are the names of the Minimize functions written down and 

Maximize ? 
 

4.6. Finding the extremum of a function of one variable 
The tasks of finding the extremum of a function include the search for its 

maximum (largest) or minimum (smallest) values in some area of the definition of 
arguments. The values of the arguments can be limited by some interval, which is 
described in the form of a system of inequalities and equations. In this case, they 
search for an extremum in the area of limiting arguments and call its conditions the 
extremum . In addition, the problems of finding the local and global extrema are also 
distinguished. There can be several local extrema, global - there can be one. To find 
the global extremum, you must first find all the local ones, and then choose the 
largest (smallest) value from them. 

The point x 0 is called the point of the local maximum (or minimum) of the 
function f ( x ) if there exists such a neighborhood 0<| x - x 0 |< δ points x 0 , which 
belongs to the domain of the function, and for all x from this area, the inequality f ( 
x )< f ( x 0 ), or f ( x )> f ( x 0 ). Points of local minimum or local maximum are called 
points of local extremum, and the value of the function at these points is called local 
minimum, or local maximum, or local extremum, respectively. 

The concept of an extremum is local in the sense that the inequality f ( x )< f ( 
x0 ) or f ( x )> f ( x 0 ) may not be fulfilled for all values of x from the domain of the 
function, but it must be fulfilled only in some neighborhood of the point x 0 . The 
local maximum should not be confused with the largest value of the function that it 
can acquire in the domain of definition (it is also called the absolute maximum). 
There can be several local maxima, the absolute maximum can be only one. This 
applies to local and absolute minima. 

 
Finding a local extremum 
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To solve problems of finding local minimum and maximum in MathCAD uses built-
in functions Minimize and Maximize , which can be used both within the computing 
unit and autonomously: 

Minimize ( f , x 1 ,...,x m ) is a vector of values of the arguments for which the function 
f reaches a minimum; 

Maximize ( f , x 1 ,...,x M ) - a vector of values of the arguments for which the function 
f reaches its maximum; 

(f, x 1 „...,x m ) - function; 

x 1 ,...,х m - arguments by which the function is minimized/maximized. 

To all function arguments f pre-assigned some values. 

Consider examples of finding the extremum of a function on the interval from - ∞ 

to + ∞, since no additional restrictions on the value of the arguments are introduced. 

Example 1 

 

 
A function is defined. 
An initial approximation of the argument is given. 
The minimum of the function is found. 
A different initial approximation of the argument is given. 
The minimum of the function is found for the new value of the argument. 

Example 2 

задається функція 
задається початкове наближення аргументу 
знаходиться мінімум функції 
задається інше початкове наближення 
аргументу 
знаходиться мінімум функції для нового  
значення аргументу 

Задається функція 
Задається початкове наближення аргументу 
Знаходиться максимум функції 
Задається інше початкове наближення 

аргументу 
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1. A function is defined. 
2. An initial approximation of the argument is given. 
3. The maximum of the function is found. 
4. A different initial approximation of the argument is given. 
5. The maximum of the function for the new value of the argument is not found 

because the initial approximation went beyond the boundaries of the local 
extremum. 
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Finding the conditional extremum 

In conditional extremum problems, the minimization and maximization functions 
must be included in the computational block, that is, they must be preceded by a 
keyword Given . Logical expressions (inequalities, equations) are written after 
the keyword with the help of Boolean operators, which set limits on the values of 
the function's arguments. 
Example 3 

 
Example 4 

 
Example 5 

 
 
Practical work no 6 
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The goal of the work: to master MathCAD tools for finding the extremum of a 
function of one variable 

Execution program 
1. Download MathCAD mathematical processor . 
2. Find the extrema of the functions given in the task. 
3. Save the created document in a personal folder. 
4. Exit MathCAD. 

Tasks for practical work 

1. Find the local extrema of the functions: 

1якщо,234)(
1якщо,13106)(

1якщо,3117)(

245

234

34

−=+−+=

−=+−+=

=−+=

xxxxxf
xxxxxf

xxxxxf

 

4. Find the conditional minimum of the function 

100,2342)( 245 +−+= xxxxxf  

5. Find the conditional maximum of the function 

03,2342)( 245 −+−+= xxxxxf  

Self-test questions 

1. What is the conditional extremum of a function? 
2. What are the local and global extrema of a function? 
3. What tools MathCAD are used to find the local extremum of a function? 
4. What is the sequence of actions when using functions Minimize and Maximize 

to find the local extremum of a function? 
5. What tools are used to find the conditional extremum of a function? 
6. What is the difference between finding a local extremum and finding a 

conditional extremum of a function? 

4.7. Finding the extremum of a function of several variables 
Many phenomena and processes of nature, science, technology and 

production can be described by functions that depend on several independent 
variables. 

A function of several (for example, two) independent variables is the 
unique correspondence of each pair of real numbers ( x 1, x 2 ) from the set X 12 to 
a single real number y from the set Y . Analytically, this correspondence is written 
as follows: y = f ( x 1 ,x 2 ) 
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or  z = f ( x , y ).  
The set X 12 is called the domain of the function, and the set Y is called the 

domain of the function. The domain of the function is a part of the plane that is 
bounded by a closed curve (the curve itself may or may not belong to the domain). 

For example, the domain of the function 2
2

2
1

2 xxay −−= is determined 

from the condition .0 22
2

2
1

2
2

2
1

2 axxxxa +−−   або  So, the domain of the function 
is a circle of radius and 

The graph of the function z = f ( x, y ) of two variables is constructed in a 
three-dimensional Cartesian coordinate system with the ordinate z and the 
abscissa x, y . The graph of the function z = f ( x, y ) has the appearance of some 
surface. The level line of the function z = f ( x, y ) is called the line f ( x, y ) = c 
= const on the X0Y plane, at the points of which the function z assumes a constant 
value c . For example, the lines of the level of the function z = x 2 + y 2 are 
concentric circles x 2 + y 2 = с ( с  > 0). 

Functions from three u = f ( x , y , ) and more y = f ( x 1 , x 2,…, x n )  it is 
impossible to represent variables graphically, since it is impossible to imagine a 
material space with a dimension of more than three. But for a function of three 
variables  
u = f ( x , y , z ) you can introduce the concept of a level surface. The surface of 
the level of the function  
u = f ( x, y, z ) is called the surface f ( x, y, z ) = с , at the points of which the 
function assumes a constant value u = c . For example, the surfaces of the function 
level u = x 2 + y 2 + z 2 there is a family of spheres x 2 + y 2 + z 2 = c . 

At the point ( x 0 , y 0 ) the function z = f ( x, y ) has an extremum (maximum, 
minimum) if its value at this point z = f ( x 0 , y 0 ) and any other point ( x , y ) 
satisfy the conditions 

),(),( 00 yxfyxf  in case of maximum, 
),(),( 00 yxfyxf  in the case of a minimum. 

At the point of extremum ( x 0 , y 0 ) partial derivatives are equal to zero: 

0),(,0),( 0000 =



=





y
yxf

x
yxf

  
. 

These equalities are a necessary condition for an extremum, and the points 
at which the partial derivatives are equal to zero are called stationary. 

If the discriminator 

,0)],([),(),( 2
000000

2 −=−= yxfyxfyxfBAC xyyx   
then the function at the point ( x 0 , y 0 ) has a maximum at A > 0 or C < 0. 

If the discriminant is less than zero, then there is no extremum at the point ( x 0 , 
y 0 ). These conditions are sufficient conditions for the existence or absence of an 
extremum. 
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In the case of functions of many independent variables, the concept of a 
conditional extremum is introduced. For a function of two independent variables 
z = f ( x, y ) the conditional extremum is the extremum of this function, which is 
reached under the condition that the variables x i y are connected by the 
corresponding equation φ(x, y ) = 0 (connection equation). 

Finding the conditional extremum is reduced to the study of the usual 
extremum of the Lagrange function 

Z = f ( x , y ) + λ φ( x , y ) , 
where λ is an undefined constant factor. Then the necessary condition for 

the extremum will be reduced to a system of three equations: 
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To find the extreme values of a function in a closed region, it is necessary 

to calculate the stationary points located in this region and the values of the 
function at these points; find the extreme values of the function on the boundary 
line of the region; choose the largest and smallest of all found values. 

 
Finding the extremum of a function of several variables in Mathcad 

The rules for finding the extremum of a function of several variables in Mathcad 
are fundamentally no different from finding the extremum of a function of one 
variable. 

Example 1. 

 

Example 2. 
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Graphic representation of example 2. 

 
For graphic interpretation (example 2), perform tabulation of functions and 

construction of graphics. For this, the limits of changing the arguments are set 
and a table of function values is obtained. Since the function is from two 
arguments, a surface template is chosen for construction. To give the graph this 
look, call the context menu of the surface (double-click at any point of the graph) 
and adjust the corresponding parameters. 
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Practical work no 7 

The goal of the work: to master MathCAD tools for finding the extremum of a 
function of several variables 

Execution program 
1. Download MathCAD mathematical processor. 
2. Find the extrema of the functions given in the task. 
3. Save the document in a personal folder. 
4. Complete work with MathCAD. 
 
Tasks for practical work 

1. Find the largest and smallest value of a function 
22 yxz −= in a circle

.422 + yx  
2. Find the largest M and the smallest t value of the function xyz = in the 

circle .122 + yx  
3. Find the largest M and the smallest t value of the function 

ххуyxz 422 −−+= in a closed region bounded by straight lines ,0=х  
,0=у  .01232 =−+ ух  

4. Find the largest M and the smallest t value of the function хуyxz ++=

in the square bounded by straight lines ,1=х  2=х  ,2=у  .3=у  
5. Find the largest M and the smallest t value of the function 

( )ухyxz +++= sinsinsin in the rectangle
,

2
0 

 х
 

.
2

0 
 у

 
Self-test questions 

1. What is the mechanism for finding the extremum of a function of two variables 
in MathCAD ? 
2. In what cases is the built-in Given function used ? 
3. How to set the interval for finding the extremum? 
4. Do I need to specify an initial approximation? 
5.  What can be the reason for not finding the extremum of the function in the 
given interval? 
 

4. 8 . Finding limits of sequences, functions in Mathcad 
Definition The number a is called the limit of the ordered variable x if for 

any sufficiently small number ε> 0 there exists a value x such that εthe condition 
is fulfilled for all subsequent values of x 



263 
 

− ax .          (1) 
It is denoted as follows: 

lim x = a , or x → a 
(read: "the limit of the value of x is equal to a ", or " x goes to a "). 

The symbol "lim" is an abbreviation of the Latin word "limes" - "border". 
The very term "boundary" was introduced by I. Newton. 

The geometric content of the concept of borders. WITH inequality (1), we 
get : 

| x – a | <ε ⇔– ε< x – a <ε ⇒ a – ε< x < a + ε. 
Therefore, if lim x = a , then no matter how 

small the number ε> 0 , there will be such a value 
of x ε, starting from which all subsequent values of 

the quantity x fall into εthe vicinity of the point a (fig.). 
Definition A variable αis called infinitely small if its limit is zero 
lim α= 0. 
If αis an infinitesimally small value, then according to the definition of the 

limit, for arbitrary ε> 0 there exists such a value αεstarting from which αthe 
condition | α| < ε, or – ε< α< ε, that is, all values of the variable, starting with αε, 

fall into εthe neighborhood of point O (Fig. 4). 
Definition A variable x is called infinitely large 

if , for any sufficiently large number M > 0, there exists 
such a value x M , starting from which the inequality holds for all subsequent 
values 

| x | > M. 
It is denoted as follows: 

=xlim or →x  
(read: "the limit of x is equal to infinity", or " x goes to infinity"). 

Geometrically, the fact that x is an infinitely large value means that starting 
from x M for all subsequent values of the variable one of the inequalities will hold 

x > M or x < – M , 
that is, all values of variable x , starting with x M , will be outside the interval 

]– M , M [ of the numerical axis. 
Among infinitely large values, positive and negative infinitely large values 

are distinguished. 
If, starting from a certain value, all subsequent values of an infinitely large 

quantity x are positive (negative), then the quantity x is called a positive ( 
negative ) infinitely large quantity and it is defined as follows: 

or  

( )
( ).

,limlim
−→+→

−=+=
xx

xx

 
Definition A number a is called the limit of a numerical sequence { x n } if 

for any number ε> 0 there exists a number N such εthat for all numbers n > N εthe 

 Рис. 
 

 Рис  4 
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inequality holds 
− axn . 

It is denoted as follows: 
axnn

=
→

lim
. 

If the sequence { x n } has a limit a , then it is called convergent. Such a 
sequence is said to converge to a . 

A sequence that has no limit is called divergent. 
The geometric meaning of the fact that the number a is the limit of the 

sequence { x n } is as follows: εno matter how small the neighborhood of the point 
a is taken, all values of x n , starting from some number n ( n > N ε), fall into this 
neighborhood ( only a finite number of members of the numerical sequence can 
remain outside this circle). 

Finding limits in the Mathcad mathematical application 
To find boundaries in the " Mathcad " application, you need to perform the 

following actions: 
1) select the border template on the Calculus (Calculations) panel (see fig.); 
2) enter the expression for finding the limit, the variable and the number to 

which it is directed in the free spaces; 
3) on the Symbols panel , press the corresponding symbol → ; 
4) press the Enter key and get the result; 

 
Remember! Trigonometric functions in MathCAD have the following 

form: 
● acos(z) — arccosine; 
● acot(z) — cotangent; 
● acsc(z) is the arc cosecant; 
● angle(x,y) — the angle between the point (x,y) and the OX axis; 
● asec(z) — arcsecant; 
● asin(z) is arcsine; 
● atan (z) — arctangent; 
● atan2(x,y) is the angle counted from the OX axis to the point (x,y); 
● cos(z) — cosine; 
● cot(z) is the cotangent; 
● csc(z) is the cosecant; 
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● sec(z) — sequence; 
● sin(z) — sine; 

● tan(z) is the tangent; 
o z is a function argument ( it MUST be written in parentheses). 

Practical work No. 8 
The goal of the work: to master the MathCAD tools for finding the limits of a 
function 

Execution program 
1. Download the MathCAD mathematical application . 
2. Complete the given task. 
3. Save the created document in your own folder. 
4. Finish work in Mathcad . 
Tasks for practical work 
Calculate the limits of functions by the option number in the group list 

using Mathcad . 
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4. 9 . Derivative and finding it in Mathcad 
Definition of the derivative and its meaning 
Let the function y = f ( x ) is defined and continuous in some interval [ a , 

b ], and let the values x and x + x belong to this interval. 
Definition The derivative of the function y = f ( x ) at the point x is called 

the limit of the growth ratio of the function Δy = Δf ( x ) at this point to the growth 
of the argument Δx that caused this growth, if Δx goes to zero and this limit exists. 

To denote the derivative function y = f ( x ) use different symbols: 

( ) ( ) ( )
dx

xdf

dx

dy
yfyxyxf xx ,,   ,,,, 

. 
So, by definition 

x

xfxxf

x

xf

x

y
xf

xxx 

−+
=




=




=

→→→

)()(
lim

)(
limlim)(

000 .   (1) 
The physical content of the derivative. 
Let s = s ( t ) be the equation of rectilinear motion. The speed v ( t ) of 

rectilinear movement at time t is the derivative of the distance traveled s ( t ) by 
time t , i.e. 

)()( tstv =  
The mechanical content of the derivative. 
Let m = m ( l ) be the mass of a material thread of variable length l . The 

linear density ρ( l ) of a material thread at a distance l from its end is a derivative 
of the mass of the thread m ( l ) along the length l , i.e. 

ρ( l ) = m ′( l ) 
The geometric content of the derivative. 
Let y = f ( x ) is the equation of the curve. Angular coefficient tg αthe 

tangent drawn to the curve at a point with the abscissa x is the derivative of the 
function f ( x ) by variable x : 

tg α= f ′( x ) 
In general, if the function y = f ( x ) describes some process, then the 

average speed of this process (change in y compared to x ) on the segment Δx can 
be considered the expression: 

x

y
vC




=

, 
and the speed of the process at a given value of x is a derivative of the function 

y by x , i.e 

)(limlim)(
00

xy
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y
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x
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x
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
==

→→ . 
From the definition of the derivative (1) follows the rule (method) of its 

finding . 
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The rule for finding the derivative. 
Let y = f ( x ) is a continuous function on [ a , b ] and a < x < b . To find the 

derivative y = f  ( x ) required: 
1. Find the value of the function at the point x : f ( x ). 
2. Give x an increment of Δx and find the value of the function at the point  

x + Δx : f ( x + Δx ). 
3. Find the increment of the function: 

Δy = f ( x + Δx ) – f ( x ). 
4. Find a relationship 

x

xfxxf

x

y



−+
=



 )()(

. 
5. Find the limit of this ratio at Δx →0 (if it exists, then it will be the sought-

after derivative), i.e 

x

xfxxf

x

y
xyxf

xx 

−+
=




==

→→

)()(
limlim)()(

00 . 
Finding derivatives in Mathcad 

Using the symbol menu to find derivatives 

 
1) Select the variable by which the integration is performed; 
2) Go to the menu Symbols → Variables → Integrate ; 
3) Below the result will appear under the expression . 
 
Using the Calculus panel to calculate derivatives 
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1) select the key for finding the indefinite integral on the Calculus 

(Calculations) panel (see figure); 
2) enter the variable on which the integration will take place and the 

corresponding expression in the blanks; 
3) on the Symbols panel, press the corresponding symbol → ; 
4) press the Enter key and get the result; 
 
Finding derivatives of higher orders and partial derivatives 

 
1) select the differential finding key on the Calculus panel (see figure); 
2) enter the variables, the order of the derivative, and the expression for 

differentiation in the appropriate places; 
3) on the Symbols panel, select the corresponding symbol → ; 
4) press the Enter key and get the result 
 
Practical work No. 9 

The goal of the work: to master MathCAD tools for finding derivatives 

Execution program 
1. Download MathCAD mathematical processor . 
2. Find the derivatives of the functions given in the task. 
3. Save the created document in a personal folder. 
4. Exit MathCAD. 
 

Tasks for practical work 
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Self-test questions 

1. What methods for finding the derivative exist in Mathcad ? 
2. What are the features of entering functions in Mathcad ? 
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4. 10. Numerical methods of differentiation 
Calculation of derivatives of higher orders 

The second derivative of the function y=f ( x ) is called the derivative of 
the first derivative, which is denoted as follows: 

.)( 2

2








===
dx
dy

dx
d

dx
ydyy

   
Since the derivative is the rate of change of the function, the second 

derivative is the rate of change of the rate of change of the function or the 
acceleration of the function. 

The third derivative is a derivative of the second derivative: 
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The derivative of the nth order of the function y = f ( x ) is called the 

derivative of the derivative of the ( n-1 ) order: 
( ) ( ) .)( 1

1
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To calculate the derivative of the function f ( x ) For the Nth order at the 

point x, you perform the same actions as when calculating the derivative of the 
first order, except that the template is selected The Nth derivative is entered from 
the palette or from the keyboard using the <Ctrl>+ <?> key combination . This 
template additionally contains a placeholder for entering a number N. Before 
using the differentiation operator , the function argument must be given the value 
for which the derivative will be calculated. 

When calculating derivatives, a fairly complex and accurate algorithm is 
used, which allows you to perform calculations with an accuracy of 7-8 decimal 
places, which implements Ridder's numerical method, which does not depend on 
the value of the built-in constant TOL . 

Derivatives of higher orders are also calculated using Ridder's method, and 
when the order of the derivative is increased by one order, the accuracy of 
calculations decreases by approximately one digit. 
Calculation of partial derivatives 

In contrast to the function of one variable, the concept of partial derivatives 
is introduced for the function of many variables. 

The partial derivative of the function of many variables y = f ( x 1 , x 2,..., x n 
) with respect to the independent variable x and ( и= 1,2,...n) is called a finite 
boundary 

.
x
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→   
Similarly, the partial derivative with respect to y is found . 
Thus, the partial derivatives are the instantaneous rates of change of the 

function y = f ( x 1 , x 2,..., x n ) when one of the arguments x and and constant values 
of all other n - 1 independent arguments. 
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Partial derivatives of higher orders (for example, the second) are 
determined by the formulas: 
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If the derivative ki xxy , exists in the vicinity of the point ( x 1 , x 2 ,..., x n ) and 

is continuous at this point, and the derivative ik xxy , exists at this point, then 
.,, ikki xxxx yy =  

When calculating partial derivatives, the rules regarding the sum, product, 
fraction, etc. are also used. 

When finding the partial derivative z′ x, the ordinary derivative of the 
function of one variable x is calculated , considering the variable u as a constant. 
When finding the derivative z ′ y variable x is considered constant . 

 
Calculation of the derivative of the second order numerically (=) and 

symbolically (→). 

 
Examples of symbolic and numerical calculation of partial derivatives in 

Mathcad . 



277 
 

 



278 
 

Practical work #10 
The purpose of the work: to master the numerical methods of differentiation 
using the tools of the MathCAD mathematical processor 
 

Execution program 
1. Download MathCAD mathematical processor . 
2. Find the derivatives of the functions given in the task. 
3. Save the document in a personal folder. 
4. Complete work with MathCAD 

 
Tasks for practical work 

1. Find the partial derivatives of the first order for each independent variable 

1. .184222 +−−+−= уххуyxz  

2. .206922 +−+−+= уххуyxz  

3. .10322 22 +−−= хyxуz  

4. ( ) .4 22 yxухz −−−=  

5. .1 22 yxz +−=  

6. .2 2244 ухухyxz −−−+=  

7. .2 3 22 ухz +−=  

8.
.

1 xy
yxarctgz

−
+

=
   

9.
.2

2

x
yz =

 

10.
.ln

x
yxz =

   
2. Find second-order derivatives of functions 

1. .xyez =      2 . .ln 22 yxz +=  
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3. 
.32

yx
yxz

−
+

=
    4 .

.
22 yx

xyz
+

=
 

5. .22 3223 yхуyxхz +++=   

6. .432234 yхуухyxхz ++++=   

7. x
yz

2cos
=

  
Self-test questions 

1. What is the differentiation of a function ? 
2. What means are used to find derivatives of higher orders in Mathcad ? 
3. What is the difference between numerical and symbolic methods of 

calculating derivatives in Mathcad ? 
4. How to find partial derivatives in Mathcad ? 
 

4.11. Numerical methods of integration 
Integration is the inverse operation to differentiation, when performing 

which a function is found based on a given derivative or differential. 
Let f ( x ) be the derivative of the function F ( x ) ( f ( x ) = F΄ ( x )) for all 

values of x in some interval, and let f ( x ) dx be its differential ( df ( x ) = f ( x ) 
dx ). 

The function F ( x ) is called the primitive function f ( x ) or the differential 
f ( x ) dx . Finding the original function is an integration operation. 

If the function f ( x ) has a primitive F ( x ), then all other functions of the 
form  
G ( x ) = F ( x ) + c (c is a constant value) will also be primitive, since the 
derivatives of the left and right sides of the equality are the same, that is, G ΄ ( x 
) = F ΄ ( x ). 

The general form of the original function for the differential f ( x ) dx  is 
called the indefinite integral and is denoted as follows: 

 += ,)()( CxFdxxf  
where f ( x ) dx is the integrand expression, f ( x ) is the integrand function, 

x is the variable of integration. 
Let the function y = f ( x ) be continuous on the interval [ a , b ] , which we 

divide into n  parts 
the average value of the function on the intervals ∆ x i by f ( x i ). Then the 

area of the curved trapezoid S is approximately equal to the sum of the areas of 
the rectangles 
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which when ∆ x i decreases (∆ x i → 0, n → ∞) will approach the real area. 

This limit is called a definite integral, i.e 

.)(lim)(
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xxfdxxf
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Since f ( x ) dx = dF ( x ) , then 

.)()()()( 0 cxFxFxdFdxxf
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a

b
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+=== 
 

the constant c from the condition that at x = a the area F ( x ) = 0. 
0 = F 0 ( a ) + c , 
c = -F 0 ( a ), 
F ( x ) = F 0 ( x ) – F 0 ( a ). 
Then the area F ( b ) is equal to 
F ( b ) = F 0 ( b ) - F 0 ( a ). 
Thus, to calculate the integral 

( ) ( ) ( ) ( ) −==
b

a

b
a aFbFxFdxxf 00

, 
it is necessary to take the difference of the initial values in the upper and 

lower limits of integration. The expression is called the Newton-Leibnitz formula. 
Mathcad tools for defining integrals 
Calculation of integrals in Mathcad is carried out by selecting the 

appropriate template located in the Calculus (Calculations) panel. 

 

After entering the symbol, the integrand and the variable of 
integration are entered in the placeholders. To get the result, enter the equal sign 
(=) or symbolic equality (→) followed by pressing the Enter key . In the first case, 
the integration will be carried out numerically, in the second – symbolically. 

Finding integrals is possible using the Symbols menu . 
For this you need: 
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1) enter the integral function as an expression without using the integration 
sign and without dx; 

2) single out the variable by which the integration is performed (most often 
only x ); 

3 ) go to the menu Symbols → Variables → Integrate ; 
4 ) the result will appear below the expression. 

 
Specifying the accuracy of calculations 
The result of numerical integration is not the exact, but the approximate 

value of the integral, determined with an error that depends on the value of the 
built-in constant TOL . The smaller it is, the more accurately the integral will be 
calculated, but more time will be spent on calculations. By default, TOL =0.0001. 
In order to speed up the calculation, set a larger TOL value . By default, Mathcad 
independently selects the calculation algorithm, based on the analysis of the limits 
of integration, the type of integrand function, etc. In this case, the AutoSelect 
option is set (Automatic selection ) . The user can choose the numerical 
integration algorithm independently. For this purpose, the following actions are 
performed: 

⮚ Call the context menu on the left side of the integral being calculated; 
⮚ In the context menu, choose one of four numerical algorithms: 

o Romberg (Romberga) – for most functions without features; 
o Adaptive (Adaptive) – for functions that quickly change on 

the integration interval; 
o Infinite Limit (Infinite limit ) – for integrals with infinite 

limits; 
o Singular Endpoint - a modified Romberg algorithm for 

functions undefined on one or both limits of integration. 
 

 
Practical work #11 

The goal of the work is to master the numerical methods of integration 
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using the tools of the Mathcad mathematical processor . 
Execution program 

1. Download the mathematical application Mathcad . 
2. Calculate the integrals from the task with the calculation accuracy set by 

default. 
3. Set the value of the system constant TOL =0.01, repeat the calculation. 
4. Compare the obtained results. 
5. Check which calculation algorithm is installed in the math processor by 

default. 
6. Save the created document in your own folder. 
7. Finish work in Mathcad . 
 

Tasks for practical work 
1. Calculate indefinite integrals 

1.
.

1

4

 −
dx

x
x

 

2.
.

12

4

 +x
dxx

 

3. 
.

)1( −xx
dx

  4. 
.

)1( +xx
dx

 5.
.

)1)(32( +− xx
dx

 

6. 
.

1
1

2

2

 −
+ dx

x
x

  7. 
.

1072 +− xx
dx

 8.
.

1032 −+ xx
dx

  

9. 
.

94 2 −x
dx

  10. 
.

32 2 − x
dx

  11.
.

4)1( 2 +−x
dx

  

12. 
.

322 ++ xx
dx

 13. 
.

5,22 −− xx
dx

  14.
.

544 2 ++ xx
dx

 

15. 
.

)32(1 2
+− x

dx

 16. 
.

34 2
−− xx

dx

 17.
.

968 2
−+ xx

dx

 

18. 
.

962 2
−− xx

dx

19. 
.cos2 dxx   20. .sin 2 dxx   21. 

.
cos1 − x
dx

22. 
.

sin1 + x
dx

  23. 
.

cos1
cos1 dx

x
x

 +
−

  24. 

.
sin1
sin1 dx

x
x

 −
+

25. .)( 42 dxxtgxtg +   
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26 . 
.

11 ++ x
dx

  27. 
.

)2(
34

2 −
+ dx

x
x

  28.
.

1 +xx
dx

 

29. 
.

1

3

 −x
dxx

  30.
.

2
1 dx

xx
x

 −
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3 
2. Calculate definite integrals 

1. 

1

0

.ln dxxх
  28. 

.1cos

2

0
32



х
dx

х  3.
.

2

0
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dxctgx
 

4. 
.

sin

4

0
2



x
xdx

  5. 
.

25
55

0
2 − х

dx

  6.
.
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4

2
2 −− хх

dx

 

7. 

.
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3
2

3
1

2 −хх
dx

 8. 
.

4
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Self-test questions 
 

4.12. Programming of linear algorithms using MathCAD function 
programs 

implement one or another calculation algorithm in MathCAD in two ways: 
▪ using appropriate operators or functions directly in the text of the MathCAD 

document . This method is called programming in the text of the document 
; 

▪ using so-called function programs, which contain constructions similar to 
the constructions of the programming languages Pascal , Fortran : "assign 
value" operators, loop operators, conditional operators, etc. This method is 
called programming in a function program . It includes two stages: 
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o description of the program-function; 
o program-function call. 

Using program functions 
Before using the function program, it must be specified, that is, described. 

The description of the program-function in the working document is placed 
before its call and contains: the name of the program-function, a list of formal 
parameters (which may not be present), and the body of the program-function. 

Each function program has an original name by which it is called. Due to 
this name, the result of executing the function program is "returned" to the 
working document. 

The name of the function program is followed by a list of formal parameters 
enclosed in parentheses. Through formal parameters, the data required for 
calculations are transferred inside the function program. Names of simple 
variables, arrays, and functions can be used as formal parameters. Formal 
parameters are separated from each other by a comma. A program-function may 
not have formal parameters, and then data is passed through the variable names 
defined above the description of the program-function. 

The body of a program-function can include any number of statements, 
local "assign value" statements, conditional statements and loop statements, as 
well as other program-functions and user functions. 

Sequence of program-function description 
To enter a description of the function program into the working document, 

perform the following actions: 
▪ enter the name of the function program and the list of formal parameters; 
▪ enter the character ":", ":=" will be displayed on the screen. 
▪ open the Programming panel and press the Add button line . A vertical 

dash and a vertical column with two input fields for entering statements that 
form the body of the function program will appear on the screen. 

▪ if there are more operators, the number of input fields is added by pressing 
the button again Add line 

▪ an additional input field is added below the currently highlighted operator; 
▪ the entered operator or input field, if necessary, can be removed by placing 

it between the input cursor and pressing the Delete key . 
▪ fill the lower input field with the expression that determines the result. 

To give a value to a variable in the middle of the program, use the local 
operator "give value": the name of the ←value variable. Using the regular 
operator ":=" in the body of a function program results in a syntax error. 

 Reference to the function program 
To execute a function program, you need to refer to its name with a list of 

actual parameters. The actual parameters indicate for which specific values the 
calculations in the body of the program are performed. Actual parameters are 
separated by a comma. Between the actual and formal parameters there should be 
a correspondence in number, sequence and type. The latter means: 
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▪ if the formal parameter is a simple variable, then the actual parameter can 
be a constant, a variable, an arithmetic expression; 

▪ if the formal parameter is a vector or matrix, then the actual parameter must 
be a vector or matrix. 

▪ if the formal parameter is the name of a built-in function or other program, 
then the actual parameter must be the same object. 
The reference to the program-function must be after the description of the 

program-function and the actual parameters must be defined before the reference. 
The names of the actual parameters when calling the function program may 

not coincide with the names of its formal parameters. 
Programming in the function program of linear algorithms 

 A computing process in which the necessary operations are performed 
strictly sequentially is called a linear algorithm. The operators that implement this 
algorithm in the body of the function program are also arranged sequentially and 
are all executed, starting from the first and ending with the last. 
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Enter the description of the function program
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The program 1dd has four parameters. The parameter 1sig specifies the sign 

before the square root. If 1sig =1, then we get the root 1x , if 1sig =-1, then 2x . 
The program implements a linear algorithm and all operators are always 

executed strictly sequentially. 
Practical work #12 
Purpose of 

work : 
acquiring practical skills in programming linear 

algorithms 
 

Execution program 
1. MathCAD mathematical processor . 
2. Write function programs for solving the equations given in the task. 
3. Save the document and send it for review. 
4. Exit MathCAD . 

Tasks for practical work 
1. Develop a function program and find the roots of the equation that describes 

the dependence of phosphorus concentration in the soil on the time of 
bioremediation . 



286 
 

Let the concentration of phosphorus Y in oil-contaminated soil depend on 
the time of bioremediation X is described by the equation: 

44,930766,10035,0 2 +−= XXY . 
It is required to determine the period of time after which the concentration 

of phosphorus in the soil will be equal to the value that was before the ecological 
disaster, namely: 135 mg/kg. That is, it is required to solve the following 
equation: 

13544,930766,10035,0 2 =+− XX , or 013544,930766,10035,0 2 =−+− XX : After 
reduction, we have: 056,410766,10035,0 2 =−− XX . 
2. Develop function programs and find the roots of equations: 
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 Questions for self-control 

1. What are the ways to implement the calculation algorithm in MathCAD ? 
2. What are the rules for using program functions? 
3. What does the description of program functions consist of? 
4. Is it necessary to set formal parameters? 
5. What are the methods of transferring data to a function program? 
6. What is the sequence of the program-function description? 
7. How to add an additional field for entering an operator in the body of a 

function program? 
 

 
4.13. Programming branched algorithms using MathCAD function 

programs 
In branched algorithms, there are several branches of computational 

processes. The choice of a specific branch depends on the fulfillment or non-
fulfillment of the specified conditions on the values of the algorithm variables. 

 if function and the conditional operator are used for programming 
branched algorithms . Using the specified constructions, you can change the 
sequence of execution of operators. New concepts can be used in these 
constructions. 

Expressions of relations . These expressions are used to compare two 
arithmetic expressions with each other. Expressions of relations are written in the 
form: 

<Expression A> <Relation sign> <Expression B>. Signs of relationships can 
be the following symbols: = . If the given relation is fulfilled, then the 
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expression of the relation takes the value 1 ( true ), if not, then 0 ( false ). Unlike 
programming languages, it is possible to check several conditions at once in one 
expression by adding relational signs and arithmetic expressions. 

Logical operations . Two logical operations are defined, which are applied 
between expressions of relations. 

Logical OR operation . It is denoted by the sign "+" and written in the form: 
<Log.expression1> +<Log.expression2>. The result is 0 if both Boolean 
expressions are 0 and is 1 for the rest of the Boolean expression values. 

Logical operation I. It is denoted by the sign "*" (in the text it is a dot) and 
written in the form: <Log.expression1> .<Log.expression2>. The result is 1 if 
both logical expressions are equal to 1 and equal to 0 for the rest of the values of 
the logical expressions. 

Logical expression . A logical expression is a construction consisting of 
relational expressions, signs of logical operations, and parentheses. The value of 
the logical expression is calculated from left to right, taking into account the well-
known rule about the priority of operations. List of priorities in descending order: 

▪ parenthesis; 
▪ logical operation I; 
▪ logical OR operation. 

Conditional function and f . The function is written in the form: 
And f (< logical expression >, < arithmetic expression1>, < arithmetic 

expression2>). 
If the logical expression =1, then the function will accept the value of 

the arithmetic expression1, if the logical expression =0, then the function 
will accept the value of the arithmetic expression2. 

An example . 
For most populations, there are restraining factors, and for one reason or 

another, cell growth stops. In this case, until the nutrient medium is exhausted, 
cell growth occurs according to the exponential law, and then, for some time, it 
remains unchanged. In the general case, the growth model under the condition of 
depletion of the nutrient medium has the form: 
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, 
where t f – the time of exhaustion of the nutrient medium; 
x – initial number of cells; 
t – observation time; 
r is const . 
 The growth rate calculation algorithm contains two branches, the choice of 

which depends on the time of depletion of the nutrient medium. That is, the 
calculation algorithm contains a logical condition : if the time of observation is 
less than or equal to the time of depletion of the nutrient medium, then the growth 
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rate is calculated according to the formula: trex  , if less, then  according to the 

formula ftrex 
 . 
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An example of solving a problem by means of MathCAD  
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The initial number of cells 

 
The time during which depletion of the nutrient medium occurs 

 
Observation time 

 
The body of the function program 

  

 
 
 

  

  

 
The result of calculations by the function program 
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The graph of the function x(t) at f =25 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

Practical work #13 
 
Purpose of work 

: 
acquiring practical programming skills of branched 

algorithms 
Work execution program 

1. MathCAD mathematical processor . 
2. Write a function program to solve the problem given in the task. 
3. Save the document and send it for review. 
4. Exit MathCAD . 

Task 
The dependence of the rate of biochemical transformation of substances on 

water temperature in predictive calculations is determined by the formulas: 
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, 
where 20k - the value of the coefficient of non-conservativeness of the 

substance at 20 0 C, 1/day; T is water temperature, ° C . 
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Task options: 
1) 20k =0.07 1/d; T= 1..10 about C ; 
2) 20k =0.0 8 1/d; T= 1..10 about C ; 
3) 20k =0.0 9 1/d; T= 1..10 about C ; 
4) 20k =0, 1 1/d; T= 1..10 about C ; 
5) 20k =0.15 1 /d; T= 1..10 about C ; 
6) 20k =0.2 1 /d; T= 1..10 about C ; 
7) 20k =0.25 1 /d; T= 1..10 about C ; 
8) 20k =0.3 1 /d; T= 1..10 about C ; 
9) 20k =0.4 1 /d; T= 1..10 about C ; 
10) 20k =0.07 1/d; T= 1..10 about C ; 

 
Questions for self-control 

8. What are the ways to implement the calculation algorithm in MathCAD ? 
9. What are the rules for using program functions? 
10. What does the description of program functions consist of? 
11. Is it necessary to set formal parameters? 
12. What are the methods of transferring data to a function program? 
13. What is the sequence of the program-function description? 
14. How to add an additional field for entering an operator in the body of a 

function program? 
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SECTION 5. MS DATABASE MANAGEMENT SYSTEM ACCESS  
 
MS Access desktop databases are quite diverse. Access databases can be 

used to store and track any information, including inventory, contacts, or business 
processes. This section describes how to create Access desktop databases, add 
data to them, and configure and use the created databases. 

 
5.1. The main window and menu of MS DBMS Access  

Before starting work with DBMS and creating a database, consider the 
main elements of the MS Access window. 

 
Fig. 5.1 – The main window of MS Access 2016 DBMS. 

1. Save the database. Standard icon for all MS programs Office , which allows 
you to quickly save changes made to a file. 

2. Using controls from the Quick Access Toolbar. You can quickly add 
controls to a form or report, or modify existing controls, by clicking the tools 
icon when the form or report is open in markup or design view. 

3. Obtaining a certificate . Click on the question mark to view the help content. 

4. Hiding the menu bar . Click the up arrow to hide the ribbon and leave only 
the tabs. 



293 
 

5. Launching dialog windows . If an icon is displayed next to any group of 
menu ribbon commands, that group contains additional hidden 
options. Click on the icon to access additional features available to the group. 

6. File management. The database can be opened, closed, printed, shared, 
saved as previous versions or chalons, encrypted, compressed, or restored. 

7. Mode button (View, depending on the translation of the interface). To switch 
from one mode (view) of the current object to another, click the Mode button 
. The down arrow under the button will reveal a list of available views for the 
current object. 

8. Sorting objects. Specify sorting criterion (by object type, by connections, by 
creation date, by editing date) and a filter label by groups depending on the 
selected filtering criterion. 

9. Object filtering. Enter a keyword in the search field to filter objects in the 
database. 

10. Status bar. Displays information about the current object. 

MS Access 2016 DBMS menu bar 
bar is located under the title bar in which the commands are located: 

FILE - MAIN - CREATE - EXTERNAL DATA - DATABASE TOOLS 
FILE - create, open, save a document, finish work. You can also view the 

properties of the database, compress or restore it, manage users and access , set 
the database password. 

 
Fig. 5.2 – MS Access 2016 database properties window. 

MAIN - to select the mode (view) of the current object , install a filter and 
sort, work with records (creation, saving, deletion), search for the required 
information, format text. 
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Fig. 5.3 - The "Main" menu of the MS Access 2016 DBMS. 

CREATION - using the designer or wizard to create tables, queries, forms, 
reports and macros. 

 
Fig. 5.4 - MS Access 2016 DBMS "Create" menu. 

EXTERNAL DATA - import data from Excel , Access , ODBC database 
, text file, XML file, etc. Save import options . Export data in a variety of formats 
or send it by e-mail. 

 
Fig. 5.5 - "External data" menu of MS Access 2016 DBMS. 

DATABASE TOOLS – compress or restore a database, open the Visual 
editor Basic , execute a macro, create a data schema, analyze the dependence of 
objects and rapid actions or table structures, split the database into two files, call 
the manager of add-ons or button forms. 

  
Fig. 5.6 - The "Database tools" menu of the MS Access 2016 DBMS. 

 
5.2. Access template information 

If you need to organize and manage your data in Access, but don't want to 
spend time building a database from scratch, you can use the classic database 
template. 

An Access template is a file that, when opened, creates a complete database 
application with the built-in tables, forms, reports, queries, macros, and 
connections you need to get started. Because templates are designed as end-to-
end database solutions, they save you time and effort and get you up and running 
with your database right away. Once you create a database using a template, you 
can customize it to suit your needs, just like a database created from scratch. 
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Selecting a template 
Access templates include ready-to-use built-in tables, queries, forms, and 

reports. As soon as you start Access, a number of available templates are 
displayed. More patterns can be found online. 

  
Fig. 5.7 – MS Access 2016 DBMS template selection window. 

1. In Access, choose File > New . 
2. Select the desktop database template and enter the name of the database in 

the File name field. (If there is no suitable template, use the Find 
Online Templates field). 

3. To save, you can use the default location shown under the File name field 
, or click the folder icon to choose a new location. 

4. Click the Create button . 

  
Fig. 5.8 – Creation of a new database in MS Access 2016 DBMS. 
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Depending on the template, you'll need to do one of the following to get 
started. 

● If Access displays the Sign In dialog box with an empty list of users, do 
the following. 

a. Select the New User item . 
b. User Information form . 
c. Select Save and Close . 
d. Select the username you just entered and click the Login button . 

● Security Warning message in the Access message bar and you trust the 
source of the template, click the Enable Content button . If the database 
requires re-login, log in again. 
  



297 
 

5.3. Creating a database from scratch . 
 

If no template meets your needs, you can create a new desktop database. 
1. In Access, choose New > Empty Desktop Database . 
2. In the File name field , enter a name for the database. 
3. To save, you can use the default location shown under the File name field 

, or click the folder icon to choose a new location. 
4. Click the Create button . 

 
Adding a table 
In a database, information is stored in several related tables. Here's how to 

create a table. 
1. When you first open a database, the tabular view of the data will display 

an empty table to which you can add data. To add another table, go to the 
Create tab and click the Table button . Data can be simply entered into 
an empty field (cell) or inserted from another source, such as an Excel 
workbook. 

2. To rename a column (field), double-click the column header and type a 
new name. 
Advice. Choose meaningful names so you know what each field contains 

without looking at its contents. 
1. On the File tab , select Save . 
● To add more fields, enter data in the Click to add column . 
● To move a column, select it by clicking the column header, then drag it to 

the desired location. You can also select multiple adjacent columns and 
drag them together to a new location. 
Copy and paste data 
You can copy and paste data from other programs, such as Excel or Word, 

into an Access table. It is most convenient to do this if the data is divided into 
columns. If the data is in a word processing program such as Word, use commas 
to separate the columns or convert the data to a table before copying. 

1. If the data needs to be edited, such as separating first and last names, do so 
in the source program. 

2. Open the data source and copy the data ( Ctrl+C ). 
3. Open the Access table to which you want to add data in the data table 

window and paste the data ( Ctrl+V ). 
4. Double-click each column header and enter meaningful names. 
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5. Select File > Save and give the new table a name. 
Note. In Access, the data type for each field is set based on the data added 

to the first row of each column, so make sure that the data in 
subsequent rows matches the data in the first row. 

Import or link to data 
You can import data from other sources or link to data from Access without 

moving the information from where it is stored. Linking is convenient to use 
when multiple users update data at the same time and you need to always see the 
latest version, or you need to save storage space. For most formats, you can 
choose the way you want to add data: import or link. 

The import process may vary slightly depending on the source, but the 
instructions below will help you get started. 
1. On the External Data tab , select the data format to import or link. If the 

desired format is not displayed, click the Advanced button. 
2. Follow the instructions in the Get External Data dialog box . 

  
Fig. 5.9 – Importing or linking with data in the MS Access program. 
Note. If the desired format is still not available, you may need to first export 

the data to a file format supported by Access (for example, a 
delimited text file). 

During binding, some data formats are read-only. Below are the external 
sources from which data linking or importing is supported. 

Table 5.1. 
List of data formats of external sources for linking or importing data. 
Data formats Importation Binding 
Microsoft Excel Yes Yes (read only) 
Microsoft Access Yes Yes 
ODBC databases such as SQL 
Server 

Yes Yes 
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Text files or comma-separated 
data (CSV) files 

Yes Yes (only adding new 
records) 

SharePoint list Yes Yes 
XML Yes  
Data Services  Yes (read only) 
HTML document Yes Yes 
Outlook folder Yes Yes 

 
Organizing data using a table analysis tool  
You can use the table analysis wizard to quickly identify redundant data. 

Using the wizard, you can easily organize data into separate tables. The original 
table is saved as a backup copy. 

1. Open the Access database with the table you want to analyze. 
2. On the Database Tools tab, click the Analyze Table button . 
The first two pages of the wizard contain a quick guide with examples. If 

the Show intro pages check box is displayed, select the check box and click the 
Back button twice to view the intro. If you no longer want to see the introduction 
pages, clear the Show introduction pages check box. 

 
Further actions 
The rest of the design process depends on what you need to do. You will 

most likely need to create queries, forms, reports, and macros. Listed below are 
topics with useful information to read before creating a database: 

● General information about tables  
● General information about requests  
● Creating an Access form  
● General information about reports in Access  
● Data protection through backup and recovery processes  

 
5.4. General information about tables in MS Access . 

 
Tables are important objects in a database because they contain all the 

information or data. For example, a business database might contain a Contact 
table that stores vendor names, email addresses, and phone numbers. This article 
provides an overview of tables in Access. Before creating tables, determine what 
tables you might need and what your requirements are. 

A relational database, such as an Access database, usually has several 
related tables. In properly designed databases, each table stores data on a specific 

https://support.office.com/uk-ua/article/%D0%97%D0%B0%D0%B3%D0%B0%D0%BB%D1%8C%D0%BD%D1%96-%D0%B2%D1%96%D0%B4%D0%BE%D0%BC%D0%BE%D1%81%D1%82%D1%96-%D0%BF%D1%80%D0%BE-%D1%82%D0%B0%D0%B1%D0%BB%D0%B8%D1%86%D1%96-78ff21ea-2f76-4fb0-8af6-c318d1ee0ea7
https://support.office.com/uk-ua/article/%D0%97%D0%B0%D0%B3%D0%B0%D0%BB%D1%8C%D0%BD%D1%96-%D0%B2%D1%96%D0%B4%D0%BE%D0%BC%D0%BE%D1%81%D1%82%D1%96-%D0%BF%D1%80%D0%BE-%D0%B7%D0%B0%D0%BF%D0%B8%D1%82%D0%B8-a9739a09-d3ff-4f36-8ac3-5760249fb65c
https://support.office.com/uk-ua/article/%D0%A1%D1%82%D0%B2%D0%BE%D1%80%D0%B5%D0%BD%D0%BD%D1%8F-%D1%84%D0%BE%D1%80%D0%BC%D0%B8-Access-5d550a3d-92e1-4f38-9772-7e7e21e80c6b
https://support.office.com/uk-ua/article/%D0%97%D0%B0%D0%B3%D0%B0%D0%BB%D1%8C%D0%BD%D1%96-%D0%B2%D1%96%D0%B4%D0%BE%D0%BC%D0%BE%D1%81%D1%82%D1%96-%D0%BF%D1%80%D0%BE-%D0%B7%D0%B2%D1%96%D1%82%D0%B8-%D1%83-%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D1%96-Access-e0869f59-7536-4d19-8e05-7158dcd3681c
https://support.office.com/uk-ua/article/%D0%97%D0%B0%D1%85%D0%B8%D1%81%D1%82-%D0%B4%D0%B0%D0%BD%D0%B8%D1%85-%D0%B7%D0%B0-%D0%B4%D0%BE%D0%BF%D0%BE%D0%BC%D0%BE%D0%B3%D0%BE%D1%8E-%D0%BF%D1%80%D0%BE%D1%86%D0%B5%D1%81%D1%96%D0%B2-%D1%80%D0%B5%D0%B7%D0%B5%D1%80%D0%B2%D0%BD%D0%BE%D0%B3%D0%BE-%D0%BA%D0%BE%D0%BF%D1%96%D1%8E%D0%B2%D0%B0%D0%BD%D0%BD%D1%8F-%D1%82%D0%B0-%D0%B2%D1%96%D0%B4%D0%BD%D0%BE%D0%B2%D0%BB%D0%B5%D0%BD%D0%BD%D1%8F-96539a81-5984-4d56-99ca-ee81f8d6356c
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topic, such as employees or products. The table consists of records (rows) and 
fields (columns). Fields contain different types of data, such as text, numbers, 
dates, and hyperlinks. 

 
Fig. 5.10 - Table mode in MS Access. 

1. Record - contains certain data, for example, information about a specific 
employee or product. 

2. Field – contains data about one aspect of a table subject, such as a name 
or email address. A field is also commonly called a column or attribute. 

3. Field value – each record has a field value. For example, Contoso , Ltd. 
or abc@example.com . 

 
Properties of tables and fields 
The characteristics and behavior of tables and fields are defined and 

controlled by properties. Table properties are set in the table properties window, 
for example, to define the way the table is displayed by default, you should set 
the table property Default View . A field property defines an aspect of the field's 
behavior. Field properties can also be set in design mode using the Field 
Properties area . Each field has a data type that determines the type of 
information stored in it. For example, data types are multiple lines of text or a 
currency. 

Connections of tables 
Although each table contains data on a separate topic, tables in a relational 

database such as Access store data on related topics. For example, a database may 
contain: 

● customer table, which contains the names of the company's customers and 
their addresses; 

● a table of the items you sell, including pFigs and images for each item; 
● an order table that tracks customer orders. 

To link data stored in different tables, you should create relationships. A 
relationship is a logical combination of two tables with common fields. 

Keys 
Fields used to link tables are called keys. A key usually consists of one 

field, but can also consist of several fields. There are two types of keys: 
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● Primary Key – A table can have only one primary key. The primary key 
consists of one or more fields - unique identifiers of each record stored in the 
table. Access automatically assigns a unique identification number that acts as a 
primary key. 

● Foreign Key – A table can also have one or more foreign keys. A foreign 
key contains values that match the primary key values of another table. For 
example, suppose there is an Orders table in which each order has a customer ID 
corresponding to an entry in the Customers table. The Customer ID field is a 
foreign key to the Orders table. 

Correspondence of values in the key fields forms the basis of table 
connections . A table relationship is used to combine data from related tables. 
Suppose you have two tables: "Customers" and "Orders". In the "Clients" table, 
each record is determined by the primary key field (identifier). 

To associate each order with a customer, add a foreign key field to the 
Orders table that corresponds to the ID field in the Customers table, and then 
create a relationship between the two keys. When adding a record to the Orders 
table, you should use the customer ID value from the Customers table. So, if you 
need to look up any information about a customer, you use a relationship to 
determine which data from the Customers table matches the desired records in 
the Orders table. 

 
Fig. 5.11 - The relationship between the tables displayed in the Relationships window. 

1. The primary key is indicated by a key icon next to the field name. 
2. External key. Note: The key icon is missing. 

 
Advantages of using connections 
Storing data separately in linked tables provides the following advantages: 
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● Consistency. Because each data item is recorded only once in a single 
table, there is less chance of ambiguity or inconsistency. For example, a 
customer's name is stored only once in the customer table, and not multiple times 
(and possibly inconsistently ) in the order table. 

● Efficiency. Writing data to one location means that less disk space is used. 
In addition, it is usually faster to find data in small tables than in large ones. In 
the end, if you do not use separate tables for different subjects, the tables will 
have an excessive amount of data and Null values (absence of data). Both lead to 
wasted disk space and reduced performance. 

● Intelligibility. Database layout is easier to understand if subjects are 
properly separated between tables. 

Adding a table to a local database 
You can create a table by creating a new database, inserting a table into an 

existing database, or importing or linking to a table from another data source, 
such as a Microsoft Office Excel workbook, a Microsoft Office Word document, 
a text file, a Web service, or another database. When a new empty database is 
created, a new empty table is automatically inserted into it. So you can enter data 
into it to start defining fields. 

Creating a new table in a new local database 
1. On the File tab , choose New > Empty Desktop Database . 
2. In the File name field , enter the file name of the new database. 
3. To save the database to a different location, click the folder icon. 
4. Click the Create button . 
A new database will open with a new table named "Table1". Rename the 

table according to the type of data it will store. 
Creating a new table in an existing database 
1. On the File tab , click Open , and then click the desired database if 

it appears in the Recents list . If it does not appear in this list, select one of the 
browser options to find the required database. 

2. On the Create tab, click the Table button . 
A new table will be added, which will open in a tabular data window. 
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Fig. 5.12 - Creating a table using the "New" menu in MS Access. 

 
The structure of the not yet filled table can be edited both in tabular mode 

(table view) and in designer mode. 

 
Fig. 5.13 - Table designer mode in MS Access 2016. 

The picture shows a screenshot of a database design interface. A table named "Таблиця1" is 
selected, and its fields are visible. The fields include "Ідентифікатор" (Identifier), 

"Антонумерація" (Autonumber), and "Опис (необов'язково)" (Description (optional)). 
 
External data 
The database can be linked to various external data sources, such as other 

databases, text files, and Excel workbooks. When an external data relationship is 
created, Access can use it as a table. Depending on the external data source and 
the relationship method, you can edit the data in the linked table and create 
relationships that span that table. However, the external data layout cannot be 
changed using this connection. 



304 
 

 
Creating a table by importing and linking 
A table can be created by importing or linking to data stored in another 

location. You can import or link to data that resides in an Excel sheet, in a 
Windows SharePoint Services list , in an XML file, in another Access database, 
in a Microsoft Office Outlook folder, and so on. 

 
Fig. 5.14 - Data import in MS Access 2016. 

Importing data creates a copy of the data in a new table in the current 
database. Subsequent changes to the data source do not affect the imported data, 
and changes to the imported data do not affect the data source. After you connect 
to a data source and import data from it, you can use it without connecting to the 
data source again. You can also change the layout of the imported table. 

When a data link is established, a linked table is created in the current 
database that maintains a persistent link to existing data stored in another location. 
If you change the data in the linked table, it will also change in the source. If the 
data changes in the source, the changes are also reflected in the linked table. When 
using a linked table, you must ensure a persistent connection to the data source. 
You cannot change the layout of a linked table. 

Note. You cannot change data on an Excel sheet using a linked table. 
Instead, import the data from the source into an Access 
database, and then connect to that database in Excel. For more 
information about connecting to Access in Excel, see Excel 
Help. 

 
 
 
Create a new table by importing or linking to external data 
1. On the External Data tab , in the Import and Binding group , 

select one of the available data sources. 
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2. Follow the instructions that appear in the dialog boxes for each step. 
A new table is created and displayed in the navigation area. 
 
Creating a table using a SharePoint site 
You can create a table in your database that will import data from or be 

linked to a SharePoint list. You can also create a new SharePoint list using the 
built-in template. 

1. On the New tab , click SharePoint Lists , and then do one of the 
following: 

2. Create a SharePoint list based on a template  
a. Select Contacts , Tasks , Questions , or Events . 
b. In the Create New List dialog box , enter the URL of the SharePoint site 

where you want to create the list. 
c. Enter the name of the new list and its description in the Enter a name for 

the new list and Description fields . 
d. To open the linked table after it is created, select the Open list after 

completion check box (set by default). 
3. Create a new custom list  
a. Click Custom . In the Create New List dialog box , enter the URL of the 

SharePoint site where you want to create the list. 
b. Enter the name of the new list and its description in the Enter a name for 

the new list and Description fields . 
c. To open the linked table after it is created, select the Open list after 

completion check box (set by default). 
4. Import data from an existing list  
a. Select Existing SharePoint List . 
b. In the Get External Data dialog box , enter the URL of the SharePoint 

site that hosts the data you want. 
c. Select the Import source data into a new table in the current database 

radio button and click Next . 
d. Select the check box next to each SharePoint list you want to import. 
5. Create a link to an existing list  
a. Select Existing SharePoint List . 
b. In the Get External Data - SharePoint Site dialog box , enter the URL 

of the SharePoint site that contains the list you want to connect to. 
c. Select the Connect to data source by creating a linked table radio 

button and click Next . 
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d. Select the check boxes next to the SharePoint lists you want to link to. 
 
Creating a table using a web service 
You can create a table in your database that will connect to data on a 

website with a web service interface. 
Note. Web service tables are read-only. 
1. On the External Data tab , in the Import and Binding group , 

click Advanced , and then click Data Services . 
2. If the required connection is already established, go to step 5. 

Otherwise, continue with the next step. 
3. Click the Set up a new connection button . 
4. Select the desired connection file and click OK . 
5. In the Create Web Services Data Connection dialog box , expand 

the desired connection. 
6. Fields will appear on the right side of the Access dialog box. 
7. If necessary, enter the name of the linked table in the Specify link 

name field . Access will use this name for the linked table in the navigation pane. 
8. Click the OK button . A linked table will be created in Access. 
Assign table properties in a local database for desktop systems 
You can set properties to apply to the entire table or to all records. 
1. Select the table where you want to set the properties. 
2. On the Home tab, in the View group , click the View button , and 

then click Designer . 
3. On the Design tab, in the Show or Hide group, 

select Property Sheet. 
4. In the properties window, select the General 

tab . 
5. Click the box to the left of the property you want to set and enter the 

desired option for it. To view a list of table properties, select Available table 
properties . 

6. Press Ctrl+S to save changes. 
Table 5.2. 

A list of table properties in MS Access and a description of their use. 

Table property Using 
Display a view on a 
SharePoint site 

Used to determine whether table-based views can be displayed on 
a SharePoint site. 

data table is expanded Used to expand all subtables after opening a table. 
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The height of the data 
subtable 

Do one of the following: 
● if you want the subtable window to expand to display all rows, 

leave this property at 0"; 
● to control the height of the subtable , enter the desired height 

in centimeters. 

Orientation Used to set the display orientation according to the direction of 
reading the language: left-to-right or right-to-left. 

Description Description of the table. It will appear in the table tooltips. 

Default view Used to set the Table View , PivotTable , or PivotChart view as 
the default view when the table is opened. 

Check rule Used to enter an expression that must be true each time a record is 
added or modified. 

Verification text 
Used to enter the message that will be displayed if an entry 
conflicts with an expression in the Validation Rule property 
field . 

Filter Used to specify conditions to display only matching rows in the 
tabular data view. 

Location for Used to select one or more fields to define the default sort order 
for rows in a tabular data view. 

The name of the data 
subtable 

Used to specify whether the subtable should be displayed in the 
tabular data view window, and if so, to specify the table or query 
that will provide the rows for the subtable . 

Link main fields 
Used to list in a table or query the fields that are used for a subtable 
and that correspond to the Link main fields property specified 
for the table . 

Link child fields It is used to list the fields in the table that correspond to the Link 
Child Fields property specified for the table . 

Filter when loading 
It is used to automatically apply the filter conditions in the Filter 
property (by setting it to Yes ) when the table is opened in the 
tabular data view window. 

Order of location in case 
of download 

It is used to automatically apply the sorting conditions in the 
Arrange by property (by setting it to Yes ) when the table is 
opened in the tabular data view window. 

Advice. Press Shift+F2 to open the help field for entering or editing the 
parameter value in the property field. The Scale window will 
appear . 

If an expression is defined for the Validation Rule property and you need 
help creating it, click the button next to the Validation Rule property field to 
display the Expression Builder window . 

Adding a field to a table in a local database 
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Each data item to be tracked is stored in a field. For example, the fields 
"Last name", "First name", "Phone number" and "Address" are created in the 
contact table. The "Product name", "Product code" and "PFig" fields are created 
in the product table. 

Before creating fields, try to break the data into its smallest significant 
components. Over time, it will be much easier to combine data than to separate 
it. For example, instead of the field "P.I.B." It is worth creating separate fields 
"Surname", "First name" and "Patronymic". This will allow you to easily search 
or sort data by first name, last name, or both. If you plan to use the data element 
for reporting, sorting, searching, or calculation purposes, place it in a separate 
field. For more information about database construction and field creation, see 
link in section. 

After you create a field, you can also set field properties to control its 
display and behavior. 

In Access, you can create a new field by entering data in a new column in 
the data table window. When you create a field by entering data in a tabular data 
view, Access automatically assigns a data type to the field based on the data you 
entered. If other types of data cannot be entered for the value, Access sets the data 
type to text, but the data type can be changed. 

Add a field using data entry 
When you create a new table or open an existing table in the data table 

window, you can add a field to it by entering data in the Click to add table 
column. 

 
Fig. 5.15 - Entering data into a column Click to add . 

To add a new field, do the following. 
1. Create or open a table in the data tabular window. 
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2. In the Click to add column, enter the name of the field you want to create. 
Enter a descriptive name so the field can be easily recognized. 

3. Enter the data in the new field. 
Setting field properties 

After creating a field, you can set its properties. This will allow you to control its 
display and behavior. 
For example, setting field properties provides the following options: 

● control the display of data in the field; 
● avoid entering incorrect data in the field; 
● specify the default value for the field; 
● speed up the search and sorting of data in the field. 

Some of the available field properties can be set while working in the data 
tabular window. However, to access the field's properties and define a complete 
list of them, you need to switch to designer mode. 

Setting field properties in the data tabular window 
While working in the tabular data view window, you can rename a field and 
change its data type, Format property , and some other properties. 

● Opening the table in the data tabular window . In the navigation area, 
right-click the table and in the context menu, select the Tabular data 
window item . 

● To rename a field, do the following. When you add a field by entering 
data in a data table window, Access automatically assigns a common name 
to the field. The first new field will be named "Field1", the second new 
field will be named "Field2", etc. By default, the field name is used as its 
label whenever the field is displayed, such as a table column header. To 
make fields easier to use when viewing or editing records, give fields more 
descriptive names. 

● Right-click the header of the field you want to rename (for example, 
"Field1"). 

● In the context menu, select the Rename field item . 
● Enter a new name in the field header. 

Field names can be a maximum of 64 characters (letters or numbers), including 
spaces. 

Change the data type of a field 
When a field is created by entering data in a data table view, Access 

examines the data to determine the appropriate data type for the field. For 
example, if you enter 01/01/2006 , Access will interpret the data as a date and set 
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the field to Date and Time. If Access cannot determine the data type for sure, it 
defaults to a text data type. 

The data type of the field depends on what other field properties can be set. 
For example, for a field with a data type of Hyperlink or Memo, you can only set 
the Append Only property . 

You may need to change the data type of the field manually in some cases. 
Suppose there are room numbers that resemble dates, such as "10/2001". If you 
enter 10/2001 in the new field in the data tabular window , the automatic data 
type detection function will select the data type "Date and Time" for the field. 
Because room numbers are signatures, not dates, they should be assigned a text 
data type. To change the data type of a field: 

1. Go to the Fields tab . 
2. In the Formatting group, in the Data Type list , select the desired data 

type. 

 
Fig. 5.16 - The Data Type and Formatting menu in MS Access 2016. 

Changing the field format 
In addition to determining the data type of a new field, Access can also set 

the Format property of a field based on the data you enter. For example, 
entering "10:50" would define the data type as "Date/Time" and set the Format 
property to "Average Time Format". To manually change the Format field 
property, follow these steps: 

1. On the ribbon, click the Field tab . 
2. In the Formatting group, in the Formatting list , select the desired 

format. 
Note. Depending on the data type of the field, the Formatting list may not 

be available for some fields (for example, for text). 
Setting other field properties 

1. In the data tabular window, select the field for which you want to set the 
property. 
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2. On the Field tab, in the Formatting group , select the desired properties. 

Setting field properties  
The calculated field is created in the designer mode. 

● Open the table in the designer mode in which you need to create a 
calculated field. In the navigation area, right-click the table and select 
Design Mode from the context menu . 

● Change the data type of a field Find the name of the field for which you 
want to set the data type, select the Data type box , and then select a data 
type from the list. 

● To set other field properties, do the following . In the table layout grid, 
select the field for which you want to set properties. In the Field 
Properties area, enter the required settings for each property. Press Ctrl+S 
to save changes. 
Note. The properties that can be set depend on the data type of the field. 

Tables in Access web apps 
The Access client enables developers to create and modify tables that will 

be stored on SQL Server. The information that Access needs to create and 
maintain the table and its properties, such as input masks, substitution 
information, and formatting, is stored in a system table ( 
Access.ColumnProperties ) in the user database. 

 
 
 
 

5.5. Basic information about queries in MS Access. 
 
A query makes it easy when you need to view, add, change, or delete data 

in an Access database. Here are some more reasons to use queries: 
● quick data search using filtering according to certain criteria (conditions); 
● calculating or summarizing data; 
● automating data management tasks, such as periodically reviewing a 

dataset. 
An on-premise Access database offers more querying options, but some of 

them (listed below) are also available in Access web applications (a new type of 
database created in Access and published online). 

Note. To try using the queries in this example, you should use a local 
Access database. 
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Let's take a closer look at the following examples of creating and using 
queries in the Access program: 
− with the help of queries it is easier to search for data and work with them , 
− creating a selective query , 
− viewing data from selected fields , 
− simultaneous viewing of data from several related tables , 
− creating a parameterized query , 
− defining the data type of the parameter , 
− creating a summary request , 
− performing calculations on the basis of data , 
− display of summary or aggregate data , 
− creating a consolidated query , 
− creating a request to create a table , 
− creating an add request , 
− creating an update request , 
− creating a deletion request .  

Using queries makes it easier to find and work with data 
If the database is structured correctly, the data that needs to be represented 

by a form or report is usually contained in several different tables. A query allows 
you to retrieve information from different tables and collect it for display in a 
form or query. A query can be a request to retrieve data results from a database, 
or a request to perform an action on the data, or both. With the help of a query, 
you can get an answer to a simple question, perform calculations, combine data 
from different tables, or add, change, or delete data from a database. Because of 
this versatility, there are many types of queries that can be created to suit the task 
at hand. 

Creating a selective query  
If you need to check data only in certain fields of a table, or view data from 

multiple tables at once, or simply view data based on certain conditions, you 
should use a select query. 

View data from selected fields 
For example, if you have a table in your database that contains a lot of 

product information and you need to view a list of products and their pFigs, you 
can create a select query that returns only the product names and their 
corresponding pFigs by following the procedure below. 

1. Open the database, and on the Create tab , click the Query Builder 
button . 
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2. In the Table Display dialog box , on the Tables tab, double-click the 
Products table , and then close the dialog box. 

3. Suppose that the table "Products" has the fields "Product name" and "PFig 
according to the pFig list". Double-click the Product Name and List PFig fields 
to add them to the inquiry request form . 

4. On the Design tab, click the Run button . The request will start, then the 
list of products and pFigs will be displayed. 

 
Simultaneous viewing of data from several related tables 
Suppose, for example, there is a database for a store that sells products, and 

it is necessary to view the orders of customers who live in a certain city. Let's say 
that data about orders and customers is stored in two tables named, respectively, 
``Customers'' and ``Orders''. Assume that each table has a customer ID field that 
forms the basis of a one-to-many relationship between the two tables. With the 
help of the following procedure, you can create a query that will return the orders 
of customers from a certain city, for example, Donetsk. 

1. Open the database. On the Build tab, in the Queries group , click the 
Query Builder button . 

2. In the Table Display dialog box , on the Tables tab , double-click 
Customers and Orders . 

3. Close the Table Display dialog box . Notice the line (called a link) 
connecting the ID field in the Customers table to the Customer ID field in 
the Orders table. This line shows the relationship between the two tables. 

4. In the Clients table, double-click the Company and City fields to add them 
to the inquiry form. 

5. City column, clear the check box in the Display row . 
6. In the Criteria line of the City column , enter Donetsk . 

If the Display check box is disabled, the city is not displayed in the query 
results, and the word Donetsk entered in the Criteria line indicates that 
only records with the value "Donetsk" in the "City" field should be 
displayed. In this case, the request returns only clients from Donetsk. You 
don't need to display a field to apply a criterion to it. 

7. In the Orders table, double-click the Order ID and Order Date fields to 
add them to the next two columns in the query form. 

8. On the Design tab, in the Results group , click Run . After completing 
the request, a list of orders for clients from Donetsk will be displayed. 

9. Press CTRL+S to save the query. 
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Creating a parameterized query  
If you need to use variants of a certain query often, it makes sense to use a 

parameterized query. When executing a parameterized query, you will be asked 
to specify field values. The values you specify will be used to create the query 
criteria. 

Note. You cannot create a parameterized query in an Access web 
application . 

Continuing the theme started in the previous example, which demonstrated 
the creation of a select query that returns orders for customers from Donetsk, the 
following procedure can be used to modify the select query so that it prompts for 
the city every time it is executed. For further consideration, you should open the 
database created in the previous example. 

1. In the navigation area, right-click the query named Out-of-town orders 
(created in the previous section) and select the context menu item Designer 
. 

2. On the request form, in the Criteria line in the "City" column, delete 
Donetsk and enter [For which city?] . 
The line [For which city?] is the parameter that you will be prompted to 
specify. The square brackets indicate that the parameter must be entered 
during the query, and the text (in this case: For which city? ) is the 
question that will be displayed when prompted for the parameter value. 
Note. You cannot use a dot (.) or an exclamation mark (!) in the text of the 

hint. 
1. Enable the check box in the Display row of the "City" column to display 

the city in the query results. 
2. On the Design tab, in the Results group , click Run . A prompt will 

appear to enter the value of the "City" parameter. 
3. Enter Ivano-Frankivsk and press Enter to view orders from customers in 

Kharkiv. 
And what if you don't know what value to enter? You can use 
generalization symbols as part of a hint. 

4. On the Home tab, in the View group , click the View button , and then 
click Designer . 

5. On the request form, in the Criteria line of the City column , enter Like 
[To which city?]&"*" . 
In this option prompt text, the keyword Like , the ampersand character ( & 
), and the asterisk ( * ) in quotes allow the user to enter a combination of 
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characters, including wildcards, to return a string of results. For example, 
if the user enters * , the query will return all cities; if he enters L , the query 
will return all cities whose name begins with the letter "L"; if the user types 
*c* , the query will return all cities whose name contains the letter "c". 

6. On the Design tab , in the Results group , click Run , and then in the 
query prompt, type New and press Enter . 
The request will be fulfilled, and the orders of customers from Ivano-
Frankivsk will be displayed. 
 
Defining the data type of the parameter 
You can also define what data type the parameter should accept. You can 

set the data type for any parameter, but it is most important to set the data type 
for numeric and monetary data or date and time data. If the data type to be 
accepted by the parameter is specified, an error message will be displayed if the 
wrong data type is entered, for example, if a text data type is entered instead of 
the expected monetary one. 

Note. If the parameter is set to text data, any data input is interpreted as 
text and no error message is displayed. 

To determine the data type for a query parameter, follow the procedure 
below. 

1. With the query open in Designer view, on the Designer tab, in the Show 
or Hide group , click the Options button . 

2. In the Query Parameters dialog box , in the Parameter column , type a 
hint for each parameter for which you need to specify a data type. Make 
sure that each parameter matches the prompt used in the Criteria line of 
the request form. 

3. In the Data Type column , select the data type for each parameter. 
Create summary query  
A summary row in the data in a tabular view is very useful, but for more 

complex questions, a summary query is used. A summary query is a selective 
query that allows you to group and summarize data, for example, if you want to 
display the total sales volume of a product. You can use the "Amount" function 
(aggregate function) in the summary request to display the total sales volume of 
goods. 

Note. You cannot use aggregate functions in an Access web application. 
To modify the product subtotals query created in the previous example to 

get product subtotals by product, follow the procedure below. 



316 
 

1. On the Main tab, click the View button , and then click Designer . 
In the designer view, a request for product summaries will open. 

2. On the tab Designer in the group to display or to hide click element 
Results . 
Summary line will be displayed on the request form . 
Note. Despite their similar names, the Summary form row and the Data 

Summary row in a tabular view are not the same thing. 
● You can group items by field values using the Summary form line . 
● You can add a row of data to the results of a summary query in the 

Summary tabular view . 
● When using the Summary form row, you must select an aggregate 

function for each field. If there is no need to perform field calculations, you 
can group by field. 

● In the second column of the form, in the Summary row , select the Sum 
function from the drop-down list . 

● On the Design tab, in the Results group , click Run . The query will run, 
then a list of products with subtotals will be displayed. 

● Press CTRL+S to save the query. Leave the request open. 
Perform calculations based on data 

Typically, tables are not used to store calculated values such as subtotals, even if 
they are calculated based on data within the same database, because calculated 
values can become out of date if the values on which they are based change. For 
example, there is no need to store data about a person's age in tables, because this 
value needs to be updated every year. Instead, that person's date of birth is stored 
and then a query is used to calculate the person's age. 

Let, for example, there is a database for some products that need to be sold. 
In this database, there is a table called "Order Details", which contains 
information about the product in fields such as the pFig of each product and 
requests. To calculate a subtotal, you can use a query that multiplies the quantity 
of each item by the unit pFig of that item, multiplies the quantity of each item by 
the unit pFig and discount for that item, and then subtracts the total discount from 
the item's total cost. If the previous example created a sample database, open it 
and do the following. 

1. On the Build tab, click the Query Builder button . 
2. In the Table Display dialog box , on the Tables tab, double-click Order 

Details . 
3. Close the Table Display dialog box . 
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4. In the Order Details table, double-click the Product ID item to add this 
field to the first column of the inquiry form. 

5. In the second column of the request form, right-click the Field line and 
select the Scale context menu item . 

6. In the Scale window , type or paste the following expression:: Summary: 
([Quantity]*[Unit Cost])-([Quantity]*[Unit Cost]*[Discount]) 

7. Click the OK button . 
8. On the Design tab, click the Run button . The query will run, then a list 

of products and subtotals for each order will be displayed. 
9. To save the query, press CTRL+S, and then name the query: Product 

Summaries . 
 

5.6. Displaying summary or aggregate data 
 
If tables are used to record transactions or regularly store numerical data, 

it is useful to be able to view such data as a whole, as sums or averages. In Access, 
you can add a "Summary" row to a data table. A totals row is a row at the bottom 
of a data table that can display a running total or other aggregate value. 

1. Run a product summary query and leave the results open in the Data Table 
View. 

2. On the Main tab, click the Summary button . A new row will appear 
below the data in the table view with the word Summary in the first 
column. 

3. Click the cell in the last row of data in the table view labeled Summary . 

4. Click the arrow to display the available aggregate functions. Since the 
column contains text data, there are only two options: None and Number 
. 

5. Select the Quantity item . The content of the cell will change, and it will 
no longer be the Total , but the number of column values. 

6. Click the adjacent cell (second column). A button with an arrow will appear 
in the cell. 

7. Click on it and select the Sum function . The field will display the sum of 
the column values. 

8. Leave the query open in the data tabular window. 
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Create a summary query  
Now let's say you want to view product totals, but you also want to display 

month-by-month totals so that each row shows product totals and each column 
shows monthly totals. To display product totals and product totals for a month, 
use a cross query. 

Note. The cross-reference query is not displayed in the Access web 
application. 

You can change the product totals query again so that the query returns 
product totals rows and monthly totals columns. 

1. On the Home tab, in the View group , click the View button , and then 
click Designer . 

2. In the Query Customization group , click the Show Table button . 
3. In the Table Display dialog box , double-click Orders , and then click 

Close . 
4. On the tab Designer in the group Request type click element Cross table 

On the form, the line Display is hidden , and the line is crossed table is 
displayed . 

5. In the third column of the form, double-click the Field line with the right 
mouse button and select the Scale... context menu item . The Scale field 
will open . 

6. In the Scale window , type or paste the following expression: Month: 
''Month'' & DatePart (''m", [OrderDate]) 

7. Click the OK button . 
8. In the Crosstab row , select the following values from the drop-down list: 

Row Heading for the first column, Value for the second column, and 
Column Heading for the third column. 

9. On the Design tab, in the Results group , click Run . The query will run, 
then the subtotals for the month will be displayed. 

10. Press CTRL+S to save the query. 
 
Creating a request to create a table 
You can use the create table query to create a new table based on data stored 

in other tables. 
Note. The table creation query is not available in Access web applications. 
For example, you need to send data for Chernihiv orders to a business 

partner in Chernihiv who uses Access to prepare reports. Instead of sending all 
the order data, you need to send only the data related to the Chernihiv orders. 
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You can build a select query that contains the Chernihiv orders data and 
then use it to create a new table by following the procedure below. 

1. Open the example database from the previous example. 
You may need to enable database content to execute a query to create a 
table. 
Note. If you see a message under the ribbon about enabling the database, 

select the Enable Content option. If the database is already 
in a trusted location, the message line will not be displayed. 

2. On the Build tab, in the Queries group , click the Query Builder button 
. 

3. In the Table Display dialog box , double-click Order Details and Orders 
, and then close the Table Display dialog box . 

4. In the Orders table , double-click the User ID and Shipping City fields 
to add these fields to the form. 

5. In the Order Details table , double-click the Order ID , Product ID , 
Quantity , Unit PFig , and Discount fields to add these fields to the form. 

6. In the column of the Delivery City form , clear the check box in the 
Display line . In the Criteria line, enter 'Chernihiv' (in single quotes). 
Check the query results before using them to create a table. 

7. On the Design tab, in the Results group , click Run . 
8. Press Ctrl+S to save the query. 
9. In the Request name field, enter Request for orders from Chernihiv and 

click the OK button . 
10. On the Home tab, in the View group , click the View button , and then 

click Designer . 
11. On the tab Designer in the group Request type click element Creation 

tables . 
12. In the Create Table dialog box, in the Table Name field , enter Order 

from Chernihiv and click the OK button . 
13. On the Design tab, in the Results group , click Run . 
14. In the confirmation dialog, click Yes and see the new table that appears in 

the navigation area. 
Note. If a table with the specified name already exists, it will be deleted in 

Access before the query is executed. 
 
Create an add request 
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You can use an append query to retrieve data from one or more tables and 
add it to another table. 

Note. Add request is not available in Access web applications . 
Suppose, for example, that a joint table with a business partner from 

Chernihiv was created, but it is known that he also works with clients from 
Donbas. You need to add rows to the table that contain data about Donbass before 
giving the partner shared access to the table. This is how you can add data about 
Donbas to the "Orders from Chernihiv" table. 

1. In the "Designer" view, open the request with the name "Request for orders 
from Chernihiv". 

2. On the tab Designer in the group Request type click element Adding . It 
will open dialogic window Adding . 

3. In the Add dialog box , click the arrow button in the Table Name field 
and select the Order from Chernihiv drop-down list item , and then click 
OK . 

4. On the form, in the Criteria line of the "Delivery city" column, delete 
"Chernihiv" and enter "Donbas" . 

5. In the Add to row, select the appropriate field for each column. 
In this example, the value of the Append to string must match the value 
of the Field string , but this is not necessary for the append query to work. 

6. On the Design tab, in the Results group , click Run . 
Note. When running a query that returns a large amount of data, you may 

receive an error message stating that you cannot cancel the 
query. To ensure that the request is fulfilled, try increasing the 
memory segment limit to 3 MB. 

 
Create an update request  
You can use an update request to change data in tables. You can also use 

this query to enter criteria to determine which rows to update. An update request 
provides an opportunity to view the updated data before performing the update. 

WARNING!  A change request cannot be canceled. You need to back 
up the table that will be updated using the update request. 

Note. An update request is not available in Access web applications. 
In the previous example, you added rows to the "Orders from Chernihiv" 

table. In this table, the Product ID field displays the numeric product ID. To make 
the data more reportable, you can replace product IDs with product names. To do 
this, you should do the following. 
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1. Open the "Orders from Chernihiv" table in the designer view. 
2. In the "Product ID" line, change the data type from Number to Text . 
3. Save and close the "Orders from Chernihiv" table. 
4. On the Build tab, in the Queries group , click the Query Builder button 

. 
5. In the Table Display dialog box , double-click the Orders from 

Chernihiv and Products items , and then close the Table Display dialog 
box . 

6. On the tab Designer in the group Request type click element Update . 
7. The Sort and Display lines will disappear on the form , and the Update 

to line will appear . 
8. In the Orders from Chernihiv table , double-click the Product ID item 

to add it to the form. 
9. On the form, in the Update line to the Product ID column , type or paste: 

[Products].[Product Name] 
Advice. You can use an update request to remove field values with an 
empty string ( "" ) or a NULL value in the Update to line . 

10. In the Criteria line , type or paste: [Product ID] Like ([Products].[ID]) 
11. In the data tabular window, you can see which values will be changed by 

the update request. 
12. On the Design tab, click View > Table View . The query will return a list 

of item IDs to be updated. 
13. On the Design tab, click the Run button . 

When opening the "Orders from Chernihiv" table, the numerical values in 
the product identifier fields will be replaced by the product names from the 
"Products" table. 
 
 
Create a removal request 

To delete data from tables, you can use a delete request. With the delete query, 
you can also enter criteria to determine which rows to delete. The delete request 
provides an opportunity to view the rows to be deleted before the deletion is 
performed. 

Suppose, for example, that while preparing to send the "Orders from 
Chernihiv" table from the previous example to your business partner from 
Chernihiv, it turned out that some rows contain several empty fields. You chose 
to delete these rows before submitting the table. You can simply open the table 
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and delete the rows manually, but if there are a lot of rows and you have clear 
criteria to determine which rows to delete, it may be more convenient to use a 
delete request. 

You can use the request to delete rows from the "Orders from Chernihiv" 
table that are not relevant for the order ID, following the procedure below. 

1. On the Build tab, click the Query Builder button . 
2. In the Table Display dialog box , double-click the Order from Chernihiv 

item and close the Table Display window 
3. On the tab Designer in the group Request type click element Delete On 

the form the Sort and Display rows will disappear and the Delete row will 
appear . 

4. In the Orders from Chernihiv table , double-click the Order ID field to 
add it to the form. 

5. On the form, in the Criteria line of the Order ID column, enter Is Null . 
6. On the Design tab, in the Results group , click Run . 

 
4.7. General information about reports in Access 

With reports, you can view, format, and summarize data. For example, you 
can create a simple report that will show the phone numbers of all your contacts, 
or a summary report of sales data in different regions and for different time 
periods. 

This section provides an overview of reports in Access. It also provides an 
overview of how to create a report and use options such as sorting, grouping, and 
summarizing data, as well as how to preview and print the report. 

A report is a database object that is convenient to use to present information 
in a database for any of the following purposes. 

● Display or distribute a summary of data. 
● Archive snapshots of data. 
● Providing detailed information about individual records. 
● Creating signatures. 

Parts of the report 
Although you can create free reports that do not contain data, this article 

will use a report that is bound to a data source, such as a table or a query. 
According to its structure, the report is divided into sections that can be viewed 
in the designer mode. Understanding how each section works will help you create 
even better reports. For example, the part that houses the calculated control 
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determines how Access calculates the results. The table below describes the types 
of parts and their purpose. 

Table 5.3. 
Description of types of report parts and their purpose. 

Section Section display when 
printing 

The place of use of the section 

Header of the 
report. 

At the beginning of the 
report. 

A report header is used for data that would normally 
appear on the title page, such as logos, names, or 
dates. If you place a calculated control that uses the 
Sum aggregate function in the report header , the 
sum will be calculated for the entire report. The 
report header is printed first, followed by the page 
header. 

Page header. At the top of each page. The page header is used to repeat the report title on 
each page. 

header . 
At the beginning of 
each new group of 
records. 

The group header is used to print the name of the 
group. For example, in a report grouped by 
products, the group header is used to display the 
product name. If you place a calculated control that 
uses the Sum aggregate function in the group header 
, the sum will be calculated for the current group. 
Depending on the number of grouping levels, the 
report may contain several parts with a group 
header. For more information on creating group 
headers and footers, see in the section on adding 
grouping, sorting, and summarization. 

Details 
Appears once for each 
row in the record 
source. 

This is where the controls that make up the body of 
the report are placed. 

Group footer. 
At the end of each 
group of records. 

The group footer is used to display summary data 
for the group. Depending on the number of 
grouping levels, the report may contain several parts 
with a group footer. 

Page footer. 
At the end of each 
page. 

A page header is used to print page numbers or 
information that pertains to each page. 

Report footer. 

At the end of the report. 

Note In design mode, 
the report footer is 
placed below the page 
footer. But when 
printing or previewing, 

The report footer is used to print summaries or other 
summary data for the entire report. 
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Section 
Section display when 
printing 

The place of use of the section 

the report footer will be 
placed above the page 
footer , just after the 
last group footer, or 
after the detail row on 
the last page. 

Creating meaningful reports is much easier when the database has a well-
designed table structure and well-defined relationships. 

Creating a report 
Follow the steps below to generate reports for your local Access database. 
Step 1. Selection of the recording source 
The record source can be a table or a named or built-in query. The record 

source must contain all the rows and columns from which data is to be added to 
the report. 

● If the data you want came from an existing table or query, select that table 
or query in the navigation pane and go to step 2 .  

● If the record source has not yet been created, do one of the following: 
Go to step 2 and use the Blank Report tool  

Or 
● Create a table(s) or query with the required data. Select a query or table in 

the navigation area and go to step 2 . 
 
Step 2. Choosing a reporting tool 
The tools for creating reports are located on the Create tab in the Reports 

group . The parameters are described in the table below. 
Table 5.4. 

Tools for creating reports and their parameters. 
Instrument Description 

Report Creates a simple tabular report that contains all the fields of the 
record source selected in the navigation pane. 

Report Builder Opens a blank report in design mode. You can add fields and controls 
to this report. 

Blank report Opens a blank report in layout view and opens a field list from which 
you can add fields to the report. 

Report Wizard Launches a step-by-step wizard where you can specify fields, 
grouping/sorting levels, and layout options. 

https://support.office.com/uk-ua/article/%d0%97%d0%b0%d0%b3%d0%b0%d0%bb%d1%8c%d0%bd%d1%96-%d0%b2%d1%96%d0%b4%d0%be%d0%bc%d0%be%d1%81%d1%82%d1%96-%d0%bf%d1%80%d0%be-%d0%b7%d0%b2%d1%96%d1%82%d0%b8-%d1%83-%d0%bf%d1%80%d0%be%d0%b3%d1%80%d0%b0%d0%bc%d1%96-Access-e0869f59-7536-4d19-8e05-7158dcd3681c?ui=uk-UA&rs=uk-UA&ad=UA#__step_2__choose
https://support.office.com/uk-ua/article/%d0%97%d0%b0%d0%b3%d0%b0%d0%bb%d1%8c%d0%bd%d1%96-%d0%b2%d1%96%d0%b4%d0%be%d0%bc%d0%be%d1%81%d1%82%d1%96-%d0%bf%d1%80%d0%be-%d0%b7%d0%b2%d1%96%d1%82%d0%b8-%d1%83-%d0%bf%d1%80%d0%be%d0%b3%d1%80%d0%b0%d0%bc%d1%96-Access-e0869f59-7536-4d19-8e05-7158dcd3681c?ui=uk-UA&rs=uk-UA&ad=UA#__step_2__choose
https://support.office.com/uk-ua/article/%d0%97%d0%b0%d0%b3%d0%b0%d0%bb%d1%8c%d0%bd%d1%96-%d0%b2%d1%96%d0%b4%d0%be%d0%bc%d0%be%d1%81%d1%82%d1%96-%d0%bf%d1%80%d0%be-%d0%b7%d0%b2%d1%96%d1%82%d0%b8-%d1%83-%d0%bf%d1%80%d0%be%d0%b3%d1%80%d0%b0%d0%bc%d1%96-Access-e0869f59-7536-4d19-8e05-7158dcd3681c?ui=uk-UA&rs=uk-UA&ad=UA#__step_2__choose
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Instrument Description 

Signatures 
Launches a wizard where you can choose a standard or custom 
signature size, and specify which fields to display and how they 
should be sorted. 

 
Step 3. Creating a report 
1. Click the button of the desired report. If the wizard starts, follow its 

instructions and click Finish on the last page . 
2. Access displays the report in the Layout view. 
3. Format the report as needed. 

o Resize fields and labels by dragging their edges. 
o Drag the field to another location. 
o Right-click a field and select the appropriate command from the 

context menu to split or merge cells, delete or select fields, or perform other 
formatting. 

In addition, with the help of the functions described in the following 
sections, the report can be made even more attractive and convenient to read. 

Grouping, sorting and summarizing 
The fastest way to add grouping, sorting, or summarization to a local 

database report is to right-click the desired field and select the appropriate 
command from the context menu. 

Grouping, sorting, and totaling can also be added using the Grouping, 
Sorting, and Totaling panel when the report is open in markup or design mode: 

1. To open this panel, click the Design tab , and in the Grouping and 
Summarizing group, click the Grouping and Sorting button . 

2. Click the Add Group or Add Sort button , and then specify the 
field by which you want to group or sort. 

3. To specify additional parameters and add summaries, click the 
Expand button in the grouping or sorting row . 

 
Selection of data with conditional formatting 
Access includes tools for highlighting data in a report. You can add 

conditional formatting rules for each control or a group of such controls, and in 
client application reports, you can also add histograms for comparing data. 

 
Add conditional formatting to controls  
1. Right-click the report in the Navigation Pane and select Layout 

View . 
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2. Select the controls that you want, and then on the Format tab , in 
the Control Formatting group , click the Conditional Formatting button . 

Advice. To select multiple controls, hold down the Ctrl key while 
selecting the controls . 

3. In the Conditional Formatting Rule Manager dialog box , click 
the Create Rule button . 

4. In the New Formatting Rule dialog box , in the Choose Rule Type 
area , select the value you want. 
⮚ To create a rule that will be calculated for each record individually, select 

Check values in the current record or Use expressions . 
⮚ To create a rule that compares records with each other using histograms, 

select the Compare with other records value . 
1. In the Change rule description area , specify the rule that will 

determine when and what formatting should be applied, and then click OK . 
2. To create an additional rule for the same control or set of controls, 

repeat this procedure starting at step 4. 
 
Customizing color and fonts 
Try using the App Theme options to customize the color and fonts. 
1. Open the report in markup mode by right-clicking the report in the 

navigation pane and selecting Markup Mode . 
2. In the Report Layout Tools options group, on the Design tab , 

click the Themes button . Hover over different themes in the collection to view 
the effects. To select a topic, click it, then save the report. 

3. in the Colors and Fonts collections . 
 

Adding a logo or background image 
You can add a logo or background image to the report. When this image is 

updated, it will be updated in all places where it is used in the database. 
Add or remove an image 
1. In the Navigation Pane, right-click the report, and then click Layout 

View . 
2. In the report, click the position where you want to add the image, 

and then on the Design tab, in the Footer group, click the Logo button . 
3. Navigate to the image and click the Open button . Access will add 

the image to the report. 
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4. To delete an image, right-click the image and select Delete from the 
context menu. 

Adding a background image 
1. In the Navigation Pane, right-click the report, and then click Layout 

View . 
2. On the Design tab, in the Background group , click the 

Background Pattern button . 
3. Select an image from the Image Collection list , or click Browse , 

select an image, and then click OK . 
Preview and print the report 
Preview 
1. Right-click the report in the navigation pane and select Preview . 

Using the commands on the Preview tab , you can perform the following actions: 
o print the report; 
o change page size or layout; 
o zoom in or out or view multiple pages at the same time; 
o update the data in the report; 
o export the report to a file of another format. 

2. Click the Close window button. 
Print the report 
Print report without preview 
1. Right-click the report in the navigation pane and select Print. The 

report will be sent to the default printer. 
Note. If you select a report in the navigation pane and select Print on the 

File tab , you can set additional print options, such as the 
number of pages and copies, and specify the printer. 

2. Click the Print button to open a dialog box where you can select a 
printer, specify the number of copies, and more. 
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5.8. Creating an Access form 
The form is an analogue of a window in a store, which allows you to easily 

browse and choose the products you need. Because forms are objects that users 
can use to add, edit, or display data stored in a Microsoft Access database, the 
structure of the form is an important consideration. If the database is expected to 
be accessed by multiple users, properly designed forms are critical to efficient 
and accurate data entry. 

There are several ways to create a local Access database form, the most 
common of which are described in this article. 

 
Creating a form from an existing table or query 
To create a form from a database table or query, in the Navigation Pane, 

click the table or query that contains the data for the form, and then on the New 
tab, click Form . 

Access will create a form that will appear in the Layout view. If necessary, 
you can change the structure, for example, adjust the size of the text fields 
according to the amount of data. 

Creating an empty form 
1. To create a form with no controls or preformatted elements, on the 

Design tab, click the Blank Form button . Access will open a blank form in the 
Layout view and display the Field List area . 

2. In the Field List area , click the plus sign (+) next to one or more 
tables that contain fields that you want to appear on the form. 

3. To add a field to a form, double-click it or drag it onto the form. To 
add multiple fields at once, hold down the Ctrl key , click multiple fields, and 
then drag them all together onto the form. 

Note. The order of the tables in the Field List area can change depending 
on which part of the form is currently selected. If you can't add 
a field to a form, try selecting another part of the form and then 
add the field again. 

1. Use the tools in the Controls group on the Form Layout Tools tab 
to add a logo, title, page count, or date and time to your form. 

2. If you want to add a wider variety of controls to your form, select 
the Design tab and use the tools in the Controls group . 

 
Creating a split form 
A split form allows you to simultaneously view data in two views: 
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− in form submission 
− in the data tabular window. 

Working with split forms allows you to take advantage of two types of 
forms in one form. For example, you can use a table view to quickly find a record, 
and then a form view to view and edit that record. These two views are connected 
to the same data source and are constantly synchronized with each other. 

 
Fig. 5.17 - Working with a split form in MS Access 2016. 

The picture shows a form for entering new stationery items. The form has fields for the item 
code, name, unit pFig, and quantity. The user can enter data into these fields and then save 

the information to the database. 
 
To create a new split form using the Split Form tool, in the Navigation 

Pane, click the table or query that contains the data for the form, and then on the 
New tab , click More Forms , and then click Split Form . 

Access creates a form whose structure you can change. For example, you 
can adjust the size of the text fields according to the amount of data if necessary. 

 
Create a form that displays multiple records 
A multi-item form, also known as a continuous form, is convenient to use 

if you need to display multiple records on the form, but have more customization 
options than data in a table view, you can use the Multi-item tool. 

1. In the navigation pane, click the table or query that contains the data 
you want to display on the form. 

2. On the Create tab, click Advanced Forms > Multiple Elements . 
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Access will create a form that will appear in the Layout view. In layout 
view, you can change the layout of the form while displaying data in it. For 
example, the size of text fields can be adjusted according to the amount of data. 

Create a form that contains a subform 
When working with related data stored in separate tables, there is often a 

need to view data from multiple tables or queries in a single form. For this, it is 
convenient to use subforms . Subforms can be added in a variety of ways, 
depending on your needs. 

Creating a navigation form 
A navigation form is a regular form that contains a navigation control. 

Navigation forms are a great addition to any database, but if your database is 
going to be published online, creating a navigation form is especially important 
because the Access navigation area is not visible in the browser. 

1. Open the database to which you want to add the navigation form. 
2. On the New tab, in the Forms group , click the Transitions button 

, and then select the desired navigation form style. 
Access will create the form, add a navigation control to it, and display the 

form in the Layout view. 
 
 
 

String functions and their use 
You can use string functions to create expressions for a variety of text 

operations. For example, you may want to display only part of the serial number 
on a form, or combine multiple lines such as last name and first name. 

Table 5.5. 
A list of the most commonly used string operations and the functions 

used to perform them. 
Action Function Example The results 

Returns 
characters from 
the beginning of 
a string 

Left function  = Left ([ Serial_Number 
],2) 

If [ Serial_Number ] is 
"CD234", the result is 
"CD". 

Returns 
characters from 
the end of a 
string 

Right function  
= Right ([ 
Serial_Number ],3) 

If [ Serial_Number ] is 
"CD234", the result is 
"234". 

http://msdn.microsoft.com/uk-ua/library/gg251556.aspx
http://msdn.microsoft.com/library/gg278801.aspx
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Action Function Example The results 
Determining the 
position of a 
character in a 
line 

InStr function  
= InStr 
(1,[Name],"about") 

If [Name] is "Mykola", 
the result is 4. 

Returns 
characters from 
the middle of a 
string 

Mid function  
= Mid ([ Serial_Number 
],2,2) 

If [ Serial_Number ] is 
"CD234", the result is 
"D2". 

Remove spaces 
at the beginning 
and end of a line 

Functions LTrim 
, RTrim and Trim  = Trim ([Name]) 

If [Name] is "Mykola", 
the result is "Mykola". 

Joining two lines 
The plus sign 
operator (+)* 

=[First Name] + [Last 
Name] 

If [First Name] is 
"Mykola" and [Last 
Name] is Voloshyn, the 
result is " Mykola 
Voloshyn " 

Joining two lines 
with a space 
between them 

The plus sign 
operator (+)* 

=[First name] + “ “ + 
[Last name] 

If [First Name] is 
"Mykola" and [Last 
Name] is Voloshyn, the 
result is "Mykola 
Voloshyn" 

Change the 
string case to 
lower or upper 
case 

UCase function 
or LCase function = UCase ([Name]) 

If [Name] is "Mykola", 
the result is "MYKOLA". 

Determination of 
string length 

Len function  = Len ([Name]) 
If [Name] is "Mykola", 
the result is 6. 

* This is not actually a function, but an operator. However, this is the fastest 
way to concatenate strings. In a desktop database, you can also use the ampersand 
(&) operator to join. You must use the plus sign (+) in the Access web application. 

Access has many other text-related features. To learn more about them, 
open the expression builder and view the list of functions. The Expression Builder 
is available almost every time you need to build a function. Most of the time, 
you'll see a small Build button that looks like this: . 

To explore the Expression Builder , open it from the Source property of 
a control on a form or view. Use one of the methods below, depending on 
whether you are using a desktop database or an application. 

 
Displaying the expression builder in a desktop database 

http://msdn.microsoft.com/uk-ua/library/gg264811.aspx
http://msdn.microsoft.com/library/gg251677.aspx
http://msdn.microsoft.com/uk-ua/library/gg278916.aspx
http://msdn.microsoft.com/uk-ua/library/gg278916.aspx
http://msdn.microsoft.com/library/gg264252.aspx
http://msdn.microsoft.com/library/gg264252.aspx
http://msdn.microsoft.com/library/gg264497.aspx
http://msdn.microsoft.com/library/gg251657.aspx
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1. Open the desktop database (ACCDB). 
2. Press F11 to open the navigation pane if it is not already open. 
3. If the form is already available, right-click it in the Navigation Pane and 

select Markup Mode . If there is no ready-made form, on the Create tab 
, click the Form button . 

4. Right-click the text box on the form and select Properties . 
5. In the property sheet, select All > Control Source and click Build on 

the right side of the Control Source property field . 

 
Fig. 5.18 - Selection of the source of the control element of the form. 

6. Under Expression Elements, expand the Functions node , and then click 
Built-in Functions . 

7. In the Expression Categories section , select Text . 
8. In the Expression Values section , choose different functions and read the 

brief description at the bottom of the expression builder . 
Note. Different functions are available for different situations. Access 

automatically filters the list based on which functions will 
work in a particular situation. 

Display the Expression Builder in an Access web application 
1. Open the web app in Access. If you're viewing it in a browser, choose 

Options > Preferences in Access . 
2. Click a table in the left column, and then click the view name to the right 

of the list of tables. 
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Fig. 5.19 - Selecting a view in the list of MS Access tables. 

3. Select Edit , click the text box, and click the Data button that appears next 
to the text box 

.  
4. Click the Build button to the right of the Control Source drop-down 

list . 
5. Under Expression Elements, expand the Functions node , and then click 

Built-in Functions . 
6. In the Expression Categories section , select Text . 
7. In the Expression Values section , choose different functions and read the 

brief description at the bottom of the expression builder . 
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Practical work no 13. Creation of databases. Work with tables . 
 

The purpose of the work : to master the practical skills of creating databases, 
working with tables. 

 
Work execution program 

1. Download Access . 
2. Consider the project of the database "Students" from the assignment for 

practical work. Explain the expediency of creating the specified tables. 
3. Create a "Students" database. 
4. Create using the database table constructor according to the task for 

practical work. 
5. Enter data in the table in editing mode. 
6. View entered table data. 
7. Save the database. 

 
Tasks for practical work 

Create a database for processing information on university students. 
When filling out the database tables, take arbitrary data. The number of objects 
in the main database table must be at least 10, and in the additional ones - at least 
5. The structure of the "Students" database tables: 

● Students ( Last name , First name, Patronymic name, Year of birth, 
Faculty code, Specialty code, Group, Course, Year of enrollment, 
Region code, Address, Place of residence) - main table; 

● List of faculties (Faculty code, Faculty name); 
● List of specialties (Specialty code, Specialty name); 
● Composition of faculties (Faculty Code, Specialty Code); 
● List of groups (Group code, Faculty code, Group name, ); 
● List of regions (Region Code, Name). 

 
Theoretical information 

A database (DB) is a systematized repository of information. A telephone 
directory is an excellent example of a database. Databases are created in cases 
where it is necessary to track, analyze and store information over a period of time. 

A database management system (DBMS) is a program whose main functions 
are the creation of a database structure, recording, searching, sorting, processing 
(analysis) and printing of information stored in the database. 
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In a computer database, information is presented in the form of a table, very 
similar to a spreadsheet. The names of the columns are the names of the fields , 
and the columns themselves are the fields . Rows of data are called records . 

Microsoft Access is one of the simpler relational database management 
systems that is part of Microsoft Office . Working with Access , you can solve 
the following tasks: 

● break the data into logically connected parts; 
● enter, edit and find the necessary data; 
● find a lot of data according to the given conditions; 
● create forms and reports; 
● automate the performance of standard tasks; 
● graphically establish a relationship between data; 
● insert pictures into forms and reports; 
● create your own programs with menus, dialog boxes and command 
buttons that are ready to work with the database. 

 
Database design 

Before starting to create tables, forms and reports, it is necessary to spend 
some time designing the database. Focus your attention on data, performers and 
tasks. Some tips to follow when designing a database: 

▪ Start by analyzing an existing database (manually or computer 
generated). Review the forms and reports used. Determine the source 
of the data (if it is a computer, consider the possibility of importing 
data). Talk to people who use information from the database, discuss 
the problems and wishes that arise in connection with this. Review the 
problems that are solved with the help of the database and think about 
the ones that need to be solved in the future. 

▪ Identified the data and tasks that need to be solved, divided them into 
groups. These groups will later become tables. 

▪ Determine the types of data that will be stored in each table. These 
groups of table data are called fields . 

▪ View common elements of the tables (for example, the name of the 
customer can be a common element of the customer table and the 
invoice table). These common elements are called key fields. 

▪ Consider designing forms and reports. 
▪ Define selection criteria for queries. 
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▪ Consider how to automate standard database tasks such as running 
queries and printing reports. 

▪ Consider data security issues such as backup strategy, data sharing, 
and access restrictions when working on a network. 

▪ in this subject area 
Thus, the result of the database design process is the distribution of data by 

tables, the structure of tables, establishing the connection of tables (definition of 
fields for connection). 

 
Getting started with Access 
To download Access , you need to execute the command: " Start" 🡪" 

Programs " 🡪" Microsoft Access " . In the window that appears, you can create 
a new database and open a previously created database. 

Creating a new database 
After selecting the " New desktop database" item , you must specify the 

name of the database and its location (disk, folder). After clicking the " Create" 
button, a file with the extension . acc db . A database window with a list of 
database objects (tables, queries, forms, reports, pages, macros, modules) will 
appear on the screen. 

The database window has roots for each type of database object. If we select 
an object type, for example, a table, a list of database table names appears on the 
screen. To open the required object, double-click on its name or select the name 
and select the "Open" command from the context menu. 

To create new database objects or modify existing database objects, use the 
"Create" menu. 

 
Database objects 
Tables are a place to store data. The table consists of rows and columns. 

Each column has its own format. Tables can be created and edited. 
Queries are used to filter and select data. During their operation, you can 

link tables, which allows you to create complex tables from a series of small ones 
or from large tables to make small ones. Thus, an analogue of additional (virtual) 
tables is created, which are only in the computer's memory. 

Forms allow you to create an interface that allows users to work with tables 
in a more convenient way. The form is created based on tables and queries. 

Reports are a tool for displaying data on the screen or for printing in a 
convenient form. Reports are created based on queries and tables. 
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Macros are an automation tool that allows you to use ready-made commands 
to create a sequence of execution. 

Modules are software procedures for organizing more functional process 
management than macros. They are created using the VBA language. 

Tables 
You can perform operations on database tables: creation, editing, deletion. 
After designing and creating a database, the next step is to create tables to 

store data. To do this, select the "Create" menu and select one of the table creation 
methods in the "Tables" group: 

● empty table (by entering data); 
● in designing mode; 
● letters SharePoint . 

One of the main characteristics that must be specified when creating tables 
is the type of data. 

 
Data type definition 
The data type defines the type of information that is stored in the field. When 

you specify a field's data type, Access knows not only what data can be stored in 
that field, but also how much space to reserve for it. 

Access provides the following basic data types: 
● Numerical . Any type of numbers. They are used in calculations. 
● Text . Text or numbers that do not require calculations (maximum number 

of characters 255). 
● MEMO field. Long text or a combination of text and numbers (up to 65535 

characters/64 Kbytes ). 
● Date/Time Date and time relative to years from 100 to 9999 inclusive (8 

bytes). 
● Pecuniary. Monetary values and numerical data used in mathematical 

calculations with an accuracy of up to 15 whole digits and up to 4 digits 
after the decimal point. 

● Counter. Unique sequentially increasing by 1 or random numbers that are 
automatically entered Access when adding each new record to the table. 
The value of counter type fields cannot be updated. 

● Logical. The fields contain one of two logical values in 1 bit ( True / False 
, Yes / No). 
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● An OLE object field. An object (for example, a Microsoft Excel table, a 
Microsoft Word document, a picture or other data in binary format) is 
linked or “ embedded ” in a Microsoft Access table (up to 1 GB). 

● Master of substitutions. A field is created that offers a selection of values 
from a list, or from a field with a list that stores a set of constants or values 
from another table. 

● Hyperlink. A string of letters and numbers, which is the address of the 
hyperlink. 

 
When you create a field, Access will automatically prompt you to make it 

text. But you can change the field type using a list. 
 
Setting a field property 
Fields are characterized by properties that determine the way data is stored 

and displayed. Field properties are automatically transferred to other database 
objects that use this table - forms, reports, queries. In the " Field Properties " tab 
of the " Table " window, the following properties are indicated: 

▪ "Field size" . Specifies the size of text fields by a specified number of 
characters; limits numeric fields to a specified range of values. 

▪ "Field format" . Specifies the specified format for displaying dates and 
numbers. 

▪ "Number of decimal places" . Sets the number of decimal places in type 
fields Numerical and Monetary . 

▪ "Input mask" . Sets (only for Text and Memo fields ) formatting characters 
, such as “-” in phone number fields, to be filled in automatically during data 
entry. 

▪ "Field signature" . The label used in forms and reports instead of the field 
name. 

▪ "Default value" . Sets the initial value that is automatically entered in the 
new record. 

▪ "Condition for value" . Limits data entry to values that meet previously 
specified conditions. 

▪ "Required field" . It is set for data that must be entered. 
▪ "Empty lines" . Allows fields of type " Text " and " Memo " to have a term 

of zero length (""). By default, Access does not store these dates. 
▪ " Indexed field" . Sets an additional index that is based on the specified 

field. Indexes help Access find the values it needs. An index for primary key 
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fields is automatically created and maintained. If you need to frequently 
search or sort on some fields, you can significantly increase the search speed 
thanks to this property of the field. Indexes can be set to fields of all types, 
except for attached and “ embedded ” OLE , Memo and logical type objects. 
The list of all field indexing possibilities is in the line of this property. 

Control questions 
1. What is the purpose of the database design stage? 
2. Define characteristics of data types? 
3. What is the purpose of table fields and their characteristics? 
4. Describe database objects? 
5. Determine the possibilities of working with database tables? 

 
Practical work No. 14 . Using forms in databases . 

 

The purpose of the work : to master the skills of building forms and their use in 
database management. 

Work execution program 
1. Download Access . 
2. Create forms for filling in the tables of the "Students" database using the 

wizard. 
3. Edit forms in Designer mode: 

● insert the name of the form; 
● replace the name of the fields with the Ukrainian language; 
● for some fields, set precision and additional parameters for input; 
● set a formula for calculation fields. 

4. Enter the data in the table according to the form. 
5. Save the work results. 
6. Search for students according to the conditions of data matching of some 

fields, for example, faculty, date of birth - year, region). 

Theoretical information 

Forms are used for the convenience of the user when working with the 
database (viewing, entering, managing and printing data). More often, they are 
created to simplify entering and viewing data in database tables. 

Form creation 
Select the "Create" menu and use the Form Wizard in the "Forms" group. 

First, we select the table for which we are creating a form, and then in the window 
that appears, using the arrow buttons, we transfer the fields necessary for the form 
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to the " Selected fields" object. 

 
Fig. 5.20 - Selection of fields when creating a form in MS Access . 

For example, the form (table type or ribbon type) for working with the 
Subdivision table looks like this: 

 
Fig. 5.21 - View of the created form in MS Access . 

 
 

Editing the form 
To make changes to a previously created form, select a specific form and 

click the "Designer" button. On the screen we will see the layout of the form, 
which can be changed to a more user-friendly one. 
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Fig. 4.22 - Form designer mode in MS Access . 

 
The operation of changes to the layout of the form is associated with a 

certain sequence of changes in the sections "Header (Form Header)", "Page 
Header", "Details (Data Area)", "Form Footer", "Form Note". To change the size 
of the section, it is enough to bring the mouse pointer to the lower edge of the 
section and, holding down the left mouse button, resize the section. 

To reformat the names in the "Form Header" section, click on the name of 
the element. The form layout element is highlighted with size markers that allow 
you to change its size. In the highlighted element, you can enter information about 
its name, for example, we want to change the name of the element. The rules for 
entering text are similar to the rules of Word . To move an element, you need to 
move the mouse pointer with the left mouse button, move the element to the edge 
of its rectangle (the pointer will take the form of a hand) and, without releasing 
the left mouse button, move it to the desired place. 

When editing the layout of the form, the "Control elements" panel, which is 
located in the additional "Designer" menu, is often used. The "Select" key is 
active by default. 

 
Table 5.6. 

Assignment of the main keys of the panel of elements 
But

ton Name 
Butto
n Name 

 "Choice"  "Switch" 

 " Inscription "  "List" 
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 "Field"  "Rectangle" 

 "Button"  "Flag" 

 "Tab"  " Free object frame " 

 "Hyperlink"  "Attachment" 

 "Parameter group"  "Switch" 

 "Page break"  " Subform /report" 

 "List box"  
" Attached object 

frame " 

 "Chart"  "Image" 

 "Line"   
If one of the fields of the database has a calculation value, then the data is 

entered into it from the form where the calculation formula is located. For 
example, product data (pFig, quantity) is entered into the table, and the cost is 
calculated. Then, when working with the form of this table in the designer mode, 
you need to select the "Field" element for the cost, which is in the data area, call 
up the context menu on it (right mouse button) and select the "Properties" item in 
it. In the properties window of the selected form element, in the "Data" tab, in the 
"Control element source" line, click the "Expression builder " button (...). In the 
" Expression Builder " window, open the required table (Costs), select the 
necessary fields and mathematical symbols for calculating the cost, and press the 
" OK " button at the end of the expression. 

 
Fig. 5.23 - " Expression Builder " window in MS Access . 

In the properties window of the selected form element, in the "Format" tab, 
you can set the number of decimal places in the number, etc. (see Fig. 5.24). 
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Fig. 5.24 - Properties window of the "Area" field. 

 
View table data 
The form is used for entering and editing data. Changing the current record 

is done using the scroll buttons ( , ) or the command "Go" in the main menu, 
which allows you to view all records. To enter a new record, you need to go to 
the last empty line. 

You can use filters to view the data in the form. Thanks to filters, you can 
display in the form only those of the table records that meet the specified criteria. 

Filters are saved automatically when you save the form. That way, when 
you apply the form again, you can reuse the saved filter. If it is not necessary, 
then it is necessary to remove the filter using the main menu command "Filter" 
or "Clear all filters". 

 
Control questions 

1. What is the purpose of forms? 
2. Describe the main points of creating forms? 
3. What is the purpose of filters in the form? 

 
Practical work no 15 . Creation of queries in MS Access . 

 
The purpose of the work: to master the practical skills of creating and using 

queries in MS Access. 
 

The order of work 
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1. Download Access , the "Students" database. 
2. Create sample requests: 

− c students with a year of birth more than 1994; 
− c students born from 1990 to 2002; 
− c students from the region (determine the region independently), 

year of admission – 2016; 
− list of students of the faculty (indicate the specific faculty); 
− c students of the 3rd year of all specialty groups (indicate a specific 

specialty). 
3. Based on the requests from point 2, create parametric requests. 
4. Create cross queries: 

− the number of students in all regions by year of admission from 
2015-2017; 

− the number of students in each specialty in different courses. 
5. Save the database. 

 
Theoretical information 

Queries allow you to link tables, which allows you to create complex tables 
from a series of small ones or from large tables to small ones. Thus, an analogue 
of additional (virtual) tables is created, which are only in the computer's memory 
and do not take up space on the disk. The methods of working with queries are 
the same as with tables. 

Queries are used to view, change and analyze data by various means. 
Queries can also be used as a source for forms, reports, and data access pages. 

Request types: 
● sample requests ; 
● requests with parameters ; 
● cross-examination ; 
● change requests ( deletion, update or addition of entries in the table ); 
● SQL queries ( unification requests, management requests, subordinate 

requests, requests to the server ) . 
The most common request is a sample request. It selects data from one or 

more tables and then displays them in the required order. 
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Fig. 5.25 – An example of using a request for sampling from several tables. 

 
A parameter query is a more flexible query that, when used, displays 

prompts for input in its dialog box, such as conditions for two dates. Therefore, 
these queries are often used to create forms and reports. 

Cross-reference queries display the results of statistical calculations (totals, 
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number of records, and average values) performed on data from one table field. 
These results are grouped into two sets of data, one in the left column of the table 
and the other in the top row. 

Creating requests in the designer mode (QBE form ) 
Creation of queries is carried out in relation to the conditions of selection 

of records, which can be quite different. 
Table 5.7. 

Types of requests relative to different selection conditions 
Selection condition Example 

Exact match $1000 

Search using pattern characters IN*; 1# A 

Search for mismatches 
(the “ NOT ” operator is used) NOT “ In *” 

Search by date 04.04.04; Date () 
Search for empty fields (using the operator “ 

NULL ” or “ NOT NULL ”) NULL 

The comparison operator 04.04.05 ; < Date () 

Value Yes/No 
No/True/0/1 

specify one of the 
options 

Complex selection condition (logical operations 
“ AND ”, “ OR ”, “ NOT ” are used) 1000 OR 3000 

 
Table 5.8. 

Use of symbols in selection conditions 
Symbol 

Explanation 

* Any number of any characters 
? One any symbol 
# Used instead of any number 
[] It is used to represent one of the symbols indicated in square 

brackets (U[IA]) 
! It is used to represent characters missing in square brackets 

(U[!IA]) 
- Used to represent a single character that is in a range, for 

example Y[Y-A]) 
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LIKE Used to represent symbols similar to a condition . For 
example, LIKE “[А-Д]*” 

Between Used when the value must be within a given range 
In  used when the values must be in the field itself. 

 
To create requests, you must perform the following actions: 

● go to the "Create" menu; 
● select designer mode; 
● select the tables needed for the query (after each table, press the "Add" 

button). Press the "Close" button; 
● if the necessary tables were not selected in time, this action can be performed 

using the context menu, which is called to the upper part of the designer, 
where the selected tables are placed; 

● if it is necessary to create a connection between the fields of different tables, 
we do it with the mouse (we move the field from one table to the field from 
the second table). The result should be a line that shows the connection; 

● specify the fields of the tables that are needed to form the request ("Field" 
line); 

● check the presence of the "Display" flag for each field that we want to display 
in the result table after the query is executed; 

● if it is necessary to sort the query result by any field, then in the "Sorting" 
line, specify the sorting order; 

● conditions for requests are specified in the "Criteria" line; 
● switch to table view mode. 

In the Criteria line, you can use square brackets with the text of the question 
or the sign “ ? ” (empty question), if it is necessary to ask a question about this 
field during the request (parametric request). 

Control questions 
1. What is the purpose of parametric queries? 
2. What types of requests are there? 
3. How can I create a request?  
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Practical work No. 16. Reports in Microsoft Access . 
 

The purpose of the work : to master the practical skills of creating reports and 
working with them. 

 
Work execution program 

1. Download Access . 
2. Open the Students database 
3. Create the following reports, where the field names are written in 

Ukrainian: 
– the report is generated by the "Report Master" based on the list of 

all faculties of the university (the name of the report is Faculties ); 
– a report on students of a separate faculty with the calculation field 

Age (select the faculty yourself, the name of the report is 
Students_faculty ); 

– a report on students from a separate region (define the region 
yourself, the name of the report is Students_region ). 

4. Save the database. 
 

Theoretical information 
Creating reports 
When working with databases, it is often necessary to process and display 

information on a monitor or printer. This can be done using reports. In the report, 
the user can select data from one or more tables or database queries, make the 
necessary calculations and prepare it in the most convenient form. In Access, you 
can use samples of standard report structures (mostly simpler forms), or build 
your report of any complexity. If the user does not yet have the skills to build 
reports, it is better to use the Access software tools for building reports, which is 
called the "Report Wizard " . 

To build a report, you need: 
● open the database file window, select the "Create" menu; 
● in the "Reports" group, select the option to build a report: 
⮚ " Autoreport " - the selected or calculation fields are issued automatically 

in the report; 
⮚ "Constructor" - construction of a report by the user; 
⮚ "Report Wizard" - building a report using Access software ; 
⮚ " Empty report " – a completely empty report without data is created; 
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⮚ " Labels " are used to prepare address labels and stick them on postal 
envelopes for mailing. 

● for example, we choose the report creation option "Report Wizard"; 
● select the table or query and the fields from which we will use information 

to build the report; 
● click on the " Next" button ; 
● windows for creating reports open, where we select the grouping levels (if 

necessary), the sorting order (if necessary), the type and style of the report 
layout , the name of the report. 

The "View report" option indicates that the result of the report created 
using the "Report Wizard" will be displayed on the screen (active by 
default). 

Option "Changing the structure of the report" - a version of the 
constructed report appears on the screen for making changes to it by the 
user. We leave it unchanged and click on the Finish button, a report 
execution results window appears on the screen 
 
Editing the report 
To make changes in the report, you must perform the following actions: 

1. to choose necessary report ; 
2. click the " Designer" button . 
A report will appear on the screen, which has sections: 

● " Report Title / Report Header " - in this section maybe find the title of the 
report , information about the date and time. Covers once at the start report 
. 

● " Upper footer " - is used mainly for the formation of caps ( permanent 
information ) weekend reports . Repeated from above each page . 

● “ Details / Data area ” is the main area, where they take out data database 
fields , calculated indicators and other data It is repeated for each record . 

● " Page footer " - used for placement rooms pages and auxiliary data . It is 
repeated at the bottom of each page . 

● Notes of the report / Footer of the report " - you can place final results , 
auxiliary data Outputs once at the end everything report . 
Resize sections in a report 
The height of each report section can be changed, and all report sections 

have the same width. Changing the width of one area automatically changes the 
width of the entire report. 
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To change the width or height of the report, you need to place the mouse 
cursor on the bottom or right edge of the section being changed, respectively. At 
the same time, the mouse cursor should take the form of a vertical or horizontal 
bidirectional arrow. By moving it in the desired direction, the size of the partition 
also changes. In order to change the height and width of the section at the same 
time, you need to set the mouse cursor in the lower right corner of the section and 
repeat the operations described above. 

Resizing, moving, and editing report elements 
Each section of the report consists of separate rectangles filled with data. 

This rectangle is called a report element. To change the size of the report element, 
you must: select it by clicking the left mouse button, bring the cursor to the corner 
or edge of the rectangle so that the mouse cursor takes the form of a bidirectional 
arrow. By moving the cursor in the desired direction, without releasing the left 
mouse button, we change the size of the report element. 

To move a report element, you must: select it by clicking on it with the left 
mouse button. After that, move the cursor along the rectangle until it takes the 
shape of a palm. This is an indication that the report item can be moved. By 
moving the cursor in the desired direction, without releasing the left mouse 
button, we also move the report element. 

 
Control questions 

1. What is the purpose of reports? 
2. What are the sections in the report? 
3. How to save the report in a separate file? 
4. Explain the method of editing reports. 
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CHAPTER 6. DESIGNING PRESENTATIONS IN THE 
POWERPOINT PROCESSOR  

 
Microsoft PowerPoint 2016 has a new look. It looks cleaner and is perfect 

for tablets and phones, allowing you to present with touch and swipe. Presenter 
mode automatically adapts to the presentation settings. It can even be used on one 
monitor. Themes are now offered in several variants, making it easier to give your 
presentation the look you want. Also, when working with other users, you can 
add notes to ask questions or get feedback. 

 
6.1. Getting started with PowerPoint  

 
Instead of opening a blank presentation, PowerPoint 2016 offers several 

ways to create your next presentation based on a template, theme, recent 
presentation, older presentation, or blank presentation. 

  
Fig. 6.1 - The window for creating a new presentation in POWERPOINT. 

 
6.2. New capabilities of the POWERPOINT program 
Simple speaker mode 
Presenter mode allows you to view notes on the monitor while the audience 

only sees the slides. In previous releases, it was difficult to determine exactly 
what would be displayed on a particular monitor. In the improved speaker mode, 
such a problem no longer exists, which greatly simplifies work with this mode. 
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Fig. 6.2 – The view of the presentation in the Simple mode of the speaker . 

● Using speaker mode on one monitor. Presenter mode no longer requires 
multiple monitors. Now in speaker mode you can train without connecting 
additional equipment. 

● Zoom on the slide. Click the magnifying glass icon to zoom in on charts, 
diagrams, or any other elements you want to draw your audience's attention to. 

● Go to the slide. Use the slide navigator to navigate to other slides in your 
presentation. 

● Automatic tuning. PowerPoint can automatically determine your computer 
settings and select the correct monitor for Presenter mode. 

Create and share online interactive presentations 
Office Mix is a new free solution for PowerPoint that lets you create and 

share interactive presentations or " mixes " online. Mixes play like Internet 
videos, but with support for animations, dynamic links, and more. 

 
Fig. 6.3 - " Mixes " menu bar in POWERPOINT. 

To get Office Mix , download and install the free add-in. When you open 
PowerPoint, you'll see a new Mix tab . You can record audio or video notes for 
each slide in your presentation. You can embed quizzes, featured videos, and 
more. Easily record the information displayed on the screen while adding audio 
notes . When you're ready, preview your mix , then upload it to OfficeMix.com 
to share it. The OfficeMix.com portal offers analytics, which you can view to learn 
audience statistics and quiz results. 

Convenient work with widescreen screens 

https://mix.office.com/Gallery
https://mix.office.com/Gallery
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Most televisions and video systems in today's world are widescreen and 
support HD, as does PowerPoint. The program features a 16:9 layout, and new 
themes are designed to take advantage of widescreen displays. 

 

  
Fig. 6.4 – Options for using different layouts of slides in Powerpoint . 

Start a network meeting from PowerPoint 
Now there are several ways to make a PowerPoint presentation over the 

Internet. You can send a link to the slides or start a full Lync meeting in which 
the presentation is displayed with audio and instant messaging. Participants can 
join the presentation from any location, on any device using Lync or the Office 
presentation service. 

 
Fig. 6.5 – Options for displaying a 

PowerPoint presentation on different 
devices. 

 
Improved designer tools  

Theme options 
Themes now come in multiple options, such as different color palettes and 

font families. In addition to standard size themes, PowerPoint 2016 also includes 
new wide-format themes. Select a theme and its variant from the home screen or 
from the Designer tab. 
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Fig. 6.6 – Choosing a theme and color palette in PowerPoint 2016. 

Alignment and uniform arrangement of objects 
You no longer need to visually inspect the placement of objects on slides to see 
if they are properly aligned. Smart guides are automatically displayed when 
objects such as images, shapes, etc. are placed almost flat, and signal that the 
objects are placed evenly. 

 
Fig. 6.7 – Automatic arrangement of objects in PowerPoint. 

Improvement of the ways of movement 
PowerPoint now displays the end point where the object will end up when 

you create a path. The source image remains in place, and its "ghost" image 
moves along the path to the end point. 

 
Fig. 6.8 – Creating a path for moving objects in PowerPoint. 

 
Combining common shapes 
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Select two or more common shapes on a slide and combine them to create 
new shapes and icons. 

 
Fig. 6.9 – Grouping of objects in PowerPoint. 

Improved video and audio support 
PowerPoint now supports more media formats, including MP4 and MOV 

with H.264 video and AAC audio, as well as other HD content. PowerPoint 
includes additional built-in codecs , so you don't need to install them separately 
to ensure that files of a certain format can be played. 

Use Background Playback to play music while viewing a slideshow. 
New eyedropper for matching colors 
Now you can take the exact color that the object on the screen has, and then 

apply it to any shape. The eyedropper automatically selects colors to match. 
 

  
Fig. 6.10 – the "Eyedropper" tool 

in PowerPoint. 
 
PowerPoint on touch 

devices 
Now you can work 

with PowerPoint on most 
devices, including PCs running Windows 8 and 10. Using standard touch input 
controls, you can drag, tap, scroll, zoom, and pan your slides and literally feel the 
presentation. 

Sharing and saving 
Share and save Office files in the cloud storage on OneDrive or on your 

organization's website. There, you can open PowerPoint presentations and other 
Office files, and share them. You can even work simultaneously with colleagues 
on the same file. The cloud is like a file storage in the sky. It can be accessed at 
any time while online . Now you can easily store Office files in your own 
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Fig. 6.11 – Sharing and saving PowerPoint files in the OneDrive cloud . 

You can now leave feedback in PowerPoint using the new Notes area. 
Notes and editorial corrections can be shown or hidden. 

  
Fig. 6.12 - Saving Feedback in the new " Notes " area. 

Joint work on one presentation 
You can work together with colleagues on the same presentation in the 

desktop version or in the online version of PowerPoint and immediately see the 
changes that others make.  
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6.2. The first steps of creating a presentation in PowerPoint  
PowerPoint presentations work on the same principle as slide shows. To 

convey an idea or tell a story, it is better to divide the material into slides. Each 
slide can be imagined as a blank canvas for drawings, words and figures that will 
help create a coherent report. 

 
Fig. 6.13 – Elements of the main PowerPoint window. 

Choosing a topic 
When you open PowerPoint, the built-in topics are displayed. A theme is a 

slide design with a single style that includes colors, fonts, and special effects like 
shadows, reflections, and more. 

1. Choose a topic. 
2. Click the Create button or select a color option, and then click the Create 

button . 
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Insert a new slide 
On the Home tab, click Create Slide and select a slide layout. 

 
Fig. 6.15 – Creating a new slide in a PowerPoint 2016 presentation. 

 
Save the presentation 

1. On the File tab , select the Save command . 
2. Select or navigate to a folder. 
3. In the File name field , enter a name for the presentation and click Save . 

Note. If you often need to save files to a certain folder, you can "pin" this 
path so that it is always available. 

 
Fig. 6.16 – Saving a presentation in PowerPoint 2016. 

Advice.  Save your work as you do it. Don't forget to press Ctrl+S from 
time to time . 
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Fig. 6.17 – Changing the theme or slide size of a PowerPoint presentation. 

 
6.3. Working with objects in the PowerPoint program  

Adding text  
Click on the text space and start entering data. 

 
Fig. 6.18 – Entering text in PowerPoint presentations. 

 
Text formatting 

1. Highlight the text. 
2. On the Drawing Tools tab, select the Format tab . 
3. Do one of the following: 
4. To change the text color, select Text Fill , and then select a color. 
5. To change the color of the outline, select Text Outline , and then select a 

color. 
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6. To apply shadows, reflections, glows, reliefs, volumetric rotations, 
transforms, click Text Effects , and then select the desired effect. 

 
Fig. 6.19 – Editing text in a PowerPoint 2016 presentation. 

Adding shapes  
1. On the Insert tab, click the Shapes button . 
2. Select the shape you want, click anywhere on the slide, and then drag to 

create the shape. 

 
Fig. 6.20 – Adding new shapes in a PowerPoint 2016 presentation. 

Advice. To create a regular square or circle (or resize other shapes), 
hold down the  Shift key while dragging . 

Adding images  
On the Insert tab , do one of the following: 

● To insert a picture saved on your local drive or internal server, click 
Pictures , locate the picture, and then click Insert . 
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Fig. 6.21 – Adding new images in a PowerPoint 2016 presentation. 

● To insert an image from the Internet, select Online Images and find the 
image you want using the search box. 
For example, type Cats or Graphic images of cats in the Bing Image 

Search box . 
● Select the picture and click the Insert button . 

 
6. 4. Presentation output methods  

Conducting a presentation 
On the Slide Show tab , do one of the following: 

● To start the presentation from the first slide, in the Start Slide Show group 
, click From the beginning . 

 
Fig. 6.22 – Presentation presentation in PowerPoint 2016. 

● If you're not currently viewing the first slide and want to start from that, 
click From Current Slide . 

● If you need to present to people who are in a different location, click the 
Online Presentation button and set up your presentation over the Internet 
by selecting one of the options below. 
Exit slide show view 
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● That exit the slide show view , press on the keyboard at any time key Esc 
. 

 
Fig. 6.23 - Menu groups in the PowerPoint program. 

 
Printing of slides of the speaker's presentation 

1. On the File tab, go to the Print tab . 
2. In the Printer section, select the printer you want to use for printing. 
3. In the Options group , click the arrow next to Full Page Slides , and then 

under Print Layout, click Notes Pages . 
4. Click the Print button . 

 
Fig. 6.24 – Printing a presentation in PowerPoint 2016. 

Practical work No. 17. Creating PowerPoint presentations. 
 

The purpose of the work: to master the skills of creating presentations in the 
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PowerPoint program. 
 

Theoretical information 
In the presentation process, it is desirable to have auxiliary illustrative 

material (graphs, tables, photos, etc.) to achieve greater informativeness and 
visuality of the material. The PowerPoint program is used to create a suitable 
presentation . 

Start the Microsoft program PowerPoint  
● download the Windows operating system ; 
● click on the " Start" button; 
● in the " Programs" menu item , select the "Microsoft PowerPoint " 

sub-item; 
● a screen saver will appear in PowerPoint , then the program window 

with a request for options for working with the presentation (create a 
new one or open a created one). 

Creating a presentation 
When you start PowerPoint, a dialog box appears on the screen where: 

 
Fig. 6.25 – Creating a presentation in PowerPoint 2016. 

" Master autocontent " - for opening presentations that were previously 
created and viewed last or saved elsewhere. 

"design templates" - for creating a presentation of your own content and 
sequence of material, but with automatic background design of presentation 
slides, the templates of which are in the program library. 

"empty presentation" - for creating a presentation with its own content and 
sequence of material, as well as independent background design of presentation 
slides. 
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Self-creation of a presentation 
● in the "File" menu item , select the "Create " sub-item; 
● in the left part of the window, among the proposed options, select the 

"New presentation" item ; 
● in the " Main " menu , select the layout of the first slide; 
● the first slide according to the selected structure will appear on the 

screen; 
● highlighting the elements of the slide structure, fill them with 

appropriate content; 
● to create a new presentation slide, in the "Main" menu item , select 

the "Create a slide " sub-item; 
● in the dialog box that appears, select the layout of the next slide; 
● repeat the above procedures for filling and creating slides. 
Making presentation slides 
To ensure the desired effect from the presentation, the slides are decorated 

with a suitable colored background, multimedia effects of the appearance and 
disappearance of the slide, sound accompaniment, etc. To decorate the 
background of newly created slides or change the existing background, you can 
use the "Design template" or choose the color, texture, pattern of the 
background of the slide yourself, etc. 

Designing the background of the slides using the "Design Template" 
● create a slide; 
● select "Theme " in the "Designer" menu item . 

 
Fig. 6.26 – Choosing a presentation topic in PowerPoint 2016. 

Self-designing the background of the slides 
● create a slide; 
● in the "Designer" menu item , select the "Background format" sub-

item ; 
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● in the dialog box that appears, open the list of possible background 
options; 

● in the opened list check: 
− "Solid fill" - for choosing a plain color of the background of the slide 

from the color palette; 
− "Gradient fill" - for applying a gradient background fill; 
− "Image or texture" - for choosing the background texture of the 

slide, or using your own graphic image as a background; 
− "Pattern filling" - for selecting the background pattern of the slide; 
− " Hide the background image " - do not display the background 

image; 
− " Color " - to select the main color of the slide background; 
− "Transparency " – to select the transparency of the slide background 

in percentage; 
● click the "Apply" button - to apply the selected background option to 

one slide, or "Apply to all" - to apply the selected background option 
to all presentation slides. 

Slide presentation modes 
PowerPoint allows you to perform operations with slides in different 

modes. It is advisable to create slides, fill them with content, and set animation 
effects on slide elements in the "Normal" slide presentation mode. 

"Slide Sorter" mode allows you to display the presentation on the screen 
in its entirety, move slides, manage slide change effects, view effects, etc. The 
finished presentation is viewed in the "Slide Show" mode . 

To select the presentation mode of the slides, it is necessary to select the 
sub-item "Normal" , "Structure presentation" or "Slide sorter" in the " 
View" menu item to select the desired presentation mode 

 
or click on the buttons on the toolbar 

 . 
"Normal" mode 

In the normal slide presentation mode, it is most appropriate to perform 
the following operations: 

■ Fill out slide templates: 
− select the zone in the slide structure that is planned to be filled; 
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− set the parameters of the font that will be filled in the title or text 
area; 

− to insert a graphic object from a file in the "Insert" menu item , 
select the "Image" sub-item , go to the cascade sub-menu and select the "From 
file" item . 

− to insert a graphic object from the clip library, double-click the clip icon 
and select the desired one; 

■ Set animation for slide elements: 
− in the "Animation" menu item , select the "Animation area" sub-

item . 
− in the dialog box that appears, select those slide elements that will 

appear on the slide field with a certain effect and in a certain sequence. 
Unchecked slide elements appear simultaneously with the slide background; 

− in the "Timing" tab , in the "Animation order" field , select the 
element for which the animation must be adjusted. Using the "Animation" 
parameter group , specify the method of starting the animation, as well as the 
time interval after which the effect will be automatically performed; 

− to change the sequence of appearance of slide elements on the 
working field, it is necessary to highlight the desired element in the list of 
elements, use the buttons to set the object in the desired place of the display 
sequence; 

 
− in the "Effects parameters" tab , you can also add sound to the 

effect by specifying the appropriate sound file; 
− in the "Appearance" field , if the effect is applied to the text, 

specify the order of text display (all at once, by words or by letters); 
− to get acquainted with all the changes made, you need to click on the 

"Play" button . The adjusted effect will be displayed accordingly with all the 
specified parameters. 

"Slide sorter" mode 
In the slide sorter mode, it is most appropriate to perform the following 

operations: 
■ Change the order of slides: 
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− select and cut to the clipboard a slide that is planned to be shown in a 
different sequence; 

− set the cursor between the slides where you plan to insert the cut slide; 
− insert a slide from the clipboard, 
− or drag the desired slide to the desired place using the mouse. 
■ Add new slides: 
− " Main " menu button " Create slide " ; 
− or highlight the slide that precedes the newly created one and  

press " Enter " ; 
− or using the context menu button " New slide ". 
■ Copy slides from one presentation to another: 
− set the cursor between the slides, where the borrowed slides will be 

inserted; 
− in the "Main" menu item , select the "Create a slide" sub-item ; 
− in the dialog box that appears, select the item "Reuse slides" and find 

in the structure of drives and folders the file with the presentation from which the 
slides must be inserted ; 

− in the dialog box that appears, in the "Select slides" field , mark the 
necessary slides and press the "Insert" button . 

■ Delete slides: 
− down the <Ctrl> key , select the necessary slides; 
− press the <Delete> key . 
■ Create slide transition effects: 
− < Ctrl > key ; 
− in the "Transitions" menu item , in the "Effects" field , select the 

desired slide change effect from the list; 
− in the "Timeline" area, check: " mouse button click " - to change 

slides by clicking the mouse button, "After" - to change slides automatically 
after the time interval indicated on the numerical pointer; 

− click the button: "Apply to all" - to apply the effect to all slides of the 
presentation. 

■ Create an automatic cyclic display of a presentation: 
− pre-install the function of automatic slide change on each slide of the 

presentation (see the previous point); 
− in the "Slide Show" menu item , select the " Presentation settings " 

sub-item . 
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− in the dialog box that appears, in the "Slideshow" field, check 
"Automatic (full screen)" ( "Continuous cycle" option ) . When the "Slide 
Show" mode is enabled , the presentation will be cyclically repeated until the 
<Esc> key is pressed . 

 
Fig. 6.27 - Setting the cyclic display of animation in PowerPoint 2016. 

■ Hide slides 
In the event that not all slides of the presentation are required to be shown 

at the moment, they can be marked as hidden. Hidden slides are displayed in all 
modes except Slide View. To hide slides, you must: 

− select the necessary slides and click on the "Hide slide" button from 
the context menu. 

− hidden slide numbers will be placed in a square frame crossed 
diagonally. 

"Slide show" mode 
At any stage of creating a presentation in PowerPoint, you can view 

individual slides or the entire presentation in real-time. 

Start the presentation for viewing 
Select the slide from which you plan to start showing the presentation in 

any of the modes, click on the "From the current " button in the "Slide show 
" menu item , and a slide show will be launched on the screen. To exit the slide 
show mode, use the <Esc> key . 

After the slide show is finished, the presentation will be displayed in the mode from which it was launched. 

Work execution program 
1. Choose the topic of the presentation. 
2. Prepare the original graphic (sound, video) information in digital form, which 

will be used when creating a presentation. 
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3. Download the PowerPoint program . 
4. Create a presentation on a specified topic using text, graphics, (sound, video) 

information in the amount of 6-10 slides. 
5. The created presentation can be presented in two display options: the first one 

is to change the slides by clicking the mouse, the second one is to continuously 
show the slides in a closed loop with a slide show interval of 4 seconds. 

Control questions 
1. How to create a presentation based on a content template? 
2. How to apply a presentation design template? 
3. How to set animation of slide elements? 
4. How to design the background of a presentation slide? 
5. How to create an automatic presentation presentation? 
6. How to create and save a presentation? 
7. What is the file format in MS PowerPoint? 
8. How many ways to create a presentation? 
9. What are Presentation Viewing Modes? 
10. How to insert a slide? What is Slide Markup? 
11. How to work with tables in MS PowerPoint? 
12. What types of organizational charts are highlighted in MS PowerPoint?? 
13. Inserting objects from libraries. Formulas. Clips Flash videos. 
14. Sample slides. Sample notes. Footers. 
15. What are the rules for using Animation? 
16. Presentation management options. 
17. Hyperlinks in slides. 
18. Control buttons in the presentation. 
19. Presentation display settings. 
20. Placing the presentation on the Internet. 
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